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1 Overview

1 Overview

Part Concepts

Geometry

Variable Values

EnSight 7 User Manual

EnSight (for Engineering inSight) provides engineers and scientists with an easy-
to-use graphics postprocessing package. EnSight supplies powerful, easy-to-use
tools through a user-friendly interface.

The purpose of this chapter is to give you an overview of the EnSight system and
its documentation. Because of the power and flexibility of EnSight, the synergy
between features provides a great many visualization techniques.

The Overview topics discussed are:

Part Concepts
Data Types
Graphical Environment
Transformations
Frames
Coloration
Created Parts
Queries
Transient Data
Animation
Implementation
Documentation

Contacting CEI

EnSight processing begins with your model. Usually the elements of your model
are grouped into parts. Within EnSight, nearly all information is associated with
parts, and nearly all actions are applied to parts.

A part consists of nodes and elements (elements are sets of nodes connected in a
particular geometric shape). Each node, which is shared by its adjoining elements,
is defined by its coordinate-location in the model frame of reference.

EnSight-compatible data files provide variable values either at each part’s nodes,
element centers, or both. When needed (or requested) EnSight will find any
variable’s value at any point on or within an element by utilizing the element’s
shape function.
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1 Overview

Part Attributes

Within EnSight, you can specify additional information about each part. These
part attributes tell EnSight how to display each part and how the part responds to

EnSight controls and display options. Part attributes include:

Category

Includes attributes that control....

General Attributes

Color By Attributes

Node, Element, and Line
Attributes

Surface Attributes

Displacement Attributes

Labeling Attributes

Part Operations

Visibility

Susceptibility to Auxiliary Clipping
Reference frame

Response to changes in time (frozen or active)
Symmetry options

Coloration (constant or by a palette associated with a
variable)

Node visibility

Node type (dot, cross, or sphere)

Node size (constant or variable)

Node detail (for spheres)

Element-line visibility

Element-line width

Element-line style (solid, dotted, or dot-dash)
Element representation on client (full, border,
3D border/2D full, feature angle, or not loaded)
Element-size shrink-factor

Polygon Reduction

Shaded Surface susceptibility

Surface shading (flat, Gouraud, smooth)

Fill density (for transparency)

Lighting (diffuse, shininess, and highlight intensity)

Displacement variable
Displacement scaling factor

Node, element, and part label visibility

Parts can be copied to show, for example, the same part colored by a different
variable. Model parts can be split along an arbitrary plane or any quadric surface,
and merged with other model parts. The geometry of parts can be simplified by

creating a new part by extracting a simpler representation of an existing part.

Part Representation

Parts can be represented with simpler geometry, both to enhance visualization

performance and for special effects. Representation modes include:

Full mode, which represents all the part’s elements in the graphics window.
Border mode, which represents 3D elements with their 2D external faces.

Feature angle mode, which represents with 1D elements the “significant”

edges of the part (you control what is “significant™)

(see Section 3.3, Part Editing, and Section 8.1, Part Mode)

EnSight 7 User Manual
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1 Overview

EnSight supports a number of common data formats as well as interfaces to
various simulation packages. There are four different means to get your data into
EnSight.

Type 1 - Direct (built-in) Readers - Are accessed by choosing the desired format
in the Data Reader dialog. These include common data formats as well as a
number of readers for commercial software.

Type 2 - User-Defined readers - A library of routines is provided with EnSight to
allow users to create their own custom interfaces. Like Type 1, User-Defined
Readers have the advantage of not requiring a separate data translation step and
thus reduce user effort and disk storage requirements. A number of User-Defined
Readers are provided with EnSight; complete documentation and dummy routines
may be found in the directory SCEI_HOME/ensight76/src/readers.

Type 3 - Stand - Alone Translators - May be written by the user to convert data
into EnSight format files. A complete description of EnSight formats may be
found in Chapter 11 of the EnSight Online User Manual. Several translators are
provided with EnSight. These are found in the directory SCEI_HOME/ensight76/
translators. Translators must first be compiled before they may be used. Some
require links to libraries provided by the vendor of the program in question. See
the README files found in each translator’s directory.

Type 4 - EnSight Format - A growing number of software suppliers support the
EnSight format directly, i.e. an option is provided in their products to output data
in the EnSight format.

The table that follows summarizes all of the data formats and software packages
for which an interface of Type 1-4 exists. As this information changes frequently,
please consult our website (www.ensight.com) or your EnSight support
representative should you have any questions. If your format or program is not
listed here, there is the possibility that an interface does indeed exist. Contact
EnSight support for assistance. Should you create a User-Defined Reader or
Stand-Alone Translator and wish to allow its distribution with EnSight, please
send an email to this effect to support@ensight.com.

Data Format / Program | Type Comments

ABAQUS

1 Direct reader for binary or ascii (.fil) files (ABAQUS STANDARD or
EXPLICIT

ACUSOLVE

Contact vendor for information

ADAGIO

Use Exodus II reader

ADINA

Use I-DEAS neutral files and translators

ALEGRA

Use Exodus II reader

ANSYS

Direct reader for binary .rst, .rth, .rmq, .rfl files

CASE (EnSight6/EnSight Gold)

Native EnSight formats, EnSight6 Case and EnSight Gold Case

CFD++

Exports EnSight Case format

CFD-ACE

Contact vendor for DTF reader

CFD-FASTRAN

Contact vendor for DTF reader

CFDESIGN

Uses Tecplot files and reader

CFF

User reader for Common File Format from BOEING (WIND code)

CFX4

w

User reader, and translator (useful if results contain massed particles)

CFX5

Code exports EnSight Case format

CFX-TASCflow

WA= ]—=[(N|wW|[DN

Converts TASCflow output to EnSight format (or use PLOT3D converter
from vendor)

CGNS

3 User reader

EnSight 7 User Manual
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Data Format / Program | Type Comments

COBALT 2,4 User reader (obtain from vendor) - or - Exports EnSight Case Gold format

CRAFT 4 Exports EnSight Case Gold format

CRUNCH 4 Exports EnSight Case Gold format

CTH 2 Use Exodus II reader

ECLIPSE 3 Contact CEI for details

ENSIGHT (EnSight 5) 1 Original EnSight format (unstructured)

ESTET 1 Direct reader

EXODUS I 2 User reader

FAST Unstructured 1 Direct reader for NASA FAST unstructured format

FEFLO 3 Contact vendor for information

FEMWATER 2 Use GMS reader

FENSAP 4 Contact vendor for information

FIDAP 1 Direct reader for FIDAP neutral (FDNEUT) files

FINE/Aero 1,2 Use PLOT3D or CGNS files/reader

FINE/Turbo 1,2 Use PLOT3D or CGNS files/reader

FIRE 4 Code exports EnSight format

FLOW-3D 2 User reader for FLOW-3D results (flsgrf) files

FLUENT (particle files) 3 Converts Fluent particle file to EnSight format

FLUENT 4 Code exports EnSight Casefile format

FOAM 4 Contact developer (Imperial College) for interface details

GASP 4 Exports EnSight Case format

GMS 2 User reader for GMS groundwater modeling framework, contact CEI for
information

GUST 4 Exports EnSight Case format

HDF 2 Contact CEI for information

I-DEAS 3 Translator for I-DEAS FEA neutral file

10/API 2 User reader for MODELS 3 framework, contact CEI for information

KIVA 2,3 Conversion routines to export EnSight format, contact CEI for info

LS-DYNA 2 User reader for d3plot files

MAYA ESC 4 Contact vendor for information

MODELS 3 2 Use IO/API reader

MOVIE.BYU 1 Direct reader for MOVIE.BYU format files

MPGS 4.1 1 Direct reader for MPGS, EnSight’s predecessor

MSC.DYTRAN 2 User reader for MSC/Dytran archive (.arc) or data (.dat) files

MSC.NASTRAN 2 User reader for binary OP2 files

MUSES/Prism 2 User reader from Thermoanalytics

NCC 2 User reader interface to National Combustion Code, contact CEI for info

N3S 1 Direct reader for the EDF code N3S

NetCDF 2 User reader, contact CEI for information

NSMB 2 User reader developed by CERFACS and CSCS

NSU2D / NSU3D 4 Contact CEI for information

PATRAN 3 Converts PATRAN neutral files to MOVIE.BYU format

PHOENICS 1 Use PLOT3D file/reader, contact CEI for information

PLOT3D 1 Direct reader for PLOT3D and FAST structured formats

POLY-3D 3 Contact vendor for information

POLYFLOW 4 Outputs EnSight Case format

POWERFLOW 3 Contact CEI for information on interfaces available

PRESTO 2 Use Exodus II reader

PRONTO 2 Use Exodus II reader

PXI 2 User reader for Parallel Exodus Interface format

RADIOSS 3 Contact vendor for interface details

RADTHERM 2 User reader from Thermoanalytics

RESCUE 2 User reader for Schlumberger reservoir modeling framework, contact CEI
for information

1-4 EnSight 7 User Manual
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Data Format / Program | Type Comments
SCRYU 2 User reader
SILO 2,3 Reads various formats supported by SILO API
SPHINX 4 Code exports EnSight format
STAR-CD (Version 3.0.5 & up) |4 Code exports EnSight Casefile format (including particle data)
STL 2 User reader for STL geometry files (may also be exported)
TAHOE 4 Contact CEI for information on interfaces available
TECPLOT 2 User reader for TECPLOT structured and unstructured formats
Telluride 4 Code exports EnSight format
UNCLE 2 User reader, contact CEI for details
UNIC-CFD 3 Contact vendor for details
USM3D 4 Contact CEI for information
VECTIS 2,3 User reader

Geometry EnSight reads unstructured and structured geometric data grouped by parts. Data

Analysis Results

Measured Data

Cases

can be 0D, 1D, 2D or 3D.

EnSight reads scalar and vector variable values associated with each node and/or
element of the geometry. The loading of variable values is optional, and variables
can be unloaded to free memory.

EnSight can read measured or computed particles (referred to as discrete particles
in EnSight). Particles can have the same variables as the model geometry, or their
own variables. Particles can be displayed as points, crosses, or spheres whose size
can vary according to a variable value. Sphere smoothness is also controllable.
Discrete particles can be time dependent with the geometry, or time dependent
with a steady geometry.

(See EnSight Gold Measured/Particle File Format, in Section 11.1)

EnSight provides the capability to read and manipulate up to eight datasets or
models at a time. Each new “Case” is handled by its own Server process while the
Client appropriately deals with merged variables, solution times, etc. This option
allows both the recombination of models partitioned for parallel analysis and a
number of comparative operations.

Graphical Environment

Hidden Lines and
Shaded Surfaces

Clipping

Annotations

EnSight 7 User Manual

Parts are visualized in a main Graphics Window. You can create additional
viewports and adjust their size to your needs. Each viewport has its own
transformations (global, local, look-at, look-from, and Z-clip locations). Part
visibility is also controllable in each viewport.

A separate “Show Selected Part(s)” window helps in identifying parts.

You can choose to shade surfaces and/or hide hidden lines for realistic views of
your model. Visible element edges can be overlaid on shaded solid images.

In addition to user-control of the front and back clipping planes of your
workspace, you can cutaway parts or portions of parts along any plane using
Aucxiliary Clipping. Individual parts can be made immune to the effect, enabling
you to look at parts inside of other parts.

EnSight can display text-strings, lines, arrows, logos, entity labels, and color-map
legends. Text annotations (which may include variables) can be made to
automatically update for time-dependent data.



1 Overview

Image Output

Perspective

Background Color

Transformations

Frames

Coloration

Variable Palettes

Created Parts

Clips

Screen images can be saved from within EnSight. Conversion to popular formats
is under user control as the image is saved.

You have your choice of a perspective view or an orthogonal view. The latter is
useful for comparing the position of parts and positioning EnSight tools.

You can specify a constant or blended color background for the main Graphics
Window and independently for any Viewports displayed in the Graphics Window.

The standard transformations of rotate, translate, and scale are available, as well
as positioning of the Look-At and Look-From points. An automatic zoom control
is available. The transformation-state (the specific view in the Graphics Window
and Viewports) can be saved for later recall and use. Transformations can be
performed with precision in a dialog, or interactively with the mouse. For the
latter case, you can choose to represent the parts with bounding-boxes all the time
or only while they are moving. Transformations can individually be reset by type.

(see Chapter 9, Transformation Control)

Transformations actually apply to frames—the parts attached to the frames
transform right along with their frame. You can create new frames and transform
them like parts (in a dialog or with the mouse), and change to which frame a part
is attached. You control whether and how frames are displayed, enabling you to
use them as rulers. Frames can have rectangular, cylindrical, or spherical
coordinates.

Frames, and therefore all parts attached to them, can be “periodic”. Rotational or
translational periodicity (as well as mirror symmetry) attributes are under user
control allowing, for example, an entire pie to be built from one slice of the pie.

(see Section 8.5, Frame Mode and Section 9.3, Frame Transform)

Parts can be colored according to the value of a variable. This “fringes” feature
works for both lines and surfaces. The coloration of each part is an attribute of that
part.

You control the value-color correspondence with a palette. A palette’s scale can
be linear, logarithmic, or exponential. Palettes can have a continuous range of
colors, or color bands. Off-the-scale parts or portions of parts can be made
invisible.

(see Section 4.2, Variable Summary & Palette)

In addition to the model parts defined in the dataset, you can (and usually will)
define additional created parts based on both the geometry and variable-values of
existing parent-parts. Model parts and most kinds of created parts can be used as
parent parts. Created parts have their own part attributes, including the creation
attributes that define them, but remain dependent upon their parent-parts. A
created part automatically regenerates if any of its parent-parts are changed in a
way that will affect its representation.

A clip is a plane, line, box, ijk surface, xyz plane, rtz surface, quadric surface
(cylinder, sphere, cone, etc.), or revolution surface passing through specified

EnSight 7 User Manual



Contours

Developed Surfaces

Elevated Surfaces

Isosurfaces

Particle Traces
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1 Overview

parent-parts. The plane clip can either be limited to a specific area (finite), or clip
infinitely through the model. A line clip is finite and most other clips are infinite

in nature. You control the location of the various clips with an interactive Tool or
appropriate parameter or coefficient input.

A clip line has query points along the line (you control how many).

A clip plane will either be a true clip through the model, or can be made to be a
grid where the grid density is under your control.

Clip surfaces can be animated as well as manipulated interactively.

In most cases you will create a clip which is the intersection of the clip tool and
the parent parts. This clip can either be a true intersection or all elements that
cross the intersection surface (a “crinkly” surface). You can also choose to cut the
parent parts into half spaces.

(see Section 7.5, Clip Create/Update)

Contours are created by specifying which parts are to be contoured, and which
function palette to use. The contour levels can be tied to those of the palette or can
be specified independently by the user.

(see Section 7.2, Contour Create/Update)

Developed Surfaces can be created from cylindrical, spherical, conical, or
revolution clip surfaces. You control the seam location and projection method that
will flatten the surface.

(see Section 7.9, Developed Surface Create/Update)

Elevated Surfaces can be displayed using a scalar variable to elevate the displayed
surface of specified parts. The elevated surface can have side walls.

(see Section 7.7, Elevated Surface Create/Update)

Isosurfaces can be created using a scalar, vector component, vector magnitude, or
coordinate. Isosurfaces can be manipulated interactively or animated by
incrementing the isovalue.

(see Section 7.3, Isosurface Create/Update)

Particle traces—both streamlines (steady state) and pathlines (transient)—trace
the path of either a massless or massed particle in a vector field. You control
which parts the particle trace will be computed through, the duration of the trace,
which vector variable to use during the integration, and the integration time-step
limits. Like other parts, the resulting particle trace part has nodes at which all of
the variables are known, and thus it can be colored by a different variable than the
one used to create it. Components of the vector field can be eliminated by the user
to force the trace to, for example, lie in a plane. The particle trace can either be
displayed as a line, a ribbon, or a square tube showing the rotational components
of the flow field. Streamlines can be computed upstream, downstream, or both.

Particle traces originate from emitters, which you create. An emitter can be a
point, rake, net, or can be the nodes of a part. Each emitter has a particle trace emit
time specified which you set, and a re-emit time (if the data case is transient) can
also be specified. Point, rake, and net emitters can be interactively positioned with
the mouse. For streamlines, the particle trace continues to update as the emitter
tool is positioned interactively by the user.
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Profiles
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Vector Arrows
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Vortex Cores
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Queries

Plotting

(see Section 7.4, Particle Trace Create/Update)

Profile plots can be created by scalar, vector component, or vector magnitude. You
control the orientation of the resulting profile plot.

(see Section 7.8, Profile Create/Update)
A subset Part can contain node and element ranges of any model Part.
(see Section 7.16, Subset Parts Create/Update)

Vector arrows show the direction and magnitude of a vector field. Vector arrows
originate from element vertices, element nodes (including mid-side nodes), or
from element centers. You specify which parts are to have arrows and which
vector variable to use for the arrows, as well as a scale factor. You can eliminate
components of the vector, and can also filter the arrows to eliminate high, low,
low/high, or banded vector arrow magnitudes. The vector arrows can be either
straight or curved, and can have arrow heads. The arrow heads are either
proportional to the arrow or can be of fixed size.

(see Section 7.6, Vector Arrow Create/Update)

Tensor glyphs show the direction of the principal eigenvectors. You specify which
eigenvectors you wish to view and how you wish to view compression and
tension.

(see Section 7.17, Tensor Glyph Parts Create/Update)
Vortex cores show the center of swirling flow in a flow field.
(see Section 7.19, Vortex Core Create/Update)

Shock surfaces or regions show the location and extent of shock waves in a
3Dflow field.

(see Section 7.20, Shock Surface/Region Create/Update)

Separation and attachment lines show where flow abruptly leaves or returns to the
2D surface in 3D fields.

(see Section 7.21, Separation/Attachment Lines Create/Update)

In addition to visualizing information, you can make numerical queries.

You can query on information for a node, point, element, or a part.

You can query on information for a data set (such as size, no. of elements, etc.)
You can query scalar and vector information for a point or node over time.

You can query scalar and vector information along a line. The line can either be a
defined line in space, or a logical line composed of multiple 1D elements for a
part (for example query of a variable on a particle trace).

You can query to find the spatial or temporal mean as well as the min/max
information for a variable.

Where applicable, query information can be in the form of a Fast Fourier
Transform (FFT).

The plotter plots Y vs. X curves. The user controls line style, axis control, line
thickness and color. All query operations that result in multiple value output in

EnSight 7 User Manual



Variable Creation

EnSight 7 User Manual

1 Overview

EnSight can be sent to the plotter for display. The user can control which curves to
plot. Multiple curve plots are possible. All plotable query information can be
saved to a disk file for use with other plotting packages.

(see Section 7.11, Query/Plot and Section 7.12, Interactive Probe Query)

New information can be computed resulting in a constant, a scalar, or a vector.
EnSight includes useful built-in functions for computing new variables:

Area

Coefficient

Complex Argument
Complex Imaginary
Complex Transient Response
Curl

Density, Normalized
Density, Normalized Stagnation
Distance Between 2 Nodes
Element to Node

Energy, Kinetic

Enthalpy, Normalized
Enthalpy, Normalized Stagnation
Flow

Fluid Shear Stress

Force

Gradient

Gradient Tensor

Helicity Density

Helicity, Relative Filtered
Integral, Line

Integral, Volume

Mach Number
MakeScalNode

Mass Flux Average

Min

Moment Vector

Node to Element

Normal Constraints

Offset Field

Pressure

Pressure, Dynamic

Pressure, Log of Normalized
Pressure, Pitot Ratio
Pressure, Normalized Stagnation
Pressure, Total

Shock Plot3d

Speed

Stream Function
Temperature

Temperature, Stagnation

Case Map

Complex from real and imaginary
Complex Conjugate

Complex Modulus

Complex Real

Density

Density, Stagnation

Density, Log of Normalized
Divergence

Energy, Total

Enthalpy

Enthalpy, Stagnation

Entropy

Flow Rate

Fluid Shear Stress Max
ForcelD

Gradient Approximation
Gradient Tensor Approximation
Helicity, Relative

Iblanking Values

Integral, Surface

Length

MakeScalElem

Make Vector

Max

Moment

Momentum

Normal

Normalize Vector

Offset Variable

Pressure Coefficient

Pressure, Normalized

Pressure, Pitot

Pressure, Stagnation

Pressure, Stagnation Coefficient
Rectangular to Cylindrical Vector
Spatial Mean

Sonic Speed

Swirl

Temperature, Normalized
Temperature, Normalized Stagnation
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Transient Data

Animation

Particle Trace
Animation

Flipbook Animation

Temperature, Log of Normalized Temporal Mean
Tensor Component Tensor Determinate
Tensor Eigenvalue Tensor Eigenvector
Tensor Make Tensor Tresca
Tensor Von Mises Velocity

Volume Vorticity

A calculator and built-in math functions also are useful for creating variables. Any
created variable is available throughout EnSight, and is automatically recomputed
if the user changes the current time (in case of transient data).

(see Section 4.3, Variable Creation)

In addition to the built-in general functions and the calculator options, variables
can be derived from user written external functions called User Defined Math
Functions (UDMF). The UDMF’s appear in EnSight’s calculator in the general
function list and can be used just as any calculator function.

Another feature of EnSight facilitates the creation of boundary layer variables.

(see Section 7.22, Boundary Layer Variables Create/Update)

EnSight handles transient (time dependent) data, including changing connectivity
for the geometry. You can easily change between time steps via the user interface.
All parts that are created are updated to reflect the current display time (you can
override this feature for individual parts). You can change to a defined time step,
or change to a time between two defined steps (EnSight will linearly interpolate
between steps), though the “continuous” option is only available for cases without
transient geometry.

You can animate your model in three ways: particle trace animation, flipbook
animation, and keyframe animation.

Particle trace animation sends “tracers” down already created particle traces. You
control the color, line type, speed and length of the animated traces.

If transient data is being animated at the same time, animated traces will
automatically synchronize to the transient data time, unless you specifically
indicate otherwise.

Flipbook animation is simpler to do than keyframe animation, while allowing four
common types of animation:

Sequential presentation of transient data

Mode shapes based on a displacement variable

EnSight created parts with an animation delta that recreates the part at a new
location (i.e., moving isosurfaces and Clip surfaces).

Sequential displacement by linear interpolation from zero to maximum
vector value.

You can specify the display speed, and can step page-by-page through the
animation in either direction. You can load some, or all the desired data. If you
later load more data, you can choose to keep the already loaded data. With
transient data, you can create pages between defined time steps, with EnSight
linearly interpolating the data.
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Flipbooks can be created in two formats: a) Object animation where new objects
are created for each time step. The user can then manipulate the model during
animation play back or b) Image animation where a bitmap of the Main View
image is created and stored off for each animation page. For large models, image
animation can sometimes take less memory - while trading off the capability to
manipulate the model during animation.

(see Section 7.14, Flipbook Animation)

Keyframe animation performs linearly interpolated transformations between
specified key frames to create animation frames. Command language can be
executed at key frames to script your animation. Some minimal editing is possible
by deleting back to defined key frames. Animation key frames can be saved and
restored from disk. Animation can be done on transient data and can automatically
synchronize with simultaneous flipbook animation and particle trace animation.

“Fly-around”, “rotate-objects”, and “exploded-view” quick animations are
predefined for easy use.

Keyframe animation can be recorded to disk files using a format of your choice.

(see Section 7.15, Keyframe Animation)

EnSight uses the OSF/Motif graphical user interface conventions for the Unix
version and Win32 conventions under the Windows NT4.0sp3/2000/XP operating
system. Many aspects of the interface can be customized.

EnSight is a distributed application—it runs as separate processes that
communicate with each other via a TCP/IP or similar connection. The Server
performs most CPU-intensive and data-handling functions, while the Client
performs the graphics-display and user-interface functions. The Client and Server
can run together on one host workstation in a “stand-alone” installation or on two
host systems with each hardware system performing the functions it does best.
When more than one case is loaded the Client communicates with multiple Server
processes.

A special server-of-servers (SOS) can be used in place of a normal server if you
have partitioned data. This SOS acts like a normal server to the client, but starts
and deals with multiple servers, each of which handle their portion of the dataset.
This provides significant parallel advantage for large datasets.

(see Section 11.8, Server-of-Server Casefile Format)

Each action performed with the graphical user interface has a corresponding
EnSight command. A session file is always being saved to aid in recovery from a
mistake or a program crash. The user will be prompted upon restart, after a crash,
whether or not to use a recovery file to restore the session. The command
language is human-readable and can easily be modified. Command files can be
played all the way through, or you can choose to stop the file and step through it
line-by-line.

You can define a “context” and apply it to similar datasets.

Many graphics functions of EnSight are performed by your workstation’s graphics
hardware. EnSight version 7 uses the OpenGL graphic libraries and is available
on a multitude of hardware platforms.
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Solid image lighting can be done either in hardware, or in software. The software
option does not recalculate the lighting changes due to transformations (hence, the
light source seems to move with the model). While this is less realistic, it can
greatly increase performance and decrease memory requirements.

EnSight supports shared-memory parallel computation via POSIX threads.
Threads are used to accelerate the computation of streamlines, clips, isosurfaces,
and other compute-intensive operations. (See How To Setup for Parallel
Computation for details on using.)

You can define macros tied to mouse buttons or keyboard keys to automate
actions you frequently perform.

You can save the entire current status of EnSight for later use, and can save other
entities as well (including the geometry of created parts for use by your analysis
software).

(see Section 2.5, Archive Files)

The printed EnSight documentation consists of the Getting Started manual.

The on-line EnSight documentation consists of the EnSight User Manual, a
Command Language Reference Manual, a How To Manual and the Getting
Started Manual. The online documentation is available via the Help menu.

The EnSight User Manual is organized as follows:
User Manual Table of Contents

Chapter 1 - Overview

Chapter 2 - Input/Output. This chapter describes the reading of model data
(with internal or user-defined readers), command files, archive files, context files,
scenario files, and various other input and output operations.

Chapter 3 - Parts. This chapter describes the various types of Parts, selection,
identification, and editing of Parts, and various Part operations,

Chapter 4 - Variables. This chapter describes the selection and activation of
variables, color palettes, and the creation of new variables.

Chapter 5 - GUI Overview. This chapter describes the EnSight Graphic User
Interface.

Chapter 6 - Main Menu. This chapter describes the features and functions
available through the buttons and pull-down menus of the Main Menu of the GUL

Chapter 7 - Features. This chapter describes the features and functions available
through the Icon buttons of the Feature Icon Bar of the GUL

Chapter 8 - Modes. This chapter describes the features and functions available
through the Icon Buttons of the Mode Icon Bar in the six different Modes.

Chapter 9 - Transformation Control. This chapter describes the Global
transformation of all Frames and Parts, the transformation of selected Frames and
Parts as well as selected Frames alone, the transformation of the various Tools,
and the adjustment of the Z-Clip planes and the Look At and Look From Points.

Chapter 10 - Preference File Formats. This chapter describes the format of
various preference files which the uses can affect.

Chapter 11 - EnSight Data Formats. This chapter describes in detail the format
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of the various EnSight data formats.

Chapter 12 - Utility Programs. This chapter describes a number of unsupported
utility programs distributed with EnSight.

User Manual Index

Cross References in the User Manual will appear similar to:
(see Chapter or (see Section
Clicking on these Cross References will automatically take you to the referenced

Chapter or Section.

This manual describes each command of EnSight’s command language.

The various How To documents available on-line provide detailed instructions
which explain how to perform various operations within EnSight such as creating
an isosurface or reading in data.

To order copies of EnSight documentation, contact CEI by telephone at the
numbers listed below or email ensight@ensight.com

CEI periodically publishes an EnSight newsletter, called the EnSight Post. If you
would like to receive the newsletter, see our website:

www.ensight.com.

EnSight was created to make your work easier and more productive. If you have
any questions about or problems using EnSight, or have suggestions for
improvements, please contact CEI support:

Phone: (800) 551-4448 (USA)

(919) 363-0883 (Outside-USA)
Fax: (919) 363-0833
Email: support@ensight.com
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2 Input/Output

This chapter provides information on data input and output for EnSight.

2.1 Internal Readers provides a brief description of the data formats that can be
read into EnSight using direct readers. It then describes how each format’s data
can be loaded into EnSight. Suggestions on minimizing memory usage is also
noted.

2.2 User Defined Readers describes how the user defined reader API can be used
to read data into EnSight.

2.3 Other External Data Sources describes other ways in which model data can
be prepared to be read into EnSight.

2.4 Command Files provides a description of the files that can be saved for
operations such as automatic restarting, macro generation, archiving, hardcopy
output, etc.

2.5 Archive Files describes options for saving and restoring the entire current
state of the program.

2.6 Context Files describes the options for saving and restoring context files.

2.7 Scenario Files describes the options for saving scenario files that can be
displayed in the EnLiten program.

2.8 Saving Geometry and Results Within EnSight describes how to save model
data, from any format which can be read into EnSight, as EnSight gold casefile
format.

2.9 Saving and Restoring View States describes options for saving and restoring
given view orientations.

2.10 Saving and Printing Graphic Images describes options for saving and
printing graphic images.

2.11 Saving and Loading XY Plot Data describes options for saving and loading
Xy plot data.

2.12 Saving and Restoring Animation Frames describes options for saving and
restoring flipbook and keyframe animation frames.

2.13 Saving Query Text Information describes options for saving query
information to a text file.

2.14 Saving Your EnSight Environment describes options for saving various
environment settings which affect EnSight.

Note: Formats for EnSight related files are described in chapters 10 and 11.
Formats for the various Analysis codes are not described herein.
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2.1 Internal Readers

2.1 Internal Readers

Included in this section:

Dataset Format Basics

Reading and Loading Data Basics
EnSight Case Reader

EnSightS Reader

ABAQUS Reader

ANSYS RESULTS Reader
ESTET Reader

FAST UNSTRUCTURED Reader
FIDAP NEUTRAL Reader
FLUENT UNIVERSAL Reader
Movie.BYU Reader

MPGS 4.1 Reader

N3S Reader

PLOT3D Reader

Dataset Format Basics

EnSight is designed to be an engineering postprocessor, yet its many features can
be used in other areas as well. Its native data is defined as general finite elements
or curvilinear structured data. EnSight has been used to visualize and animate
results from simulations of diesel combustion, cardiovascular flow, petroleum
reservoir migration, pollution dispersion, meteorological flow, and from many
other disciplines. EnSight has three native data formats (EnSight5, EnSight6 and
EnSight Gold) which are defined so that they can be easily interfaced to your
analysis code.

(see Chapter 11, EnSight Data Formats)

EnSight reads node and element definitions from the geometry file and groups
elements into an entity called a Part. A Part is simply a group of nodes and
elements (the Part can contain different element types) which all behave the same
way within EnSight and share common display attributes (such as color, line
width, etc.).

EnSight allows you to read multiple datasets and work with them individually in
the same active session. Each dataset comprises a new “Case” and is handled by
its own Server process.

EnSight also supports data formats for popular engineering simulation codes and
generally used data formats.
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2.1 Dataset Format Basics

Formats Used For Both Computational Fluid Dynamics and Structural Mechanics

EnSight 7 User Manual

* The EnSight6 and EnSight Gold formats support the following files:

Case

Geometry

Variable

Defines all of the variables, time steps, etc. that completely
describe the files which will be used for an EnSight Case.

Defines all geometric model Parts in terms of groups of
finite elements, or ijk blocks.

A file for each variable, which contains either scalar or
vector information for every node defined in the geometry
file (per_node) or for elements of various parts
(per_element).

Measured/Particle Defines discrete Particles in space directly from a

Boundary

simulation or measured information from an experiment.
The measured information can be used to compare actual
versus simulated results

Defines boundary portions within and across structured
blocks. (Can be EnSight’s boundary file definition or a
.fvbnd file.)

* The EnSight5 format supports the following files:

Geometry

Result

Variable

Defines all geometric model Parts in terms of groups of
finite elements.

Defines variable names such as Stress, Strain, and Velocity,
and indicates what files these are tied to. It also, defines
time information if you have a transient data case. This file
is optional (and is unnecessary if your geometry is static and
you have no results data).

A file for each variable, which contains either scalar or
vector information for every node defined in the geometry
file.

Measured/Particle Defines discrete Particles in space directly from a

simulation or measured information from an experiment.
The measured information can be used to compare actual
versus simulated results.

*+ MPGS4 is composed of the following files:

Geometry

Result
Variable

Defines all geometric model Parts in a general n-sided
polygon format.

Utilizes the EnSight results file format. This file is optional.

A file for each variable, which contains either scalar or
vector information for every node defined in the geometry
file.

Measured/Particle Utilizes the EnSight5 measured/Particle file.
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2.1 Dataset Format Basics

Formats Generally Used For Computational Fluid Dynamics

* ESTET contains the geometry and results information in one file. This is the
native binary data format for the ESTET simulation code. The EnSight5
measured/Particle file can also be used in conjunction with these.

* FIDAP Neutral contains the geometry and results in one file. This file is
produced by a separate procedure defined in the FIDAP documentation. If the
data is time dependent this information is also defined here. The EnSight5
measured/Particle file can also be used in conjunction with these.

» N3Sis native to the N3S simulation code and is composed of the files:

Geometry Defines the geometry.

Result Contains all result information describing variables and the
scalar and vector information. This file is required.

Measure/Particle Utilizes the EnSight5 measured/Particle files.
* PLOT3D is composed of the following files:

Geometry Defines the geometry. This is known as a GRID file in
PLOT3D and FAST. This file is a structured file format with
FAST enhancements.

Result Utilizes a modified EnSight results file format. This file is
optional.
Variable This file is a solution file (Q-file) defined in PLOT3D or a

function file as defined by FAST. The modified EnSight
results file provides access to multiple solution files that are
produced by time dependent simulations.

Measured/Particle Utilizes the EnSight5 measured/Particle files.

Boundary Utilizes the EnSight’s boundary file definition or a.fvbnd
file.

* FAST UNSTRUCTURED is composed of the following files:

Geometry Defines the geometry as unstructured triangles and/or
tetrahedrons. It is the FAST unstructured single block grid
file.

Result Utilizes a modified EnSight results file format. This file is
optional.

Variable This file is a solution file (Q-file) defined in PLOT3D or a

function file as defined by FAST, with I equal to the number
of points and J=K=1. The modified EnSight results file
provides access to multiple solution files that are produced
by time dependent simulations.

Measured/Particle Utilizes the EnSight5 measured/Particle files.
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2.1 Reading and Loading Data Basics

Formats Generally Used For Structural Mechanics

* ABAQUS can produce a .fil file which contains the geometry and results
requested. EnSight can read this file in either ASCII or binary format. EnSight
will read the commonly used nodal and element based results contained in this
file.

* ANSYS RESULTS contains the geometry and results in one file. The files are
defined as .rst, .rth, rfl, and .rmg files in the ANSYS documentation (EnSight
5.5 supports only the .rst file). If the data is time dependent this information is
also defined here. The EnSight5 measured/Particle file can also be used in
conjunction with these.

* Movie.BYU is composed of the following files:

Geometry Defines all geometric model Parts in a general n-sided
polygon format.

Result Utilizes the EnSight results file format. This file is optional.

Variable A file for each variable, which contains either scalar or
vector information for every node defined in the geometry
file.

Measured/Particle Utilizes the EnSight5 measured/Particle files.

Data files are never altered by EnSight. They are used only for reading the dataset
information. EnSight can produce a set of files in its native format to save
geometric information that may have been read from another format or created
through the postprocessing techniques. Section 2.8, Saving Geometry and Results
Within EnSight

Reading and Loading Data Basics

EnSight 7 User Manual

Reading and then Loading Data into EnSight is a two step process. First, files are
specified through the File Selection Dialog and then read by EnSight to the
Server. Data from the files is then loaded to the Client using the Data Part Loader
dialog. All Parts or a subset of those available on the Server may be loaded to the
Client. You should try to reduce the amount of information that is being processed
in order to minimize required memory. Here are some suggestions:

» When writing out data from your analysis software, consider what information
will actually be required for postprocessing. Any filtering operation you can do
at this step greatly reduces the amount of time it takes to perform the
postprocessing.

* Load to the Client only those Parts that you need. For example, if you were
postprocessing the air flow around an aircraft you would normally not need to
see the flow field itself, but you would like to see the aircraft surface and Parts
created based on the flow field (which remains available on the Server).

* For each Part you do load to the Client, a representation must be chosen. This
visual representation can be made very simple (through the use of the Feature
Angle option), or can be made complex (by showing all of the surface
elements). The more you can reduce the visual representation, the faster the
graphics processing will occur on the Client (see Node, Element, and Line
Attributes in (see Section 3.3, Part Editing).

2-5



2.1 Reading and Loading Data Basics

+ If you have multiple variables in your result file, activate only those variables
you want to work with. When you finish using a variable, consider deactivating
it to free up memory and thereby speed processing (see Section 4.1, Variable
Selection and Activation).

* When dealing with transient data in an EnSight flipbook, consider loading
initially only a sampling of the available time steps—you can always load the
in-between steps later if you find something interesting.
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Troubleshooting Loading Data

Problem

Probable Causes

2.1 Reading and Loading Data Basics

Solutions

Data loads slowly

Error reading data

EnSight format scalar (or vector)
data loads, but appears incorrect.
Often range of values off by some
orders or magnitude.

EnSight 7 User Manual

Loading more Parts than needed

Too many elements

Client is swapping because it does
not have enough memory to hold all
the Parts specified.

Server is swapping because it does
not have enough memory to hold all
of the Parts contained in the dataset.

Incorrect path or filename

Incorrect file permissions

Temporary file space is full

Format of the data is incorrect

Scalar (or vector) information not
formatted properly in data file

Extra white space appended to one
or more of the records

For some models, especially external
fluid flow cases, there is a flow field
Part which does not need to be
visualized. Try eliminating the
loading of this Part.

Make sure the default element
representation for Model Parts is set
to 3D Border/2D Full before loading
the data. In some cases it is helpful
to set the representation to Feature
Angle before loading.

Try loading fewer Parts or installing
more memory to handle the dataset
size.

Install more memory in your Server
host system, reduce the number of
variables activated, or somehow
reduce the geometry’s size. (If you
can get the data in, you can cut away
any area not now needed. What is
left can then be saved as a geometric
entity and that new dataset used for
future postprocessing.)

Reenter the correct information

Change the permissions of the
relevant directories and files to be
readable by you.

Temporary files are written to the
default temporary directory or the
directory specified by the
environment variable TMPDIR for
both the Client and Server. Check
file space by using the command
“df” and remove unnecessary files
from the temporary directory or
other full file systems.

Recheck the data against the data
format definition. (Can use
ens_checker for Ensight6 or EnSight
Gold format checking.)

Format the file according to
examples listed under EnSight
Variable Files in Section 2.5 (Can
use ens_checker for Ensight6 or
EnSight Gold format checking.)

Check for and remove any extra
white space appended to each record



2.1 EnSight Case Reader

EnSight Case Reader
EnSight6 and EnSight Gold input data consists of the following files:

File Selection dialog

* Case file (required)
* Geometry file (required)
* Variable files (optional)

» Measured/Particle files (optional)
- Measured/Particle geometry files
- Measured/Particle variable files

The Case file is a small ASCII file which defines geometry and variable files and
names, as well as time information. The Case file points to all other files which
pertain to the model. The geometry file is a general finite-element format
describing nodes and Parts, each Part being a collection of elements, and/or
structured ijk blocks. Measured/Particle files contain data about discrete Particles
in space from the simulation code or information directly from experimental tests.

EnSight data is based on Parts. The Parts defined in the data are always available
on the Server. However, all Parts do not have to be loaded to the Client for display.
Large flow fields for CFD problems, for example, are needed for computation by
the Server, but do not generally need to be seen graphically.

EnSight data can have changing geometry, in which case the changing geometry

file names are contained in the Case file.

-~ Fle Selection [x]

Filter

fusrilocal/bintensight73/data/frames*

Directories

usrilocal/bin/ensight73idata/framel.
fusrilocal/binfensight73idata/framel..

Case {(Add Replace Delste)

+++File Information*+++

Format Case

Specify Starting Time Step

EnSight Case File(*.case Required)

{Set) Case
Swty Bosult
5wty Mossurod

<ty Boreaday

Path

Selection

tusr/local/binfensightT3/data/frame]

Okay Apply Filter Cancel

Binary Files Are Big-Endian{HP,[BM,SGLSUN)

Files

frame.case
frame.gea

Help

Figure 2-1

File Selection dialog for EnSight6 data

The File Selection dialog is used to specify which files you wish to read.
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Directories

Files

Case
Add...

Replace...
Delete

Format

Specify Starting
Time Step

Binary Files Are

(Set) Geometry

(Set) Result
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2.1 EnSight Case Reader

Access: Main Menu > File > Data (Reader)...

This field specifies the directory name that your data files reside in. Enter a /* at the end of
the name to list all of the files and directories contained there. To filter to a smaller file list
you can be more specific by entering Parts of the file names, such as /my* which will list
all files and directories starting with “my”. If you only enter a /, then only the directories
found will be listed. To apply the Filter, click the Apply Filter button and the Directories
and Files lists will be updated and the directory will be listed in the Selection field below
as the current selection.

Selection of directories available to use in the current directory. Single click to place the
directory string in the Filter field. Double click to use the directory as the filter (same
effect as clicking once and then clicking Apply Filter button), the Directories and Files
lists will be updated and the directory will be listed in the Selection field below as the
current selection. The sliding controls to the right and bottom of the list let you view all
available directories.

Single click to select a file. This will insert the file name after the directory listed in the
Selection field. This list contains all unfiltered files that are in the filter directory.

Specify an additional case. Additional data can be read into another connected Server.
Specify a new case to replace an existing case.
Delete an existing case. Case 1 cannot be deleted, but it can be replaced.

Specifies the Format of the dataset. To read EnSight6 or EnSight Gold data, use the Case
format.

Specify starting time step. If not specified, EnSight will load the last step.

If the file is binary, sets the byte order to:
Big-Endian - byte order used for HP, IBM, SGI, SUN, NEC, and IEEE Cray.
Little-Endian - byte order used for Intel and alpha based machines.
Native to Server Machine - sets the byte order to the same as the server machine.

Model file name for file containing at least the geometry. Clicking this button inserts the
file name shown in the Selection field and inserts the path information into the Path field.
File name can alternatively be typed into field.

Result file name corresponding to the geometry file. For most data formats this file is
optional. Clicking button inserts file name shown in Selection field and also inserts path
information into Path field. File name can alternatively be typed into field.

Name of a measured file. This is an optional file. Clicking button inserts file name shown
in Selection field and also inserts path information into Path field. File name can
alternatively be typed into field.

Path to dataset location is inserted by clicking (Set) buttons or may be entered. If blank,
files are read from the Server‘s current working directory. Can use the tilde character (~)
to specify home directory on the Server host system.

File or directory selected. Click the appropriate (Set) button to use information in this
field.

Click to read the files specified in the (Set) fields and close the File Selection dialog.
Click to apply the string in the Filter field.

Click to close the File Selection dialog without reading the files specified in the (Set)
fields.

(see How To Read EnSight6 Data)



2.1 EnSight Case Reader

Loading Parts from EnSight6 or EnSight Gold Data
Data Part Loader dialog for Unstructured EnSight6 or EnSight Gold Data

Unstructured Data

Parts List

Element Visual
Rep.

3D Border, 2D
Full
Border

Feature Angle

Bounding Box

|=| DataPartioader(Case)

1 Close| | Load Selected | | Load Al | Help|

Element Visual Rep.

#* Unstructured Data + Structured Data

Parts List

left square

right sgquare _E

=] |

Element Visual Rep.  Feature Angle E

Feature Angle ! 0.0

New Part
Description

4 NOTE: Variables will not be loaded for newly
created parts until this dialog is closed.

Figure 2-2

Data Part Loader dialog for EnSight6 or EnSight Gold Unstructured Data

You use the Data Part Loader dialog to control which Parts will be loaded to the Server
(and made available on) the EnSight Client. It will automatically open after you have read
in data and clicked Okay in the File Selection dialog.

Access: Main Menu > File > Data (Part Loader) ...

This toggle indicates that the Part(s) listed in the Part List is(are) unstructured.

Lists all unstructured EnSight6 format Parts in the data files which may be loaded to the
Server (and subsequently to the Client). An EnSight6 or EnSight Gold data file can have
unstructured, structured, or both types of Parts.

Parts are defined on the server as a collection of 1, 2, and 3D elements. EnSight can show
you all of the faces and edges of all of these elements, but this is usually a little
overwhelming, thus EnSight offers several different Visual Representations to simplify the
view in the graphics window. Note that the Visual Representation only applies to the
EnSight client—it has no affect on the data for the EnSight server.

# 3D border, 2D full
v Border

+ Feature Angle

v+ Bounding Box

v Full

+ NenVisual

Figure 2-3
Element Visual Representation pulldown

In this mode, you will see all 1D and 2D elements, but only the outside surfaces of 3D
elements.

In Border mode all 1D elements will be shown. Only the unique (non-shared) edges of 2D
elements and the unique (non-shared) faces of 3D elements will be shown.

When EnSight is asked to display a Part in this mode it first calculates the 3D Border, 2D
Full representation to create a list of 1D and 2D elements. Next it looks at the angle
between neighboring 2D elements. If the angle is above the Angle value specified the
shared edge between the two elements is removed. Only 1D elements remain on the
EnSight client after this operation.

All Part elements are replaced with a bounding box surrounding the Cartesian extent of
the elements of the Part.
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Full

Non Visual

Load Selected

Load All

2.1 EnSight Case Reader

In Full Representation mode all 1D and 2D elements will be shown. In addition, all faces
of all 3D elements will be shown.

This specifies that the loaded Part will not be visible in the Graphics Window because it is
only loaded on the Server. Visibility can be turned on again later by changing the
representation.

Loads Parts selected in Parts List to EnSight Server. The Parts are subsequently loaded to
the EnSight Client using the specified Visual Representation. If Non Visual is specified,
the selected Parts will be loaded to the Server, but not to the Client.

Loads all Parts in Parts List to EnSight Server. The Parts are subsequently loaded to the
EnSight Client using the specified Visual Representation. If Non Visual is specified, the
selected Parts will be loaded to the Server, but not to the Client.

Data Part Loader dialog for Structured EnSight6 or EnSight Gold data

Structured Data

Parts List

Element Visual
Rep
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H E Data Part L oader (Case)

+ Unstructured Data 4 Structured Data

| Parts List

zone 1 (ALL), Mins/Max==(I:1/74,J:1/25,K:1/2)

zone 2 (ALL), Mins/Maxs=(1:1/74,J:1/35 K:1/30)
zone 3 (ALL), Mins/Maxs=(1:1/66,J:1/28 K:1/15)
zone 1 (ALL), Mins/Maxs=(1:1/56,J:1/18 K:1/15)

= ]
Element Visual Rep. 3D border, 2D full _J I

Feature Angle I O R
Domain Inside _l|

Using Node Ranges:
From Ta Step Delta Min Max

S | I R O |
S e e T |
i EU | N I O |

Structured Part Description I

| I—

Create And Load Structured Part |

Iblanked Part Creation

*#EFNOTE****: Variables will not be loaded for
newly created parts until this dialag is closed.

Close I Help I

Figure 2-4
Data Part Loader dialog for EnSight6 or EnSight Gold Structured Data

You use the Data Part Loader dialog to control which structured Parts will be loaded to the
EnSight Server (and subsequently to the EnSight Client). It will automatically open after
you have read in data and clicked Okay in the File Selection dialog.

Access: Main Menu > File > Data (Part Loader)...

This toggle indicates that the Part data listed is structured.

Lists all structured Parts on Server which may be loaded to the EnSight Server (and
subsequently to the EnSight Client). When one part is highlighted in this list, the Domain
and Node Range fields are updated accordingly.

.Parts are defined on the server as a collection of 1, 2, and 3D elements. EnSight can show
you all of the faces and edges of all of these elements, but this is usually a little
overwhelming, thus EnSight offers several different Visual Representations to simplify the
view in the graphics window. Note that the Visual Representation only applies to the
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3D Border, 2D
Full

Border

Feature Angle

Bounding Box

Full

Non Visual

Domain

Using Node Ranges:

From [JK

To UK

Step IJK

Element Visual Rep.

EnSight client—it has no affect on the data for the EnSight server.

# 3D border, 2D full
v Border

+ Feature Angle

v+ Bounding Box

v Full

+ NenVisual

Figure 2-5
Element Visual Representation pulldown

In this mode, you will see all 1D and 2D elements, but only the outside surfaces of 3D
elements.

In Border mode all 1D elements will be shown. Only the unique (non-shared) edges of 2D
elements will be shown, and only unique (non-shared) faces of 3D elements will be
shown.

When EnSight is asked to display a Part in this mode it first calculates the 3D Border, 2D
Full representation to create a list of 1D and 2D elements. Next it looks at the angle
between neighboring 2D elements. If the angle is above the Angle value specified the
shared edge between the two elements is removed. Only 1D elements remain on the
EnSight client after this operation.

All Part elements are replaced with a bounding box surrounding the Cartesian extent of
the elements of the Part.

In Full Representation mode all 1D and 2D elements will be shown. In addition, all faces
of all 3D elements will be shown.

This specifies that the loaded Part will not be visible in the Graphics Window because it is
already loaded on the EnSight Server. Visibility can be turned on again later by changing
the representation.

Specifies the general iblanking option to use when creating a structured Part. If the model
does not have iblanking, InSide will be specified by default.

Inside Iblank value = 1 region
Outside Iblank value = 0 region
All Ignore iblanking and accept all nodes

Specifies the beginning 1,J,K values to use when extracting the structured Part, or a
portion of it. Must be >= Min value.

Specifies the ending I,J,K values to use when extracting the structured Part, or a portion of
it. Must be <= Max value.

Valid values for the From and To fields can be positive or negative. Positive numbers are
the natural 1 through Max values. Negative values indicate surfaces back from the max, so
-1 would be the max surface, -2 the next to last surface etc. There are therefore two ways
to indicate any of the range values; the positive number from the min towards the max, or
the negative number from the max toward the min. The negative method is provided for
ease of use because of varying max values per part. (Zero will be treated like a -1, thus it is
another way to get the max surface)

15 27 3a ---> <--- ...-3, -2 ,-1
e e e e e e
min max
(always 1) (varies per zone)

Specifies the step increment through I,J,K. A Step value of 1 extracts all original data. A
Step value of 2 extracts every other node, etc.
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Create And Load
Part

2.1 EnSight Case Reader

Specifies the delta to use when creating more than one surface from the same ijk part.
Only one of the directions may be non-zero. Note that an unstructured part is the result of
any non-zero delta values.

Minimum I,J,K values for Part chosen
Maximum I,J.K values for Part chosen

Text field into which you can enter a description for the Part

Extracts the data from the data files and creates a Part on the Server (and on the Client
unless NonVisual has been specified for Representation) based on all information
specified in the dialog.

If only one part is highlighted, the values shown in the From and To fields (as well as the
Min and Max fields) are the actual values for the selected part. Using the From and To
fields you can control whether an EnSight part will be created using the entire ijk ranges
or some subset of them. The Step field allows you to sample at a more coarse resolution.
And the Delta field allows for multiple “surfaces” in a given part (like blade rows of a jet
engine). Please note that use of a non-zero delta produces an unstructured part instead of a
structured one.

If more than one Part is highlighted, the values shown in the From and To fields are the
combined bounding maximums of the selected parts. The same basic functionality
described for a single part selection applies for multiple part selection, with one part being
created for each selected part in the dialog. If the specified ranges for the multiple
selection exceed the bounds of a given part, they are modified for that part so that its
bounds are not exceeded.

(see How To Do Structured Extraction)

Iblanked Part Creation section of Structured Part Loader dialog

Structured Part(s)
To Be Parent of
Iblanked Part

Iblank Values For
Entire Mesh

Iblank Part
description
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Iblanked Part Creation

Structured Part{s) To Be Iblank Values
Parent Of Ibhlanked Part For Entire Mesh

3D block one, Mins/M ’I Bnd (2) ﬁ
7 7

3D block two, Mins/M J
| | — | - | —
Iblank Part Description I

Create And Load Iblanked Unstructured Part I

*#EFNOTE****: Variables will not be loaded for
newly created parts until this dialag is closed.

Close I Help I

Figure 2-6
Iblanked Part Creation Section of EnSight6 or EnSight Gold Structured Part Loader dialog

You use this portion of the Part Loader dialog to further extract iblanked regions from
structured parts which were created either as inside, outside, or all portions of the model.

Lists all structured parts that have been created thus far in the dialog above.

Lists all possible iblank values found in the model. This is a global list and may not apply
to all parts.

Text field into which you can enter a description for the iblanked part.
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2.1 EnSight Case Reader

Create And Load Extracts a new iblanked part from an existing structured part. This new part will actually
Iblanked be an unstructured part.
Unstructured Part

(see How To Read EnSight6 Data)
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2.1 EnSight5 Reader

EnSight5 Reader

EnSight5 input data consists of the following files:
* Geometry file (required)
» Result file (optional)
* Variable files (optional)
* Measured Particle Files (optional)

- Measured/Particle geometry files
- Measured/Particle results files
- Measured/Particle variable files

The geometry file is a general finite-element format describing nodes and Parts,
each Part being a collection of elements. The result file is a small file allowing the
user to name variables and provide time information. The result file points to
variable files which contain the scalar or vector information for each node.
Measured/Particle files contain data about discrete Particles in space from the
simulation code or information directly from actual experimental tests.

EnSight5 data is based on Parts. The Parts defined in the data are always available
on the Server. However, all Parts do not have to be loaded to the Client for display.
Large flow fields for CFD problems, for example, are needed for computation by
the Server, but do not generally need to be seen graphically.

EnSight5 data can have changing geometry, in which case the changing geometry
file names are contained in the results file. However, it is still necessary to specify
an initial geometry file name.

File Selection dialog

Filter
tseratchidatatensightiensightiensightblears]

Directories Files
README.car
car.gea
card0.dis
car0l.dis
car02.dis
car03.dis
cardd.dis
car0b.dis
car0b.dis

Case {(Add Replace Delste)

+++File Information*

Pormat EnSight 5
Specify Starting Time Step
Binary Files Are Big-Endian{HP,IBM,SGLSUN}

Geometry(*.geo Required), Results(*.res Optional),
EnSight Measured(*.mres Optional)

(Set) Geometry| | car.geo

{Set) Result car.res

(Set) Measured

by Bovgreadary

Path

tscratch/datatensishtiensishtiensishtiicar

Selection

tseratch/datatensightiensight/ensight5loaricar.res

Okay Apply Filter Cancel Help

Figure 2-7
File Selection dialog for EnSight5 data
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2.1 EnSight5 Reader

Filter

Directories

Files

Case
Add...

Replace...

Delete

Format
Specify Starting

Time Step
Binary Files Are

(Set) Geometry

(Set) Result

(Set) Measured

Path

Selection

Okay
Apply Filter

Cancel

The File Selection dialog is used to specify which files you wish to read.
Access: Main Menu > File > Data (Reader)...

This field specifies the directory name that your data files reside in. Enter a /* at the end of
the name to list all of the files and directories contained there. To filter to a smaller file list
you can be more specific by entering Parts of the file names, such as /my* which will list
all files and directories starting with “my”. If you only enter a /, then only the directories
found will be listed. To apply the Filter, click the Apply Filter button and the Directories
and Files lists will be updated and the directory will be listed in the Selection field below
as the current selection.

Selection of directories available to use in the current directory. Single click to place the
directory string in the Filter field. Double click to use the directory as the filter (same
effect as clicking once and then clicking Apply Filter button), the Directories and Files
lists will be updated and the directory will be listed in the Selection field below as the
current selection. The sliding controls to the right and bottom of list let you view all
available directories.

Single click to select a file.This will insert the file name after the directory listed in the
Selection field. This list contains all unfiltered files that are in the filter directory.

Specify an additional case. Additional data can be read into another connected Server.
Specify a new case to replace an existing case.

Delete an existing case. Case 1 cannot be deleted, but it can be replaced.

Specifies the Format of the dataset. To read EnSight6 or EnSight Gold data, use the Case
format.

Specify starting time step. If not specified, EnSight will load the last step.

If the file is binary, sets the byte order to:
Big-Endian - byte order used for HP, IBM, SGI, SUN, NEC, and IEEE Cray.
Little-Endian - byte order used for Intel and alpha based machines.
Native to Server Machine - sets the byte order to the same as the server machine.

Model geometry file name. Clicking button inserts file name shown in Selection field and
inserts path information into Path field. File name can alternatively be typed into field.

Result file name corresponding to the geometry file. For most data formats this file is
optional. Clicking button inserts file name shown in Selection field and also inserts path
information into Path field. File name can alternatively be typed into field.

Name of a measured file. This is an optional file. Clicking button inserts file name shown
in Selection field and also inserts path information into Path field. File name can
alternatively be typed into field.

Path to dataset location is inserted by clicking (Set) buttons or may be entered. If blank,
files are read from the Server‘s current working directory. Can use the tilde character (~)
to specify home directory on the Server host system.

File or directory selected. Click the appropriate (Set) button to use information in this
field.

Click to read the files specified in the (Set) fields and close the File Selection dialog.
Click to apply the string in the Filter field.

Click to close the File Selection dialog without reading the files specified in the (Set)
fields.

(see How To Read EnSight5 Data)
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Loading Parts from EnSight5 data

2.1 EnSight5 Reader

Data Part Loader dialog
-w Data Part Loader {EnSight 5) =E3
| Unstructured Datal Yoruotured Dala
Parts List
Clip_plane

Unstructured Data
Structured Data

Parts List

Element Visual
Rep.

3D Border, 2D
Full

Border

Feature Angle
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Element Visual Rep. 3D border, 2D full
Feature Angle | i

New Part
Description
NOTE: Variables will not be loaded for newly

created parts until this dialog is closed.

Close Load Selected

Load All Help

Figure 2-8
Data Part Loader dialog for EnSight5 data

You use the Data Part Loader dialog to control which Parts will be loaded to the EnSight
Server (and subsequently, to the Client). It will automatically open after you have read in
data and clicked Okay in the File Selection dialog.

Access: Main Menu > File > Data (Part Loader)...
This toggle indicates that Part data is unstructured. It must be on for EnSight5 format.
This toggle is not available for EnSight5 data.

Lists all Parts in the data files which may be loaded to the EnSight Server (and
subsequently, to the Client).

Parts are defined on the server as a collection of 1, 2, and 3D elements. EnSight can show
you all of the faces and edges of all of these elements, but this is usually a little
overwhelming, thus EnSight offers several different Visual Representations to simplify the
view in the graphics window. Note that the Visual Representation only applies to the
EnSight client—it has no affect on the data for the EnSight server.

# 3D border, 2D full
v Border

+ Feature Angle

v+ Bounding Box

¢ Full

+ NenVisual
Figure 2-9
Element Visual Representation pulldown

In this mode, you will see all 1D and 2D elements, but only the outside surfaces of 3D
elements.

In Border mode all 1D elements will be shown. Only the unique (non-shared) edges of 2D
elements will be shown, and only unique (non-shared) faces of 3D elements will be
shown.

When EnSight is asked to display a Part in this mode it first calculates the 3D Border, 2D
Full representation to create with a list of 1D and 2D elements. Next it looks at the angle
between neighboring 2D elements. If the angle is above the Angle value specified the
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2.1 ABAQUS Reader

Bounding Box

Full

Non Visual

Load Selected

Load All

ABAQUS Reader

shared edge between the two elements is removed. Only 1D elements remain on the
EnSight client after this operation.

All Part elements are replaced with a bounding box surrounding the Cartesian extent of
the elements of the Part.

In Full Representation mode all 1D and 2D elements will be shown. In addition, all faces
of all 3D elements will be shown.

This specifies that the loaded Part will not be visible in the Graphics Window because it is
only loaded on the EnSight Server. Visibility can be turned on again later by changing the
representation.

Loads Parts selected in Parts List to EnSight Server. The Parts are subsequently loaded to
the EnSight Client using the specified Visual Representation. If Non Visual is specified,
the selected Parts will be loaded to the Server, but not to the Client.

Loads all Parts in Parts List to EnSight Server. The Parts are subsequently loaded to the
EnSight Client using the specified Visual Representation. If Non Visual is specified, the
selected Parts will be loaded to the Server, but not to the Client.

(see How To Read EnSight5 Data)

ABAQUS input data consists of the following files:

* Geometry/Results file (required). This file (the ABAQUS .fil file)
contains both the geometry and any requested results. It can be either
ASCII or binary.

» EnSight5 Measured/Particle Files (optional). The measured .res file
references the measured geometry and variable files.

EnSight will read ASCII or binary .fil files directly. Geometry and commonly
used results contained in the file will be read.

The element sets in the .fil file will be used for creating parts.

(see How To Read ABAQUS Data)
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2.1 ANSYS RESULTS Reader

ANSYS RESULTS Reader
ANSYS input data consists of the following files:

EnSight 7 User Manual

* Geometry and Results file (required). The ANSYS .rst file (or similar
results files such as .rfl, .rmq, .rth) contains geometry and results and
should be entered in the geometry field of the Data dialog.

» EnSight5 Measured/Particle Files (optional). The measured .res file
references the measured geometry and variable files.

EnSight allows you to read the geometry and results data directly from an ANSYS
results data file. Not all element types possible in ANSY'S can be converted to
EnSight format. However, EnSight will handle most practical cases just fine.

Note that certain variables may read slower than others. Displacement,
acceleration, and velocity vector variables, as well as nodal solution scalars
(pressure, temperature, etc.), read in quickly because they are provided at the
nodes directly. Stress and strain variables, on the other hand, can be quite time
consuming to read because the process involves:

1.
2.
3.

4.
5.
6.

getting the element nodal values,
if necessary, computing principal stresses (or strains),

if necessary, applying equivalent stress (or strain) and/or stress (or strain)
intensity equations,

if shell elements, using one side or the other (user selectable),
averaging the values at shared nodes, and,

if higher order elements, averaging to get mid-side node values.

ANSYS data is based on Parts. The Parts defined in the data are always read on
the Server. These Parts, however, do not all have to be loaded to the Client for
display.

(see How To Read ANSYS Data)

2-19



2.1 ESTET Reader

ESTET Reader

ESTET input data consists of one file that contains all geometry and results
information. The ESTET data is a structured grid. The data file is binary.

When reading this data into EnSight, you extract Parts from the mesh interactively
based on indices assigned to the nodes in the data. Currently, three domains are
possible for extracting Parts: inside, outside, and symmetry plane. As you extract
Parts, you can limit the domains according to ranges in [, J and K.

The data can be in rectangular, cylindrical, or curvilinear coordinates. EnSight
will interpret and convert properly for any of these types.

Once the desired geometry has been extracted as Parts, you are presented with a
list of the results variables contained in the file. There is no way to automatically
determine which of the results variables are actually vector components, so you
are given the opportunity to build the vectors from the variables. The descriptions
usually make this a straightforward process. All variables not used as components
to vectors are assumed to be scalar variables.

ESTET Vector Builder and Data Part Loader dialogs

[ ESTET Vector Builder

—

Available Variables

VITESSE_U
VITESSE_V Create ESTET Parts By

/ITESSE_W Domain Inside i |VFI"“1“;;“ 3D border, 2D full i I
TEMPERATURE isual Rep.
MASSE_VOLUM Feature Angle | 198
f)II\IS]i:SI:SPIfI‘ION Using Node Ranges:

From Ta Step Delta Min Max

VISCOSITE

SCALAIRE Tl s | 1 ] o [ 1 | 20
FONCTION_FDT . sx [ [ 1 [ e T T
Set X—Compl | VITESSE U K| 1 || 28 | 1 || o [+ | =8
Set Y—Compl | VITESSE v Part Descript |
Set Z-Comp| |VITESSE W Create And Load Structured Part |

Vector Descl’iptl Velacity Iblanked Part Creation

*#EFNOTE****: Variables will not be loaded for

Build Vector |
newly created parts until this dialag is closed.

New Vector Variables
Velocity

Close I Help I

Figure 2-10

Okay Help I

ESTET Vector Builder and Data Part Loader dialogs

You use the File Selection dialog to read ESTET data files, the ESTET Vector Builder

dialog to build vector variables from scalar components for an ESTET dataset, and the
Data Part Loader dialog to extract Parts from an ESTET dataset. The latter two dialogs
open in sequence automatically after you click Okay in the File Selection dialog.

Access: Main Menu > File > Data (Reader)..> ESTET

Create ESTET Parts By

Domain
Inside
Outside
All

2-20

Select domain to extract Part.
Create a structured Part that contains elements whose nodes are flagged as being “inside”.
Create a structured Part that contains elements whose nodes are flagged as “outside”.

Create a structured Part that contains all elements because node iblanking is ignored.

EnSight 7 User Manual



Using Node
Ranges:

From [JK

To UK

Step IUK

Delta IJK

Min IJK

Max IJK
Part Descrip
Create Part

Available Variables
Set X-Comp

Set Y-Comp

Set Z-Comp
Vector Descript
Build Vector

New Vector
Variables

Okay

EnSight 7 User Manual

2.1 ESTET Reader

Specification of node range when creating a Part. Values must be between Min and Max.

Specifies the beginning 1,J,K values to use when extracting the structured Part, or a
portion of it.

Specifies the ending ,J,K values to use when extracting the structured Part, or a portion of
it.

Valid values for the From and To fields can be positive or negative. Positive numbers are
the natural 1 through Max values. Negative values indicate surfaces back from the max, so
-1 would be the max surface, -2 the next to last surface etc. There are therefore two ways
to indicate any of the range values; the positive number from the min towards the max, or
the negative number from the max toward the min. (Zero will be treated like a -1, thus it is
another way to get the max surface)

1,2,3,.--> <= -3,-2 -1

s N O N M B

min max
(always 1) (varies per zone)

Specifies the step increment through I,J,K. A Step value of | extracts all original data. A
Step value of 2 extracts every other node, etc.

Specifies the delta to use when creating more than one surface from the same ijk part.
Only one of the directions may be non-zero. Note that an unstructured part is the result of
any non-zero delta values.

Minimum [J,K values for zone chosen
Maximum I,J,K values for zone chosen
Set the name of the Part. If empty, EnSight will assign a name.

Click to create a Part according to the range, step by, and delta specifications. Using the
From and To fields you can control whether an EnSight part will be created using the
entire ijk ranges or some subset of them. The Step field allows you to sample at a more
coarse resolution. And the Delta field allows for multiple “surfaces” in a given zone (like
blade rows of a jet engine). Please note that use of a non-zero delta produces an
unstructured part instead of a structured one.

Selection to specify a variable to use for the next Set...Comp action.

Click to set the current selection to be the X component of the vector to build.
Click to set the current selection to be the Y component of the vector to build.
Click to set the current selection to be the Z component of the vector to build.
Set the name of the vector variable.

Click to define the vector variable.

List of vector variables that have been defined.

Click Okay to load the variable information.

WARNING: You should build all the vectors you are going to use before clicking
Okay, because you cannot return to this dialog. If you fail at this point to make all of
the vectors desired, it is possible to do so later using the Make Vector function

(see Section 4.3, Variable Creation)
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2.1 ESTET Reader

Iblanked Part Creation section of Data Part Loader (ESTET) dialog

Structured Part(s)
To Be Parent of
Iblanked Part

Iblank Values For
Entire Mesh

Iblank Part
description

Create And Load
Iblanked
Unstructured Part
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Iblanked Part Creation

Structured Part{s) To Be Iblank Values
Parent Of Ibhlanked Part For Entire Mesh

Domain=(IN}, Min=/M Ay Symmetry (1 ﬁ
£

i
5 — = | £ | —
Iblank Part Description I

Create And Load Iblanked Unstructured Part I

*#EFNOTE****: Variables will not be loaded for
1 newly created parts until this dialog is closed.

Close I Helu

Figure 2-11
Iblanked Part Creation Section of Data Part Loader (ESTET) dialog

You use this portion of the Part Loader dialog to further extract iblanked regions from
structured parts which were created either as inside, outside, or all portions of the model.

Lists all structured parts that have been created thus far in the dialog above.

Lists all possible iblank values found in the model. This is a global list and may not apply
to all parts.

Text field into which you can enter a description for the iblanked part.

Extracts a new iblanked part from an existing structured part. This new part will actually
be an unstructured part.

(see How To Read ESTET Data)
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2.1 FAST UNSTRUCTURED Reader

FAST UNSTRUCTURED Reader

FAST UNSTRUCTURED input data consists of the following files:

* Geometry file (required) This is the FAST UNSTRUCTURED single
zone grid file.

* Modified Result file (optional)

* Variable files (optional) These are either a PLOT3D solution file (Q-file)
or FAST function file with I = number of points and J=K=1.

» EnSight5 Measured/Particle Files (optional). The measured .res file
references the measured geometry and variable files.

FAST UNSTRUCTURED is a format containing triangle and/or tetrahedron
elements. The triangles have tags indicating a grouping for specific purposes.
EnSight will read the unstructured single zone grid format for this data type,
placing all tetrahedral elements into the first Part, and the various triangle element
groupings into their own Parts.

The modified EnSight results file allows results to be read from PLOT3D-like Q-
files or FAST-like function files. They can be time dependent.

FAST UNSTRUCTURED data can have changing geometry. When this is the
case, the changing geometry file names are contained in the results file. However,
it is still necessary to specify an initial geometry file name.

(see How To Read FAST Unstructured Data)

FIDAP NEUTRAL Reader

A FIDAP Neutral file contains all of the necessary geometry and result
information for use with EnSight.

FIDAP data is based on Parts. The Parts defined in the data are always read on the
Server. They do not, however, all have to be loaded to the Client for display. Large
flow fields for CFD problems, for example, are needed for computation by the
Server, but do not generally need to be seen graphically.

EnSight5 Measured/Particle Files can also be read with a FIDAP model. The
measured .res file references the measured geometry and variable files.

(see How To Read FIDAP Neutral Data)

FLUENT UNIVERSAL Reader

EnSight 7 User Manual

FLUENT input data files consist of the following:
» Universal file (required)
* EnSight5 format Results file (optional)
» EnSight5 Measured/Particle Files (optional).

The FLUENT Universal file contains all of the necessary geometry and result
information for use with EnSight for a steady-state case. If the case is transient,
EnSight needs a Universal file for each time step of the analysis and a modified
version of the EnSight results file.
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2.1 Movie.BYU Reader

FLUENT data is based on Parts. The Parts defined in the data are always read on
the Server. They do not, however, all have to be loaded to the Client for display.
Large flow fields for CFD problems, for example, are needed for computation by
the Server, but do not generally need to be seen graphically.

EnSight5 Measured/Particle Files can also be read with a FLUENT model. The
measured .res file references the measured geometry and variable files.

(see How To Read FLUENT Universal Data)

Movie.BYU Reader
Movie.BYU input data consists of the following files:
* Geometry file (required)
» Results file (optional)
* Variable files (optional)

* EnSight5 Measured/Particle Files (optional). The measured .res file
references the measured geometry and variable files.

Movie.BYU has a general n-sided polygon data format. In translating this format
to the element-based EnSight data format, not all elements possible in the
Movie.BYU format can be converted to EnSight format. However, for most
practical cases there are no problems.

Movie.BYU datasets can be read directly by EnSight. Additionally, an external
translator, “movieto5”, is provided if you wish to convert the actual data files to
EnSight format.

In order to read Movie.BYU data result files into EnSight, you must create a
results file of the same format as EnSight. The external translator, “mpgs4to5,”
can be used to generate a results file if you do not want to create your own using a
text editor.

Movie.BYU data is based on Parts. The Parts defined in the data are always read
on the Server. They do not, however, all have to be loaded to the Client for
display.

Movie.BYU data can have changing geometry. When this is the case, the
changing geometry file names are contained in the results file. However, it is still
necessary to specify an initial geometry file name.

(see How To Read MOVIE.BYU Data)
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MPGS 4.1 Reader
MPGS4 data files consist of the following:
* Geometry file (required)
* EnSight format Results file (optional)
* Variable files (optional)

» EnSight5 Measured/Particle Files (optional). The measured .res file
references the measured geometry and variable files.

MPGS4.x uses a general n-sided polygon, n-faced polyhedral data format. In
going from this format to the specific element data format of EnSight, you
encounter the problem associated with translating from a general format to a
specific format. Not all elements possible in MPGS4.x can be converted to
EnSight format. However, there will not be a problem in most situations.

MPGS4.x models of modest size can be read directly into EnSight. Size can
become an issue since the amount of memory needed to do the conversion in
EnSight to the internal data format in a reasonable length of time can become
excessive for large models. An external translator, “mpgs4to5”, is provided for the
larger models. You should also consider using the external translator to convert
MPGS4.x data to EnSight data if you need to continue loading the same dataset,
as this will perform the data conversion one time while reading it into EnSight
will continue to take resources each time the data is read. Converting it from
MPGS4.x to EnSight format also has the advantage of taking less disk space as
the EnSight format is more compact.

In order to read MPGS4.x results directly into EnSight, you must create a results
file of the same format as EnSight. The external translator, “mpgs4to5,” can be
used to generate a results file if you do not want to create your own using an
editor.

MPGS4 .x data is based on Parts. The Parts defined in the data are always read on
the Server. They do not, however, all have to be loaded to the Client for display.
Large flow fields for CFD problems, for example, are needed for computation on
the Server, but do not generally need to be seen graphically.

MPGS4.x data can have changing geometry. When this is the case, the changing
geometry file names are contained in the results file. However, it is still necessary
to specify an initial geometry file name.

(see How To Read MPGS Data)
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2.1 N3S Reader

N3S Reader
N3S input data consists of the following files:

* Geometry file (required)
» Results file (required)

» EnSight5 Measured/Particle Files (optional). The measured .res file
references the measured geometry and variable files.

N3S is a data format developed by Electricité de France (EDF) consisting of a
geometry file and a results file. For this data format, both files are always
required. Versions 3.0 and 3.1 are both supported.

When reading N3S data into EnSight, you extract Parts from the mesh
interactively based on different color numbers or boundary conditions. The
available color numbers and boundary conditions for the model are presented.

N3S Part Creator dialog

Create N35 Parts By
4+ A1l Elements

+ Color Number | 0
l 1

N I
+ Boundary Information

o — |

Condition Code

JITESSE_UX - | 0 Free Node ||
VITESSE_UY 1 Homogeneom
PRESSION | | 2 Non-homag

£
| | N — -
Part Descript

NOTE: Variables will not be loaded for newly
created parts until this dialog is closed.

CloseE HelpE
Figure 2-12

N3S Part Creator dialog

You use the File Selection dialog to read in N3S dataset files. You use the N3S Part
Creator dialog to extract Parts from a N3S dataset.

Access: Main Menu > File > Data (Reader)...> N3S
Create N3S Parts By
All Elements Selection to create a Part using all of the elements available within the data file.
Color Number Selection to create a Part according to the color number associated with each element.
Boundary Selection to create a Part according to specified conditions and codes.
Information
Condition Select boundary condition to use for Part creation.
Code Select Code to use for boundary condition.
Part Descript Specify name for Part.
Create Part Click to create a Part. The Part is listed in the main Parts list of the Parts & Frames dialog

and is displayed in the Main View window.

(see How To Read N3S Data)
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PLOT3D Reader
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2.1 PLOT3D Reader

PLOT3D is a commonly used structured data format and input data consists of the
following files:

* Geometry file. This is a required file. (Structured GRID file with FAST
enhancements)

* Modified EnSight Results file (optional). A standard plot3d Q-file can be
read in the results field in place of a modified EnSight Results file.

* Variable files, which are solution (PLOT3D) or function (FAST) files
(optional)

* EnSight5 Measured/Particle Files (optional). The measured .res file
references the measured geometry and variable files.

» EnSight Boundary File (optional). The boundary file defines boundary
portions within and/or across structured blocks. (Note: this can be
EnSight’s boundary file format or a .fvbnd file.)

When reading PLOT3D files into EnSight, you extract Parts from the mesh based
on a domain, a list of zones, and/or indices assigned to the nodes in the data.
Currently, three domains are possible for extracting structured Parts: (a) inside, (b)
outside, or (¢) all. These options are dependent on what the file format is from the
parameters defined in the previous paragraph. For instance, when using single
zone, non-iblanked data the domain is fixed at “Inside” and the one zone listed in
the zones list is selected. As you extract Parts from a single zone file, however, it
is possible to limit the domains according to ranges in I, J, and K.

Once the desired structured Parts have been extracted from the geometry, further
iblanking options can be used to extract unstructured parts, such as for boundaries.
When the Data Reader (PLOT3D) dismissed, the user is presented with a list of
the result variables available from the result file

To successfully read PLOT3D data, the following information must be known
about the data:

1. format - ASCII, C binary, or Fortran binary

2. whether single or multizone

3. dimension - 3D, 2D, or 1D

4. whether iblanked or not

5. precision - single or double

EnSight attempts to determine these five settings automatically from the grid file.
The settings that were determined (for the first four) are shown in the Part Builder
dialog, where you can override them manually if needed.

The precision setting is not reflected in the dialog, but is echoed in the Server shell
window. The q (or function) file precision will by default be set the same as that of
the grid file. In the rare case where the automatic detection is wrong for the grid
file or the precision is different for the q (or function) file than for the grid file,
commands can be entered into the Command dialog to manually set the precision.

test:  plot3d grid single to read grid file as single precision

test:  plot3d grid double to read grid file as double precision

test:  plot3d_gr single to read q (or function) file as single precision
test:  plot3d gr double to read q (or function) file as double precision
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2.1 PLOT3D Reader

PLOT3D Part Loader dialog

Geometry
Result
Measured

IBlanked File
Toggle

Read As

Multi-Zone File
Toggle

Dimension

Read Specified File

Use Zones
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Specified PLOT3D File
Geometry: whighin

Result: whirbin

Measured:

I Ealankad Flie

Haad Az 1 Binary - |

[T 8inif-Hone File

Dlanensdon | 8D _l|

Haad Speeified Pile

Create PLOT3D Parts By

Use Z : |
5c Sones Domain  Inside
|-

2 J Element Visual Rep. 3D border, 2D full _J I

3
! Feature Angle
I fURG
]~

Using Node Ranges:

From Ta Step Delta Min Max
L R O T N A S
Tl e [0 [ e [ 1 ] 2
K| 1+ || 2 | 1t || o [ 1 N

Part Descript I

Create And Load Structured Part |

Iblanked Part Creation

*#EFNOTE****: Variables will not be loaded for
newly created parts until this dialag is closed.

Close I Help I

Figure 2-13
Part Data Loader (PLOT3D)

You use the Part Data Loader (PLOT3D) dialog to read a specified PLOT3D file and to

extract parts out of the PLOT3D geometry.
Access: Main Menu > File > Data (Reader)... > PLOT3D

Specifies name of file which geometry data will be read.
Specifies name of file which result data will be read.
Specifies name of file which measured/discrete data will be read.

Turn on if geometry field has iblanking.

Specifies file type. Choices are:

ASCII
C Binary (Note: Files may not be portable across hardware platforms).
FORTRAN Binary (Note: Files may not be portable across hardware platforms).

Turn on if dataset contains multiple zones. If Multi-zoned and you are not doing a
“between boundary” domain option (see below), a part can span several zones (see Use
Zone list below).

Specifies the dimension of the dataset. Options are 1D, 2D, or 3D. If multi-zone, the
dimension of the problem is forced to be 3D.

Click to initiate the reading process.

List of Zones defined in the data that can be used to create Parts. If there are multiple
zones you can select one or more of them.
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Domain

Using Node Ranges
From UK

To UK

Step IUK

Delta IJK

Min UK

Max IJK

Part Descrip
Create Part
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2.1 PLOT3D Reader

Select the domain to create a structured Part from. Options are:

Inside Create structured Part from grid points flagged with Iblanking = 1
Outside  Create structured Part from grid points flagged with Iblanking = 0.
All Create part from all grid points (ignores Iblanking).

Specifies the beginning I,J,K values to use when extracting the structured Part, or a
portion of it.

Specifies the ending I,J,K values to use when extracting the structured Part, or a portion of
it.

Valid values for the From and To fields can be positive or negative. Positive numbers are
the natural 1 through Max values. Negative values indicate surfaces back from the max, so
-1 would be the max surface, -2 the next to last surface etc. There are therefore two ways
to indicate any of the range values; the positive number from the min towards the max, or
the negative number from the max toward the min. The negative method is provided for
ease of use because of varying max values per part. (Zero will be treated like a -1, thus it is
another way to get the max surface)

1,2,3,.--> <----3,-2 -1

e N O A M B

min max
(always 1) (varies per zone)

Specifies the step increment through I,J,K. A Step value of 1 extracts all original data. A
Step value of 2 extracts every other node, etc.

Specifies the delta to use when creating more than one surface from the same ijk part.
Only one of the directions may be non-zero. Note that an unstructured part is the result of
any non-zero delta values.

Minimum [,J,K values for Part chosen
Maximum I,J,K values for Part chosen
Specify name of Part you wish to create.
Click to create a Part.

If only one part is highlighted, the values shown in the From and To fields (as well as the
Min and Max fields) are the actual values for the selected part. Using the From and To
fields you can control whether an EnSight part will be created using the entire ijk ranges
or some subset of them. The Step field allows you to sample at a more coarse resolution.
And the Delta field allows for multiple “surfaces” in a given part (like blade rows of a jet
engine). Please note that use of a non-zero delta produces an unstructured part instead of a
structured one.

If more than one Part is highlighted, the values shown in the From and To fields are the
combined bounding maximums of the selected parts. The same basic functionality
described for a single part selection applies for multiple part selection, with one part being
created for each selected part in the dialog. If the specified ranges for the multiple
selection exceed the bounds of a given part, they are modified for that part so that its
bounds are not exceeded.

(see How To Do Structured Extraction)

2-29



2.1 PLOT3D Reader

Iblanked Part Creation section of Data Part Loader (PLOT3D) dialog

Structured Part(s)
To Be Parent of
Iblanked Part

Iblank Values For
Entire Mesh

Iblank Part
description

Create And Load
Iblanked
Unstructured Part
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Iblanked Part Creation

Structured Part{s) To Be Iblank Values
Parent Of Ibhlanked Part For Entire Mesh

zone 1 (IN}, Mins/Maz ’I Between {-1) ﬁ

Fi
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| N -~
Iblank Part Description I

| —

*#EFNOTE****: Variables will not be loaded for
newly created parts until this dialag is closed.

Close I

Create And Load Iblanked Unstructured Part I

Help I

Figure 2-14
Iblanked Part Creation Section of Data Part Loader (PLOT3D) dialog

(see How To Read PLOT3D Data)

You use this portion of the Part Loader dialog to further extract iblanked regions from
structured parts which were created either as inside, outside, or all portions of the model.

Lists all structured parts that have been created thus far in the dialog above.

Lists all possible iblank values found in the model. This is a global list and may not apply
to all parts.

Text field into which you can enter a description for the iblanked part.

Extracts a new iblanked part from an existing structured part. This new part will actually
be an unstructured part.
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2.2 User Defined Readers

2.2 User Defined Readers
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A user defined reader capability is included in EnSight which allows otherwise
unsupported structured or unstructured data to be read. In other words, the user
can create their own data readers. Each user defined reader utilizes a dynamic
shared library produced by the user. Once produced, these readers show up in the
list of data formats in the Data Reader Dialog just like an internal readers.

The readers are produced by creating the routines of an API. Two versions of the
userd defined API are available starting with EnSight version 7.2. The 1.0 API
(which has been available since EnSight version 6) was designed to be friendly to
those producing it, but requires more manipulation internally by EnSight and
accordingly requires more memory and processing time. The 2.0 AP is
considerably more efficient, and was designed with that in mind. It requires that
all data be provided on a part basis, and as such lends itself closely to the EnSight
Gold type format. A few of the advantages of the new 2.0 API are:

* Considerably more memory efficient

* Considerably faster

» Tensor variables are supported

» Complex variables are supported

* Geometry and variables can be provided on different time lines

 If boundary representation is available, provides for its use instead of
having EnSight compute it.

The process for creating and using a user-defined reader is explained in detail in
the README files on the installation CD or in your installation directory.

On the CD: /CDROM/ensight76/src/readers

In installation
directory: $CEI_HOME/ensight76/src/readers

Therein you will also find a detailed description of each routine in the API and the
order in which the routines are called by EnSight. In the subdirectories at the same
location as the README’s, you will find source code for some sample readers
and a README file for working readers. The sample are often helpful examples
when producing your own reader.

Start EnSight (or EnSight server) with the command line option (-readerdbg), for
a step-by-step echo of reader loading progress.

The actual working user defined readers included in the EnSight distribution may
vary, but typically would include such formats as:

CFF PXI SCRYU
CFX4 FLOW-3D SILO
Cobalt LS-DYNA STL
MSC/Dytran  NASTRAN TECPLOT
EXODUSII  OP2 VECTIS
CGNS RADIOSS HDF5
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2.3 Other External Data Sources

2.3 Other External Data Sources

External Translators

Translators supplied with the EnSight application enable you to use data files
from many popular engineering packages. These translators are found in the
translators directory on the EnSight distribution CD. A README file is supplied
for each translator to help you understand the operation of each Particular
translator. These translators are not supported by CEI, but are supplied at no-cost
and as source files, where possible, to allow user modification and porting.

Exported from Analysis Codes

Several Analysis codes can export data in EnSight file formats. Examples of these
include Fluent, STAR-CD, CFX and others.
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2.4 Command Files

2.4 Command Files

Documenting Bugs

Nested Command
Files

Default Command
File

Command dialog

EnSight 7 User Manual

Command files contain EnSight command language as ASCII text that can be
examined and even edited. They can be saved starting at any point and ending at
any point during an EnSight session. They can be replayed at any point in an
EnSight session. However, some command sequences require a certain state to
exist, such as connection to the Server, the data read, or a Part created with a
Particular Part number.

There are a multitude of applications for command files in EnSight. They include
such things as being able to play back an entire EnSight session, easily returning
to a standard orientation, connecting to a specific host, creating Particle traces,
setting up a keyframe animation, etc. Anything that you will want to be able to
repeatedly do is a candidate for a command file. Further, if it is a task that you
frequently do, you can turn the command file into a macro (see To Use Macros
below).

Command files are one of the best ways of documenting any bugs found in the
EnSight system. Hopefully that is a rare occasion, but if it occurs, a command file
provided to CEI will greatly facilitate the correction of the bug.

Command files can be nested, which means that if you have a command file that
does a specific operation, you can play that command file from any other
command file, as long as any prerequisite requirements are completed. This is
done by adding the command play: <filename> in the command file.

EnSight is always saving a command file referred to as the default command file
(unless the you have turned off this feature with a Client command line option).
This command file can be saved (and renamed) when exiting EnSight, as
described later in this section. The default command file is primarily intended to
be a crash recovery aid. If something unforeseen were to prematurely end your
EnSight session, you can recover to the last successfully completed command by
restarting EnSight and running the default command file. Saving the Default
Command File for EnSight Session

E E Command

Commans Entry>

_| Record I
Record Part Selection By Number I
_l Play |
Enim'}'upi‘l Si’ﬁl %I Eﬁfam?izmzﬁl
Delay Between Commands Io—
_| Delay Refresh
Figure 2-15 Reload Macmsl
Command dialog Close| Help|

You use the Command dialog to control the execution of EnSight command language. The
language can be entered by hand, or as is most often the case, played from a file. This
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2.4 Command Files

Command History

Command Entry

Record

Record Part
Selection By

Play

Interrupt

Step

Skip
Continue

Delay Between
Commands

Delay Refresh

Reload Macros

dialog also controls the recording of command files as well as Macro path definition.
Access: Main Menu > File > Command...

Displays most recent command language executed (or recorded). Can click on an entry
which will bring entry to the Command Entry field.

Command language entry. Enter command and press RETURN. During file playback,
next command to be executed is shown here. Any command preceded by a # is a comment
line.

Select to start play file recording. Will be prompted for file name. Can simultaneously
record and play files. When engaged, all actions in EnSight are recorded to the specified
file.

Select the method by which parts will be recorded in the command language - either by
Number (default) or by Name.

Select to start playing a command file. You must provide the command language file
name. Command play continues as long as there are commands in file, an interrupt:
command has not been processed, or the Interrupt button has not been pressed.

Interrupt playback of the command file.

Step though commands of play file. File playback must be stopped. Each click will
execute next command shown in Command Entry field.

Skip over the playing command file’s next command (shown in Command Entry box).
Continue playing interrupted command file.

Set the delay between commands in seconds when playing a command file.

When enabled, will cause the EnSight graphics window to refresh only after the playfile
processing has completed or has been interrupted by the user.

Causes the Macro definitions to be reread from the site preferences directory and from the
user’s .ensight directory.

Troubleshooting Command Files

This section describes some common errors when running commands. If an error
is encountered while playing back a command file you can possibly retype the
command or continue without the command.

Problem Probable Causes Solutions
Error in command category Incorrect spelling in the command Check and fix spelling
category

Command does not exist

Error in parameter

Incorrect spelling in the command Check and fix spelling

Incorrect integer, float, range, or Fix spelling or enter a legal value
string value parameter

Commands do not seem to play Command file was interrupted by an  Click continue in the Command
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error or an interrupt command dialog

(see How To Record and Play Command Files)
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2.4 Saving the Default Command File for EnSight Session

Saving the Default Command File for EnSight Session

EnSight is always saving a command file referred to as the default command file
(unless the you have turned off this feature with a Client command line option).
This default command file receives a default name starting with “ensigAAA” and
is written to your /usr/tmp directory (unless you set your TMPDIR environment
variable). This command file can be saved (and renamed) when exiting EnSight.
If you do not save this temporary file in the manner explained below, it will be
deleted automatically for you when you Quit EnSight. If Ensight crashes for some
reason, this temporary file can be used to autorecover when it is restarted.

Quit Confirmation dialog

_| Save Command Backup File Ta:

I femrfbopdensied ASatbyTE

_| Sawve Full Backup Archive File Ta:

ensighiodsld i arehive

Do you really want to exit?

EI Cancel I

Figure 2-16
Quit Confirmation dialog

You use the Quit Confirmation dialog to save either or both the default command file and

an archive file before exiting the program.
Access: Main Menu > File > Quit...

Save Command Toggle-on to save the default command file. Can also specify a new name for the

Backup File To: command file. (see Section 2.4, Command Files for more information on using
command files.)

Save Full Backup Toggle-on and specify a name to create a Full Backup file.

Yes Click to save the indicated files and terminate the program.

(see How To Record and Play Command Files)
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2.5 Archive Files

2.5 Archive Files

Saving and Restoring a Full backup
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The current state of the EnSight Client and Server host systems may be saved to
files. An EnSight session may then be restored to this saved state after restarting at
a later time. A Full Backup consists of the following files. First, a small archive
information file is created containing the location and name of the Client & Server
files that will be described next. Second, a file is created on the Client host system
containing the entire state of the Client. Third, a file is created on each Server
containing the entire state of that Server. You have control over the name and
location of the first file, but only the directories for the other files.

Restoring EnSight to a previously saved state will leave the system in exactly the
state EnSight was in at the time of the backup. For a restore to be successful, it is
important that EnSight be in a “clean” state. This means that no data can be read
in before performing a restore. During a restore, any auto connections to the
Server(s) will be made for you. If manual connections were originally used, you
will need to once again make them during the restore. (If more than one case was
present when the archive was saved, then connection to all the Servers is
necessary).

An alternative to a Full Backup is to record a command file up to the state the user
wishes to restore at a later date, and then simply replaying the command file.
However, this requires execution of the entire command file to get to the restart
point. A Full Backup returns you right to the restart point without having to
recompute any previous actions.

A Full Backup restores very quickly. If you have very large datasets that take a
significant time to read, consider reading them and then immediately writing a
Full Backup file. Then, use the Full Backup file for subsequent session instead of
reading the data.

Important Note: Archives are intended to facilitate rapid reload of data and
context and are NOT intended for lon-term data storage. Therefore, archives are
likely NOT compatible between earlier EnSight versions and the current version
(see Release Notes for details). If EnSight fails to open an archive, it will state
that it failed and will write out a .cmd file and echo its location. As command files
ARE often compatible between earlier and later versions, the .cmd file can likely
be used to retrace the steps of the dataset.
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2.5 Saving and Restoring a Full backup

Save Full Backup Archive dialog

Archive Information
File

Client Directory
Server Directory

Archive information
File...

Client Directory...

Server Directory...

Okay

Archive Information File

car.archive

Client Directory I /home/cei/.ensight/

Server Directory Mome/cei.ensight!

Select File Name or Directory Names:

Archive Information File...l Client Dir\ectory...l Server Dir\ectory...l

Okay Cancel I Help I

Figure 2-17
Save Full Backup Archive dialog

You use the Save Full Backup Archive dialog to control the files necessary to perform a

full archive on EnSight.
Access: Main Menu > File > Backup > Save Full Backup...

Specifies name of Full Backup control file.

Specifies the directory for the Client archive file.
Specifies the directory for the Server archive file.

Click to display the file selection dialog for specifying the Archive Information File.

Click to display the file selection dialog for specifying the Client Directory.

Click to display the file selection dialog for specifying the Server Directory (for the
selected case if there is more than one). Choose a common path if there is more than one.

Click to perform the full backup.

NOTE: This command is written to the command file, but is preceded with a # (the
comment character). 1o make the archive command occur when you play the command
file back, uncomment the #.

(see How To Save and Restore an Archive)

File Selection for Restarting from an Archive

EnSight 7 User Manual

Filter

I /home/ceil.ensight/*

Directories Files

/home ceil.ensight/ j‘ car.archive j
i i

I~ | B | -

Selection

I /home/ceil.ensight/

Okay I Apply Filter Cancel Help I
Figure 2-18

File Selection for Restarting from an Archive

You use the Restore Full Archive Backup dialog to read and restore a previously stored

archive file.
Access: Main Menu > File > Backup > Restore Full...
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Troubleshooting Full Backup

Problem Probable Causes Solutions

Error message indicating that all ~ When saving and restoring archives, Dismiss all the Motif dialogs except the
dialogs must be dismissed all EnSight dialogs, except for the main Client GUIL

Client GUI, must be dismissed to

free up any temporary tables that are

in use. Temporary tables are not

written to the archive files.

Backup fails for any reason Ran out of disk space on the Client ~ Check the file system you are writing
or Server host system to, on both the Server and the Client
host systems, with the command “df”
then remove any unnecessary files to
free up disk space.

Directory specified is not writable Change permissions of destination
directory or specify alternate location.
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2.6 Context Files

EnSight context files can be used to duplicate the current EnSight state with the
same or a different, but similar, dataset. The context file works best if the dataset
it is being applied to contains the same variable names and parts, but can also be

used when this is not the case.

Input and output of context files is described below as well as in How To Save or
Restore a Context File and under Save and Restore of Section 6.1, File Menu

Functions

Saving a Context File

To save the current context, simply entered the desired file name in the dialog

under: Access: File > Save > Context...

(and if you have multiple cases to save, select Save All Cases)

File | Edit GQuery View Tools Case

Command...
Connect Server...
Collaboration...
Data (Reader}...
Data {(Part Loader)...

Print/Save Image...

F

igure 2-19

Saving a Context File

Save Context...

Restore Full Backup...

Quit... Geometric Entities...

Scenario...

X-4 Save Current Context m

Current case is: Case 2

| Save Current Case Onlyl Save All Cases

Context File Select File...
Okay| Cancel Help
I I

Restoring a Context

itext From File
Select case(s) to restore to

Context File

Okay| Cancel

Select File...

Help
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Figure 2-20
Restoring a Context File

2-39



2.6 Restoring a Context

2-40

If you are restoring a context file containing information for a single case, you can
select the case or cases that you wish to apply the context to. If you are restoring
a context file containing information about multiple cases, the selection list will
be ignored.

When restoring a context you can 1) read the new dataset and build the new parts
and then restore the context file, or 2) read the new dataset, close the part builder
without building any parts and restore the context file (whereupon the context file
will build the same parts as existed when it was saved) or 3) restore the context
before reading any data (whereupon the previous state with the same dataset will
be restored). The way you decide to do this depends upon whether the same parts
exist in the new dataset.

If the same parts do not exist, you would typically read the new dataset and build
the desired parts in the normal way. Then:

File | Edit Query View Teools Ca

Command...
Connect Server...
Collaboration...
Data (Reader)...
Data {(Part Loader}...
Print/Save Image...
Save

Restore

Quit...

Context...
Full Backup...

Ml Map Entities in List 1{Cortext File) to List 2(Mew Case) [O][=]

The model parts from the context file do not match the model parts in the current case.
Please map the parts by selecting a part from List 1{Context) to map to a part or part(s) that
you select in List 2(New Case). Then click the "Map List 1 Item Two List 2 Item(s}" button.
List 2

1 - {(M/C1) external flow field
2 - (M/C1} ami-x hypersonic body

List 1

Computational mesh

---»»»»Map List 1 Item To List 2 Item{g)}----»>>>

Close

=M Map Entities in List 1{Context File) to Li

The variables from the context file do not match the available variables in the current
case. Please map the variables by selecting a variable from List 1{Context) to map to a variable
that you select in List 2(New Case). Then click the Map "List 1 Item Tao List 2 Item({s}" button.

List 2

List 1
pressure
velocity

temperature

---»»»»Map List 1 Item To List 2 Item{g)}----»>>>

Figure 2-21
Restoring a Context

Flipbook animations are not restored using the context file because it is unknown
at the time the context file is created what state existed when the flipbook was
saved.

Context files use EnSight’s command language and other state files (such as
palette, view, and keyframe animation).
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2.7 Scenario Files

EnSight 7 User Manual

Scenario files are used by CEI’s EnLiten product which is capable of viewing all
geometry (such as parts, annotation, plots, etc.) that EnSight can display,
including flipbook, keyframe, and particle trace animations.

A “scenario” defines all visible entities you wish to view with EnLiten and
includes any saved views and notes that you want to make available to the
EnLiten user.

When you create a scenario, the following may be saved: (a) EnLiten file
containing geometric display information, saved views, and attached nodes. (b) A
palette file for each visible variable legend. (c) A JPEG image file (not used by
EnLiten). (d) A scenario description file (not used by EnLiten). (e) A EnSight
context file (not used by EnLiten).

When saving a scenario, either the scenario file itself can be saved, or the scenario
project - which includes all of the files in the previous paragraph.

EnLiten is a geometry viewer only. As such it is not capable of creating or
modifying any new/existing information such as variables or parts, or of changing
timesteps.

Since EnLiten is only a geometry viewer, only keyframe transformation
information is stored when saving a scenario file, i.e., no transient data
keyframing is possible (consider loading a flipbook instead)

Figure 2-22
Save Scenario Dialog

Scenario  Project i |
Please specify a ‘directory” to save the scenario project
ta. The directory will be created and a set of scenaria
scenario files(.els, jpg. .elv, ete) will he saved to it.
This directory can be read into EnLiten. The CEI HTML
publisher program can be run in the directory or in the
top level directory of multiple projects to autematically
create HTML files for easy navigation and organization
with a Web Browser. See Web Publisher in Help.

Select.. I

Please enter a general description to document
the contents of this scenario project.

[7 Save Keyframe Animation
[7 Save Flipbook Animation

[” Save Particle Trace Animation

Save Scenario Project Directory I

A starting view point was saved with the scenario file.
You can add additional views with the button below.

Add Current View... |

You can save notes for the scenario by entering
the information below and then selecting the
Save Note button.

Subject
Save Note I Clear I
Close I HelpI :
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2.7 Scenario Files

Scenario

Scenario Directory/
File

General
Description

Save Keyframe
Animation Toggle

Save Flipbook
Animation Toggle

Save Patrticle Trace
Animation Toggle

Save Scenario

Add Current View...

Save Note

2-42

You use the Save Scenario dialog to control the options of the scenario files to be saved in
EnSight for display in EnLiten.

Access: Main Menu > File > Save > Scenario...

Project - will save the scenario file plus files mentioned on the previous page.
File - will save only the scenario file.

Specifies the directory or file to which the scenario information will be written.

Specifies the general description which will be used when a html page is generated for the
scenario.

Select to have any currently defined keyframe animation sequence saved to the scenario.
Select to have any currently defined flipbook animation saved to the scenario.
Select to have any currently defined particle trace animation saved to the scenario.

Click to actually save the scenario.

After the scenario has been saved you may save additional views by setting the desired
view in EnSight, then selecting this button You will be asked to name the view in a
resulting pop-up dialog.

After the scenario has been saved you may write notes regarding the scenario by entering
a Subject line and typing in the notes input area. When satisfied, select this button.

(see How To Save Scenario)

EnSight 7 User Manual



2.8 Saving Geometry and Results Within EnSight

2.8 Saving Geometry and Results Within EnSight

Saving Geometric Entities

EnSight 7 User Manual

Sometimes you may wish to output geometric data or variable values from
EnSight to be included in a different analysis code, or to be used in a presentation.

EnSight has three internal writers that allow saving geometric data and variable
values in Brick of Values, Case (EnSight Gold) or VRML. EnSight also allows the
user to create their own writers.Each user-defined writer must be compiled into a
dynamic shared library that is loaded at runtime and listed in the Save Geometric
Entities dialog with the internal writer formats.

Both internal and user-defined writers have access only to the geometry of
selected parts and each of their active variables. Only parts located on the server
can be saved. This includes all original model parts, and the following created
parts: 2D-clips, Elevated Surfaces, Developed Surfaces, and Isosurfaces. The
VRML internal writer saves all the visible parts on the server (thus, particle traces,
vector arrows, contours, etc. will not be saved) in their current visible state except
for Parts which have limit fringes set to transparent. The VRML file will be saved
on the client.

The userd-defined writers can call the routines of an EnSight API to retrieve, to
get, for example, nodal coordinates, node ids, element ids of parts selected in the
Parts window to be passed by value to be used, manipulated and/or written out in
any format desired. User-defined writer dialog includes a Parameter field that
allows passing in a text field into the writer from the GUI for extra options.

Several example writers (including source code header files, Makefile and the
corresponding shared library) are included to demonstrate this capability.

The Case (Gold) Lite reader is included to demonstrate how to exercise most of
the API and output a subset of the Case (Gold) format. Complex numbers and
custom Gold format are not supported with this writer. While the writer is not
compiled, the source code of this writer, the required header files, and the
Makefile are included.

The Flatfile user-defined writer is designed to demonstrate the output selected part
nodal data (coordinates & IDs) as well as active variable values (scalar and/or
vector only) data in a comma delimited format easily imported into other
applications. If any of the keywords ‘ANSYS’ or ‘force’ or ‘body’ is entered into
the Parameter field, then Flatfile will output an ANSYS body force file.

The HDF 5.0 writer is designed to write out selected parts and their corresponding
active variables using the HDF 5.0 API which is compatible with the EnSight
HDF user-defined reader.

The STL user-defined writer is designed to write out the border geometry in the
form of triangular 2D elements of the selected part(s) at the beginning timestep.
The end time and the step time are ignored. The STL format does not support
multiple parts in a single binary file, but does support multiple parts in a single
ASCII file. Therefore, if multiple parts are selected and ascii is checked, the STL
writer outputs an ascii file with the border of each of the parts. If multiple parts
are selected and binary is checked, the STL writer outputs a binary file containing
a single border of the multiple parts.

More user-defined writers may be distributed with EnSight in the future.
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2.8 Saving Geometric Entities

Save Geometric Entities dialog

Output Format

Parameter

[path]/filename
prefix

Save As Binary
File(s)

Begin Time Step

End Time Step

Step By

2-44

-» Save Geometric Entities [O][=]

Output Formats (Select One} Please select the parts you wish to save from the Parts list, activate
the variables you wish to save from the Variables list, and then fill

prick of Valnes _ _ _ _ _ | in the following information. These files will be saved by the EnSight
Case (Gold) . server as *.gea, *.case, *.variahle.
VERML . .
Flatfile [path/lfilename prefix
Is{'r['): 5.0 Save As Binary File(s)
Begin Time Step 0 Save As A Single File
End Time Step Basizenm File | a5y
159 Steotin Mie |00
Step By 1
Okay| Cancel Help
1l Il
- Save Geometric Entities [oi[x]

Output Formats (Select One} Please select the parts you wish to save from the Parts list,
select a variable, and then fill in the following information.

Brick of ¥alues These files will be saved by the EnSight server.
Case (Gold)
VRML Parameter{s)
Flatfile . )
HDF 5.0 [path/lfilename prefix
TL Fave A Biuoasy Filels)
Begin Time Step 0 faave Ax A Slagle Pile
End Time Step Basizenm File | a5y
159 Steotin Mie |00
Step By 1
Okay| Cancel Help
il il
Figure 2-23

Save Geometric Entities dialog
(Showing Case (Gold) internal writer, and STL external writer)

The Save Geometric Entities dialog is used to save Selected Model, 2D-Clip, Isosurface,
Elevated Surface, and Developed Surface Parts as EnSight Case (Gold) files. Thus
modified model Parts and certain classes of created Parts can become model Parts of a
new dataset.

Access: Main Menu > File > Save > Save Geometric Entities...

Specify the desired format: Case(EnSight Gold), VRML, Flatfile, HDF5.0, STL, etc.

Allows passing a text field from the GUI to the writer for extra options. Some writers
make use of this field to modify their behavior (see Flatfile, for example) while others
ignore this field.

Specify path and filename prefix name for the saved files. For Case(Gold) the saved
geometry file will be named filename.geo, the casefile will be filename.case, and the
active variables will be filename.variablename. The VRML file will be filename.wrl. The
other writers will vary.

Save as Binary File(s) specifies whether to save the data in ASCII (button toggled off -
default) or binary (button toggled on) format. Writers vary in their handling of this.

Begin Time Step field specifies the initial time step for which information will be
available to save for all selected Parts and activated variables. Writers may vary in their
usage of this information.

End Time Step field specifies the final time step for which information will be saved for
all selected Parts and activated variables. Writers may vary in their handling of this.

Step By field specifies the time step increment for which information will be saved for all
selected Parts and activated variables starting with Begin Time Step and finishing with
End Time Step. The Step By value MUST be an integer. Writers may vary in their
handling of this.
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Save as a Single
File

Maximum file Size

Okay

2.8 Saving Geometric Entities

Toggle on to have a single file per variable - containing all values for all time steps for that
variable. The default is to have a file per variable per time step. Writers may vary in their
handling of this.

For Single File option, can specify the maximum file size. Continuation files are created if
the file size would exceed this maximum. Writers may vary in their handling of this.

Click ok to pass the GUI values to the selected writer, and begin executing the writer
routine

Troubleshooting Saving Geometric Entities

Problem Probable Causes Solutions
A Part was not saved User attempted to save an Select only Model, Isosurface, 2D-
unsupported Part type. Clip, and Elevated Surface Parts.

Variable(s) not saved

Error saving

The variable was not activated or the Activate all scalar and vector
variable was a constant. variables you want saved.

File prefix indicates a directory that  Re-specify a writable directory and
is not writable or disk is out of space. valid prefix name. Remove
unneeded files.

My custom user-defined writer Didn’t load at startup Start Ensight with -writerdbg option
doesn’t show up on list of formats EnSight loads user-defined writers at

EnSight 7 User Manual

startup from shared libraries found in
$CEI_HOME/ensight76/machines/
$CEI_ARCH/lib_writers

If your user-defined writer is not in
the default directory, tell EnSight
where to find it by:

setenv ENSIGHT7 UDW location

(see How To Save Geometric Entities)
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2.9 Saving and Restoring View States

EnSight’s viewports provide a great deal of flexibility in how objects are
displayed in the Graphics Window. Given the complicated transformations that
can be performed, it is imperative that users be able to save and restore

accumulated viewport transforms.

View saving and restoring is accessed from the Transformations dialog.

- Transformation Editor {Global Transform) [O][=]
File | Editor Function Help
Save View... oI

Bestore View...

Which Viewpart(s) Scale Settings

l. Increment | | pogpon

Limit 90000000

Link Interactive
Transforms

Close

Figure 2-24
View Saving and Restoring in Transformation Dialog

Access: Desktop > Transformation Edit... > File

When either the Save View... or Restore View... selection is made, the user is
presented with the typical File Selection dialog from which the save or restore can
be accomplished. Save and Restore work on a single viewport.

(see also How To Save and Restore Viewing Parameters)
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2.10 Saving and Printing Graphic Images

EnSight enables you to save an image of the Main View to a disk file or send it
directly to a printer. The choice of save file formats depends on the
implementation, but in all cases it is possible to obtain formats compatible with
printers and plotters. Currently EnVideo, Apple PICT, PCL, PostScript, SGI RGB,
CEI RGB(w/depth), TIFF, JPEG, MPEG, AVI, and TARGA formats are available.

EnSight also enables you to save images of an animation to disk files. These files
can then be converted and printed or recorded to video equipment (see Section
7.15, Keyframe Animation).

Print/Save Image dialog

- PrintfSave Image

[CIES

Format...

To File{Prefix)

Current Format: Silicon Graphics RGB

Prefix Select...

Format...

To File Toggle/Field

To Printer Using
Command Toggle/
Field

Convert to default
print colors

Show Plotters Only

Window Size
Normal
Full
User Defined

Detached Display
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Tao Printer Using Command
Convert To Default Print Colors
Show Platters Only

Windew Size Normal Bl ows Y sue
Full
Fave Bal T
User Defined
Okay Help

Figure 2-25
Print/Save Image dialog

You use the Print/Save Image dialog to specify the format and destination of an image to
save. The destination can be a disk file or a printer. You also access the Image Format
Options dialog for the various types from this dialog.

Access: Main Menu > File > Print/Save Image...

Click to select image format. (See next figure)

The image will be saved to this disk file name if toggle is on. This is a filename prefix.
An appropriate suffix, according to the file format chosen, will be added.

The command to send a file to the printer if toggle is on. Make sure your printer is setup
for the format you’ve selected.

Clicking this toggle on will convert all black to white and all white to black but will leave
all other colors as they are.

Clicking this toggle will cause the graphics window to only display plotters.

Specifies the size of the Graphics Window and the resulting image size.

Creates a window which is the size of the current Graphics Window.

Creates a window which is the size of the full screen.

Creates a window which is specified in terms of its width and height in the X and Y fields.

Uses the detached display (as specified with - dconfig option) as the source for the output.
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2.10 Saving and Printing Graphic Images

Format...

E E ImagefMovie Format And Options

Image/Movie Formats {Select One} < Color < Black & White

E E ImagefMovie Format And Options

Image/Movie Formats (Select One) 4 Colar < Black & White

APPLE PICT Saturation Factar I 1.00 APPLE PICT -~ Saturation Factor I 1.00
JPEG
: TIFF
E E ImagefMovie Format And Options Page Control Language{PCL)
. : PostScript
Image/Movie Formats {(Select One) <> Color < Black & White | Silicon Graphics RGB
APPLE PICT Saturation Factar I 1.00 ARGA
i =* Image/Movie Format And Options
TIFF Quality I 75 ] L i
Page Contral Language(PCL} Image/Movie Formats (Select One) Calor Black & White
PostScript TIFF Saturation Factor | |
_ Imageilovie Format And Options gag;’sc"_“:’“l Language(PCL)
d : ostScrip
Image/Movie Formats (Select One) Saturation Factor I 1.00 Silicon Graphics RGB
APPLE PICT A |
JPEG CEI RCE with depth ____}
IFF
Page Contral Tandnade/ PO . =™ Image/Movie Format And Options (%]

E E ImagefMovie Format And Options E

Image/Movie Formats (Select One) Type RLE

Image/Movie Formats (Select One) # Color < Black & White Page Control Language({PCL} Saturation Factor | |
) PaostScript

APPLE PICT Saturation Factor [ 99 Silicon Graphics RGB

JPEG TARGA

TIFF 4 Portrait Landscape

[Page Control Language({PCL} Gamma [ 000000
PostScript :

Silicon Graphics RGB Printer Model  LaserJetll LI |
TARGA

#rtDownload Player From:
#krtwrwrwrensight.comfenvideo. html

= - ;

A AR LT :
Image/Movie Formats (Select One) © Color < Black & White Image/Movie Formats (Select One) Saturation Factor [1 g
TIFF Saturation Factor 13 .

1.00
Pa_ge Control Lallguagr.(PCL) Silicon Graphics RGB
ST | | © Portrit  Land TARGA
QETCYIEY L+ Al ANSCApE .
e - CEI RGE with depth
Silicon Graphics RGB F N
ull Page Scale Factor | ; 4 EnVideao
TARGA : gMMPEG |
CEI RGE with depth Type | Move/Draw S :
EnVideao
MPEG Encapsulated
o s P Provies: Capable Image/Movie Formats (Select One) Saturation Factor [ gq
Silicon Graphics RGB
Element Visibility Culling TARCA
Okay Cancel Help Element Subdivision CEI RGP with depth
r EnVideao
B ovie Fo 2 0 D lz‘ ____________
v |
Image/Movie Formats (Select One) Color Black & White || | = =
TIFF Saturation Factor | |
Page Control Language{PCL}
PostScript _ _
ilicon Graphics RGB | Okay|  Cancel Help
1l Il
Figure 2-26
Okay Cancel Help Image/Movie Format Options dialogs
1l Il
Color/Black & Color versus Black and White toggle.
White
(Several Formats)
Saturation Factor At a value of 1.0, no change to the image. At lower values, a proportionate amount of
(all formats) white is added to each pixel. At a value of 0.0, the image would be all white.
Quality (JPEG) Specifies trade-off between fidelity & compression. 100 max fidelity; 0 max compression.
Portrait/Landscape Page Orientation for printing.

(PCL, Postscript)

Gamma (PCL) Gamma correction factor.
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Full Page Scale
Factor (Postscript)

Printer Model
(PCL)

Type
(Postscript)

Type
(EnVideo)

Encapsulated
Toggle
(Postscript)

Windows(PC)
Preview
Capable Toggle)

Element Visibility
Culling Toggle
(Postscript)

Element
Subdivision
(Postscript)

EnSight 7 User Manual

2.10 Saving and Printing Graphic Images

The percentage of full page scaling to do. This is according to Orientation as well. Values
are from 0.0 to 1.0.

The destination PCL printer model.

Type of Postscript output: Move/Draw (vector) or Image Pixels. If type is Image Pixels,
shaded 3D objects will be output as pixels while overlay graphics (annotation text, plots,
color legends) will be output Move/Draw for higher print quality.

Type of EnVideo output: Run Length Encoded or Jpeg.

Generate Encapsulated PostScript (EPS) for importing into other applications. (The
graphic typically will appear as a gray box in the importing application on all systems
unless the Windows(PC) Preview Capable toggle is also On).

Create an Encapsulated PostScript (EPS) file which also has a preview image for use in
Windows® applications. (The graphic will still appear as a gray box in the importing
application on Macintosh systems).

Hidden geometry will be removed from the output stream if toggle is on. Valid for Move/
Draw output only. On by default.

Subdivide output primitives (lines and polygons) if toggle is on. Although the output file
will be larger, the color distribution will be far superior. Valid for Move/Draw output only.
On by default.

(see How To Print/Save an Image)
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2.10 Troubleshooting Saving an Image
Troubleshooting Saving an Image

Problem Probable Causes

Solutions

Image has blotches or ghosts of other A viewport or menu was popped in
windows in it front of the Main Graphics Window
as the image was being saved.

Error while saving image file Directory or file specified is not
writable

Ran out of disk space

Image format not selected

Image looks bad when printed Original on-screen image has low
resolution

Image has been dithered during
processing

Non-integral ratio of printer
resolution to image resolution at

final size
Move/Draw PostScript output Primitives in Move/Draw PostScript
doesn’t look correct. output sometimes suffer from sorting
problems.

(see How To Print/Save an Image)
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Do not perform any window
manager functions until image is
finished recording to disk file.

Rename the file or change the
permissions.

Check the file system you are
writing to with the “df” command
then remove any unnecessary files to
free up disk space.

Select an image format before
saving.

Make the graphics window as large
as possible before saving the image
to increase the number of RGB
pixels used on the display.

Do not enlarge or reduce the image
until it is in your word processor.

The image is a pixel-map image. For
best results, the number of printer-
dots per image-dot should be an
integer. For example, if the original
image resolution is 72 dpi, reduced
to 48% the final-size resolution is
72/.48 = 150 dpi. On a 600 dpi
printer, each image pixel is exactly 4
printer-dots on a side.

Use Image Pixel type instead of
Move/Draw.
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2.11 Saving and Loading XY Plot Data

2.11 Saving and Loading XY Plot Data

Save...

Format

File Name

Loading:

EnSight 7 User Manual

The xy data used for curves in EnSight’s plotter can be saved to a file for future re-
loading into EnSight or for use in other plotting packages.

The process is described below as well as in Section 7.11, Query/Plot

Query [tems

ime vs. node_scalar fiy

(]
un
e
r
¥
P
1
a| Show...| Save...| Delete...
t

Marker Visibility ..

E E Save Guery Entity To
Format Eormatt\edlil

File nax XY Data
1 —_—
File Select...l
Cancel I

Figure 2-27
Saving or Loading XY Plot Data

Access: Desktop > Query/Plot Feature

Once the desired query item (curve) is selected in the list, the user can perform a
Save operation by:

Click this button in the Quick Interaction area of the Query/Plot feature to save the plotter
curve data.

Select the Format of the data to save.

Formatted is a table suitable for printing. (see Section 2.13, Saving Query Text
Information)

XY Data is the xy file format described in Section 11.10, XY Plot Data Format,
which is suitable for re-loading into EnSight.

Enter the desired filename for the xy data file, or click File Select... to be presented with
the typical File Section dialog from which to perform the op8888eration.

To Load a previously saved or externally generated xy data file (see Section 11.10,
XY Plot Data Format) into EnSight you choose the “Read From An External File”
Sample type (see How To Query/Plot). You will then be presented with the
typical File Selection dialog from which to select the file. Note: A MSC/Dytran
.ths file is also a valid entry for this option.

Figure 2-28 Query Items Sample | Read From An External File v

Query/Plot Area for Read
From An External File.

Load XY Data From File...

Show...| Sawve...| Delete...

+0 = |HMras g
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2.12 Saving and Restoring Animation Frames

2.12 Saving and Restoring Animation Frames

Both Flipbook and Keyframe Animation processes have save and restore
capability. These are best described in the chapters devoted specifically to these
features.

For Flipbook Animations, see Section 7.14, Flipbook Animation and How To
Create a Flipbook Animation.

For Keyrame Animations, see Section 7.15, Keyframe Animation and How To
Create a Keyframe Animation.
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2.13 Saving Query Text Information

2.13 Saving Query Text Information

The data used for curves in EnSight’s plotter and any other information from a
query or otherwise which is presented in the EnSight Message Window can be
saved to a file suitable for printing.

From Query/Plot Save... Formatted

One place this can occur is in the Query/Plot Quick Interaction area as described
below as well as in Section 7.11, Query/Plot

Query [tems

ime vs. node_scalar fiy
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a| Show...| Save...| Delete...
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Marker Visibility ..
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Format Eormatt\edlil

File nax XY Data
1 —_—
File Select...l
Cancel I

Figure 2-29
Saving or Loading XY Plot Data

Access: Desktop > Query/Plot Feature

Once the desired query item (curve) is selected in the list, the user can perform a
Save operation by:

Save... Click this button in the Quick Interaction area of the Query/Plot feature to save the plotter
curve data.
Format Select the Format of the data to save.

Formatted is a table suitable for printing.

XY Data is the xy file format described in Section 11.10, XY Plot Data Format,
which is suitable for re-loading into EnSight.

File Name Enter the desired filename for the xy data file, or click File Select... to be presented with
the typical File Section dialog from which to perform the operation.

From Query/Plot Show Text

Show ... Click this button to see the plotter curve information presented in the EnSight Message
Window.
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2.13 From EnSight Message Window

From EnSight Message Window

Save Text To File

2-54

A file suitable for printing can be saved from any operation which places its
information into the EnSight Message Window, such as Show Information queries
and the Query/Plot Show Text... button described previously.

E E EnSight Message Window :

temperature vs, Distance for line tool

Distance VYalue H ¥ z
0,00000e+00  1,15977e+01 -7, 50000e-01  5,00000e-01  1,00000e+00
1,31579%-01  1,162%1e+01 -56,18421e-01  5,00000e-01  1,00000=+00
2,63158e-01  1,17026e+01 -4,86842e-01  5,00000e-01  1,000002+00
2.94737e-01  1,15701e+01 -3,552632-01  5,00000e-01  1,000002+00
5,26816e-01  1,24116e+01 -2,23684e-01  5,00000e-01  1,000002+00
6,57895:-01  1,7360%5e+01 -9,21053e-02 5,00000e-01  1,000002+00
7.89474e-01  2,46960e+01 3,94737e-02  5,00000e-01  1,00000e+00
9,21053e-01  2,86126e+01  1,710532-01  5,00000e-01  1,000002+00
1,05263e+00 3,08816e+01 3,02632e-01  5,00000e-01  1,00000=+00
1,18421e+00  3,25925e+01 4,34211e-01  5,00000e-01  1,00000=+00
1,31579%e+00  3,39377e+01 5.6578%-01  5,00000e-01  1,00000=+00
1.,44737e+00  3,4980de+01  5,9736%-01  5,00000e-01  1,00000=+00
1.578959e+00  3,56720e+01  8,28947e—01  5,00000e-01  1,00000s+00
1,71053e+00  3,42229=+01  9,60526e—01  5,00000e-01  1,00000=+00
1.84211e+00  2,8244%9=+01  1,09211e+00 5,00000e-01  1,00000=+00
1,97368e+00 2,33978e+01 1,22368e+00 5,00000e-01  1,00000=+00
2,10526e+00  2,00823e+01  1,358526e+00  5,00000e-01  1,00000e+00
2,23684e+00  1,78311e+01  1,48684e+00  5,00000e-01  1,000002+00
2,36842e+00  1,62923e+01  1,61842e+00 5,00000e-01  1,00000e+00
2,80000e+00  1,52665e+01  1,75000e+00  5,00000e-01  1,00000e+00

Minimum value overall
At Point = -3.55263e-01 5,00000e-01 1,00000e+00,. Dist, = 3,94737e-01. Value =

Maximum value overall
At Point = 8.28947e-01 5,00000e-01 1,00000e+00,. Dist, = 1,5739%e+00. Value =

= I -
Closel Sawve Text Ta Filel

.

Figure 2-30
EnSight Message Window with Save Text To File Button

Brings up the typical File Selection dialog from which the information can be saved in the
file of your choice.
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2.14 Saving Your EnSight Environment

2.14 Saving Your EnSight Environment

EnSight 7 User Manual

Every user has different postprocessing needs and personal preferences for how
the EnSight windows should be positioned and sized. EnSight allows you to save
dialog expandable section settings, and dialog size and position information to a
file called “ensight7.winpos.default”. EnSight looks for this file at start up (in the
current Client directory and if not there in the .ensight7 directory of the user’s
home directory) and will bring the user interface dialogs up according to your
saved settings (if the file is found).

Almost all major dialog windows are saved in the:
ensight7.winpos.default XRESxYRES

file (where XRES and YRES are the resolution of the monitor when the
preferences were saved). The only exception are minor prompt dialogs. There are
also some dialogs for which you cannot save the size (such as the Tool Positions
dialog).

The ensight7.winpos.default file also contains the size and location for all of the
windows containing graphics.

A number of other settings, such as mouse and keyboard buttons and Icon Bar
settings can also be saved to a user preferences file.

(see Preferences... in Section 6.2, Edit Menu Functions and How to Save GUI
Settings)
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3 Parts
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The Part is the fundamental visualization entity in EnSight. Virtually every
postprocessing task you perform will involve a Part, thus it is vital to understand
how Parts work.

A Part is a collection of nodes and elements that are grouped together and share
the same attributes. When you start EnSight, you either read directly or
interactively extract Parts from the data files. Parts which come from the original
dataset are referred to as model Parts. Other Parts created within EnSight, are
referred to as created (or dependent) Parts.

In this chapter you will learn how to produce created Parts (parts derived from
other parts) and how to modify the attributes of all Part types.

Section 3.1, Part Overview is extremely important. It defines how Parts work
together to form other Parts and explains the dependencies which may exist
between model Parts and created Parts. Failure to understand the concept of Parts
as explained in this section will limit your ability to use EnSight. Please study this
section carefully.

Clip Plane Contours Elevated Surface

)=

E:
£

!

Vector Arrows \\I\Rdel Part

Particle Traces

Figure 3-1
Various EnSight Part Types
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3.1 Part Overview
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Included in this Chapter are:

Section 3.1, Part Overview

Section 3.2, Part Selection and Identification
Section 3.3, Part Editing

Section 3.4, Part Operations

3.1 Part Overview

Reassign Parent

In EnSight, a Part is simply a collection of nodes and elements which are grouped
together, will be manipulated together, and which share the same attributes. This
section defines Parts and how they are related. It gives you an overview of the Part
types and Part attributes that are available within EnSight.

Parts that are defined or extracted from your dataset are referred to as model Parts.
Parts that are created within EnSight are referred to as created (or dependent)
Parts. The types of Parts that you create depends on what features within EnSight
you choose to utilize. Any created Part is derived from Parts that already exist,
which is why the created Parts are sometimes called dependent Parts—they
depend on the Parts from which they were created. The Parts that are used to
create a dependent Part are referred to as parent Parts. Any time that a parent Part
changes, its dependent Parts must also change. A parent Part will change when
you change its attributes, or modify the current time in the case of transient data.

The Main Parts List contains all Parts that have been read in from your results data
or created within EnSight. Displayed are a Part ID Number, a Part symbol, a case
number, and a Part description. Table 3-1 lists all of the different types of Parts
and their associated symbols. The figure below of the Parts List shows a number
of different Part types.

Select Part(s) To Operate On

/ P | 1{M/C1} Flow Field KX
Parent Part 2—(I/C1) Isosurface part
Indicator 8~(TYC1} Particle trace part

- 4-{2/C1} Clip_plane ‘\ e

_—
PartID — | | 5-(ViC1) Vector Arrow par Part Description
Number 6—{C{C1) Contour part
/ \ z
Bl \ =

Part Symbol Case Number
Figure 3-2
Main Parts List
Note that in the illustration above the Isosurface Part is selected and that there is a
“P” in the left column next to the Computational mesh (model) Part. This
indicates that the Computational mesh Part is the parent Part of the isosurface
Part. All parent Parts of a created Part will be so noted if that individual created
Part is highlighted in the Main Parts List.

Parent Parts of any created Part can be changed by first selecting the created Part
in the Feature Detail Editor, then selecting a new parent Part in the Main Parts
List, and finally by clicking the Update Parent button in the Feature Detail Editor.
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3.1 Part Creation

Table 3—1 Part Types, Symbols, and Descriptions

Part Type Symbol Description
Clip 2 A surface or line resulting from a clip of other Parts using the line,
plane, or quadric tools
Contour © Lines of constant value on 2D elements
Developed Surface D) A planar surface derived by unrolling a surface of revolution (i.e.,
the unrolling of a cylinder clip Part produced by the cylinder
quadric tool)
Elevated Surface (E) Surface created by elevating elements by a variable
Isosurface 1) Surface of constant value through 3D elements of other Parts
Material Part (A) A Part created according to the intersection of or domains of
material values
Model Part M) A Part that originated from the dataset
Particle Trace (T) Path of a massless Particle through a vector field
Profile P) Plot of a variable along a line (Similar to a 2D elevated surface)
Separation/ L) Line where flow separation or attachment is occurring
Attachment Line
Shock Surface/ (K) Surface or region where shock is occurring
Region
Subset (S) Valid node and/or element label range(s) from model Part(s)
Tensor Glyph G) Glyph showing direction of first, second, and third eigenvectors of
a tensor field.
Vector Arrow \2) Arrows showing direction and magnitude of vector field
Vortex Core X Line representing center of a flow vortex
Part Creation
Part creation occurs on either the server or the client. Since the data that is
available on the client and server are different, it is useful to understand where
Parts are created and where the data structures are stored. By understanding this,
you will understand why some Parts can be created with certain parent Parts and
others cannot. This information can be gained by examining the following table.
Table 3—2 Part Creation and Data Location
Part Type Where Created Data on Data on Client
Server
Clip Server Yes Depending on Part attributes
Contour Client No Yes
Developed Surface Server Yes Depending on Part Attributes
Discrete Particle Not Applicable Yes Depending on Part attributes
Elevated Surface ~ Server Yes Depending on Part attributes
Isosurface Server Yes Depending on Part attributes
Model Not Applicable Yes Depending on Part attributes
Material Part Server Yes Depending on Part attributes

EnSight 7 User Manual

3-3



3.1 Part Attributes
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Part Attributes

Part Type Where Created Data on Data on Client
Server

Particle Trace Server No Yes
Profile Client No Yes
Separation/ Server Yes Depending on Part attributes
Attachment Line
Shock Surface/ Server Yes Depending on Part attributes
Region
Subset Server Yes Depending on Part attributes
Tensor Glyph Client No Yes
Vector Arrow Client. Server if Maybe  Yes

necessary.
Vortex Core Server Yes Depending on Part attributes

(see Introduction to Part Creation)

Each type of created Part has a unique set of attributes that are used to accomplish
its creation, the Creation Attributes. Model Parts (symbol: M) and discrete
Particle Parts (symbol: D) typically do not have creation attributes because they
are not created—they are read or extracted from the dataset. The one exception to
this is model parts originating from block structured datasets. These parts contain
the I,J,K and step attributes used to create the part.

All Parts have a set of Display Attributes that are used in visualizing the Part in the
Graphics Window. These can be modified using the Feature Detail Editor or by
utilizing the Part Mode Icons (See Section 8.4). The Feature Detail Editor for each
Part type will show you attributes grouped together under turndown sections.
They deal with such things as color, line width, symmetry operations, etc. Display
attributes do not control how the Part is created, only how it appears or how it
behaves in the Graphics Window.

Table 3-3 Display Attribute Sections

Section: Includes controls for...
General Attributes Visibility in Graphics Window and
(see Section 3.3 Part Editing) individual Viewports

Symmetry options
Susceptibility to Auxiliary Clipping
Reference frame

Response to changes in time (frozen or
active)

Coloration (constant or by a palette
associated with a variable)

Shaded Surface and Hidden Line display
Surface shading (flat, Gouraud, smooth)
Opaqueness and Fill density
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Section:

3.1 Part Attributes

Includes controls for...

Node, Element, and Line Attributes
(see Section 3.3, Part Editing)

Displacement Attributes
(see Section 3.3, Part Editing)

Lighting (diffuse, shininess, and highlight
intensity)

General Visibility: Node, Line, and
Element

Label Visibility: Node and Element

Node Representation: Node type (dot,
cross, or sphere), Node Scale, Node Detail
(for spheres), and Node size (constant or
variable)

Line Representation: Line Width and Line
style (solid, dotted, or dot-dash)

Element representation on client (full,
border, 3D border/2D full, feature angle,
or non visual), Element-size, Shrink-
Factor, Element Angle and Polygon
Reduction factor

Displacement variable

Displacement scaling factor

3-5



3.2 Part Selection and Identification

3-6

3.2 Part Selection and Identification

Selecting Parts

Identifying Parts

In the process of creating a Part you will need to be able to select the parent Part(s)
from the Main Parts List. You will also find that it is possible to either read or
create so many Parts within EnSight that you become confused as to the identity
of each Part. This section describes Part selection and identification

Items in all Parts Lists are selected using standard Motif/Win32 methods:
To: Do This: Details

Select an item Select (or Place the mouse pointer over the item
single-click) and click the left mouse button. The item
is highlighted to reflect the “selected”
state.

Extend a contiguous  Select-drag ~ Place the mouse pointer over the first

selection item. Click and hold the left mouse
button as you drag over the remaining
items to be selected. Only contiguous
items may be selected in this fashion.

Extend a (possibly Shift-click Select the first item. Place the mouse

long) contiguous pointer over the last item in the list to be

selection selected. Press the shift key and click the
left mouse button. This action will
extend a selection to include all those
items sequentially listed between the
first selection and this one.

Extend a non- Control-click Place the mouse pointer over the item.

contiguous selection Press the control key and click the left
mouse button. This action will extend a
selection by adding the new item, but
not those in-between any previously
selected items.

De-select an item Control-click Place the mouse pointer over the
selected item. Press the control key and
click the left mouse button. This action
will de-select the item.

Open the Quick Double-click Place the mouse pointer over the item
Interaction Area for a and click the left mouse button twice in
Part rapid succession.

(see How To Select Parts)

There are two quick ways to identify one or more Parts that have been selected in
the Main Parts List. You can identify them in the Graphics Window by toggling
visibility on/off while in Part Mode or you can select View > Show Selected
Parts... from the Main Menu to show only the selected Part(s) in the pop-up
Selected Part(s) Window.
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3.3 Part Editing

3.3 Part Editing

In EnSight, new Parts can be created and edited in the Quick Interaction Area
Editor or in the Feature Detail Editor specific to each type of Part. This process is
described in Sections 7.2 to 7.9. For editing, the Quick Interaction Area provides
access to the most common attributes; the Feature Detail Editor allow
modification of all attributes.

Whereas each individual change made in the Quick interaction Area Editor is
applied to the Part immediately, the Feature Detail Editor allows you to make a
number of changes to various attributes and then apply them all at one time. This
is done by toggling off View > Immediate Modification in the Feature Detail
Editor. The default behavior is to immediately apply a change when you press
Return.

The Feature Detail Editor for Parts is opened from the Main Menu (or by double
clicking on a Part creation Icon in the Main GUI Feature Icon Bar).

File Edit| Query View Tools Case

I

Part Feature Detail Editors L Selected

lipbook Animation Editor...
eyframe Animation Editor...
slution Time Editor...
ransformation Editor...
ariables Editor...

Contours
Clips...

Developed Surfaces...
Elevated Surfaces...

Isosurfaces...

references... Material Interface...
Model Parts...
Particle Traces...
Profiles...
Separation/Attachment Lines...
Shock Regions/Surfaces...
Subset Parts...
Tensor Glyphs...

Vector Arrows...
Vortex Cores...

| — Editor Title Bar
Editor Main Menu

| File Edit View

@ B _ — Part Type Icon Bar

2 - ({I/CI) I rf; .
et e — Parts List (of chosen

Part Type)

I Creation Attributes ||

General Attributes

— Creation Attributes Turndowr

Node, Element, and Line Attributes

Description of Selected Part — | P**° | Iso surface S
Display Attributes Turndowns J
!

Displacement Attributes

I

I
Closel Cr\eat\el Update Par\entl Apaely Cizémgﬁgl

Figure 3-3
Feature Detail Editor (Isosurfaces)
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3.3 Part Editing

Feature Detail Editor Main Menu

File Not applicable when Feature Detail Editor is used for Parts - only applicable for Variables.
Edit Opens a pull down menu.
Edit | View
Select All
Copy
Delete
Group...
Ungroup
r Immediate Modification
Figure 3-4
Feature Detail Editor Edit pull-down menu
Select All Selects all Parts in Feature Detail Editor Parts List. (see Section 3.4, Part Operations)
Copy Makes a copy of all selected Parts. (see Section 3.4, Part Operations), also (see How To
Copy a Part)
Delete Deletes selected Parts. (see Section 3.4, Part Operations), also (see How To Delete a Part)
Group... Groups the selected parts into a new part and removes the original parts from the list.
Ungroup Extracts the original parts out of a group and removes the group part.
Immediate Toggles on/off the immediate modification of Parts when individual changes are made to

Modification Toggle Attributes within the Feature Detail Editor. Default is on. By toggling off, you can make
several changes within the Feature Detail Editor and then apply them all at one time by
clicking the Apply Changes button.

View Opens a pull-down menu.

View |

< Show Selected Partls)... |

Figure 3-5
Feature Detail Editor View pull-down menu

Show Selected Opens the Selected Part(s) Window in which only Parts selected in the Feature Detail
Part(s) Toggle Editor’s Parts List are visible.
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3.3 Variable Color Palette Icon

Part Type Icon Bar
The Feature Detail Editor is initially opened from EnSight’s Main Menu (or by double
clicking a Part creation icon in the Feature Icon Bar) and the Feature Detail Editor’s Parts
List contains all Parts of the type named in the Editor’s Title Bar. The type of Parts in the
Feature Detail Editor’s Parts List may be changed by clicking on the appropriate icon in
the Feature Detail Editor’s Part Type Icon Bar. The figure below describes the four types
of choices available.

1. Variable Color Palette controls

2. Variable Creation (Calculator) controls

3. Model Part attribute controls

4. Created Parts
attribute controls

Figure 3-6
Feature Detail Editor Part Type Selection Icons

Variable Color Palette Icon

[

Click this icon to edit color controls. See Section 4.1 Variable Selection and Activation for
further discussion.

Variable Creation (Calculator) Icon

il
Bl
non

Click this icon to use the calculator to create new variables for the parts selected in the
Main Parts window.
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3.3 Variable Creation (Calculator) Icon

Creation Attributes

Model Parts

3-10

Creation Attributes are “specific” attributes used to create (or modify) model and created
Parts.

Creation Attributes for updating the I,J,K node range attributes of the selected block
structured Model Parts with proper updating of all dependent parts and variables. The
Creation Attributes area is inactive for unstructured Model Parts.

Access: Main Menu > Edit > Part Feature Detail Editors > Model Parts

Creation Attributes

Using Node Ranges:
From Ta

7l | | | |
K| | | [ [

—

Figure 3-7
Feature Detail Editor (Model) Creation Attributes Area

Using Node Ranges

1JK From These fields specify the desired minimum interval value in the respective [JK
component direction of the Model Part.

1JK To These fields specify the desired maximum interval value in the respective [JK
component direction of the Model Part.

1JK Step These fields specify the desired interval stride value in the respective IJK
component direction of the Model part.

1JK Min These fields verify the minimum interval limit in the respective IJK component
direction of the Model part.

1JK Max These fields verify the maximum interval limit in the respective IJK component
direction of the Model part.

(see How To Create 1JK Clips)
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3.3 Variable Creation (Calculator) Icon

Created Parts

Isosurface Clip

Contour Particle Trace Vector Arrow

Elevated Surface Profile Tensor Glyph

LT

Subset Developed Surface

Material Part Shock Surface/Region

Sl

Vortex Core Separation/
Attachment
Line

See the appropriate Section in Chapter 7 for a description of the Creation Attributes
section.

* (see Section 7.2, Contour Create/Update)

e (see Section 7.3, Isosurface Create/Update)

e (see Section 7.4, Particle Trace Create/Update)

e (see Section 7.5, Clip Create/Update)

e (see Section 7.6, Vector Arrow Create/Update)

e (see Section 7.7, Elevated Surface Create/Update)

e (see Section 7.8, Profile Create/Update)

e (see Section 7.9, Developed Surface Create/Update)

* (see Section 7.16, Subset Parts Create/Update)

e (see Section 7.17, Tensor Glyph Parts Create/Update)

* (see Section 7.19, Vortex Core Create/Update)

e (see Section 7.20, Shock Surface/Region Create/Update)
* (see Section 7.21, Separation/Attachment Lines Create/Update)
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3.3 Variable Creation (Calculator) Icon

General Attributes

Visible Toggle

Visible In Viewports

Fast Display Rep.

Visual Symmetry

3-12

General Attributes are “general” in that: (a) all Parts have them, and (b) they can’t
be neatly categorized into any other attribute type. Like all Part attributes, they are

set individually for each Part.
Access: Main Menu > Edit > Part Feature Detail Editors > (Isosurfaces..., etc.) > General Attributes

General Attributes

Visible Visible In . Fast B
Viewport(s) Display Rep. ox
Clip Ref. |
Frame
Active
Color By None
Blioo Glroo Blioo Mix.
Visual Symmetry
Show Original Instance
Type None
Surface
Shaded Shading Gouraud

Hidden Line

AQUEnEess Fill :
Opay 100 Pl TFino
Lighting Figure 3-8
Diff |19  Shin | ggo Hlnt [y g Feature Detail Editor General Attributes Area

Toggles-on/off whether Part is visible on a global basis (in the Graphics Window or in all
viewports). (Performs the same function as the Visibility Toggle in the Parts Mode Icon
Bar). Default is ON.

This small window allows you to control the visibility of the selected Part(s) on a per
Viewport basis. Each visible viewport is shown. A green outline around a Viewport
indicates that the selected Part(s) will be visible in this Viewport, while a red outline
indicates that the selected Part(s) will not be visible. Change the visibility (red to green,
green to red) by selecting a viewport with the mouse.

This button opens a pop-up menu button for the selection of the fast display representation
used to display a part on the client. This attribute helps the display of complex data sets.
The part’s fast display representation displays according to whether the Fast Display
Mode (located in the View Menu or on the desktop) is on or off and on the state of the
Static Fast Display button located under Edit > Preferences..., Performance. For instance,
when the Fast Display Mode is Off (default) the part displays according to its specified
Element Representation. When on, the parts are displayed by the fast display
representation. The fast display representation will only be used while performing
transformations, unless the Static Fast Display option has been selected. The part detail
representations are:

Box a bounding (Cartesian extent) box of all part elements (default).

off display according to specified Element Representation.

Points point cloud representation of the part (EnSight gold only).

Sparse Model  display a percentage of the model in each display box (EnSight Gold

and not running with display lists only). You control this percentage in
the performance preferences. Note, that it is useful for large models, but
should probably not be used for small models.

(see How To Set Global Viewing)

This section contains controls which allow you to produce either rotational or mirror
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3.3 Variable Creation (Calculator) Icon

visually symmetric images of parts. In general, symmetry enables you to reduce the size of
your analysis problem while still visualizing the “whole thing.” Symmetry affects only the
displayed image, not the data, so you cannot query the image or use the image as a parent
Part. However, you can create the same effect by creating dependent Parts with the same
symmetry attributes as the parent Part.

Visual Symmetry
Show Original Instance

Type Mirror
Symmetry

Mirror X
Mirror ¥
Mirror Z
Mirror XY
Mirror XZ
Mirror YZ
Mirrer XYZ

Figure 3-9
Mirror Visual Symmetry

Mirror visual symmetry includes the ability to toggle-on/off the display of a mirror image
of Parts (which are selected in the Feature Detail Editor’s Parts List) in each of the seven
other quadrants of the Part’s local frame. It also allows you to turn on or off the original
(non-symmetric) part representation. It performs the same function as the Visual
Symmetry Pull-down Icon in the Part Mode Icon Bar. You can mirror the Part to more
than one quadrant. If the Part occupies more than one quadrant, each portion of the Part
mirrors independently. Symmetry works as if the local frame is Rectangular, even if it is
cylindrical or spherical. The images are displayed with the same attributes as the Part. For
each toggle, the Part is displayed as follows. The default for all toggle buttons is OFF,
except for the original representation - which is ON.

Mirror X quadrant on the other side of the YZ plane.
Mirror Y quadrant on the other side of the XZ plane.
Mirror Z quadrant on the other side of the XY plane.
Mirror XY diagonally opposite quadrant on the same side of the XY plane.
Mirror XZ diagonally opposite quadrant on the same side of the XZ plane.
Mirror YZ diagonally opposite quadrant on the same side of the YZ plane.
Mirror XYZ quadrant diagonally opposite through the origin.
Show Original Instance the original part location.

Visual Symmetry

Show Original Instance

Axis X i |Angle [ 40007 Instances [5 Rotational Visual Symmetry

Rotational visual symmetry allows for the display of a complete (or portion of a) “pie”
from one “slice” or instance. You control this option with:
Axis X  rotates about the X axis

Y  rotates about the Y axis

Z rotates about the Z axis

Angle specifies the angle (in degrees) to rotate each instance from the previous
Instances  specifies the number of rotational instances.
Show Original Instance show the original instance or not

(see How To Set Symmetry)

Toggles-on/off whether Part(s) selected in the Part List of the Feature Detail Editor will be
affected by the Auxiliary Clipping Plane feature, which enables you to make invisible
that portion of each Part on the negative side of the current position of the Plane
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Active Toggle

Ref. Frame

Color By

RGB

Mix...

Surface

Shaded Surface
Toggle

Hidden Line
Toggle

Shading

Tool. Performs the same function as the Part Mode: Auxiliary Clipping Toggle
Icon. A Part with its Aux Clip attribute toggled-off will not be cut away. Default is
ON. (see Auxiliary Clipping in Section 6.4, View Menu Functions).

Toggles-on/off whether or not display of the Part automatically updates as the solution
time changes. When visualizing transient data, you may wish to “freeze” a Part in time
while other Parts continue to update. For example, you can create two identical vector-
arrow Parts, toggle-off Active for one of them, change the time step of the display, and see
how the vector arrows change from one time step to the other. Only the EnSight client Part
is frozen, the EnSight server Part is kept current. Default is ON.

This field specifies which frame the Part is assigned to. Default is the frame of the Part’s
parent Part (Frame O for original model Parts). Enter a different frame number in the field
to change the assignment. Changing a Part’s frame causes the Part to be drawn in the new
coordinate frame. Once assigned to a different frame, the Part will transform with that
frame. The choice of frame does not affect variable values. The interpolated value of a
variable at point 0,0,0 in Frame 0 is the same as at point 0,0,0 in Frame 1, even though the
points may appear at different locations in the Main View Window.

(see Section 8.5, Frame Mode)

This button opens a pop-up menu for the selection of the variable color palette by which
you wish to color the selected Part(s). Coloring a Part with a palette does not normally
affect graphics performance while in line drawing mode, but Shaded Surface mode
performance can become considerably slower. If you do not color by a palette (Color By >
None), the Part will be displayed according to the color specified in the R, G, B fields. If
you want to color Parts by palettes and want Shaded Surface mode, consider using the
Static Lighting option (see Static Lighting in Section 6.4, View Menu Functions).

These fields allow you to specify a solid color for the selected Part(s) (applicable only if
Color By is None). Enter a numerical value from 0 to 1 for each component color (Red,
Green, and Blue).

Opens the Color Selector dialog for the selection of a solid color for the selected Part(s)
(applicable only if Color By is None). (see Section 7.1, Color)

Toggles on/off surface shading for individual Parts. When global Shaded

Surface has been toggled on for the Graphics Window display (from Main Menu > View >
Shaded Surface or via the Global Shaded Surface Toggle in the View Mode Icon Bar),
individual Parts can be forced to stay in line drawing mode using this toggle. Default is
ON. (see Section 6.4, View Menu Functions)

Toggles on/off hidden line representation for individual Parts. When global

Hidden Line has been toggled on for the Graphics Window display (from Main Menu >
View > Hidden Line or via the Global Hidden Line Toggle in the View Mode Icon
Bar), individual Parts can be forced not to appear as Hidden Line representation using this
toggle. (To have lines hidden behind surfaces, Parts must have surfaces, i.e. 2D elements)
Default is ON. (see Section 6.4, View Menu Functions)

Opens a pop-up menu for selection of appearance of Part surface when Shaded Surface is
on. Normally the mode is set to Gouraud, meaning that the color and shading will

interpolate across the polygon in a linear scheme. You can also set the shading type to Flat,
meaning that each polygon will get one color and shade, or Smooth which means that the
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surface normals will be averaged to the neighboring elements producing a “smooth”
surface appearance.Not valid for all Part types. Options are:

Flat Color and shading same for entire element

Gouraud  Color and shading varies linearly across element

Smooth Normals averaged with neighboring elements to simulate smooth surfaces

Opaqueness This field specifies the opaqueness of the selected Part(s). A value of 1.0 indicates that the
Part is fully opaque, while a value of 0.0 indicates that it is fully transparent. Setting this
attribute to a value other than 1.0 can seriously affect the graphics performance.

Fill Pattern Opens a pop-up menu for selection of a fill pattern which can provide pseudo-
transparency for shaded surfaces. Default is Fill 0 which uses no pattern (produces a
solid surface), while Fill patterns 1 through 3 produce a EnSight defined fill pattern.

Lighting

Diff This field specifies diffusion (minimum brightness or amount of light that a Part reflects).
(Some applications refer to this as ambient light.) The Part will reflect no light if value is
0.0. If value is 1.0, no lighting effects will be imposed and the Part will reflect all light and
be shown at full color intensity at every point. To change, enter a value from 0 to 1.

Shin This field specifies shininess.You can think of the shininess factor in terms of how smooth
the surface is. The larger the shininess factor, the smoother the object. A value of 0
corresponds to a dull finish and a value of 100 corresponds to a highly shiny finish. To
change, enter a value from 0 to 100.

H Int This field specifies highlight intensity (the amount of white light contained in the color of
the Part which is reflected back to the observer). Highlighting gives the Part a more
realistic appearance and reveals the shine of the surface. To change, enter a value from 0 to
1 with larger values representing more white light. Will have no effect if Shin parameter is
ZETo0.

(see How To Set Attributes)

Troubleshooting Surface Attributes and Lighting

Problem Probable Causes Solutions

Part not in Shaded Surface mode Global Toggle not on, or if on, Turn on Shaded Surface toggle
Shaded Surface is turned off for  from View menu of Main Menu
the Part in the Feature Detail or turn and make sure Shaded
Editor Surface is turned on for the Part

in the Feature Detail Editor.

Part contains only 1D elements ~ No Solution

Part appears not to have any Diffuse light intensity too high Lower the Diff value.
lighting.
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Node, Element, and Line Attributes

General Visibility

Node Toggle
Line Toggle

Element Toggle

Label Visibility

Node Toggle

Element Toggle

Node Representation

Type

Scale

3-16

Each Part’s Node, Element, and Line attributes control the representation of the

Part on the client, and how nodes, elements, and lines are displayed.
Access: Main Menu > Edit > Part Feature Detail Editors > Node, Element, and Line Attributes

Node, Element, and Line Attributes

General Visibility

Node Line Element
Lakel Visibility
Nuode Element

Node Representation

Type Dot Soate | g 1evie02
Detall |4 Shae By Ciomebant
Yariaide whneiie

Line Representation

Width | § Style Saolid

Element Representation
Visual Rep. 3D border, 2D full

Shrink Factar [ g Angly | yapn

Reduce Polygons 2

less more
polygons polygons
Figure 3-11

Feature Detail Editor Node, Element, and Line Attributes Area

Toggles-on/off display of Part’s nodes whenever the Part is visible. Default is OFF.

Toggles-on/off display of line (1D) elements in the client-representation whenever the Part
is visible. Default is ON.

Toggles-on/off display of 2D elements in the client-representation whenever the Part is
visible. Note that 3D elements are always represented as 2D elements on the client.
Default is ON.

Toggles-on/off display of Part’s node labels (if they exist) whenever the Part is visible.
Only model Parts may have node labels. Default is OFF.

Toggles-on/off display of Part’s element labels (if they exist) whenever the Part is
displayed in Full visual representation. Only model Parts may have element labels, and.
Default is OFF.

Opens a pop-up menu for the selection of symbol to use when displaying the Part’s nodes.
Default is Dot. Options are:

Dot to display nodes as one-pixel dots.

Cross to display nodes as three-dimensional crosses whose size you specify.

Sphere to display the nodes as spheres whose size and detail you specify.

This field is used to specify scaling factor for size of node symbol. Values between 0 and 1
reduce the size, factors greater than one enlarge the size. Not applicable when node-
symbol Type is Dot. Default is 1.0.
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This field is used to specify how round to draw the spheres when the node-symbol type is
Sphere. Ranges from 2 to 10, with 10 being the most detailed (e.g., roundest spheres).
Higher values take longer to draw, slowing performance. Default is 2.

Opens a pop-up menu for the selection of variable-type to use to size each node-symbol.
For options other than Constant, the node-symbol size will vary depending on the value of
the selected variable at the node. Not applicable when node-symbol Type is Dot. Default is
Constant. Options are:

Constant sizes node using the Scale factor value.

Scalar sizes node using a scalar variable.

Vector Mag sizes node using magnitude of a vector variable.

Vector X-Comp sizes node using magnitude of X-component of a vector variable.

Vector Y-Comp sizes node using magnitude of Y-component of a vector variable.

Vector Z-Comp sizes node using magnitude of Z-component of a vector variable.

Selection of variable to use to size the nodes. Activated variables of the appropriate Size
By type are listed. Not applicable when node-symbol Type is Dot or Size By is Constant.

Specification of width (in pixels) of line elements and edges of 2D elements whenever
they are visible. Range is from 1 to 20. Default is 1. Line widths other than 1 are not
available on all hardware. This performs the same function as the Part Line Width
Pulldown Icon in Part Mode.

Selection of style of line when lines are visible. Default is Solid. Options are:
Solid

Dotted

Dot-Dash

Element Representation

Visual Rep.

Shrink Factor

EnSight 7 User Manual

Selection of representation of Part’s elements on the client. Saves memory and time to
download.
3D border, 2D full represents the Part’s 3D elements in Border representation, the
Part’s 1 and 2D elements in Full representation. The result is the outside
surfaces of the Part are displayed along with all bar elements.
Border represents the Part’s 3D elements with 2D elements corresponding to
unshared element faces, the Part’s 2D elements with 1D elements
corresponding to the unshared edges, and the Part’s 1D elements as 1D
elements. The result is the outside faces and edges of the Part’s elements.
Feature Angle first runs the 3D border, 2D full representation to get a list of 1 and
2D elements. The 1D elements and all non-shared 2D edges will be shown,
but only the shared edges above the Angle value will be shown. The result
consists of 1D elements visualizing the sharp edges of the Part.
Bounding Box represents all Part elements as a bounding box surrounding the Cartesian
extent of the elements of the Part.
Full represents all faces of the Part’s 3D elements, and all the 1 and 2D elements.
Non Visual means the Part exists on the server, but is not loaded on the client. Not
Loaded Parts may be used as parent Parts, but do not exist on the client.
Specification of scaling factor by which to shrink every element toward its centroid. Enter
the fraction to shrink by in range from 0 to 1. Default is 0.0 for no shrinkage.
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Angle Specification of lower limit for not displaying shared edges in Feature Angle
Representation. Value is in degrees.

Reduce Polygons Lower the polygon density used to represent the part. Useful for very large models. Toggle
on, then type in a value to reduce by, or slide the slider.

(see How To Set Attributes and How To Display Labels)

Troubleshooting Node, Element and Line Afttributes

Problem Probable Causes Solutions

After changing to Feature Angle Angle value is to large Set Angle to smaller value.
representation, the Part is not

shown.

Displacement Attributes
Displacement Attributes specify how to displace the Part nodes based on a vector
variable. Each node of the Part is displaced by a distance and direction
corresponding to the value of a vector variable at the node. The new coordinate is
equal to the old coordinate plus the vector times the specified Factor, or:

Chew = Corig + Factor * Vector,

where C,.,, is the new coordinate location, C,, is the coordinate location as
defined in the data files, Factor is a scale factor, and Vector is the displacement
vector.

You can greatly exaggerate the displacement vector by specifying a large Factor
value. Though you can use any vector variable for displacements, it certainly
makes the most sense to use a variable calculated for this purpose. Note that the
variable value represents the displacement from the original location, not the
coordinates of the new location.

Access: Main Menu > Edit > Part Feature Detail Editors > Displacement Attributes

Displacement Attributes

Displace By wvelocity MEE
Factor | 1.0000e-+00

Figure 3-12
Feature Detail Editor Displacement Attributes Area

Displace by Opens a pop-up menu for selection of vector variable to use for displacement (or None for
no displacement). Variable must be a vector and be activated.

Factor This field is used to specify a scale factor for the displacement vector. New coordinates are
calculated as: Cy¢,, = Copjg + Factor*Vector, where C,,, is the new coordinate location,
Corig 18 the original coordinate location as defined in the data file, Factor is a scale factor,
and Vector is the displacement vector. Note that a value of 1.0 will give you “true”
displacements.
(see How To Display Displacements)
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Troubleshooting Displacement Aftributes

Problem

Probable Causes Solutions

Displacement not visible Displace By attribute set to None Set the Displace By attribute

Create

Update Parent

Apply Changes

for Part that is not displacing.

Factor value too small. Specify a larger Factor.

Clicking this button creates a new Part using attributes currently selected/specified in the
Feature Detail Editor. This performs the same function as the Create button in the Quick
Interaction Area Editor for each type of created Part. Clicking Create updates the Graphics
Window and adds the new Part to the Main Parts List and to the Parts List in the Feature
Detail Editor for this type of Part. Not applicable for model Parts or discrete Particles.

(see Introduction to Part Creation)

Clicking this button assigns the Part which is currently selected in the Main Parts List as
the new parent Part of the created Part(s) which is(are) currently selected in the Feature
Detail Editor’s Parts List.

Clicking this button applies all changes that have been made within the Feature Detail
Editor all at once if Immediate Modification has been toggled off above in the Feature
Detail Editor’s Edit pull-down menu. If Creation attributes have been changed, the Part
will be regenerated.

IJK Axis Display Attributes

IJK Axis Visible

Scale

All Model and clip parts will have these attributes shown, but they only apply to
to those model and clip parts which are structured.

Access: Main Menu > Edit > Part Feature Detail Editors > [JK Axis Display
Attributes

IJK Axis Display Attributes

IJK Axis Visible Scale 1.9989-+00

Figure 3-13
Feature Detail Editor IJK Axis Display Attributes Area

Toggle on to display an 1JK axis triad for the part. IJK axis triad only visible when part is
visible.

The scale factor for the IJK Axis triad.
(see How To Set Attributes)

Troubleshooting IJK Axis Display Attributes

Problem

Probable Causes Solutions

IJK Axis not visible

EnSight 7 User Manual

IJK Axis Display toggle noton  Toggle it on.
for part of interest.

Scale value too small. Specify a larger scale.
Part is not a structured part. No LJK axis possible for this part.
Part is not visible Toggle on part visibility

3-19



3.4 Part Operations

3.4 Part Operations

This section will describe the Part operations accessible through “Edit > Part” in
the Main Menu and “Edit” in the Feature Detail Editor Menu. These include
Select All, Select, Delete, Assign to Single or Multiple Viewports, Group,
Ungroup, Copy, Cut, Extract, and Merge.

1Sight =| Feature Detail Editor (Model)
Edit | Query View Tools Case Help | File Edit | View
___________________ ol e | —— | — — Select All
Part L [ g——
= Select All = C
Part Feature Detail Editors > gojoci L D cd
-l Delete
Flipbook Animation Editor... Delete... —
. . . = ‘e Group...
Keyfr A tion Editar... Zroup
Seyirame Aunimation LA Assign to Single New Viewport g
Solution Time Editor... Assign to Multiple New Viewports Ungroup
=81, ultiple New Viewpo : ips 4
Transformation Editor... " Immediate Modification
Variables Editor... Group...
Ungroup
Preferences...
e T Copy
_IShaded _[Hidden Line Extract
Figure 3-14
Part Operation Selection Menus
Select All Choosing this from the Main Menu > Edit >Part pull-down, selects all Parts in the Main

Parts List. Choosing this from the Edit pull-down in the Feature Detail Editor Menu
selects all Parts in the Feature Detail Editor Parts List.
Access: Main Menu > Edit > Part > Select All

Feature Detail Editor Menu > Edit > Select All

(see How to Select Parts)

Select ... Choosing this from the Main Menu > Edit >Part pull-down, opens the Select Part(s) By
Keyword dialog.

Find What: ! fluid*

| Match Whole Word Only _| Add To Current Selection

| LI Match Case Select Next Match |
[ Use Regular Expression Select All Matches E

¥ — Match Any # of CH ﬁ
.~ Match Any 1 Char | ,

F——71 =

Closeg Help...E

Figure 3-15
Select Part(s) By Keyword dialog

Find What This field is used to specify the keyword or regular expression to compare (match) against
Part names.

Match Whole Word  When on, the entire Part name must match the keyword or regular expression.
Only Toggle When off, a Part name will be selected if only a substring of the Part name matches.

Match Case Toggle When on, the comparison is case sensitive. When off, case is ignored.
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When on, special characters in the keyword will be used to define a regular expression.
When off, any special characters will be treated as a regular character during comparison.

Contains a list of special characters available to create a regular expression. Selecting an
item from the list will insert the special character into the “Find What” text field at the
cursor location.
* Match any number of characters in the part name
Match any one character in the part name
~ Match part names that do not match the specified search criteria.
| Separates multiple search keywords or regular expressions. (extra spaces are not
allowed around “|””)

Examples: Find What: abc*xyz Match Whole Word Only: On
Select any Part who's name starts with “abc” and ends with “xyz”

Find What:  tomljerry Match Whole Word Only: OFF
Select all Part s who's names contain the string “tom” and/or the
string “jerry”

When on, any matching Part names will be added to the list of Part names currently
selected. When off, only the matching Part names will be selected.

Selects the next Part name which matches the keyword or regular expression.
Selects all Part names which match the keyword or regular expression.

If chosen from the Main Menu > Edit > Part pull-down, deletes all selected Parts in the
Main Parts List after you have confirmed in a pop-up dialog that you wish to do so. If
chosen from the Edit pull-down in the Feature Detail Editor Menu, deletes all selected
Parts in the Feature Detail Editor Parts List after you have confirmed in a pop-up dialog
that you wish to do so. If model Parts are deleted, they are no longer available for the
current session. Parts dependent upon selected Parts will also be deleted or modified
Access: Main Menu > Edit > Part > Delete...

Feature Detail Editor Menu > Edit > Delete...

(see How to Delete a Part)

Creates a new viewport and assigns all of the selected parts to the new viewport. The new
viewport will be 2D if all of the selected parts are 2D and lie on the same plane.

Creates a new viewport for each of the selected parts. Each new viewport will show one
part only. If the part is 2D, the viewport will be 2D. Further, if the part assigned to the new
viewport is a XYZ or IJK clip or an isosurface, annotation will be created in the lower left
corner of the viewport indicating the value of the clip or iso.

The group operation is used to collect any number of parts into a set which can be
modified and utilized as one entity. The operation is non-destructive and reversible, and is
used solely as a convenience to the user in order to organize a large number of parts.

Any attribute modification to a grouped part affects each of the parts in the group.

Similarly, if a grouped part is used as a parent part, each part in the group is used as a
parent in the creation process.
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Copy

relationships

When group is selected, the dialog shown in the figure below will appear. A part name
must be input in order to complete the grouping operation.

Group Name?

I fluid parts

OkayI Cancel I

Figure 3-16
Group Parts Dialog

Only parts of the same type and case can be grouped together. Further, groups can not
contain other part groups.

(see How To Group Parts)

If chosen from the Main Menu > Edit > Part pull-down, makes a copy of selected Part(s)
in the Main Parts List. If chosen from the Edit pull-down in the Feature Detail Editor
Menu, makes a copy of selected Part(s) in the Feature Detail Editor Parts List.

The Copy operation creates a dependent copy of another (original) Part. The Copy is
created on the Client and its existence is not known to the EnSight Server process. A Copy
shares geometric data and variable data with the original Part. (This type of Part is
sometimes called a “shallow copy”.)

Original Clip Part - colored by temperature ~ Copy of Clip Part, assigned to new Frame,
translated to right, and colored by velocity
at the same time step

Figure 3-17
Part Copy Example

The relationship between a Model Part and a Copy made from a Model Part will be one of
original and copy. That is, the Model Part will not be a Parent to the Copy as it is to a
Created Part such as a clip.

The relationship between a Created Part and a copy made from it will also be one of
original and copy since the Copy will initially regard as its Parent the same Part that the
original Created Part regards as its Parent. The Parent of individual Created Parts can of
course be reassigned (using the Update Parent button at the bottom of the Feature Detail
Editor) but the Parent of a Created Part Copy can Not be reassigned.

A copy can be used as a Parent Part for Parts created since the create operation will
operate on the original Part.
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The initial attributes assigned to a Copy are the same as those of the original Part at the
time of copying. All attributes for the Copy except Element Representation (3D border,
2D full, border, Feature Angle, etc.) can be changed. The Element Representation of a
Copy cannot be changed independently; a change in Element Representation of the
original changes the copy as well.

The description of the new Copy will be the same as the original Part with the suffix “-
COPY” added (of course, you can change this description in the Desc field in the Feature
Detail Editor).

You can make multiple copies from a Model or Created Part, but you can Not make copies
of copies.

A new frame is automatically created for each newly created Copy and the Copy is
assigned to the new frame so that it can easily be moved with a local transformation. The
location of the original Part and the Copy will initially coincide as well. Like all Parts,
Copies of Parts can be reassigned to different frames in the General Attributes Section of
the Feature Detail Editor (for that type of Part).

One of the most useful purposes for copies is a separation allowing for the side-by-side
display of different attributes (shown in Figure 3-11). Since all attributes except Element
Representation can be different, the original and the copy can be displaying different
variables, different displacements, etc.

(see How To Copy a Part)

Extracts selected Part(s) into a new, true Part, using the Part representation in effect at the
time (full, border, or feature). If more than one Part is selected, then they are joined into a
single Part. If more than one Part is selected when extract is invoked, then all will have
their extracted geometry joined into a single new Part. The new Part is assigned to Frame
0.

The Extract option is closely tied to Element Representation. It creates a new Part using
the geometry of the current representation (what you see is what you get). Extracted Parts
which are in Full Representation are actual copies of the original, but extracted Parts
which are in Border Representation are only the shell or boundary of the original. Extract
is often used with the Save Geometric Entities feature to save extracted Parts (and not the
originals) into a smaller set of data. It is also used to create hollow Parts from solid Parts to
be able to look inside a solid Part after cutting it open with the Cut feature.

(see How To Extract Part Representations)

If more than one Part is selected, the Merge operation creates a new model Part on the
Server host that is a combination of all selected. If only one Part is selected when Merge is
invoked, then a new Part is created on the Server host that is identical but fully
independent from the original Part (Note that this type of “copy” does not have the
restriction on Element Representation that Part Copy does, - all Attributes can be
reassigned - but it requires considerably more memory because it does not share the
geometry with the original but now has its own copy of the geometry). The merge
operation creates a new Part. The new Part is assigned the default Display Attributes and
is also assigned to Frame 0.

(see How To Merge Parts)
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Color Palettes
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Included in this chapter:

General Description

Section 4.1, Variable Selection and Activation
Section 4.2, Variable Summary & Palette

Section 4.3, Variable Creation

Variables are numerical values provided by your analysis software or created
within EnSight. Variables can be dependent on server part-geometry (for example,
the area of a part), and a part’s geometry can be dependent on its parent part’s
variable values (for example, an isosurface).

There are four types of variables: tensor, vector, scalar, and constant. Scalars and
vectors can be real or complex. Symmetric tensors are defined by six values,
while asymmetric tensors are defined by nine values. Vectors, such as
displacement and velocity, have three values (the components of the vector) if
real, or six values if complex. Scalars, such as temperature or pressure, have a
single value if real, or two values if complex. Constants have a single value for
the model, such as analysis time or volume. All four types can change over time
for transient models.

Before using a variable, it must be loaded by EnSight, a process called activation.
EnSight normally activates variables as they are needed. Section 4.1 describes
how to select, activate, and deactivate variables to make efficient use of your
system memory.

(see Section 4.1, Variable Selection and Activation)

In addition to using the variables given by your analysis software, EnSight can
create additional variables based on any existing variables and geometric
properties of server parts. EnSight provides approximately 100 functions to make
this process simpler.(see Section 4.3, Variable Creation)

Very often you will wish to color a part according to the values of a variable.
EnSight associates colors to values using a color palette. You have control over
the number of value-levels of the palette and the type of scale, as well as control
over colors and method of color gradation. You also use function palettes to
specify a set of levels for a variable, such as when creating contours.

(see Section 4.2, Variable Summary & Palette)

You can make numerical queries about variables and geometric characteristics of
Server-based parts. These queries can be at points, nodes, elements, parts, along
lines, and along 1D parts. If you have transient data, you can query at one time
step or over a range of time steps, looking at actual variable values or a Fast
Fourier Transform (FFT) of the values. (see Section 6.3, Query Menu Functions)

Once you have queried a variable, you can plot the result.
(see Section 8.3, Plot Mode)
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User Defined
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Variables can come from more than one case. If more than one case has a
variable with the same name, this will be treated as one variable. If a variable is
applicable to one case but not another, it will not be applied to the non-applicable
case(s).

When variables are activated or created, all parts except Particle Trace parts are
updated to reflect the new variable state. Particle Trace parts will always show
variables which are activated after the part’s creation as zero values.

The input to all of the predefined functions includes some type of server based
parts. Please be aware that parts which reside only on the client (contours,
particle traces, profiles, vector arrows, and tensor glyphs) will not be used.

Variables can be defined at the vertices, at the element centers, or undefined.

Users can write external variable calculator functions called User Defined Math
Functions (UDMF) that can be dynamically loaded by EnSight. These functions
appear in EnSight’s calculator in the general function list and can be used just as
any other calculator function to derive new variables.

Several examples of UDMFs can be found in the directory $CEI_HOME/ensight76/
src/math_functions/. Please see these examples if you wish to create your own
UDMFs.

When the EnSight server starts it will look in the following subdirectories for
UDMF dynamic shared libraries:

./libudmf-devel.so (.sl) (.dll)

$ENSIGHT7_UDMF/libudmf—*.SO (.s1) (.d11)
$CEI_HOME/ensight76/machines/$SENSIGHT7 ARCH/lib udmf/libudmf-*.so (.sl)
(.d11)

Depending on the server platform, the dynamic shared library must have the
correct suffix for that platform (e.g. .so, .sl, .d1l).

Currently, when a UDMEF is used in the EnSight calculator, it in invoked for each
node in the specified part(s) if all the variables operated on for the specified
part(s) are node centered. If all of the variables are element centered, then the
UDMF is invoked for each element in the part(s). If the variables are a mix of
node and element centered values, then the node centered values are automatically
converted to element centered values and then the UDMF is invoked for each
element using element centered variables.

Arguments and the return type for the UDMF can be either scalar or vector
EnSight variables or constants. At this time, only variable quantities and constants
can be passed into UDMFs. There is no mechanism for passing in either part
geometry, neighboring variables, or other information.
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4.1 Variable Selection and Activation

All available variables, both those read in and those created within EnSight, are
shown in the Feature Detail Editor (Variables), whether they have been activated
ornot. In addition, a variable list is included in each function requiring a variable.
In this case, only the appropriate variable types are shown.

Feature Detail Editor
(Variables)

Double clicking on the Color Icon in the Feature Icon Bar opens the Feature
Detail Editor (Variables).

Featirre Detail Editor (Variables)

Available Variahle Result

Type
) Gen
) Gen
(%) Cmp
=) Gwn
(=) Gun

Feature Detail Editor
Variables List

Scalar
Vector

4, 9000 +01
Yector
Scalar

E Lemperature
{|velocity
4|vol

E Coordinates
E Time

=

Activate| Activate All| Deactivate| Extended CFD |||
Variahbles... | [

Sppdy Thanges

Figure 4-1
Feature Detail Editor (Variables)

Feature Detail Editor
Variables List

This list shows all variables currently available, both those read from data and those you
have created within EnSight. Each row provides information about a variable.

Available Variable The description or name of the variable.

()or (¥ Activation status. An asterisk indicates that the variable has been activated.
Type Type of the variable:

Gvn Scalar: real scalars read from the dataset (Given).

Cmp Scalar: real scalars created within EnSight (Computed).

EnSight 7 User Manual

Gvn Complex Scalar:

Cmp Complex Scalar:

Gvn Vector:
Cmp Vector:
Gvn Complex Vector:

Cmp Complex Vector:

Gvn Tensor:
Cmp Tensor:
Gvn #:
Cmp #:

complex scalars read from the dataset (Given).
complex scalars created within EnSight (Computed).
real vectors read from the dataset (Given).

complex vectors created within EnSight (Computed).
complex vectors read from the dataset (Given).
complex vectors created within EnSight (Computed).
real tensors read from the dataset (Given).

real tensors created within EnSight (Computed).
constants read from the dataset (Given).

constants created within EnSight (Computed).
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Result

Activate

Activate All

Deactivate

Extended CFD
Variables...

Current value of a constant variable (is blank for other types of variables). Changing the
current solution time will update the value in this column to the value for the new time.

Clicking this button activates the variable(s) selected in the Feature Detail Editor
Variables List. Activation of a variable loads its values into the memory of the EnSight
Server host system. The EnSight Server then passes the necessary data to the Client. One
way you can control EnSight’s memory usage is to only activate the variables you want to
use. Once activated, a variable becomes available in the Main Variables List and, as is
described in Section 4.2, EnSight creates a default color palette for the variable.

Clicking this button activates all variables listed in the Feature Detail Editor Variables
List, regardless of which are selected.

Clicking this button deactivates the variable(s) selected in the Feature Detail Editor
Variables List. Deactivating a variable frees up some memory on both the Client and the
Server. You can activate and deactivate variables as often as you like. For example, you
could activate one variable to color a part, deactivate that variable, then activate a different
variable to re-color the part. Of course, if you have enough memory and a small enough
model, you can simply activate all the variables and leave them activated.

Opens the Extended CFD Variable Settings dialog. If your data defines variables or
constants for density, Total Energy per unit volume, and momentum (or velocity), it is
possible to show new variables defined by these basic variables in the Main Variables List
of the GUI by utilizing the capabilities of this dialog. (See Preferences... in Section 6.2,
Edit Menu Functions).

Select a variable and then select
the appropriate SET button below.

Qa1
Q5
momertun
Coordinates
Time

]

Density 1.0000e-+00 SET
{Can be a constant) ; . ot

| —

Tatal Energy Per SET
Unit Volume i E
Ratio of Specific Heats | § j000e+00 SET
{Can be a constant) z . had ik E
Momentum
—_OR — E SETE

Velocity i

SET

Freestream Mach #
Gas Constant
Freestream Density

Freestream Speed
of Sound

I 1.0000e+00
I 1.0000e+00

1.0000e+00

z 1.0000e+00

| Show Extended CFD Variables

OkayE Cancel E

H

Help

Figure 4-2
Extended CFD Variable Settings Dialog

WARNING If you deactivate a created variable or any of the variables used to define it, both the

values and the definition of the created variable are deleted. If you deactivate a variable
used to create a part’s geometry, the part will be deleted. If you deactivate a variable
who’s color palette has been used to color a part, the part’s appearance will change.

(see How To Activate Variables)
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4.2 Variable Summary & Palette

You can visualize information about a model by representing variable values with
colors, often called fringes. Fringes are an extremely effective way to visualize
variable variations and levels. A variable color palette associates (or maps)
variable values to colors. Palettes are also used in the creation of contours. The
number of contour levels is based on the number of palette color levels, and the
contour values are based on the palette level values.

EnSight uses a variable’s color palette to convert numbers to colors, while you,
the viewer, use them in the opposite manner—to associate a visible color with a
number. If you wish, EnSight can display a color-value legend in the Main View
window.

Default Palettes At least one color palette—the Coordinate color palette—always exists, even if
your model has no variables. In addition, EnSight creates a color palette for each
real scalar and vector variable that you activate, giving the color palette the same
name as the variable. If the variable is a vector variable, the default color palette
uses the vector’s magnitude. Tensor variables have no palette.

Default color palettes have five color levels. Ranging from low to high, the colors
are blue, cyan, green, yellow, and red (the spectral order). The numerical values
mapped to these five levels are determined by first finding the value-range for the
variable at the current time step when the variable is activated. The value for the
lowest level is set to the minimum value. The value for the highest level is set to
the maximum value. The three middle levels are spaced evenly between the
lowest and highest values. For datasets with only one time step, the scheme just
described works well because the variable’s value range is not changing over
time. However, if you have transient data, the range could vary widely at
different times and since the default was based on one time step, it may not be
appropriate for other time steps. EnSight can show you a histogram of the variable
values over time to assist you in setting a palette for transient cases.

Value Levels A color palette can have up to 21 levels at which the variable value is specified.
Each color palette level’s value must be between the value at the adjoining levels,
with higher levels having higher variable-values. Between levels, you select
whether the scale is linear (the default), quadratic (2*), or logarithmic (log;).
Also, you can have EnSight use one of these scales to automatically assign values
to a range of levels.

Sometimes you may wish to only visualize areas whose palette-variable values are
in a limited range. You can choose to visualize other areas with a different,
uniform color, or to make those areas invisible.

Management The Feature Detail Editor (Variables) enables you to manage your color palettes.
You can copy, save to a file, and restore from a file existing palettes
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4-6

Simple/Advanced
Interface Buttons =

Histogram Scale

| File Edit View

Clicking the Variable Summary and Palette turndown button opens that dialog
within the Feature Detail Editor (Variables) dialog.

Available Variable Type Result

temperature { ¥ Guni{H} Scalar

|5

Activate| | Activate All| Deactivate| Extendﬁ CFD|
Varjdbles...

Z

—_—
Simple Interface I Advanced Inte]éce I
4 Magnitude X oY U Z

Adjustment

Minimum Palette
Value Slider

Maximum Palette
Value ——

Variable Color
Legend

Minimum Palette
Value —

1
Min=0.0000e+00 Max=1.003de+

[ W e

1 KRR i) # of Levels |5—
Min |0.0000e+00

| File

Variable Palette Histogram

Maximum Palette Value Slider

Advanced Interface Mode

Edit

View

Available Variable Type Result
temperature o ) GuniM} Scalar A
velocity s
Coordinates

Vectur

Time Scalar
M T
Activate| Activate All| Deastivate| Extended CFD
Variables...

lava_waves
saturn_pastelyellow_to_purple
grayscale banded

2. 5085@_01 carnation_red white
grayscale

hot_metal

reverse_rainbow

7.52566-01 Max | 1.0034e+00
Predefined Palettes
5 017%_01 EnSightDefaultPalette

Restore I Save... I

Undo Restore I
Legend Display Ath'ibut\es...l

Fllp Colors

] e

Saphy Cliangars

File Menu

Save Selected
Palette(s)

Simple Interface Mode

Figure 4-3
Feature Detail Editor: Variables, both Simple and
Advanced Interface Mode

File | Edit View

Save Selected Palette(s) |
Save All Palettes

BRestore Palette(s)

Save Selected Constant(s)

Save All Constants

Ely

Simple Interface I Advanced Interface I
4 Magnitude X Y L Z
r r ] .
Min=0.0000e+00 Max=1.0034e+00

I Creew Thune Shepy E’;&;},I o Bk I &
1.0034e+00 ey Continuous .I|
Scale Linear b= | |

Limit
Fringes Ne -

Display I
Undefined By Part Calor i
# of Levels

5.017Ce-01 [5

Edit Level ll—

_| Interpolate Ta Level |

Value | 0.0000e+00

R|0.00 G|o.oo B| 1.00

0.0000e+00 Mix...

Flip Calors I

7.5256e-01

2.5085¢-01

Legend Display AH‘ributes...I

|5 =
Seady Chiamges

Clicking this button opens a pull-down menu with the following options:

Opens the file selection dialog for the specification of a filename in which to save the

selected color palette(s).
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Save All Palettes...

Restore Palette(s)

Save Selected
Constant(s)

Save All
Constant(s)

Edit Menu

Select All

Immediate

Modification Toggle

Simple/Advanced
Interface

Variable Palette
Histogram

Over Time Step
Toggle & Beg, End
Fields

Magnitude,
X,Y,Z, Toggles
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4.2 Variable Summary & Palette

Opens the file selection dialog for the specification of a filename in which to save all color
palette(s).

Opens the file selection dialog for the specification of a filename from which to restore
previously saved color palettes.

Opens the file selection dialog for the specification of a filename in which to save the
selected constant values.

Opens the file selection dialog for the specification of a filename in which to save all

constant values.
Edit | View
Select All

r Immediate Modification

Clicking this button opens a pulldown menu with the following choice:

Clicking this selects all variables in the Feature Detail Editor Available Variables List.

Default is On. While on, any modification made in the Editor is immediately implemented
by EnSight. For large problems, this may be impractical. In such instances, click this
toggle off, make all desired modifications, and then implement then all at once by clicking
the Apply Changes button at the bottom of the Editor dialog.

Buttons which allow the user to choose between a simple or advanced mode for this
dialog. The advanced interface is shown in the figure. The simple interface is a small
subset of the advanced.

This histogram shows the relative number of nodes at which the value of the selected
variable is within the range represented by a particular color band. The two vertical white
slider bars are used to interactively set the minimum and maximum variable values to be
used in the variable’s color palette and these will show up in the Legend both within the
turndown area and within the Graphics Window. The small horizontal white line on the
left hand side can be used to interactively adjust the vertical scale of the histogram.

Toggles on/off the automatic assignment of values to palette levels using the palette-
variable’s value range over multiple time steps which are specified in the Beg and End
fields to the right of the toggle. This function is only available when you are using
transient data. All other attributes of the color palette (including the number of levels,
colors, type, etc.) are not changed.

For vector variables, this controls which histogram and color palette will be displayed and

edited. By default, the vector magnitude is used, however, the X, Y, and Z components of
the vector are also available.
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4.2 Variable Summary & Palette

Type This button opens a pop-up menu for the selection of the desired type of color gradation.
Both the legend in the turn-down area and the legend in the Graphics Window (if visible)
are affected. Options are:

Continuous displays graduated color variation across or along each element interpolating the color
across each element based on the value of the variable at the nodes. If the variable tied to
the palette is defined at the element centers it will be averaged to the nodes for display.

Banded displays discrete color values for each value range, but interpolates the location demarcation
line within an element.

Constant displays each element with one color for the entire element rather than interpolating the

color across the element using values at the nodes. The color of the first node encountered
is used.

Scale This button opens a pop-up dialog for the selection of the desired type of scale for the
value-separation of levels and color gradation. The options are:

Linear scale divisions, where the value-separation of levels is uniform and values map linearly to the
colors.

Quadratic scale divisions, where the value-separations of levels are not equal, but instead are based
on the second order of the variable (value2). Level-values always increasing upwards. For
example, for five levels with a low-level value of 0 and a high-level value of 16, the linear
scale would be 0, 4, 8, 12, 16 while the quadratic scale would be 0, 1, 4, 9, 16.

Logarithmic scale divisions, where the value-separations of levels are not equal, but instead are
based on the base—10 logarithm of the variable value (log10). Level-values always
increasing upwards. For example, for five levels with a low-level value of 1 and a high-
level value of 10000, the linear scale would be 1, 2500, 5000, 7500, 10000 while the
logarithmic scale would be 1, 10, 100, 1000, 10000.

Limit Fringes This button allows you to select how you wish to display elements with node values above
and below the range of the palette scale values. This option only works for hidden surface
mode. Options are:

No limit on values. Values above and below are colored with color of the corresponding end of the
range (no interpolation).

By Model Color option colors values outside the function range with the current part- color (the
color of the part when its Color By Palette attribute is None).

By Invisible option does not display elements whose node values are all above or below the value-
range of the palette.

Display Undefined If the variable is not defined, the element cannot be colored according to the color palette.
In this case, the element will be colored by the Part Color, or the element will become
invisible.

# of Levels This field specifies the number of value-levels for the variable color palette, which are

shown beside the Legend color bar. The number of levels is independent of the Type and
Scale, and can range from 2 to 21 with the default being 5.

Min For the Simple Interface, this field is used to specify the variable value for the bottom
level.

Max For the Simple Interface, this field is used to specify the variable value for the top level.

Edit Level Selection of the level you wish to edit, selected with stepper buttons, by entering a value in

the field, or by clicking the mouse pointer on the desired level in the Variable Color
Legend area. Levels start at 1 and count up from lower end. You can change the variable-
value and color assigned to any level. Also, you can have EnSight interpolate value-levels
and colors over a range of levels.

Interpolate to Level If this option is toggled-on while you are specifying a value (or color), the value (or color)
Toggle and Field of EnSight adjusts the values (or colors) of intermediate levels between the current level
and the specified Interpolate To Level according the specified Scale type.

Value This field specifies the variable value for the current palette level.
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These fields are used to specify the color to use for the current palette level.

Clicking this button opens the Color Selector dialog which provides an alternative to the
RGB fields for the specification of the color to use for the current palette level.
(see Section 7.1, Color)

For the Simple Interface only, shows a list of all predefined color palettes.
For the Simple Interface only. Restores the palette selected in the Predefined Palettes list.

For the Simple Interface only. Will bring up a file dialog to allow saving of the currently
defined color palette.

For the Simple Interface only. Will set the color palette definition back to what existed
before the previous Restore.

Reverses colors in the palette.

Clicking this button opens a pop-up message which reminds you that additional options
for the modification of Legend display attributes may be found in the Annot Mode Icon
Bar.

(See How To Create Color Legends, How To Edit Color Palettes)
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4.3 Variable Creation

You can create additional variables based on existing data. Typical mathematical
operations, as well as many special built-in functions, enable you to produce
simple or complex equations for new variables. Some built-in functions enable
you to use values based on the geometric characteristics of server parts. In
general, created variables are available for any process, just like given variables.
If you have transient data, a time change will recompute the created variable
values.

Often an analysis program produces a set of basic results from which other results
can be derived. For example, if a computational fluid dynamics analysis gives you
density, momentum and total energy, you can derive pressure, velocity,
temperature, mach number, etc. EnSight provides many of these common
functions for you, or you can enter the equation(s) and build your own.

As another example, suppose you would like to normalize a given scalar or vector
variable according to its maximum value, or according to the value at a particular
node. Variable creation enables you to easily accomplish such a task. The more
familiar you become with this feature, the more uses you will discover.

EnSight allows variables to be defined at vertices (nodes) or element centers. If a
new variable is created from a combination of nodal and element based variables,
such a new variable will always be element based.
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Constants

Scalars

Vectors
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4.3 Variable Creation

The Feature Detail Editor (Variables) dialog Variable Creation turn-down section
provides function selection lists, calculator buttons, and feedback guidance to aid
you in building the working expression (or equation) for a new variable. You can
use three types of values in an expression: constants, scalars, and vectors.

A constant in a variable expression can be a... for example...

number
constant variable from the Active Variables list

scalar variable at a particular node/element
(component and node/element number in brackets)

vector variable component at a particular node

3.56
Analysis_Time

temperature[25]

velocity[Z][25]

/element (component and node/element number in brackets)

coordinate component at a particular node/element
(component and node/element number in brackets)

any of the previous three at a particular time step
(time step in braces right after the variable name)

(Note: This only works for model variables, not created ones)
Math function

General function that produces a constant

A scalar in a variable expression can be a...

Scalar variable from the Active Variables list
vector variable component (component in brackets)
coordinate component (component in brackets)

any of the previous three at a particular time step
(time step in braces right after the variable name)

(Note: This only works for model variables, not created ones)

General function that produces a scalar

A vector in a variable expression can be a...

vector variable from the Active Variables list
coordinate name from the Active Variables list

any of the previous two at a particular time step
(time step in braces right after the variable name)

(Note: This only works for model variables, not created ones)

General function that produces a vector

coordinate[ X][25]

temperature {15}[25]
velocity {15} [Z][25]
coordinate {15} [X][25]

COS(1.5708)
AREA (plist)

for example...

pressure
velocity[Z]
coordinate[Y]

pressure{29}
velocity {29} [Z]
coordinate{29}[Y]

Divergence(plist,velocity)

for example...

velocity
coordinate

velocity {9}
coordinate{9}

Vorticity(plist,velocity)



4.3 Variable Creation

Examples of Expressions and How To Build Them

The following are some example variable expressions, and how they can be built.
These examples assume Analysis Time, pressure, density, and velocity are all
given variables.

Expression Discussion and How To Build It

-13.5/3.5 A true constant since it does not change over time. To build it,
type on the keyboard or click on the Variable Creation dialog
calculator buttons -13.5/3.5

Analysis_Time/60.0 A simple example of modifying a given constant variable. If
Analysis_Time is in seconds, this expression would give you
the value in minutes. To build it, select Analysis_Time from
the Active variable list and then type or click /60 . 0.

velocity*density This expression is momentum, which is a vector. To build it,
select velocity from the Active Variables list, type or click *,
then select density from the Active Variable list.

SQRT(pressure[73] *  This says, take the pressure at node (or element if pressure is

2.5)+ velocity[X][73]  an element center based variable) number 73, multiply it by
2.5, take the square root of the product, and then add to that
the x-component of velocity at node (or element) number 73.
To build it, select SORT from the Math function list, select
pressure from the Active Variables list, type [731+*2.5) +,

select velocity from the Active Variable list, then type
[X][73]

pressure{19} This is a scalar, the value of pressure at time step 19. It does
not change with time. To build it, select pressure from the

Active Variables list, then type {19}. (Note: variable must be a
model variable, not a computed variable)

MAX(plist,pressure) MAX is one of the built-in General functions. This expression
calculates the maximum pressure value for all the nodes of
the selected parts. To build it, type or click (, select MAX from
the General function list and follow the interactive
instructions that appear in the Feedback area of this dialog (in
this case, to select the parts, click Okay, and select pressure
from the Active Variable list).

(pressure This scalar is essentially the normalized pressure, squared. To

/pressure_max)"2 build it, first build the preceding MAX(plist,pressure)
expression and name it “pressure_max”. Then to build this
expression, select pressure from the Active Variables list,
type or click /, select pressure_max from the Active
Variables list, then type or click )*2.

Notice in the last example how a complex equation can be broken down into
several smaller expressions. This is necessary as EnSight can compute only one
variable at a time. Calculator limitations include the following:

1. The variable name cannot be used in the expression.
The following is invalid:
temperature = temperature + 100

Instead use new variable:
temperature2 = temperature + 100

4-12 EnSight 7 User Manual



4.3 Variable Creation

2. The result of a function cannot be used in an expression.
The following is invalid:
norm_press_sqr = (pressure / MAX(plist,pressure) )2
Instead use two steps:
p_max = MAX(plist,pressure)
then:
norm_press_sqr = (pressure / p_max)"2
3. Created parts (or changing geometry model parts) cannot be used with a time

calculation (using {}). If one of these parts is selected when you use {}, the
calculation will fail and an error message will be given.

4. Because calculations occur only on server based parts, client based parts are
ignored when included in the part list of the pre-defined functions, and variable
values may be undefined.

Clicking the Calculator Icon opens the Feature Detail Editor (Calculator) dialog.

=™ Feature Detail Editor (Calculator) [%]
File Edit View Help
= =
Available Variable Type Result
dizplacenents (%3 GuniM} Vector
Analyzis_Time (%3 GuniM} 1,0000e+01
Area (%3 CmpiM3 2,4517e+07
Coordinates (=3 GuniN) Vector
Time (=) GuniN) Scalar
Activate| Activate All| Deactivate| Extended CFD
Variables...
Variable Name
Working
Expression
Clear Evaluate
General Math Active Variables
Areal(part) ABS displacements
CaseMap{par ACOS Analysiz_Time
Coeff{part, s« ASIN Area
Cmplx{part, ATAN Coordinates
CmplxArgip: COSs
CmplxConj(p CROSS
Feedback Okay
[X] [¥] [Z] » {
7 8 9 i }
L3 5 6 * [
1 2 3 1
0 e + P1
Close Sppdy Changes
L L
Figure 4-4

Feature Detail Editor (Calculator) dialog
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Variable Name This field is used to specify the name for the variable being created. Built-in general
functions will provide a default, but they can be modified here. Variable names must not
start with a numeric digit and must not contain any of the following reserved characters:

«( [ { + @ b8
) ] } - space # " /

Working Expression ~ The expression or equation for the new variable is presented in this area. Interaction with
the expression takes place here, either directly by typing in values and variable names,
etc., or indirectly by selecting built-in functions and clicking calculator buttons.

Clear Clicking this button clears the Variable name field, Working Expression area, Feedback
area, and deselects any built-in function.

Evaluate Clicking this button produces the new variable defined in the working expression area.
Until you click this button, nothing is really created. The selection commands specify to
which parts the new variable should be applied.

General Scroll this list of built-in functions provided for your convenience. Click on a function to
insert it into your Working Expression. For some functions, the Feedback Window
provides interactive instructions.

Area Area (any part(s))
Computes a constant variable whose value is the area of the selected parts. If a part
is composed of 3D elements, the area is of the border representation of the part. The
area of 1D elements is zero.

Case Map CaseMap (2D or 3D part(s), case to map from, scalar/vector/tensor)
Finds the specified scalar, vector, or tensor variable values for the specified part(s)
from the indicated case.

case to map from constant number
scalar/vector/tensor scalar, vector, or tensor variable
Coefficient Coeff (any 1D or 2D part(s), scalar, component)

Computes a constant variable whose value is a coefficient Cx , Cy, or Cz such that

C,= fndS  C, = fndS  C, = fndS
S s s
where:

f = any scalar variable
S = 1D or 2D domain

n, = x component of normal
n, =y component of normal

n, =z component of normal

‘component \ [X], [Y], or [Z]

Specify [X], [Y], or [Z] to get the corresponding coefficient.
Note: Normal for a 1D part will be parallel to the plane of the plane tool.

Complex Cmplx(any part(s), scalar/vector(real portion), scalar/vector(complex portion), [optional
frequency(Degrees)])
Creates a complex scalar or vector from two scalar or vector variables. The
frequency is optional and is used only for reference.

Z=A+Bi
real portion scalar or vector variable
complex portion scalar or vector variable (but must be same as real portion)
[frequency] constant number (optional)

4-14 EnSight 7 User Manual



Complex
Argument

Complex
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Complex

Imaginary

Complex
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Complex
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4.3 Variable Creation

CmplxArg (any part(s), complex scalar or vector)
Computes the Argument of a complex scalar or vector. The resulting scalar is given
in degrees and will be in the range -180 and 180 degrees.

Arg = atan(Vi/Vr)
CmplxConj (any part(s), complex scalar or vector)

Computes the Conjugate of a complex scalar of vector. Returns a complex scalar or
vector where:

Nr=Vr
Ni=-Vi

CmplxImag (any part(s), complex scalar or vector)
Extracts imaginary portion of a complex scalar or vector into a real scalar or vector.

N=Vi

CmplxModu (any part(s), complex scalar or vector)
Returns a real scalar/vector which is the modulus of the given scalar/vector

N = SQRT(Vr*Vr + Vi*Vi)

CmplxReal(any part(s), complex scalar or vector)
Extracts the real portion of a complex scalar or vector into a real scalar or vector.

N=Vr

CmplxTransResp(any part(s), complex scalar or vector, constant PHI(0.0-360.0 Degrees))

Transient Response Returns a real scalar or vector which is the real transient response:

Curl

EnSight 7 User Manual

Re(Vt) = Re(Ve)Cos(phi) - Im(Ve)Sin(phi)

which is a function of the transient phase angle “phi” defined by:
phi=2Pift
where
t = the harmonic response time parameter
f = frequency of the complex variable “Vc”
and the complex field “Vc¢”, defined as:
Ve =Vce(x,y,z) = Re(Ve) + 1 Im(Ve)
where
Vc = the complex variable field
Re(Vc) = the Real portion of V¢
Im(Vc¢) = the imaginary portion of Vc
i=Sqrt(-1)
Note, the transient complex function, was a composition of V¢ and
Euler’srelation, namely:
Vt = Vt(x,y,z,t) = Re(Vt) + i Im(Vt) = Vc * e”(i phi)
where:
e”(i phi) = Cos(phi) + i Sin(phi)
The real portion Re(Vt), is as designated above:

Note: this function is only good for harmonic variations, thus fields with a
defined frequency!

‘phi angle ‘constant number between 0 and 360 degrees.

Curl (any part(s), vector)
Computes a vector variable which is the curl of the input vector

Curly = V= (- L (L I (L Iy

dy 0z 2z o’ \x ay



4.3 Variable Creation

Density Density(any part(s), pressure, temperature, gas constant).
Computes a scalar variable which is the density P , defined as:
- L2
P~ TR

where: p = pressure
T = temperature
R = gas constant

pressure scalar variable
temperature scalar variable
gas constant scalar variable, constant variable, or constant number
Normalized DensityNorm (any part(s), density, freestream density)
Density Computes a scalar variable which is the Normalized Density p, defined as:
Pn = P/P;
where: p = density

p, = freestream density

density scalar variable, constant variable, or constant number
freestream density constant variable or constant number
Log of DensityLogNorm (any part(s), density, freestream density)
Normalized Computes a scalar variable which is the natural log of Normalized Density
Density defined as:

Inp, = In(p/p,)

where: p = density

p; = freestream density

density scalar variable, constant variable, or constant number
freestream density constant variable or constant number
Stagnation DensityStag (any part(s), density, total energy, velocity, ratio of specific heats)
Density Computes a scalar variable which is the Stagnation Density p, defined as:

N ANU/G=1)
p, = o7+ ar"

where: p = density
vy = ratio of specific heats
M = mach number

total energy must be a scalar
velocity must be a vector

density scalar variable, constant variable, or constant number
total energy scalar variable
velocity vector variable
ratio of specific heats |scalar variable, constant variable, or constant number
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Normalized DensityNormStag (any part(s), density, total energy, velocity, ratio of specific heats,
Stagnation freestream density, freestream speed of sound, freestream velocity magnitude)
Density Computes a scalar variable which is the Normalized Stagnation Density p .
defined as:
pon = po/ pai

where:  p, = stagnation density

where:  p,; = freestream stagnation density

density scalar variable, constant variable, or constant number
total energy scalar variable
velocity vector variable
ratio of specific heats scalar variable, constant variable, or constant number
freestream density constant variable or constant number
freestream speed of sound constant variable or constant number
freestream velocity magnitude constant variable or constant number
Distance Dist2Nodes(any part(s), nodeID1,nodelD2).
Between Nodes Computes a constant, positive variable that is the distance between any two nodes.

Searches down the part list until it finds nodeID1, then searches until it finds nodeID2 and
returns Undef if nodeID1 or nodeID2 cannot be found. Nodes are designated by their
node id’s, so the part must have node ids. (Note that most created parts do not have node
ids.)

Note: to find the distance between two nodes on different parts, or between two nodes if
one or both don’t have ids, or the ids are not unique for the model (namely, more than one
part has the same node id) use the line tool. See the Advanced Usage section of How To
Use the Line Tool.

nodelD1 constant number
nodelD2 constant number
Divergence Div (2D or 3D part(s), vector)
Computes a scalar variable whose value is the divergence defined as:
Div = ou + gv + ow
dx dy Oz

where u,v,w = velocity components in X,y,z directions.

Element to Node FElemToNode (any part(s), element-based scalar or vector).
Averages an element based variable to produce a node based variable.
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Energy:
Total Energy

Kinetic Energy

Enthalpy

EnergyT (any part(s), density, pressure, velocity, ratio of specific heats).
Computes a scalar variable of total energy per unit volume

2
e= P(ei+ 7\ Total Energy

e; = ey——= Internal Energy

€y = g Stagnation Energy
where:

p = density

V = Velocity

Or based on gamma, pressure and velocity:

p .V

e = —+——+p—
(y-1) "2
density scalar variable, constant variable, or constant number
pressure scalar variable
velocity vector variable
ratio of specific heats |scalar variable, constant variable, or constant number

KinEn (any part(s), velocity, density)
Computes a scalar variable whose value is the kinetic energy E, defined as:

1
Ek = Esz

where p = density
V' = Velocity variable

velocity vector variable

density scalar variable, constant variable, or constant number

Enthalpy (any part(s), density, total energy, velocity, ratio of specific heats)
Computes a scalar variable which is Enthalpy # defined as:

_(E_D)
h Y(p 2
where: E =total energy per unit volume
p = density
V' = velocity magnitude
v = ratio of specific heats

density scalar variable, constant variable, or constant number
total energy scalar variable
velocity vector variable
ratio of specific heats |scalar variable, constant variable, or constant number
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Normalized EnthalpyNorm (any part(s), density, total energy, velocity, ratio of specific
Enthalpy heats, freestream density, freestream speed of sound)

Computes a scalar variable which is Normalized Enthalpy 4, defined as:
h, = h/h,

where: h = enthalpy
h, = freestream enthalpy

density scalar variable, constant variable, or constant number
total energy scalar variable

velocity vector variable

ratio of specific heats scalar variable, constant variable, or constant number
freestream density constant variable or constant number

freestream speed of sound | constant variable or constant number

Stagnation EnthalpyStag (any part(s), density, total energy, velocity, ratio of specific heats)
Enthalpy Computes a scalar variable which is Stagnation Enthalpy %, defined as:
.Y
hy = ht3

where: & = enthalpy
V' = velocity magnitude

density scalar variable, constant variable, or constant number
total energy scalar variable
velocity vector variable
ratio of specific heats |scalar variable, constant variable, or constant number

Normalized EnthalpyNormStag (any part(s), density, total energy, velocity, ratio of
Stagnation specific heats, freestream density, freestream speed of sound, freestream velocity
Enthalpy magnitude)
Computes a scalar variable which is Normalized Stagnation Enthalpy 7,
defined as:
hon = ho/ h oi

where: &, = stagnation enthalpy

h,;= freestream stagnation enthalpy

density scalar variable, constant variable, or constant number
total energy scalar variable

velocity vector variable

ratio of specific heats scalar variable, constant variable, or constant number
freestream density constant variable or constant number

freestream speed of sound constant variable or constant number

freestream velocity magnitude | constant variable or constant number

EnSight 7 User Manual 4-19



4.3 Variable Creation

Entropy Entropy (any part(s), density, total energy, velocity, ratio of specific heats, gas
constant, freestream density, freestream speed of sound)
Computes a scalar variable which is Entropy s defined as:

L
Pi R
s = In|——|| —
(R\ Y (Y -1
Pi
where: R = gas constant
p = density

p; = freestream density

p = pressure

p,; = freestream pressure = (picf)/y
¢; = velocity magnitude

v = ratio of specific heats

density scalar variable, constant variable, or constant number
total energy scalar variable

velocity vector variable

ratio of specific heats scalar variable, constant variable, or constant number
gas constant constant variable or constant number

freestream density constant variable or constant number

freestream speed of sound |constant variable or constant number

Flow Flow (any 1D or 2D part(s), velocity).
Computes a constant variable whose value is the flow Q. defined as:

0,= V,dS
s
where v, = Velocity value normal to the surface

S =1D or 2D domain

‘velocity ‘vector variable

Note: Normal for a 1D part will be parallel to the plane of the plane tool

Flow Rate FlowRate (any 1D or 2D part(s), velocity).
Computes a scalar variable Q0 defined as:

Q="V-n

where V= Velocity

n = Surface Normal

velocity vector variable
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Fluid Shear FluidShear(2D part(s), velocity magnitude gradient, viscosity)
Computes a scalar variable tau whose value is defined as:

tau=p ‘Z—Z where tau = shear stress

p = dynamic viscosity
%r—lz/ = Velocity gradient in direction of surface normal
Hints: To compute fluid shear stress:

1. Use gradient function on velocity to obtain “Velocity Grad” variable in
the 3D part(s) of interest.

2. Use clip option (through the 3D part(s) used in 1.) to obtain a surfaceon
which you wish to see the fluid shear stress.

3. Compute Fluid Shear variable (on the 2D clip surface of 2.)

velocity gradient vector variable

viscosity scalar variable, constant variable, or constant number
Fluid Shear FluidShearMax (2D or 3D part(s), velocity, density, turbulent kinetic energy, turbulent
Stress Max dissipation, laminar viscosity)

Computes a scalar variable £ defined as:

L =F/A= (u+u)E  where F =force

A = unit area
u, = turbulent (eddy) viscosity

u, = laminar viscosity (treated as a constant)

E =local strain
The turbulent viscosity u, is defined as:

2
L, 00.09K

; . where p = density

K = turbulent kinetic energy
€ = turbulent dissipation

A measure of local strain E (i.e. local elongation in 3 directions) is given by
E = JQ2tr(D-D))  where
20D D) = 2((d;))" + (dy) + (dg)") +((d )+ (d))” + () )
given the Euclidean norm defined by
(D D) = (d)) + (d) + (dyy) + 20,7 + (@) + ()
and the rate of deformation tensor dij defined by

2d11 d12 d13

d;;="'w/'z
d,=""y +'v/'x = d,,
di;="v/'z+'w/'x=d;

dy;="'z+'w/'y =d;,
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given the strain tensor e;; definedby ¢, = 1d'

ij 27 1
velocity vector variable
density scalar variable, constant variable, or constant number
turbulent kinetic energy scalar variable
turbulent dissipation scalar variable
laminar viscosity constant variable or constant number
Force Force(2D part(s), pressure)

Computes a vector variable whose value is the force F defined as:
F = pA
where p = pressure

A = unit area
Note: The force acts in the surface normal direction.

‘pressure ‘ scalar variable

Force 1D ForcelD(1D planar part(s), pressure, surface normal)
Computes a vector variable whose value is the force F defined as:

F = pL
where p = pressure

L = unit length times 1
Note: The force acts in the part’s normal direction (in plane).

pressure scalar variable
surface normal vector variable
Gradient Grad (2D or 3D part(s), scalar or vector(Magnitude will be used))

Computes a vector variable whose value is the gradient GRAD, defined as:
L L
GRADf 3 +ay] +azk

where  f'=any scalar variable (or the magnitude of the specified vector)
X, ¥, z = coordinate directions

i, J, k = unit vectors in coordinate directions

Gradient GradApprox (2D or 3D part(s), scalar or vector(Magnitude will be used))

Approximation Same as Gradient, except all elements are first subdivided into triangles (for 2D) or
tetrahedrons (for 3D) and a closed-form solution is done on the subdivided
element’s nodal values (only applicable for per node variables). This is basically a
quicker, linear approximation of the regular gradient.

Gradient Tensor GradTensor (2D or 3D part(s), vector)

Computes a tensor variable whose value is the gradient GRAD; defined as:

_ R OF; | OF;
GRADy = Si+ S5+ 5ok

where F = any vector variable
X, ¥, z = coordinate directions
i, J, k = unit vectors in coordinate directions

Gradient Tensor GradTensorApprox (2D or 3D part(s), vector)
Approximation Same as Gradient Tensor, except all elements are first subdivided into triangles (for
2D) or tetrahedrons (for 3D) and a closed-form solution is done on the subdivided

element’s nodal values (only applicable for per node variables). This is basically a
quicker, linear approximation of the regular gradient tensor.
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Helicity:
Helicity Density  HelicityDensity(any part(s), velocity)
Computes a scalar variable g 4 whose value is:

Hyg=VeQ
where: V = Velocity
Q = Vorticity
‘Velocity ‘Vector variable

Relative Helicity HelicityRelative(any part(s), velocity)
Computes a scalar variable H, whose value is:

_VeQ
e

where: ¢ = the angle between the velocity vector and the vorticity vector.

H, = cos ¢

‘Velocity ‘Vector variable

Filtered Relative  HelicityRelFilter(any part(s), velocity, freestream velocity magnitude).
Helicity Computes a scalar variable H, f whose value is:

H}’f: H

- 5 if |Hyl 2 filter

or Hrf =0 | if |Hd| <filter
where H, = relative helicity (as described above)

Hy = helicity density (as described above)

filter = 0.1(V,,)?

velocity vector variable

freestream velocity magnitude | constant variable or constant number

Iblanking Values [blankingValues (Any iblanked structured part(s))
Computes a scalar variable whose value is the iblanking flag of selected parts.

Integrals:

Line Integral IntegralLine (1D part(s), scalar or (vector, component))
Computes a constant variable whose value is the integral of the input variable over
the length of the specified 1D part(s).

Surface Integral IntegralSurface (2D part(s), scalar or (vector, component))
Computes a constant variable whose value is the integral of the input variable over
the surface of the specified 2D part(s).

Volume Integral IntegralVolume (3D part(s), scalar or (vector, component))
Computes a constant variable whose value is the integral of the input variable over
the volume of the specified 3D part(s).

Length Length (any 1D part(s))
Computes a constant variable whose value is the length of selected parts. While any
part can be specified, it will only return a nonzero length if the part has 1D elements.

Line Integral See Line Integral under Integrals.
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Mach Number Mach (any part(s), density, total energy, velocity, ratio of specific heats)
Computes a scalar variable whose value is the Mach number M defined as:
u u

P c

p

where m = momentum
p = density
u = speed, computed from velocity input.
v = ratio of specific heats (1.4 for air)

p = pressure (see Pressure below)
¢ = speed of sound

See Total Energy in this section for a description.

density scalar variable, constant variable, or constant number
total energy scalar variable
velocity vector variable
ratio of specific heats |scalar variable, constant variable, or constant number

Make Scalarat  MakeScalElem (any part(s), constant number or constant variable)

Elements Assigns the specified constant value to each element, making a scalar variable.
Make Scalarat  MakeScalNode (any part(s), constant number or constant variable)

Nodes Assigns the specified constant value to each node, making a scalar variable.
Make Vector MakeVect (any part(s), scalar or zero, scalar or zero, scalar or zero)

Computes a vector variable formed from scalar variables. First scalar becomes the X
component of the vector, second scalar becomes the Y component, and the third
scalar becomes the Z component. A zero can be specified for some of the scalars,
creating a 2D or 1D vector field.

Massed Particle MassedParticle (massed particle trace part(s))

Scalar
This scalar creates a massed-particle per element scalar variable for each of the
parent parts of the massed-particle traces. This per element variable is the mass of
the particle times the sum of the number of times each element is exited by a mass-
particle trace. See Particle-Mass Scalar on Boundaries in Chapter 7

Mass-Flux MassFluxAvg (any 1D or 2D part(s), scalar, velocity, density)
Average Computes a constant variable whose value is the mass flux average b,,, defined as:

opb(VeN)dA
_ MassFluxOfScalar _ Flow(plist, bpV)
MassFlux Flow(plist, pV)

bavg = 4
op(V eN)dA
4
where b = any scalar variable, i.e. pressure, mach, a vector component, etc.
p = density (constant or scalar) variable
V' = velocity (vector) variable
dA = area of some 2D domain
N = unit vector normal to dA

scalar any scalar variable, i.e. pressure, mach, a vector component, etc
velocity a vector variable
density scalar variable, constant variable, or constant number
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Max Max (any part(s), scalar or (vector, component))
Computes a constant variable whose value is the maximum value of the scalar (or

vector component) in the parts selected. The component is not requested if a scalar

is selected.

‘ [component] ‘if vector variable, magnitude is the default, or specify [x], [y], or [z] ‘

Min Min (any part(s), scalar or (vector, component))
Computes a constant variable whose value is the minimum value of the scalar (or

vector component) in the parts selected.

‘if vector variable, magnitude is the default, or specify [x], [y], or [z] ‘

‘ [component]

Moment Moment (any part(s), vector, component).
Computes a constant variable (the moment about the cursor tool location) whose

value is the x, y, or z component of Moment M .
M, = S(Fyd,— Fyd,)
M, = X(F,dy—F,d,)

M, = S(Fyd),—Fydy)
F,; = force vector component in direction i of vector F(X,y,z)

where
= (Fx,Fy,Fz)
d; = signed moment arm (the perpendicular distance from the
line of action of the vector component F; to the moment axis
(which is the current cursor tool position)).
vector any vector variable
component [X], [Y], or [Z]

MomentVector  MomentVector (any part(s), force vector).
Computes a vector variable (the moment is computed about each point of the

selected parts) whose value is the x, y, or z component of Moment M .

M, = 5(Fyd,~F.d))

M, = X(F,d,—Fyd,)

M, = S(Fyd),—Fydy)

F,; = force vector component in direction i of vector F(X,y,z)

= (Fx,Fy,Fz)
d; = signed moment arm (the perpendicular distance from the

line of action of the vector component F; to the moment axis

(model point position)).

where

Momentum(any part(s), velocity, density).

Momentum
Computes a vector variable m, which is:

m = pV

where P = density
V= velocity

a vector variable

velocity
scalar variable, constant variable, or constant number

density

Node to Element NodeloElem (any part(s), node-based scalar or vector).
Averages a node based variable to produce an element based variable.
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Normal Normal (2D part(s) or 1D planar part(s))
Computes a vector variable which is the normal to the surface at each node for 2D
parts, or for 1D planar parts - lies normal to the 1D elements in the plane of the part.

Normal NormC (2D or 3D part(s), pressure, velocity, viscosity)
Constraints Computes a constant variable whose value is the Normal Constraints NC defined as:

NC = J.(fp + y‘g—ifﬁ\ ds
S
where p = pressure
V = velocity
| = dynamic viscosity
n = direction of normal
S =Dborder of a 2D or 3D domain

pressure scalar variable
velocity vector variable
viscosity scalar variable, constant variable, or constant number

Normalize Vector NormVect (any part(s), vector)

Computes a vector variable whose value is a unit vector U of the given vector V' .
U= v, V,7)

g

where: V = vector variable field

2 2 2
V= v +r +v,

Offset Field OffsetField (2D or 3D part(s))

Computes a scalar field of offset values. The values will be in model distance units
perpendicular to the boundary of the part. Note that an isosurface created in this
field would mimic the part boundary, but at the offset distance into the field.

Offset Variable  OffsetVar(2D or 3D part(s), scalar or vector, constant offset value)

Computes a scalar (or vector) variable defined as the offset value into the field of
that variable that exists in the normal direction from the boundary of the part.

‘ constant offset value ‘ constant number (constant variable is not valid)

Pressure Pres (any part(s), density, total energy, velocity, ratio of specific heats)
Computes a scalar variable whose value is the pressure p defined as:

p=a-np(E-1?

P
where: m = momentum
E = internal energy
p = density

V' =velocity = m/p
v = ratio of specific heats (1.4 for air)

density scalar variable, constant variable, or constant number
total energy scalar variable
velocity vector variable
ratio of specific heats |scalar variable, constant variable, or constant number
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Pressure PresCoef (any part(s), density, total energy, velocity, ratio of specific heats, freestream
Coefficient density, freestream speed of sound, freestream velocity magnitude)

Computes a scalar variable which is Pressure Coefficient C, defined as:

PiVi
>
where: p = pressure
P; = freestream pressure

p; = freestream density

V, = freestream velocity magnitude

density scalar variable, constant variable, or constant number
total energy scalar variable

velocity vector variable

ratio of specific heats scalar variable, constant variable, or constant number
freestream density constant variable or constant number

freestream speed of sound constant variable or constant number

freestream velocity magnitude | constant variable or constant number

Dynamic PresDynam (any part(s), density, velocity)
Pressure Computes a scalar variable which is Dynamic Pressure ¢ defined as:
_ oV
177
where: p = density

V' = velocity magnitude
See also: Kinetic Energy

density scalar variable, constant variable, or constant number
velocity vector variable
Normalized PresNorm (any part(s), density, total energy, velocity, ratio of specific heats,
Pressure freestream density, freestream speed of sound)

Computes a scalar variable which is Normalized Pressure p, defined as:
Py = P/P;
where: p; = freestream pressure = 1/y

Y = ratio of specific heats

p = pressure

density scalar variable, constant variable, or constant number
total energy scalar variable

velocity vector variable

ratio of specific heats scalar variable, constant variable, or constant number
freestream density constant variable or constant number

freestream speed of sound | constant variable or constant number
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Log of
Normalized
Pressure

Stagnation
Pressure

Normalized
Stagnation
Pressure

4-28

PresLogNorm (any part(s), density, total energy, velocity, ratio of specific
heats, freestream density, freestream speed of sound)
Computes a scalar variable which is the natural log of Normalized Pressure
defined as: Inp, = In(p/p;)

where:  p, = freestream pressure = 1/y
Y =ratio of specific heats
p = pressure
density scalar variable, constant variable, or constant number

total energy scalar variable

velocity vector variable

ratio of specific heats scalar variable, constant variable, or constant number

freestream density constant variable or constant number

freestream speed of sound constant variable or constant number

PresStag (any part(s), density, total energy, velocity, ratio of specific heats)
Computes a scalar variable which is the Stagnation Pressure p, defined as:

.y v/ (y=1)
o= o150

where:  p = pressure

vy = ratio of specific heats
M = mach number

density scalar variable, constant variable, or constant number

total energy scalar variable

velocity vector variable

ratio of specific heats |scalar variable, constant variable, or constant number

PresNormStag (any part(s), density, total energy, velocity, ratio of specific heats,
freestream density, freestream speed of sound, freestream velocity magnitude)
Computes a scalar variable which is Normalized Stagnation Pressure p,,

defined as: p,, = p,/p,;

where:  p, = stagnation pressure

p,; = freestream stagnation pressure

density scalar variable, constant variable, or constant number

total energy scalar variable

velocity vector variable

ratio of specific heats scalar variable, constant variable, or constant number

freestream density constant variable or constant number

freestream speed of sound constant variable or constant number

constant variable or constant number

freestream velocity magnitude
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Stagnation PresStagCoef (any part(s), density, total energy, velocity, ratio of
Pressure specific heats, freestream density, freestream speed of sound, freestream velocity
Coefficient magnitude)

Computes a scalar variable which is Stagnation Pressure Coefficient C,,

inzw
definedas: C, = (p,-p,)/ 5

where: p, = stagnation pressure

p; = freestream pressure = 1/7y

vy = ratio of specific heats
p, = freestream density

V= velocity magnitude

density scalar variable, constant variable, or constant number
total energy scalar variable

velocity vector variable

ratio of specific heats scalar variable, constant variable, or constant number
freestream density constant variable or constant number

freestream speed of sound constant variable or constant number

freestream velocity magnitude | constant variable or constant number

Pitot PresPitot (any part(s), density, total energy, velocity, ratio of specific heats)
Pressure Computes a scalar variable which is Pitot Pressure » defined as:
P
P, = sp
v/ (y=1))
(lt.l\
2 7
E
vy-n(E-5)
s - (1/(y=1)
(20— || (=
v+ 1 E V2 Y+ 1
Yy - 1)(— S
p 2

where v = ratio of specific heats

E = total energy per unit volume

p = density

V' = velocity magnitude

p = pressure
density scalar variable, constant variable, or constant number
total energy scalar variable
velocity vector variable
ratio of specific heats |scalar variable, constant variable, or constant number

Note: For mach numbers less than 1.0, the Pitot Pressure is the same as the Stagnation
Pressure. For mach numbers greater than or equal to 1.0, the Pitot Pressure is
equivalent to the Stagnation Pressure behind a normal shock.
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Pitot PresPitotRatio (any part(s), density, total energy, velocity, ratio of specific heats,
Pressure freestream density, freestream speed of sound)
Ratio Computes a scalar variable which is Pitot Pressure Ratio Py defined as:

_ A
Ppr = str-D(E-BL-

where s = (defined above in Pitot Pressure)
v = ratio of specific heats
E = total energy per unit volume

p = density

V' = velocity magnitude
density scalar variable, constant variable, or constant number
total energy scalar variable
velocity vector variable
ratio of specific heats scalar variable, constant variable, or constant number
freestream density constant variable or constant number
freestream speed of sound constant variable or constant number

Total PresT (any part(s), pressure, velocity, density)
Pressure Computes a scalar variable whose value is the total pressure p, defined as:
p,=pt p("j’\
where p = density
V' =velocity
p = pressure
pressure scalar variable
velocity vector variable
density scalar variable, constant variable, or constant number

Rectangular To RectToCyl (any part(s), vector)

Cylindrical Vector Produces a vector variable with cylindrical components according to frame 0.
(Intended for calculation purposes)
x =radial component, y = tangential component, =z =z component

Shock Plot3d ShockPlot3d(2D or 3D part(s), density, total energy, velocity, ratio of specific heats).
computes a scalar variable ShockPlot3d, whose value is:
ShockPlot3d = L o 87a9(®).
¢ lgrad(p)
where V= velocity
¢ = speed of sound
p = pressure

grad(p) = gradient of pressure

density scalar variable, constant variable, or constant number
total energy scalar variable
velocity vector variable
ratio of specific heats |scalar variable, constant variable, or constant number
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Spatial Mean SpaMean (any part(s), scalar or (vector, component))
Computes a constant variable whose value is the volume (or area) weighted mean
value of a scalar (or vector component) at the current time. This value can change
with time. The component is not requested if a scalar variable is used

The spatial mean is computed by summing the product of the volume (3D, or area
2D) of each element by the value of the scalar (or vector component) taken at the
centroid of the element, for each element over the entire part. The final sum is then
divided by the total volume (or area) of the part.

ZSivoli
ZVOli

where: s; = Scalar taken at centroid of element i

SpatialMean =

vol; = Volume (or Area) of element i

‘ [component] ‘if vector variable, magnitude is the default, or specify [x], [y], or [z] ‘

Speed Speed (any part(s), velocity)
Computes a scalar variable whose value is the Speed defined as:

Speed = i+ v+ w?

where: u,v,w = velocity components in the X,y,z directions.
‘ velocity ‘ vector variable
Sonic Speed SonicSpeed(any part(s), density, total energy, velocity, ratio of specific heats).

Computes a scalar variable ¢, whose value is:
c- [
Y

where Y = ratio of specific heats

p = density
p = pressure
density scalar variable, constant variable, or constant number
total energy scalar variable
velocity vector variable
ratio of specific heats |scalar variable, constant variable, or constant number

Stream Function Stream (any 2D part(s), velocity, density)
Computes a scalar variable whose value is the Stream Function ¥ defined as:

= —vdx +udy
where: u,v = velocity components in X, Y directions
velocity vector variable
density scalar variable, constant variable, or constant number

Surface Integral ~ See Surface Integral under Integrals.
Computes a constant variable whose value is the integral of the input variable over
the surface of the specified 2D part(s).
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Swirl Swirl (any part(s), density, velocity).
Computes a scalar variable Swirl, whose value is:
Qe)

Swirl = ——
pr’
where: € = vorticity

P = density
V' =velocity

density scalar variable, constant variable, or constant number

velocity vector variable

Temperature Temperature (any part(s), density, total energy, velocity, ratio of specific heats,
gas constant)
Computes a scalar variable whose value is the temperature 7 defined as:
—I(E 1
r=1E-5
m = momentum
E =total energy per unit volume
p = density
V' =velocity = m/p
v = ratio of specific heats (1.4 for air)
R = gas constant

where:

density scalar variable, constant variable, or constant number

total energy scalar variable

velocity vector variable

ratio of specific heats |scalar variable, constant variable, or constant number

constant variable or constant number

gas constant

Normalized
Temperature

TemperNorm (any part(s), density, total energy, velocity, ratio of specific heats,
freestream density, freestream speed of sound, gas constant)

Computes a scalar variable which is Normalized Temperature T, defined as:

T
T = =
n Ti
where: T = temperature
T, = freestream temperature
density scalar variable, constant variable, or constant number

total energy

scalar variable

velocity

vector variable

ratio of specific heats

scalar variable, constant variable, or constant number

freestream density

constant variable or constant number

freestream speed of sound

constant variable or constant number

gas constant

constant variable or constant number
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Log of TemperLogNorm (any part(s), density, total energy, velocity, ratio of specific
Normalized heats, freestream density, freestream speed of sound, gas constant)
Temperature Computes a scalar variable which is the natural log of Normalized Temperature

defined as: InT, = In(T/T))

where: T = temperature
T, = freestream temperature

density scalar variable, constant variable, or constant number

total energy scalar variable

velocity vector variable

ratio of specific heats scalar variable, constant variable, or constant number

freestream density constant variable or constant number

freestream speed of sound constant variable or constant number

gas constant constant variable or constant number
Stagnation TemperStag (any part(s), density, total energy, velocity, ratio of specific heats, gas constant)
Temperature Computes a scalar variable which is the Stagnation Pressure T,

definedas: T, = T(] + (Y;—I\ M)

where: T = temperature

Y = ratio of specific heats
M = mach number

density scalar variable, constant variable, or constant number
total energy scalar variable

velocity vector variable

ratio of specific heats scalar variable, constant variable, or constant number
gas constant constant variable or constant number

Normalized TemperNormStag (any part(s), density, total energy, velocity, ratio of
Stagnation specific heats, freestream density, freestream speed of sound, freestream velocity
Temperature magnitude, gas constant)

Computes a scalar variable which is Normalized Stagnation Temperature T,

definedas: 7,,=T7,/T,

o
where: T, = stagnation temperature

T, = freestream stagnation temperature

density scalar variable, constant variable, or constant number
total energy scalar variable

velocity vector variable

ratio of specific heats scalar variable, constant variable, or constant number
freestream density constant variable or constant number

freestream speed of sound constant variable or constant number

freestream velocity magnitude |constant variable or constant number

gas constant constant variable or constant number

Temporal Mean  TempMean (any part(s), scalar or vector, timestep1, timestep2)
Computes a scalar or vector variable, depending on which type was selected, whose
value is the mean value at each node of a scalar or vector variable over the interval
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Tensor:

Tensor
Component

Tensor
Determinate

Tensor
Eigenvalue

Tensor
Eigenvector

Tensor Make

Tensor
Tresca

4-34

from timestep1 to timestep2. Thus, the resultant scalar or vector is independent of

time.
timestep1 constant number
timestep2 constant number

TensorComponent(any part(s), tensor, tensor row(1-3), tensor col(1-3))
Creates a scalar variable which is the specified row and column of a tensor variable.

S = Tij
i=given row (1 to 3)
j = given column (1 to 3)

tensor row constant number (1 to 3)

tensor col constant number (1 to 3)

TensorDeterminant(any part(s), Tensor or 3 Principals or 6 Tensor Components)
Computes the determinate of a tensor variable. The tensor may be specified as
either a tensor, three principal values or six tensor components. If the three tensor
components are given they must be given in the order:

T11, T22,T33, T12, T13,T23.

TensorEigenvalue(any part(s), tensor, which number(1-3))
Computes the number (1-3) eigenvalue of the given tensor. The first eigenvalue is
always the largest, while the third eigenvalue is always the smallest.

TensorEigenvector(any part(s), tensor, which number(1-3))
Computes the number (1-3) eigenvector of the given tensor.

TensorMake(any part(s), T11, T22,T33,T12, T13, T23)
Create a tensor from six scalars.

TensorTresca(any part(s), Tensor or 3 Principals or 6 Tensor Components)
Computes Tresca stress/strain from a tensor variable. The tensor may be specified
as either a tensor, three principal values or six tensor components. Ifthe three tensor
components are given they must be given in the order:
T11, T22, T33, T12, T13, T23.

S,, = |0,- 04
where: G,, =yield stress
o, = greatest principal stress/strain

c; = least principal stress/strain
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Von Mises

Velocity

Volume

Volume Integral

Vorticity
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TensorVonMises(any part(s), Tensor or 3 Principals or 6 Tensor Components)
Computes Von Mises stress/strain from a tensor variable. The tensor may be
specified as either a tensor, three principal values or six tensor components. If the

three tensor components are given they must be given in the order:
T11, T22,T33,T12, T13, T23.

Oyp = N/(GI - 02)2 +(0,- (’3)2 (03— (’1)2

where: G,, =yield stress

o, = greatest principal stress/strain
6, =middle principal stress/strain
6; = least principal stress/strain

Velo (any part(s), momentum, density)

Computes a vector variable whose value is the velocity V defined as:

yp=m
p
where p = density
m = momentum
momentum vector variable
density scalar variable, constant variable, or constant number
Vol (3D part(s))

Computes a constant variable whose value is the volume of 3D parts.

See Volume Integral under Integrals.

Vort (any 2D or 3D part(s), velocity)

Computes a vector variable with components , , {, {, defined as:
R T YO VI VP .
Y dy oz Y. 0z ox Z  ox dy

where u,v,w = velocity components in the X, Y, Z directions.

‘Velocity

‘Vector variable
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Math

Math functions use the syntax: function (value or expression). All angle arguments are in
radians. For most functions the value can be either a constant, scalar, or vector and the
result of the function will be of corresponding type. When you select a math function
from the list, the function name and the opening “(“ appears in the Working Expression
for you. However, after defining the argument(s) for the function, you have to manually
provide any commas needed and a closing “)”. The Math functions include:

corresponding type of result:

Routines which accept argument(s) of type constant, scalar, or vector and produce the
(function works on each component of a vector)

U BS(constant) absolute value = constant
or  (scalar) scalar
or  (vector) vector

4 COS(constant) arccosine = radian constant
or (scalar) radian scalar
or (vector) radian vector

USTN(constant) arcsine = radian constant
or  (scalar) radian scalar
or  (vector) radian vector

M UTAN(constant) arctangent = radian constant
or  (scalar) radian scalar
or  (vector) radian vector

WUTAN2(constant, constant) = radian constant
or (constant, scalar) =radian scalar

or (constant, vector) = radian vector
or (scalar ,scalar) =radian scalar
or (scalar, vector) =radian vector
or (vector, vector) =radian vector

MUTAN2(y, x) calculates ATAN(y/x) where the signs of both variables are used to determine the quadrant of the result.
Returns the result in radians which is between -PI and PI (inclusive). So:

where:
ATAN2(vectorl,vector2) = (ATAN2(vectorlx/vector2x), ATAN2(vectorly/vector2y), ATAN2(vectorlz/vector2z) )

COS(radian constant) cosine = constant
or  (radian scalar) scalar
or  (radian vector) vector

CROSS(vector, vector) cross product = vector

IDOT(vector, vector) dot product = scalar

[EXP(constant) e Y*1"¢ = constant
or  (scalar) scalar
or  (vector) vector

GT(constant,constant) greater of = constant

or (constant,scalar) scalar
or (constant,vector) vector
or (scalar,scalar) scalar
or (scalar,vector) vector
or (vector,vector) vector

where:
GT(vectorl,vector2) = (GI(vectorlx, vector2x), GT(vectorly, vector2y), GT(vectorlz, vector2z) )

ILOG{(constant) In = constant ILOG10(constant) log;( = constant
or  (scalar) scalar or (scalar) scalar
or  (vector) vector or (vector) vector
IL T(constant,constant) lesser of = constant

or (constant,scalar) scalar

or (constant,vector) vector

or (scalar,scalar) scalar

or (scalar,vector) vector

or (vector,vector) vector where:

LT{(vectorl,vector2) = (LT(vectorlx, vector2x), LT(vectorly, vector2y), LT(vectorlz, vector2z) )

IRMS (vector) root-mean-square (magnitude) = scalar

IRND(constant) round to nearest = constant
or  (scalar) scalar
or  (vector) vector

ISIN(radian constant) sine = constant
or (radian scalar) scalar
or (radian vector) vector

ISORT(constant) square root = constant
or  (scalar) scalar
or  (vector) vector

TAN(radian constant) tangent = constant
or  (radian scalar) scalar

or  (radian vector) vector
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Feedback

Okay

Calculator
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Selection list of all variables which are active and therefore available for use in
Expressions. You activate variables in the Feature Detail Editor Variables List.

This area displays interactive guidance when you select a General function, including
detailed instructions concerning the function’s arguments.

Click this button when so prompted by the Feedback instructions. It basically signals the
completion of various intermediate tasks for general functions.

This on-screen calculator can usually be used in place of typing on your keyboard.
Button Function

0to9 number digits

. decimal

e e for exponential notation
+ plus operator

minus operator
multiplication operator
division operator
exponentiation operator
PI value for 7

> >~ % |

( opening parentheses. For function arguments and general grouping
) closing parentheses. For function arguments and general grouping
[ opening brackets. For components and node/element numbers

] closing brackets. For components and node/element numbers

[X] X component

[Y] Y component

[Z] Z component

(see How To Create New Variables)
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5 GUI Overview

The Graphical User Interface for EnSight 7 has undergone a number of
improvements. These changes are not revolutionary in nature as compared to the
EnSight 6 interface, but are refinements intended to increase, even more, the ease
of use of EnSight. For example, the need for scrolling has been greatly reduced,
tool toggles are on the desktop, and some of the advanced modes are off by
default. Our experience has shown that current users of EnSight 6 have no
difficulty in running EnSight 7. The interface has been designed to allow the user
to access most commonly needed capabilities at the desktop level.

The purpose of this Chapter is to provide a brief overview of the EnSight 7 GUI.

“Desktop” - refers to the upper level of the GUI. It contains the following areas:

. [3¢= EnSight Message
Main Menu —‘Eile Edit Query View Tools Case Help | — Area
3 = B EEET 1l Feature
Select Part(s) To Operate On lcon Bar
Main Parts — 1)
List <4—1— Quick
Interaction
Area
Quick Desktop )
Buttons > Shaded _|Hidden Line Cursor _ILine _|Plane Axis [|Bounds Fast Display | Legend...| | Info..S Information
5 Area Button
Mode ——p!
Selection A
Area n
t
P
1
Mode Icon -
Bar q Graphics
- Window
t
F
v 1
- oW
-4
e ommumcate
CEI
Expires June 29, 2003 J
Copyright 1994-2002 CFT, Tnc.
Transformation N -8 {3 Reset... Transf. Edit... +X| +¥| +Z| -X| -¥| -Z| Store| Recall| Unde Tool Tips
Control Area ‘ )
Tool Tips
Figure 5-1 Toggle

EnSight 6 Start-Up GUI

When EnSight first comes up, the Graphical User Interface should appear
approximately as shown. The different sections of the GUI are used for specific
purposes.
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Main Menu

Main Parts List

Feature Icon Bar

Mode Selection Area

In addition to providing access to high-level features such as Command File
Creation/Editing/Reading, Results Data Reading, File Printing, Saving/Restoring
a session, and Quitting, the Main Menu provides access to often-used
postprocessing features such as editing, querying variable data, part appearance
adjustment, and tool visibility.

Chapter 6 contains a complete description of each section of the Main Menu.
(see Chapter 6, Main Menu)

The Main Parts List contains the descriptions of all parts that have been read in
from your results data (model parts) or created within EnSight (created parts).
Displayed are a part number, a part symbol, a case number, and a part description.

Select Part{s) To Operate On

_ P | 1-M/C1) Computational m =
Parent Part 2-(C/C1} Contour part
Indicator 3-(I/C1) Isosurface part —_
|4-(T/C1) Particle trace part | | ———_ p_ Description
Part Number — | 5-(2/C1) Clip_plane
6—(V/C1} Vectar Arrow par

\ J
B \\ =
Part Symbol Case Number

Figure 5-2
Main Parts List

You will find sub-sets of this Main Parts List in the Feature Detail Editor for each
type of part. For example, the Feature Detail Editor (Isosurface) will contain a
parts list of only isosurface parts.

For a complete description of the Main Parts List as well as a detailed discussion
about Part selection, editing, and operations thereon:
(see Section 3.1, Part Overview)

This Icon Bar provides rapid access to color assignment, new part creation, part
displacement, 2D plot creation, data querying, time step control, flipbook
animation and keyframe animation. Clicking once on an icon opens its associated
editor in the Quick Interaction Area.

Double clicking on the Color icon will open the Feature Detail Editor for
Variables. Double clicking on a new part creation Icon (contours, isosurfaces,
particle traces, clips, vector arrows, elevated surfaces, profiles, developed
surfaces) will open the Feature Detail Editor for that type of created part.

Chapter 7 contains a detailed explanation of the features in the Quick Interaction
Area which are available through each of the Icons.
(see Chapter 7, Features)

The Mode Selection Area contains four to six buttons which allow you to choose
which of the “Modes” you wish to work in. The Mode selected will not only
determine which icons you see in the Mode Icon Bar but also the way in which
you work within the Graphics Window, The six possible Modes are:

* View Mode for the specification of how you wish to “view” parts and their
labels. By default this mode is not displayed. The most common

EnSight 7 User Manual



Mode Icon Bar

Transformation Area

Message Area

Information Area
Button

EnSight 7 User Manual

uses of this mode are on the desktop. If needed, this mode can be
turned on under Edit > Preferences... Graphical User Interface -
View Mode Allowed.

* Annot Mode for the addition and editing of annotation lines, text, and logos to
the Graphics window as well as the editing of Variable legends

e VPort Mode for the creation and control of additional viewports within the
Graphics Window

* Part Mode for the specification of attributes for specific parts

e Plot Mode for the creation and specification of attributes for 2D Variable
plots

* Frame Mode for the creation and specification of attributes for additional
frames of reference within EnSight. By default this mode is not
displayed. If needed, this mode can be turned on under Edit >
Preferences... Graphical User Interface - Frame Mode Allowed.

Chapter 8 contains a detailed explanation of the features available and the
differences between the six modes.
(see Chapter 8, Modes)

The vast majority of editing features available in EnSight are divided into six
different groups and are accessible through the Mode Icon Bar. The set of Icons
you see at any time are determined by which Mode has been selected in the Mode
Selection Area.

The various Mode Icon Bars can be customized by the user:
See Preferences... in Section 6.2, Edit Menu Functions)

Chapter 8 contains a detailed explanation of the features available and the
differences between the six modes.
(see Chapter 8, Modes)

This area determines how you will transform Parts within the Graphics Window
and also provides quick access to the Transformations Editor for precise control of
transformations. Buttons are available for quick viewing down any of the major
axes, for Storing/Recalling views and for undoing the last transformation.

Chapter 9 contains a detailed description of the features in the Transformation
Area.
(see Chapter 9, Transformation Control)

This area provides feedback on what EnSight is doing. If you are using Transient
data, this area will indicate which time step is currently in use.

This button will bring up a dialog which will display any output that EnSight
generates. When no new information is in the area, the button will be the typical
interface color. When new information has been placed in the area, the button will
be green in color. If warning information has been placed in the area, it will be
yellow in color. If error information has been placed in the area, it will be red in
color.
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Quick Interaction Area

Quick Desktop Buttons

Graphics Window

Tool Tips Toggle

This area provides quick access to the features associated with each of the Icons in
the Feature Icon Bar.

Chapter 7 contains a detailed explanation of the features in the Quick Interaction
Area which are available through each of the Icons.
(see Chapter 7, Features)

This area contains some very commonly used toggles, such as the shading and
tools.

This area shows the model using the current display attributes. You perform all
interactive transformations in the Graphics Window.

This toggles on/off the Tool Tips (balloon help) for most icons. This option is
useful for new users, but it is on the Desktop so experienced users can easily turn
it off. (It’s state is a part of the user’s preferences - so it is remembered from
session to session.)
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Motif Window
Manager

NOTE:

Interface Components

Dialogs
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GUI Conventions

The EnSight graphical user interface (GUI) uses the OSF/Motif toolkit for menus,
dialogs, buttons, and other interface components. This section provides Motif
specific information, as well as a quick introduction to some of the features of
EnSight interface components.

The Motif Window Manager (mwm) is commonly used on workstations
supporting Motif. Its use is recommended with EnSight. Although not required,
the following values for mwm resources are strongly recommended:

Mwm*focusAutoRaise: false
Mwm*keyboardFocusPolicy: pointer

Without the first setting, windows may raise automatically when the mouse is
moved into a window (which is very distracting). The second setting causes
windows to be active (accept input) when the cursor is in the window, even if the
window is partially obscured or has not been selected. These and other mwm
resources are set in the appropriate X session resource file. See a local X Windows
expert if you don’t know where this file resides. See the references at the end of
this chapter for more information on Motif, mwm, and X Windows.

The resources above prefixed with Mwm are specific to the Motif Window
Manager. If you are using a different window manager consult your Systems
Administrator for the equivalent settings. For instance, EnSight has been tested
and performs as described herein on the 4Dwm and CDE window managers.

The EnSight GUI uses menus and dialogs that utilize and expand upon established
OSF/Motif conventions. This section provides some general information on the
operation of EnSight dialogs, menus, lists, buttons, and text fields.

A dialog is a window that groups interface components based on function.
Dialogs are typically opened by making selections from a menu. Menu selections
that open dialogs always end with “...”. Most EnSight dialogs can be opened and
closed independently. In order to optimize scarce workstation screen real estate,
you should close dialogs that are not in use.

Dialogs typically consist of buttons, menus, lists, and areas to type in. Many
EnSight dialogs also have expandable sections that let you hide parts of the
interface that you use infrequently. Each expandable section consists of an
indicator button, a section title, and the contents of the section. The indicator
button and the section title are always visible. If the section is open, the contents
are visible as well.
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Turndown Button

[ Feature Detal Eor Eeveted Sutaces) |

File Edit View

@fa]-j -]

5 — |

— {(E/C1) Elevated surface

\&|

.~ Rectangular
Button

Desc I Elevated surface

Creation Attributes

Variable velocity

Xloooeo | ¥|oo000  Z[o.0000

Scale Factor I 1.0000e+00 et Defaultl | — Square Button
Offset I 0.00009+00/

[7 Surface [ Sidewalls

[l General Attributes |
Node, Element, and Line Attributes |

Displacement Attributes

I~ T
Closel Cr\eat\el Update Parentl Aaaky Cizzzngﬁffl
Menus The EnSight documentation uses the following terms to describe various types of
menus.
Menu Bar ——— | File Edit Query View Tools | Case

Pull-down menu

Cascade menu

Menu Bar

Pull-down menu

4 Cursor
4 Line

© Plane
4 Box

Quadric

Tool Positions...

Diamond button
group (explained
below)

A horizontal strip across the top of some dialogs
listing menu titles.

A pull-down menu is one accessed directly from a
menu bar.

Cascade menu or submenu A submenu is accessed from another menu

selection. Submenu selections are indicated by a
right-pointing arrow.
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Pop-up menu A pop-up menu is accessed by pressing the
associated rectangular button. The current selection
from the menu always appears as the button title.
(An example is the rectangular button labeled
“PRESSURE” beside the word Variable shown
above in the Feature Detail Editor.)

Lists EnSight provides access to the list of Model and Created Parts as well as Original
and Created Variables through the Main Parts List and the Main Variables List as
well as the sub-lists available in the various Feature Detail Editors. These lists are
presented as scrollable sections. Various mechanisms are used to select items from
a list for further action:

Select Part(s} Te Operate On

B
2-(M/Cl) side mount

4-(M/Cl) rear mounts
5-{M/C1} windshield

Scroll Bars

Select (or single-click) Place the mouse cursor over the item and click the
left mouse button. The item is highlighted to reflect
the “selected” state.

Select-drag Place the mouse cursor over the first item. Click
and hold the left mouse button as you drag over the
remaining items to be selected. Only contiguous
items may be selected in this fashion.

Shift-click Place the mouse cursor over the item. Depress the
shift key and click the left mouse button. This
action will extend a selection to include all those
items sequentially listed between the previous
selection and this one.

Control-click Place the mouse cursor over the item. Depress the
control key and click the left mouse button. This
action will extend a selection by adding the new
item, but not those in-between. Use this mechanism
to build a non-contiguous selection.

Double-click Place the mouse cursor over the item and click the
left mouse button twice in rapid succession.

Buttons EnSight uses the following kinds of buttons:

Rectangular Place the mouse cursor in the button area and click
the left mouse button. Rectangular buttons typically
access the function described in the label. If the

label is followed by “...” then the button opens
another dialog. (Example shown above.)
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Arrow

Diamond

Square

Turndown

Min | 3 5000e+01

Place the mouse cursor in the button area and click
the left mouse button. Arrow buttons typically have
an associated text field. Clicking the button
increments or decrements the text field value.

(Example shown below.) \

Max | 7 0000e+01 Increment | 5 4000,-+00

Place the mouse cursor in the button area and click
the left mouse button. Diamond buttons (also called
radio buttons) are toggles that select an item from a
mutually exclusive list. Exactly one diamond button
of a group can be on at any given time. (Example
shown above.)

Place the mouse cursor in the button area and click
the left mouse button. Square buttons are toggles
that access the function indicated by the label
(Example shown above.).

Place the mouse cursor in the button area and click
the left mouse button. Turndown buttons are toggles
for opening and closing a section. A down pointing
arrow button indicates an open section. A right
pointing arrow button indicates a closed section.
(Example shown above.)

Text Fields EnSight utilizes three types of text fields:

Information Text Fields

Editable Text Fields

These text fields are used to report information and
cannot be edited by the user. Information text fields
are surrounded with a single pixel border.

Place the mouse cursor in the text field and click to
insert a blinking insertion cursor. Several
techniques are available to accelerate text editing.
Select a single word by double-clicking or the entire
string by triple-clicking. Selected text is replaced by
subsequent typing. The left and right arrow keys
(on most systems) will move the insertion cursor.
EnSight does not recognize the change in the text
field until you press Return.

Where appropriate, EnSight recognizes the following shortcut specifications for

UNIX directories:

-/
~username/
./

./

5-8

Expands to your home directory
Expands to the home directory of username
Expands to the current working directory

Expands to the parent directory of the current
working directory
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Tear-Off Menus If your window system allows it, the EnSight user interface supports “tear-off”
menus. Judicious use of tear-off menus can provide custom, rapid access to
frequently used functions. To use tear-off menus:

Tools | Case X Tools Tear-off |[O][x]
Cursor Cursor
Line Line
Plane Plane
Box Box
Quadric Quadric
Tool Positions... I'To_ol Pasitions... ,
Select (or single-click) Place the mouse cursor over a pulldown menu

button, then click and release the left mouse button.
This operation will open the pulldown menu.

Tear off Move the mouse cursor to the dotted lines on the
menu, and again click and release the left mouse
button. This will “tear off”” the pulldown into a
separate window which can be placed anywhere on
the screen.

Closing a tear-off A tear-off menu can be closed by selecting Close
from the tear-off window’s frame menu which is
accessed clicking on the
button in the upper left of the dialog frame.

Dialog Control The window manager will normally allow you to
control some basic functions (Restore, Move,
Raise, Lower, Close) by clicking-holding the right
mouse button on a dialog or window border.

References
The following books provide more information on various aspects of OSF/Motif,
X Windows and the Motif Window Manager.

Kobara, Shiz, Visual Design with OSF/Motif, Addison-Wesley Publishing Co.,
Reading, MA, 1991.

Berlage, Thomas, OSF/Motif: Concepts and Programming, Addison-Wesley
Publishing Co., Wokingham, England, 1991.

Heller, Dan, Motif Programming Manual (for OSF/Motif Version 1.1), X Window
System, Vol. 6, O’Reilly & Associates, Inc., 1991.

Open Software Foundation, OSF/Motif Programmer’s Guide, Revision 1.2, and
OSF/Motif Programmer’s Reference Revision 1.2, P T R Prentice-Hall, Inc.,
Englewood Cliffs, NJ, 1993.

Quercia, Valerie and O’Reilly, Tim, “Appendix C: The OSF/Motif Window
Manager,” in X Window System User’s Guide (Volume Three) O’Reilly &
Associates, Inc., Sebastopol, CA, 1990.
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This chapter describes the functions available from the Main Menu.

File Edit Query View Tools Case Eelpl

Figure 6-1
EnSight Main Menu

Section 6.1, File Menu Functions
Section 6.2, Edit Menu Functions
Section 6.3, Query Menu Functions
Section 6.4, View Menu Functions
Section 6.5, Tools Menu Functions
Section 6.6, Case Menu Functions

Section 6.7, Help Menu Functions
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6.1 File Menu Functions

Clicking the File button in the Main Menu opens a pull-down menu which
provides access to capabilities which enable you to record and play command
files, connect the EnSight Client process to an EnSight Server process, read data
into the EnSight Server, load parts, print and save images, save and restore an
archive file, and quit from EnSight.

File Pull-down Menu

Command

Connect Server

Collaboration

Data (Reader)

Data (Part Loader)

Print/Save Image

=™ En3ight

File | Edit Query View Tools Case Help

Command...
Connect Server...
Collaboration...
Data (Reader)...
Data (Part Loader}...
Print/Save Image...
Save

BRestore

Quit...

Figure 6-2
File pull-down menu

Opens the Command dialog which is used to record and play Command Files
Access: Main Menu > Command...

(see Section 2.4, Command Files and How To Record and Play Command Files)

Opens the Connect Server dialog which is used to perform an Auto or Manual connection
from the EnSight Client process to an EnSight Server process.
Access: Main Menu > Connect...

For a complete description of the Connection process:

(see How To Connect Automatically)

Opens the Collaboration dialog which is used to create a session that can be joined by a
colleague, or to join a session that a colleague has opened.

Access:  Main Menu > Collaboration...

For a complete description of the Collaboration process:

(see How To Use Collaboration)

Opens the File Selection dialog which is used to specify files you wish to read into
EnSight.

Access: Main Menu > Data (Reader)...

(see Reading and Loading Data Basics, in Section 2.1 and How To Read Data)

Opens the Data Part Loader dialog which is used to load parts into EnSight.
Access: Main Menu > Data (Part Loader)...

(see Reading and Loading Data Basics, in Section 2.1 and How To Read Data)

Opens the Print/Save Image dialog which is used to print or save images from EnSight.
Access: Main Menu > Print/Save Image...

(see Section 2.10, Saving and Printing Graphic Images and How To Print/Save an Image)
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Save

Context...

Full Backup

Geometric Entities

Scenario...

Restore

Context...

Full Backup

Quit
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6.1 File Menu Functions

Opens a pull-down menu which allows you to choose between the following Save options:
Context, Full Backup or Geometric Entities.
Access: Main Menu > File > Save

Opens the Save Current Context dialog where you can specify the name of a context file to
be created. This file saves information needed to reproduce the same basic imagery on a
different set of data.

Access: Main Menu > File > Save > Context...

(See How To Save or Restore a Context File)

Opens the Save Full Backup Archive dialog which is used to save an entire session as an
Archive file which can later be used to restore EnSight to the same condition present when
the Archive file was made.

Access: Main Menu > File > Save > Full Backup

(see Section 2.5, Archive Files and How To Save and Restore an Archive)

Opens the Save Geometric Entities Dialog which is used to save selected part geometric
information and active variable values from EnSight. EnSight Gold, VRML, Brick of
Values, or User-defined writer formats can be selected.

Access: Main Menu > File > Save > Geometric Entities

(see Section 2.8, Saving Geometry and Results Within EnSight and How To Save
Geometric Entities)

Opens the Save Scenario dialog where you can create a scenario file which can be viewed
by CEI’s EnLiten product. EnLiten can display any scene created with EnSight and can be
run standalone or be embedded in Microsoft applications.

Access: Main Menu > File > Save > Scenario...

(See How To Save Scenario)

Opens a pull-down menu which allows you to choose between the following Restore
options: Context or Full Backup. stored archive file.
Access: Main Menu > File > Restore

Opens the Restore Context From File dialog where you can specify the name of a context
file to be applied and which case to apply it to. First read in your data, then restore the
context. This will do its best to create the same basic imagery (as that when the context
file was saved) to your current model.

Access: Main Menu > File > Restore > Context...

(See How To Save or Restore a Context File)

Opens the Save Full Backup Archive dialog which is used to save an entire session as an
Archive file which can later be used to restore EnSight to the same condition present when
the Archive file was made.

Access: Main Menu > File > Restore > Full Backup

(see Section 2.5, Archive Files and How To Save and Restore an Archive)
Opens the Quit Confirmation dialog which allows you to save a command file or/and an

archive file before exiting EnSight.
Access: Main Menu > Quit...



6.1 File Menu Functions

(see Section 2.5, Archive Files)
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6.2 Edit Menu Functions

Part

Part Feature Detail
Editors

EnSight 7 User Manual

Clicking the Edit button in the Main Menu opens a pull-down menu which
provides access to the following features:

File Edit | Query View Tools Case Help

Part Feature Detail Editors =

Flipbook Animation Editor...
Keyframe Animation Editor...
Solution Time Editor...
Transformation Editor...
Variables Editor .

Preferences...

Figure 6-3
Edit pull-down menu

Opens a pull-down menu which allows you to choose between the following part
operations:

e Select All (see Section 3.4, Part Operations and How To Select Parts)
* Select ... (see Section 3.4, Part Operations and How To Select Parts)
* Delete (see Section 3.4, Part Operations and How To Delete a Part)

» Assign to Single New viewport (see Section 3.4, Part Operations)
* Assign to Multiple New viewports (see Section 3.4, Part Operations)

* Group & Ungroup (see Section 3.4, Part Operations and How To Group Parts)

* Copy (see Section 3.4, Part Operations and How To Copy a Part)
e Extract (see Section 3.4, Part Operations and How To Extract Part
Representations)
* Merge (see Section 3.4, Part Operations and How To Merge Parts)
Access: Main Menu > Edit > Part

Opens a pull-down menu which allows you to choose between the following options to
open the Feature Detail Editor:

» Selected Part Type (see Section 3.1, Part Overview and Introduction to
Part Creation)

* Contours (see Section 3.3, Part Editing, Section 7.2, Contour
Create/Update, and How To Create Contours)

* Clips (see Section 3.3, Part Editing, Section 7.5, Clip
Create/Update, How To Create Line Clips, How To
Create Plane Clips, How To Create Quadric Clips,
and How To Create [JK Clips)

* Developed Surfaces (see Section 3.3, Part Editing, Section 7.9, Developed
Surface Create/Update, and How to Create Developed
Surfaces)

» Elevated Surfaces (see Section 3.3, Part Editing, Section 7.7, Elevated
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Flipbook Animation
Editor

Keyframe Animation
Editor

Solution Time
Editor

Transformation Editor

Variables Editor

Surface Create/Update, and How to Create Elevated
Surfaces)

¢ Isosurfaces (see Section 3.3, Part Editing, Section 7.3, Isosurface
Create/Update, and How to Create Isosurfaces)

* Material Parts (see Section 3.3, Part Editing, Section 7.18, Material
Parts Create/Update, and How to Create Material
Parts)

e Model Parts (see Section 3.3, Part Editing and Introduction to Part
Creation)

e Particle Traces (see Section 3.3, Part Editing, Section 7.4, Particle
Trace Create/Update, and How to Create Particle
Traces)

* Profiles (see Section 3.3, Part Editing, Section 7.8, Profile
Create/Update, and How to Create Profile Plots)

* Shock Regions/Surfaces (see Section 3.3, Part Editing, Section 7.20, Shock
Surface/Region Create/Update, and How To Extract
Shock Surfaces)

* Separation/Attachment Lines (see Section 3.3, Part Editing, Section 7.21,
Separation/Attachment Lines Create/Update, and
How To Extract Separation/Attachment Lines)

* Subset Parts (see Section 3.3, Part Editing, Section 7.16, Subset
Parts Create/Update, and How to Create Subset Parts)

» Tensor glyphs (see Section 3.3, Part Editing, Section 7.17, Tensor
Glyph Parts Create/Update, and How to Create
Tensor Glyphs)

e Vector Arrows (see Section 3.3, Part Editing, Section 7.6, Vector
Arrow Create/Update, and How to Create Vector
Arrows)

* Vortex Cores (see Section 3.3, Part Editing, Section 7.19, Vortex
Core Create/Update, and How To Extract Vortex
Cores)

Access: Main Menu > Edit > Part Feature Detail Editors...

Opens the Flipbook Animation editor in the Quick Interaction Area which is used to
create, save, and restore Flipbook Animation sequences.

Access: Main Menu > Edit > Flipbook Animation Editor...

(see Section 7.14, Flipbook Animation and How To Create a Flipbook Animation)

Opens the Keyframe Animation editor in the Quick Interaction Area which is used to
create, save, and restore Keyframe Animation sequences.
Access: Main Menu > Edit > Keyframe Animation Editor...
(see Section 7.15, Keyframe Animation and How To Create a Keyframe Animation)

Opens the Solution Time Editor in the Quick Interaction Area which is used to specify the
currently displayed time step in a transient dataset.

Access: Main Menu > Edit > Solution Time Editor...

(see Section 7.13, Solution Time and How To Animate Transient Data)

Opens the Transformation Editor dialog which is used to precisely position parts, frames,
and tools in the Graphics Window and to Save and Restore Views.

Access: Main Menu > Edit > Transformation Editor...

(see Chapter 9, Transformation Control)

Opens the Feature Detail Editor (Variables) dialog which is used to obtain information
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Annotation
Preferences

EnSight 7 User Manual

6.2 Edit Menu Functions

about variables, change the information, and to create new variables.
Access: Main Menu > Edit > Variables Editor...
(see Chapter 4, Variables)

Opens the Preferences dialog which is used to set or modify preference values for the
various categories within EnSight.

|| Preferences

Preference Categories(Select One)
&
Color Palettes

Command Line Parameters
Data

General User Interface
Image Saving and Printing
Interactive Probe Query
Mouse and Keyhoard

Parts

Performance ¥

In this area you can set default attributes and preferences which will be used for the
current EnSight session. You may also save any of these to the preference file(s) so that
they will be the defaults for future invocations of EnSight. Each of the preference
categories will now be explained.

dkkERRRRE A g ate Hon Preferenceg #tstsiti

1} #* Click Here To Start

2y Turn ON the button named
*ALLOW EDITING DEFAULTS’
in the Annot mode icans.

3 Modify any Annot mode icons
now available. For example:Line Width.

1}  Save To Preference File I

Click Here To Start Will place you in Annotation mode in EnSight with no
annotations selected (default mode). You must do step 2) so
that you are allowed to edit annotation defaults. You can
then change any annotation attributes desired and they will

become the defaults for the session.

Save To Preference File  Will write the current annotation preferences to the

preference file for future EnSight sessions.

(see How To Set Annotation Preferences:)
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Color Palettes
Preferences

6-8

ittt Calor Palette/Legend Preferences #t#tdd

Color By RGE
Textures

Displa; =" Vhen Part Is Colored

Auto Replace Legend When Part Is Colored
Reset Legend Ranges When Time Is Changed
Use Continuous Palette For Per Element Vars

Legend Editing Interface Advanced

Use Predefined
Palette

Pick Predefined Palette From List...

Tao set legend defaults(such as the Scale type):

1} Click Here To Start

2) Modify any legend attributes in the
Feature Detail Editor now displayed.
For example: Type or Scale.

Sawve To Preference File

Color By

Display Legend When
Part is Colored

Auto Replace Legend
When Part is Colored

Reset Legend Ranges
When Time Is Changed

Use Continuous Palette
For Per Element Vars

Can select RGB or Texture color mode

Will cause the legend to automatically appear when you color
a part by a variable.

Will cause legends to be automatically replaced when the
current legend is no longer in use (i.e. no parts are colored by
the variable) and a new variable is in use.

Will cause legend ranges to be reset according to variable
values at the current time.

By default the legend for Per Element variables has a “Type”
of Constant. Toggle this on to change the default “Type” to
Continuous.

Legend Editing Interface Can be EnSight’s Simple or Advanced interface.

Use Predefined Palette

Pick Predefined Palette
From List...

Legend Defaults:
Click Here To Start

Save To Preference File

Allows you to enter a predefined palette name if you have
predefined color palettes.

Allows you to pick from your predefined palette list.

Will allow you to modify legend default attributes.

Will write the current legend and palette preferences to the
preference file for future EnSight sessions.

(see How To Set Color Palette Defaults:)
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Parameter Preferences

Data Preferences
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FkdkdkrEt Command Line Preferences #tttttrts

Select Fram This List Ta See More
Information. Select Add Ta Insert
Inta The Preference List.

-deonfig

-no_display_lis

-no_guad_stere

-multi_samplir

-no_mult_sam

-num_samples

-no_sgtart_scres:

-no_gtencil_bui

P

-ports

-rangel(

-readerdbg

-rgh

8¢ Add Selected Item Ta

Current Args Below

Sawve To Preference File

By selecting arguments from the list and hitting:

Add Selected Item To You can build customized command line preferences.
Current Args Below

Save To Preference File  Will save the command line preferences to the preference file
for future invocations of EnSight.

(see How To Set Command Line Preferences:)

shekskopotolokksb Data Preferences shekskopotolokksb

Default Data
Directory

Binary $e :
Files Are Big-Endian{HP IBM,SGI,SUN)

If Starting Time Step .4
is not specified load ast Step

When reading data  w, papts
automatically load b

New Data Notification Prompt

Select Below To Toggle Reader Visibility.
{*) Case

{*y EnSight 5

"y ABAQUS

{*y ANSYS RESULTS

{*y ESTET

{*y FAST UNSTRUCTURED
{*y FIDAP NEUTRAL

{*y FLUENT UNIVERSAL
{*) Movie

{*y MPGS 4.1

Default Reader

Sawve To Preference File

Default Data Directory ~ Will allow you to specify a default directory for data files.
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Binary Files Are

If Starting Time Step is
not specified load

When reading data
automatically load

New Data Notification

Select Below To Toggle
Reader Visibility

Default Reader

Save To Preference File

Allows you to specify the default byte order for binary files.
The allowable settings are Big-Endian, Little-Endian, or
Native To Server Machine.

Can be set so that the default starting time step for transient
data can be either Last Step or First Step.

Allows you to have EnSight automatically load A/l Parts,
First Part, Last Part, or No Parts at startup. If No Parts is
specified, the Part Loader dialog will be presented to the user
at startup.

Options for dealing with notification of a change in the
model dataset while EnSight is running. Please contact CEI
support if you have need of this.

Allows you to specify which data formats will appear in the
“Format” pull-down of the Data Reader dialog.

Allows you to specify the default data reader format.

Will save the data preferences to the preference file for future
invocations of EnSight.

(see How To Set Data Preferences:)

General User Interface

Preferences

Akt General User Interface Preferencesg #tititit:

| Taol Tips

_| Large Parts List

[7 Frame Mode Allowed
7 View Mode Allowed

Record Part Selection In Number i
Command Language By

Sawve Above Items To Preference File I

Modify and Sawve Icon Layout... I

Sawve Size and Position of Main Windows I

Tool Tips

Large Parts List

Frame Mode Allowed
View Mode Allowed

Record Part Selection in
Command Language By

Save Above Items To
Preference File

6-10

Will cause pop-up help information to appear when the
mouse is placed over certain icons while running EnSight.

Will cause a separate, larger parts list dialog (which can be
expanded) to be used in place of the normal parts list.

Will display Frame as a managed mode.
Will display View Mode as a managed mode.

Allows you to specify whether the part selections recorded in
command language will be by part Name or by part Number.

Will save the preferences above to the preference file for
future invocations of EnSight.
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Modify and Save Icon
Layout....

Show Help Labels
For Mode Icons

Button Name

Visible

Order

Description

6.2 Edit Menu Functions

Opens the Icon Bar Preferences dialog
— Icon Bar Preferences ||§||Z|
Show Help Labels For Mode Icons
Select the icon bar to change. ALl fields. except the 'Menu ID' kewwords. can be changed.
The text below is in a simpls positionsl text editor, Just select and change the text,
#NOTE#*: You nust restart EnSight to see changes to the order of the icons.
Which Icon Bar? Main Feature
Meru 10 Butt: View Visible Order Description
FEAT_COLOR  'Col Part ON 1 'Color Parts’
FEAT CHTRS  'Con annat ON 2 'Contour’
FERT_ISOSR  'Iso — ON 3 'Izosurface’
FEAT_TRACE  'Far Plot ON 4 'Particle Trace'
FERT_CLIPS 'Cli ON 5 'Clip*
FEAT_ARROH  'WVec VPort 0N & 'Vector Arrouw'
FERT_TENSOR ' Ten Frame ON 18 'Tenzor Glyeh'
FEAT_ELSRF  'Ele b ON 7 'Elevated Surface’
FERT_PROFI  'Profiles’ ON 16 'Profile’
FEAT_DVSRF  'DevelopedinSurfaces' ON 17 'Developed Surface'
FEAT_SUBST  'Subset'wnParts’ OM 8 'Subzet Parts'
FEAT_DISFL 'Displace’ ON 9 'Displacements'
FEAT_OUERY  'Query’ ON 10 'QuerysPlot*
FEAT_PROBE 'Interactive’nProbe Query' ON 11 'Interactive Probe Query'
FERAT_STIME 'SolutionnTime' OM 12 'Solution Time'
FEAT_FLIFE 'FLipbook\nfnination’' ON 13 'Fliphook Animation’
FEAT_KANIM  'KeuframesnAnimat ion ' ON 14 'Keyframe Animstion’
FEAT_CALC  'Caleulator’ ON 15 'Variable Calculator'
FERT_VORT ‘Vortex'nCores ' ON 20 'Vortex Cores'
FEAT_SHOCK  'Shock Regions/\nSurfaces' ON 21 'Shock Surfaces/Regions'
FERT_SEPATT 'Separat.,/Attach,‘nlines’ ON 22 'Separation/Attachnent. Lines'
FEAT_ENDLAY 'Boundary Lawer\r¥ariables' ON 23 'Boundary Lauer Variables'
FEAT_MATR ‘MaterialinInterface ' OM 19 'Material Parts®
Close Save As Default Help
. T
Figure 6-4

Icon Bar Preferences

When toggled on, the Icon name will appear beneath each
icon in the Mode Icon Bar. You can customize the EnSight
GUI by specifying which icons appear and their order in the
Feature and Mode Icon Bars. Do NOT modify the Menu ID
for any function. The other fields for each function may be
edited within the dialog. Customization options are:

Describes the function of the icon which would be displayed
if EnSight was started with no icons (command line
function). Further, this is the name which will appear below
the each Mode Icon when Show Help Labels For Mode Icons
is toggled on.

Determines the visibility of a feature icon. Must be either ON
or OFF.

Determines the order in which the icons appear. A value of 1
will cause the icon to appear leftmost in the Main Feature
Icon Bar and uppermost in the Mode Icon Bars.

The text description of the button which will be displayed in
the Message Area when the icon is selected. You must click
the Save As Default button to save any changes you have
made. The Button Name and Order, if modified, will not take
effect until you restart EnSight. Changes to Visibility,
Description, and Show Help Labels however, will be
implemented immediately upon clicking the Save as Default
button (and will control these options in future EnSight
sessions as well).

When EnSight is started, the icon preferences are initially
read from the $CEI_HOME/ensight76/site preferences
directory and are then overwritten by any information in the
user’s preferences directory.

(see How To Customize Icon Bars)
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Save Size and Position Will record the location and size of the main GUI, and all

of Main Windows dialogs that have been opened during the session or are
currently open and will make those locations and sizes the
default for future sessions of EnSight. Be aware also that if
you had a turn-down section open in a dialog (such as
General Attributes in the Feature Detail Editor dialog) when
you closed it earlier in the session or at the time you choose
Save Window Positions, this will be recorded as well and
opening that dialog in future sessions will also open that turn-
down section within the dialog.
(see How To Save GUI Settings)

(see How To Set General User Interface Preferences:)

Image Saving and
Printing Preferences wwkrknkk Print/Save Image Preferences * s

1} <, Click Here To Start

2) Modify any print/save image attributes in
the dialog now displayned.

3} Save To Preference File I

Click Here To Start Will allow you to modify default attributes for image saving
and printing.

Save To Preference File  Will write the current print/save preferences to the preference
file for future EnSight sessions.

(see How To Set Image Saving and Printing Preferences:)

Interactive Probe

1} <, Click Here To Start

2} In the probe guery interaction area,
that was just made available, adjust
parameters for any of the gquery types,
display attributes, items displayed,
or ‘Report By value.

3} Save To Preference File I

Click Here To Start Will allow you to modify default attributes for interactive
probe queries.

Save To Preference File  Will write the current interactive probe query preferences to
the preference file for future EnSight sessions.

(see How To Set Interactive Probe Query Preferences:)

Mouse and Keyboard
Preferences

werttt Mouse and Keyboard Preferences #ttes

Left Transf. Action
Middle Translate
Right Zoom

Picking is accomplished using the 'p' key.
Zoom Style| Manual Drag

Save Ta Preference File
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Here you can specify the actions of the three mouse buttons. Select the option you wish
to assign to each button. The options are as follows:

Transf. Action

Rotate

Translate

Zoom

Pick

Nothing

When this option is chosen (it is the default for the left
button), depressing the button and moving the mouse will
perform the transformation (rotate, translate, zoom) currently
selected in the Transformation Control Area on the model.

When this option is chosen, depressing the button and
moving the mouse will perform a rotate transformation on
the model.

When this option is chosen, depressing the button and
moving the mouse will perform a translate transformation on
the model.

When this option is chosen, depressing the button and
moving the mouse will perform a zoom transformation on the
model.

When this option is chosen, depressing the button will
perform a pick operation. If Pick has not been assigned to
one of the mouse buttons, the “p” key is used to perform the
operation. (see Pick Pull-down Icon in Section 8.1, Part
Mode)

When this option is chosen, no function is mapped to the
mouse button.

Note: One of the Mouse buttons must be assigned to Transf. Action. Macros cannot be
assigned to a mouse key which has a function assigned to it. (see How To Customize

Mouse Button Actions)

Zoom Style

Manual Drag

Automatic Slide

Save To Preference File

Choose method to use for zoom action. For either option,
zooming stops when the mouse button is released.

Zoom DISTANCE is based on the distance you move your
mouse when the mouse button is pressed.

Zoom Velocity is based on the distance the mouse is moved
when the mouse button is pressed.

Will write the current mouse and keyboard preferences to the
preference file for future EnSight sessions.

(see How To Set Mouse and Keyboard Preferences:)
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Parts

Performance
Preferences

ekt Part Preferences Ftes

Allow editing part defaults
*++ To save generic attributes for all part types:

1} Click Here To Start

2} Modify any Part mode icons now
available. For example:Line Width.

3} Save General Part Preferences To File

**+ To save attributes for specific part types:
1) Edit Attributes Guick Interaction Area

Using
2) Start Editing
For Part

3} Modify part attributes with the chosen
editor{Detail Editor or Quick Interaction

Area.

1y Save Preferences For Part

Type Chosen Tao File

Cantours

Allow Editing Part
Defaults

Generic Attributes:
Click Here To Start

Save General Part
Preferences To File

In EnSight 7.4 you can change a default attribute, such as line
width, by making sure there are no parts selected in the main
part list and changing an icon under Part mode. We used to
pop up a message to warn the user that they are changing a
default instead of a particular part if they forgot to select one.
This preference now allows or disallows changing a default
attribute. These default attributes will be used for any part
created or loaded in the future, so that the user doesn’t have
to keep changing each new part.

Will allow you to modify default visual part attributes which
apply to all part types.

Will write the current generic part preferences to the
preference file for future EnSight sessions.

Attributes For Specific Part Types:

Edit Attributes Using

Start Editing For Part

Save Preferences For
Part Type Chosen
To File

Allows you to specify which area to use for default attribute
modification - the Quick Interaction Area or the Detail
Editor Dialog.

Allows the user to specify the part type for which default
attributes will be modified.

Will write the current specific part type preferences to the
preference file for future EnSight sessions.

(see How To Set Part Preferences:)

Fkdkkkr Performance Preferences ittt

Cull Lines
Static Fast Display
Transparency Re-sort

{1=Sparse...100=Full}

Detail Repr. Point Resalution{1-100} 1
{1=Draw every pwint, 2=Draw half, ...}

Detail Repr. Sparse Model Resalution | g,

Sawve To Preference File

EnSight 7 User Manual



Plotter Preferences

Query Preferences
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Cull Lines
Static Fast Display

Transparency Re-sort

Detail Repr. Point
Resolution

Detail Repr. Sparse
Model Resolution

Save To Preference File

6.2 Edit Menu Functions

Will only draw shared lines between polygons once.

Will cause the fast representation to always be displayed. If
this is off (the default), fast display will only be active during
a transformation.

Causes polygons to be resorted with each transformation - so
the image is always correct. If not on, the polygons will not
be resorted while the mouse is down during transformations,
but will be resorted when the mouse is released.

Allows specification of fraction of nodes to display in Fast
Display, point representation. (The default is “1”, indicating
all nodes, “2” would be every other node, “3” every third
node, etc.) (EnSight Gold only)

Allows specification of the percentage of the model
geometry that will be displayed. (EnSight Gold and no
display list mode only)

Will write the current performance preferences to the
preference file for future EnSight sessions.

(see How To Set Performance Preferences:)

wwkrttt Dlather Preferenceas sttt

1} <, Click Here To Start

2) Modify any Plot mode attributes
now available. For example:
Graph Attrs: width, heightbackground...
Axiz Attrs: label format,line width...
Curwve Attrs: type, width, style...

3} Save To Preference File I

Click Here To Start

Save To Preference File

Will allow you to modify defaults for the various plotter
graph, axis, and curve attributes.

Will write the current plotter preferences to the preference
file for future EnSight sessions.

(see How To Set Plotter Preferences:)

kR Cuery Preferences #ttttis

Auto Plot Queries

Chaek Por Bwisting Plottons

Tao set guery defaults(such as the guery type):

1} Click Here To Start

2} In the guery interaction area,
that was just made available, adjust
parameters for any of the guery types,
constraints, or visibility attributes.

Sawve To Preference File

Auto Plot Queries

Automatically plot a newly created query to a plotter. The
plot will go into a new or an existing plotter, depending on
the state of the “Check for Existing Plotters” toggle.
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User Defined Input
Preferences

Check for Existing
Plotters

Click Here To Start

Save To Preference File

Check for plotters of the same type (same X and Y units) as
the new query is being autoplotted. If one exists, plot the
query to the existing plotter.

Will allow you to modify defaults for the various query
attributes.

Will write the current query preferences to the preference file
for future EnSight sessions.

(see How To Set Query Preferences:)

wkikakt User Defined Input Preferences ##tttdt

Macro Panel Interface

Part Panel Interface

Zoom Using Valuator
Sensitivity | 1 goo000
Rotate Using Mixed Maode

Sensitivity | | goo000

User Defined Input Device

Sawve To Preference File

This area provides access to user defined input devices. The input devices include a
Macro Panel Interface (a grid of commands that displays in the Main Graphics window
and executes EnSight command files upon selection), and/or a User Defined Input
Device (a virtual input device designed for - but not limited to - use with VR
environments such as an Immersadesk)

Macro Panel Interface

Part Panel Interface

User Defined Input
Device

Zoom Using

Toggles on/off the user defined macro panel (defined in your
~/.ensight7/macros/hum.define file) to the Main
Graphics window. (An example hum.define file is located at
$CEI_HOME/ensight7/src/input/HUM/hum.define

on your client system.).

Display a part list in the graphics window. This is helpful
when in full screen mode or in a VR environment, to allow
picking of parts that can be operated on via macros.

Toggles on/off the User Defined Input Device that is linked
via a runtime library. (Steps outlining the implementation of
this library and input device are found in the file:
$CEI_HOME/ensight76/src/input/README

on your client system.).

Opens a pull-down menu for selection of the type of input

device used for zoom transformations. The type of devices

are:

Valuator  a device that returns a value (like a virtual
joystick).

Position  a device that returns delta movement in the Z
direction (like a wand).
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Sensitivity

Rotate Using

Sensitivity

Save To Preference File

6.2 Edit Menu Functions

Specifies a positive scalar value that adjusts the Sensitivity of
the type of zoom input device selected in Zoom Using (i.e.
values < 1 are slower, and values > 1 are faster).

Opens a pull-down menu for selection of the type of input
device used to record rotation transformations.

Mixed Mode A device that returns virtual angle values
where the Z rotations correspond to
(literal) movement of the input device
about its local Z (or roll) axis; and where
the X and Y rotations correspond to
translational movements of the input
device with respect to its local X and Y

axes.

Direct Mode A device that returns virtual angle values
that correspond to (literal) rotational
movements of the input device about its

local X, Y, and Z axes.

Specifies a positive scalar value that adjusts the Sensitivity of
the type of rotation input device selected in Rotate Using (i.e.
values < 1 are slower, and values > 1 are faster).

(see How To Enable User Defined Input Devices)

Will write the current user defined input preferences to the
preference file for future EnSight sessions.

(see How To Set User Defined Input Preferences:)

Variables Preferences

wkkkkRERE N o e ah]e Preferences Fhtit

For a General Function.
{*)Area

{(*)CaseMap
{(*ICoeff

{(*3Cmplx
(ICmplxArg
{(*ICmplxConj
(ICmplxImag
(*ICmplxModu
{(*)CmplxReal
(*ICmplxTransResp

Nuotify Before Activating A Variable

Select Below To Toggle Visibility

Sawve To General Variable Preferences File

Modify Extended CFD Variable Settings...
Save To Extended CFD Preference File

Notify Before Activating

A Variable

Select Below To Toggle
Visibility For a General
Function

EnSight 7 User Manual

Will cause you to be notified before a variable, which was
going to be automatically activated, is actually activated.

Toggle visibility of functions in the General Functions list of
the new variable calculator dialog. There are many general
functions and this allows you to limit the list to only
functions that you wish to use.
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Save To General Variable Will write the variable notification preference to the

Preferences File

Modify Extended CFD
Variable Settings...

Save To Extended CFD
Preference File

Density

Total Energy Per
Unit Volume

Ratio of Specific
Heats

Momentum or
Velocity

Freestream Mach #

Gas Constant

preference file for future EnSight sessions.

Opens the Extended CFD Variable Settings dialog. If your
data defines variables or constants for density, total energy
per unit volume, and momentum (or velocity), it is possible
to show new variables defined by these basic variables in the
Main Variables List of the GUI by utilizing the capabilities of
this dialog.

Select a variable and then select
the appropriate SET button below.

Qa1
Q5
momertun
Coordinates
Time

]

Density 1.0000e-+00 ser|
| {(Can be a constant) I . Al —I
Total Energy Per SET
| Unit Volume I —I
Ratio of Specific Heats 1.1000e+00 SET
{Can be a constant} I . Al
Momentum I SET
] —-OR-—-
Velocity I SET

Freestream Mach # | 1.0000e+00
Gas Constant I 1.0000e-+00

Freestream Density [ g000e-+00

Freestream Speed I 1 0000+00
of Sound :

| Show Extended CFD Variables

OkayI Cancel I Help I

Figure 6-5
Extended CFD Variable Settings Dialog

Will write the current Extended CFD settings to the
preference file for future EnSight sessions.

Permits the selection of the density variable from the list
(click SET after selection) or the specification of a constant
value in the field provided.

Permits the selection of the energy variable from the list.
Click SET after selection.

Permits the selection of the ratio of specific heats variable
from the list (click SET after selection) or the specification of
a constant value in the field provided.

Permits the selection of the momentum or velocity variable
from the list. Click SET after selection.

Permits the specification of the freestream mach number in
the field provided.

Permits the specification of the gas constant in the field
provided.
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Freestream Density Permits the specification of the freestream density value in

the field provided.
Freestream Speed  Permits the specification of the freestream speed of sound
of Sound value in the field provided.
Show Extended When selected, all of the variables that can be derived from

the information entered will be

CFD Variables Shown in the Main Variables List of the GUI. (will not take
effect until the Okay button is clicked.

Okay Clicking this button applies the changes made in the dialog.
(See How To Create New Variables)

Save To Extended CFD  Will write the current extended CFD preferences to the
Preference File extended CFD preference file for future EnSight sessions.

(see How To Set Variable Preferences:)

View Preferences

dkkERRRE 1] e Prefepences Frbttitis

Plane Tool Filled

Use graphics hardware to offset line objects
from =olid surfaces. (Ex. offset contours, vecto}
arrows, ete, from their clip plane parent part.}

Default Orientation Look from +Z axis
Please set the main interface '"View' menu

items as you would prefer them to be for
defaults. Then select Save below.

Sawve To Preference File

Plane Tool Filled Will cause the plane tool to be a filled transparent surface. If
it is off, the plane tool will be in line drawing mode. You can
save this default to the preference file.

Save To Preference File ~ Will write the current view preferences to the preference file
for future EnSight sessions.

Use Graphics Hardware There are two offsets employed in EnSight. This one,

to offset line objects hardware offset, is perpendicular to the monitor screen, and
done in hardware if this toggle is on. This will allow, for
example, contour lines to appear closer to the viewer than
their parent part so they are visible no matter what orientation
the part is viewed from. The second offset is the display
offset. The display offset can be set in the feature detail
editor for line parts such as contour lines, particle trace lines,
vector arrows, and separation/attachment lines. The display
offset is the distance in the direction of the element normal
(perpendicular to the surface).

Default Orientation The default axis for viewing can be selected and set.

(see How To Set View Preferences:)
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Viewport Preferences

wkkEE Y jgwport Preferences #Hirskiiis

1} Click Here To Start

2) Modify any Vport mode attributes
now available. For example:
Background Color: constant, blended...
Border Attrs: visibility, color...
3D/2D Grid Attrs: line width color,gradations...

3}  Save Defaults To Preference File

Sawve Current Layout To Preference File

Click Here To Start

Modify and Vport
mode attributes now
available

Save Defaults To
Preference File

Save Current Layout
To Preference File

Will allow you to modify default viewport attributes.

Select Vport along the left side of the main window. The
attributes for viewports will appear in the iconbar for you to
modify. Attributes as shown above and many others may be
set.

Will write the current viewport default values to a preference
file for future EnSight sessions.

Will write out the current viewport screen layout to a file for
future EnSight sessions.
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6.3 Query Menu Functions

Show Information

Cursor

Node

EnSight 7 User Manual

Clicking the Query button in the Main Menu opens a pull-down menu which
provides access to the following features:

File Edit gueryl View Tools Case Help

Show Information =

Over Time/Distance...

Interactive Probe...

Dataset...

Figure 6-6
Query pull-down menu

EnSight provides several ways to examine information about variable values. You can, of
course, visualize variable values with fringes, contours, vector arrows, profiles,
isosurfaces, etc. Only parts with data residing on the Server host system may be queried.
Thus, parts that reside exclusively on the Client host system (i.e. contours, particle traces,
profiles, vector arrows) may NOT be queried.

(see Table 3—2 Part Creation and Data Location)

Opens the following pull-down menu:

Show Information L ‘Cursor

Over Time/Distance... Node...

Interactive Probe... 1JK...

Dataset... Element...
Part

Figure 6-7
Show Information pull-down menu

Access: Main Menu > Query > Show Information

(see How To Get Point, Node, Element and Part Information)

Provides the following information in the Status History Area about a Point inside of the
selected Part(s) who’s position you have specified with the cursor tool:
x,y,z coordinates, Frame assignment of Point, the Part that the Point is found in,
the closest Node to the Point, and the specified Variable value at the Point
Access: Main Menu > Query > Show Information > Point
(see How To Get Point, Node, Element and Part Information and How To Use the Cursor
(Point) Tool)

Opens the Query Prompt dialog which is used to specify Node ID number.

1 Please select the parts and variables you wish to use |
1 for your guery, then enter the Node ID and select Okay.|;

| Node ID? M
: OkayI Cancell

Figure 6-8
Query Prompt dialog
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UK

Element

Part

Over Time/Distance

When Okay button is pressed, the following information about the specified Node is
shown in the Status History Area:
x,y,z coordinates, Frame assignment of Node, the Part that the Node is found in,
and the specified Variable value at the Node
Access: Main Menu > Query > Show Information > Node...

(see How To Get Point, Node, Element and Part Information)

Opens the Query Prompt dialog which is used to specify IJK values.

Please select the parts and variables you wish to use
for your gquery, then enter the IJK values and select Oka;

Okay Cancel I

Figure 6-9
Query Prompt for IJK Values

When Okay button is pressed, the following information about the Node specified by the
IJK values is shown in the Status History Area:

Node ID, Part in which the Node is located, x,y,z coordinates of the Node,

Frame assignment of the Node, and the specified Variable value at the Node.
Access: Main Menu > Query > Show Information > IJK...

(see How To Get Point, Node, Element and Part Information)

Opens the Query Prompt for Element ID.

Please select the parts and variables you wish to use
| for your gquery, then enter the Element ID and select Okay.

| Element ID? s
OkayI Cancell

Figure 6-10
Query Prompt for Element ID

When Okay button is pressed, the following information about the Element is shown in

the Status History Area:
Part in which Element is located, Type of Element, IJK bounds (if a structured
mesh), Number of Nodes, Node ID numbers, information on neighboring
Elements, and the specified Variable value at the Element.

Access: Main Menu > Query > Show Information > Element...

(see How To Get Point, Node, Element and Part Information)

Causes the following information about the Part to be shown in the Status History Area:
Part type (structured or unstructured), number of Nodes in Part, minimum and
maximum X,y,z coordinates, Element type, and the number of Elements.

Access: Main Menu > Query > Show Information > Part

(see How To Get Point, Node, Element and Part Information)

Opens the Query/Plot Editor in the Quick Interaction Area which is used to obtain
information about variables and to create plots of the information.
Access: Main Menu > Query > Over Time/Distance...

(see Section 7.11, Query/Plot, How To Query/Plot)
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Dataset
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Opens the Interactive Probe Query Editor in the Quick Interaction Area which is used to

obtain information interactively about variables.
Access: Main Menu > Query > Interactive Probe...

(see Section 7.12, Interactive Probe Query and How To Probe Interactively)

Opens the Query Dataset dialog which is used to obtain information about datasets for the

selected case.

A iated Files

Filename Size

cube,res L)
cube, tenp 107955 Wed Aug 30 08130
cube,velo 323837 Wed Aug 30 08130

e —
File Specific Information

-

Thiz is the cube datas with formatted
data (%8d,. 13.5F). 1dth Jul 7593,
node id assign

element id of ¥

o —

General G tric

Coordinate System Type: Rectangular
Model Extents:

in Ma
W =2,0000e+00 300008 +00

-]

El t Detail
Element Type Mumber of

hexad 7512

Figure 6-11
Query Dataset dialog

For the specified file, specific, general and detail information is provided.

Access: Main Menu > Query > Dataset...

(see Section 7.11, Query/Plot and How To Query Datasets)

6.3 Query Menu Functions
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6.4 View Menu Functions

Fast Display

Shaded Toggle

Clicking the View button in the Main Menu opens a pull-down menu which
provides access to the following features:

File Edit Query View | Tools Case

Fast Display

Shaded

Hidden Line
Perspective
Auxiliary Clipping
Show Selected Part{s)...
Axis Triad Visibility
Bounds Visibility
Label Visibility
Legend
Text/Line/Logo
Static Lighting

Figure 6-12
View pull-down menu

Toggles the Fast Display mode.
Access: Main Menu > View > Fast Display

Fast Display in this pull-down is the same as the one located on the Desktop.

By default, EnSight displays all of the lines and elements for each part every time the
Main View window redraws. If you have very large models (or if you have slow graphics
hardware), each redraw can take significant time. As a result, interactive transformations
become jerky and lag behind the motion of the mouse. Ironically, the slower the graphics
performance, the harder it is to perform precise interactive transformations. To avoid this
problem, you can tell EnSight to show a lesser detailed part representation, i.e, a bounding
box surrounding each Part, or the Part as a point cloud. You can select to show the detail
representation all the time, or only while you are performing transformations. This
obviously displays much less information, but may be sufficient if you want to rotate a
very large model.

A lesser detail display is also useful when experimenting with keyframe-animation rates.
Using lesser detail, the display rate can be adjusted to approximate the video rate, thus you
can see how your scene will transform on the video tape

The default setting is off, indicating that all lines and elements of all visible parts will be
redrawn. When on, the redraw will show only the part’s Fast Display Representation (by
default a box). The fast display representation is only used while transformations are being
performed. The fast display representation will be continuously displayed if the Static Fast
Display option is turned on in:

Main Menu > Prefs > Graphics Window > Static Fast Display.

Toggles the Global Shaded mode for parts on and off. (The Shaded Toggle in the View
Mode Icon Bar performs the same action.) EnSight by default displays parts in line mode.
Shaded mode displays parts in a more realistic manner by making hidden surfaces
invisible while shading visible surfaces according to specified lighting parameters. Parts
in Shaded mode require more time to redraw than when in line mode, so you may wish to
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first set up the Graphics Window as you want it, then turn on Shaded to see the final result.
Access: EnSight dialog > View > Shaded

or View Mode Icon Bar: Shaded Toggle

or Desktop > Shaded
(see Section 8.6, View Mode and How To Set Drawing Style)

Troubleshooting Hidden Surfaces and Shading

Problem Probable Causes Solutions

Main View shows line drawing after Shaded is toggled off for each Toggle Shaded on for individual

turning on Shaded. individual part. parts with the Shaded Icon in Part
Mode or in the Feature Detail Editor
dialog.

There are no surfaces to shade—all  If parts are currently in Feature

parts have only lines. Angle representation, change the
representation. If model only has
lines, you can not display shaded
images.

The element visibility attributes has  Toggle the element visibility on for

been toggled off for the part(s). individual parts in the Feature Detail
Editor dialog.
Hidden Line Toggles the global Hidden Line display for all parts on/off. (The Hidden Line Toggle icon
Toggle in the View Mode Icon Bar performs the same action.) This simplifies a line drawing

display by making hidden lines - lines behind surfaces - invisible while continuing to
display other lines. Hidden Line can be combined with Shaded to display both surfaces
and the edges of the visible surface elements. Hidden Line can be toggled on/off for
individual parts by using the Hidden Line Toggle icon in the Part Mode Icon Bar.

To have lines hidden behind surfaces, you must have surfaces (2D elements). If the
representation of the in-front parts consists of 1D elements, the display is the same
whether or not you have Hidden Lines mode toggled-on. During interactive
transformations, the display reverts to displaying all lines. When you release the mouse
button, the Main View display automatically resumes Hidden Line mode. The Hidden line
option will not be active during playback of flipbook animations.

Hidden line overlay is disabled if transparency is turned on.

Access: Main Menu > View > Hidden Line
or View Mode Icon Bar: Hidden Line Toggle
(see Section 8.6, View Mode and How To Set Drawing Style)

Hidden Line Overlay dialog

[ Feen Line Overlay ]

***Naote: Hidden line can reduce transformation speed.
Please remember to turn if off when not needed.

4 Specify Line Overlay Color

Blo Gl1 B2 Mix...
Okay Cancell
Figure 6-13

Hidden Line Overlay dialog
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If you combine Shaded mode with Hidden Line mode, the lines overlay the surfaces. The
Hidden Line Overlay dialog will pop-up on the screen if the Shaded option is currently on
and you then turn the Hidden Line option on. From this dialog you specify a color for the
displayed lines (you do not want to use the same color as the surfaces since they then will
be indistinguishable from the surfaces). The default is the part-color of each part, which

may be appropriate if the surfaces are colored by a color palette instead of their part-color.

Specify Overlay ~ Toggle-on if you want to specify an overlay color. If off, the overlay line color will be the
same as the part color.

R,G B The red, green, and blue components of the hidden line overlay. These fields will not be
accessible unless the Specify Overlay option is on.

Mix... Click to interactively specify the constant color used for the hidden line overlay using the
Color Selector dialog.
(see Section 7.1, Color and How To Change Color)

Okay Click to accept the hidden line overlay color options.
Perspective Toggles the view within each of the viewports within the Graphics Window between a
(Global) Toggle perspective view (the default) and an orthographic projection. Perspective is what gives

you the sense of depth when viewing a three dimensional scene on a two dimensional
surface. Objects that are far away look smaller and parallel lines seem to meet at infinity.
Orthographic projection removes the sense of depth in a scene. Lines that are parallel will
never meet and objects of the same size all appear the same no matter how far away they
are from you. Orthographic projection mode often helps when you are positioning the
Cursor, Line, and Plane tools using multiple viewports. This is the Global toggle. Each
viewport also has a Perspective Toggle.

Access: Main Menu > View > Perspective

(see Section 8.4, VPort Mode and see How To Set Global Viewing)

Auxiliary Clipping Toggles the Auxiliary Clipping feature on/off. (Default is Off). The Auxiliary Clipping

Global Toggle Global Toggle icon in the View Mode Icon Bar performs the same action. Like a Z-Clip
plane, Auxiliary Clipping cuts-away a portion of the model. When Auxiliary Clipping is
On, Parts (or portions of Parts) located on the back (negative-Z) side of the Plane Tool are
removed. Parts whose Clip attribute you have toggled off (in the General Attributes
section of the Feature Detail Editor dialog or with the Auxiliary Clipping Toggle Icon in
the Part Mode Icon Bar) remain unaffected.

Auxiliary Clipping is interactive—the view updates in real time as you move the Plane
Tool around
(see Section 6.5, Tools Menu Functions and How To Use the Plane Tool).

Unlike a Z-Clip plane, Auxiliary Clipping applies only to the parts you specify, and the
plane can be located anywhere with any orientation though it is always infinite in extent
(see Section 9.6, Z-Clip and How To Set Z Clipping).

Auxiliary Clipping is helpful, for example, with internal flow problems since you can
“peel” off the outside parts and look inside. This capability is also often useful in

animation.

The position of the Plane Tool and the status of Auxiliary Clipping is the same for all
displayed viewports.
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Do not confuse Auxiliary Clipping with a 2D-Clip plane, which is a created part whose
geometry lies in a plane cutting through its parent parts or with the Part operation of
cutting a part.

(see Section 3.4, Part Operations, How to Create Plane Clips, and How To Cut a Part).

Troubleshooting Auxiliary Clipping

Problem

Probable Causes Solutions

The Plane Tool does not appear to The Auxiliary Clipping toggle is off Turn the Auxiliary Clipping toggle

clip anything for all parts. on for individual parts in the Feature
Detail Editor (Model) dialog General
Attributes section.
The Plane Tool is not intersecting the Change the position of the Plane
model Tool.
The Main View window shows All of the part(s) is(are) on the back  Change the position of the Plane
nothing other than the Plane Tool side of the Plane Tool and is(are) Tool.
after Clipping is toggled-on. thus clipped

Axis Triad Visibility

Frame Toggle

Global Toggle

Label Visibility

BoundsVisibility

Element Labeling
Toggle

EnSight 7 User Manual

Opens the pull-down menu which allows you to toggle on/off the visibility of the Global
axis triad, the axis triads for all Frames, and the model axis triad.

Toggles on/off (default is On) the display of all coordinate Frame axis triads. (The All
Frame Axis Triad Visibility Toggle icon in the Frame Mode Icon Bar performs the same
function.)The visibility of individual coordinate Frame axes can be selectively turned on/
off by clicking on the Frame’s axis triad and then clicking on the Frame Axis Triad
Visibility Toggle in the Frame Mode Icon Bar.

Access: Main Menu > View > Axis Visibility > Axis - Local

(see Section 8.5, Frame Mode)

Toggles on/off (default is Off) the display of the global coordinate frame axis. (The Global
Axis Visibility Toggle icon in the Frame Mode Icon Bar performs the same function.)The
global coordinate frame axis triad represents the Look-At Point.

Access: Main Menu > View > Axis Visibility > Axis - Global

(see Section 8.6, View Mode)

Opens the pull-down menu which allows you to toggle on/off the visibility of labels for
Elements or Nodes.

Toggles on/off (default is Off) the extents box for all parts.

Toggles on/off (default is Off) the global visibility of labels (if they are available in the
dataset) for elements in all parts. (The Element Label Toggle in the View Mode Icon Bar
performs the same function.) Visibility of element labels for individual parts can be
controlled in the Node, Element, and Line Attributes section of the Feature Detail Editor
(Model).

Access: Main Menu > View > Label Visibility > Element Labeling

(see Section 8.6, View Mode)
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Node Labeling
Toggle

Legend Toggle

Text/Line/Logo Toggle

Static Lighting

6-28

Toggles on/off (default is off) the global visibility of labels (if they are available in the
dataset) for nodes in all parts. (The Node Label Toggle in the View Mode Icon Bar
performs the same function). Visibility of node labels for individual parts can be
controlled in the Node, Element, and Line Attributes section of the Feature Detail Editor
(Model).

Access:Main Menu > View > Label Visibility > Node Labeling

(see Section 8.6, View Mode)

Toggles on/off (default is on) the global visibility of all legends. (the Legend Visibility
Toggle Icon in the Annotation Mode Icon Bar performs the same function). Visibility of
individual legends can be controlled by using the Show Legend button above the Feature
Icon Bar. Clicking the Show Legend button will make visible only those legends for
variables which are selected in the Variables List, and then only if Legend Visibility is
toggled on. If a Legend has been made visible by selecting a variable and then clicking the
Show Legend button, deselecting the variable and clicking the Show Legend button again
will turn visibility off for that individual legend.

Access: Main Menu > View > Legend

(see Section 4.2, Variable Summary & Palette, Section 8.2, Annot Mode and How To
Create Color Legends.

Toggles on/off global visibility for text strings and lines which have been created and
logos which have been imported. (The Text/Line/Logo Visibility Icon in the Annotation
Mode Icon Bar performs the same function). Visibility of individual Text strings, Lines, or
Logos can be controlled by selecting the item while in Annotation Mode and clicking the
Visibility Toggle in the Annotation Mode Icon Bar. While in Annot Mode, you will notice
that the item does not disappear, but turns transparent. Such items will not appear in the
Graphics Window in any Mode except Annotation Mode, and then only if global visibility
has been turned on.

Access: Main Menu > View > Text/Line/Logo

(see Section 8.2, Annot Mode, How To Create Lines and Arrows, How To Create Text
Annotation, and How To Load Custom Logos.

Toggles on/off whether the light source moves as the model transforms, or instead remains
stationary. Static lighting only affects shaded surfaces (i.e., Hidden Surfaces mode is
toggled-on). When the Static Lighting option is off (the default), the light source remains
fixed as you transform the model. Your graphics hardware performs the lighting
calculations each time the Graphics Window redraws.

When the Static Lighting option is on, the light source moves with the model (it is the
lighting of the model that remains “static”). EnSight performs the lighting equations once.
This can greatly improve graphics performance, especially when color fringes are on in
which case the performance boost may be as much as a factor of five. Also, memory
requirements are somewhat less with Static Lighting, an important point to remember if
you are loading flipbook animation pages as objects. However, keep in mind that this
performance improvement comes at the cost of realism since the display’s lighting does
not update when the scene moves.

Access: Main Menu > View > Static Lighting
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6.5 Tools Menu Functions

Cursor Tool
Toggle

Line Tool Toggle

Plane Tool

EnSight 7 User Manual

The Cursor, Line, Plane, and Quadric (cylinder, sphere, cone, and revolution)
Tools in EnSight are used for a variety of tasks, such as: positioning of clipping
planes and lines, query operations, particle trace emitters, etc. Collectively these
tools are referred to as Positioning Tools. Clicking the Tools button in the Main
Menu opens a pull-down menu which provides access to these features:

File Edit Query View Tools | Case Help
Cursor
Line
Plane
Box
Quadric

Tool Positions...

Figure 6-14
Tools pull-down menu

Makes the Cursor Tool visible/invisible in the Graphics Window. The Cursor Tool appears
as a three-dimensional cross colored red, green, and blue. The red axis of the cross
corresponds to the X axis direction for the currently selected Frame, while green matches
the Y and blue matches up with the Z. The Cursor Tool is initially located at the Look-At
point and may be repositioned interactively in the Graphics Window by selecting and
dragging it or by selecting Pick Cursor Location from the Pick Pull-down Icon menu in
the Part Mode Icon Bar. Alternatively, you can reposition it precisely by specifying
coordinates in the Transformation Editor dialog (described in Tool Positions... Cursor

Mode below).
Access: Main Menu > Tools > Cursor
or Desktop > Cursor

(see Section 8.1, Part Mode and How to Use the Cursor (Point) Tool)

Makes the Line Tool visible/invisible in the Graphics Window. The Line Tool appears as a
white line with a cross at the center point. The Line Tool is initially centered about the
Look-At point and sized so that it fills approximately 10% of the default view. You can
change its length and orientation interactively in the Graphics Window by selecting one of
its end points. You can reposition it interactively in the Graphics Window by selecting its
center and dragging it or by selecting Pick Line Location from the Pick Pulldown Icon
menu in the Part Mode Icon Bar. Alternatively, you can reposition it precisely by
specifying coordinates in the Transformation Editor dialog (described in Tool Positions...

Line Mode below).
Access: Main Menu > Tools > Line
or Desktop > Line

(see Section 8.1, Part Mode and How to Use the Line Tool)

Makes the Plane Tool visible/invisible in the Graphics Window. (Note: Its appearance
(line or filled) is controlled under Main Menu > Edit > Preferences > View)

Access: Main Menu > Tools > Plane

or Desktop > Plane

The Plane Tool is shown with an X, Y, Z axis system, is initially centered about the Look-
At point, and lies in the X-Y plane. You can reposition it interactively in the Graphics
Window by selecting its center point in the Graphics Window and dragging it or by
selecting Pick Plane Location from the Pick Pull-down Icon menu in the Part Mode Icon
Bar. Alternatively, you can reposition it precisely by specifying coordinates in the
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Transformation Editor dialog (described in Tool Positions... Plane Mode below). You can
change its orientation interactively in the Graphics Window by selecting the X, Y, or Z
letters at the ends of the axes. You can resize the Plane Tool interactively in the Graphics
Window by selecting the corner or the plane between the ends of the X and Y axes.

(see Section 8.1, Part Mode and How to Use the Plane Tool)

Box Tool Makes the Box Tool visible/invisible in the Graphics Window.
Access: Main Menu > Tools > Box

The Box Tool is shown with an X, Y, Z axis system and is initially centered about the
Look-At point. You can resize it interactively in the Graphics Window by selecting any of
its corner points and dragging. You can reposition it interactively in the graphics window
by selecting the origin of the box and dragging. You can perform these types of operations
as well as rotations, in the Transformation Editor dialog (described in Tool Positions...
Box Mode below). You can even reposition it precisely by specifying coordinates in the
Transformation Editor dialog.

(see Section 8.1, Part Mode and How to Use the Box Tool)

Quadric Opens a pull-down menu which allows you to choose one of the Quadric Tools and make
it visible.
Access: Main Menu > Tools > Quadric

Quadric r[
S

Figure 6-15
Quadric Tool pull-down menu

Cylinder Tool Makes the Cylinder Tool visible/invisible in the Graphics Window. The Cylinder Tool
Toggle appears as thick direction line with center point and a circle around the line at the mid and
two end points. Thinner projection lines run parallel to the direction line through the three
circles outlining the surface of the cylinder. The Cylinder Tool is initially centered about
the Look-At point with the direction line pointing in the X direction. You can change its
length and orientation interactively in the Graphics Window by selecting one of its end
points. You can change its diameter by selecting the circle about the mid point. You can
reposition it interactively in the Graphics Window by selecting its center or alternatively,
you can reposition it precisely by specifying coordinates in the Transformation Editor
dialog (described in Tool Positions... Quadric below).
Access: Main Menu > Tools > Quadric
(see How to Use the Cylinder Tool)

Sphere Tool Makes the Sphere Tool visible/invisible in the Graphics Window. The Sphere Tool
Toggle appears as thick direction line with several circles outlining the sphere. The Sphere Tool is
initially centered about the Look-At point with the direction line pointing in the X
direction. You can change its radius and orientation interactively in the Graphics Window
by selecting one of the thick direction line end points. You can reposition it interactively in
the Graphics Window by selecting its center or alternatively, you can reposition it
precisely by specifying coordinates in the Transformation Editor dialog (described in Tool
Positions... Quadric below).
Access:Main Menu > Tools > Quadric
(see How to Use the Sphere Tool)
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Makes the Cone Tool visible/invisible in the Graphics Window. The Cone Tool appears as
thick direction line with a circle at the end point. Thinner projection lines run from the
beginning point to the circle at the end point outlining the surface of the cone. The Cone
Tool is initially centered about the Look-At point with the direction line pointing in the X
direction. You can change its length and orientation interactively in the Graphics Window
by selecting one of the thick direction line end points. You can change its diameter by
selecting the largest circle about the end point. You can reposition it interactively in the
Graphics Window by selecting its center or alternatively, you can reposition it precisely by
specifying coordinates in the Transformation Editor dialog (described in Tool Positions...
Quadric below). The cone tool always operates as if the tool extends infinitely from the
origin at the half angle. The half angle of the cone tool is in degrees.

Access: Main Menu > Tools > Quadric

(see How to Use the Cone Tool)

Makes the Surface of Revolution Tool visible/invisible in the Graphics Window. The
Revolution Tool appears as thick direction line with several circles outlining each user
defined point along the tool. Thinner projection lines run through the circles to outline the
revolution surface. The Revolution Tool is initially centered about the Look-At point with
the direction line pointing in the X direction. You can change its length and orientation
interactively in the Graphics Window by selecting one of the thick direction line end
points. You can reposition it interactively in the Graphics Window by selecting its center
or alternatively, you can reposition it precisely by specifying coordinates in the
Transformation Editor dialog (described in Tool Positions... Quadric below).

Access: Main Menu > Tools > Quadric

(see How to Use the Surface of Revolution Tool)

Opens the Transformation Editor dialog which allows you to precisely position the various
tools within the Graphics Window in reference to the selected Frame.
Access: Main Menu > Tools > Tool Positions...

Clicking on Editor Function in the Transformation Editor dialog and then selecting Tools
> Cursor from the pull-down menu configures the dialog as shown below.

- Transformation Editor {Cursor Tool) [O][=]
File Editor Function Help
Transform Action: m % m yiki
About Axis: X ¥ A All

0.0 +
Which Frame Scale Settings
Coord. frame 0 Increment | | pogpon
Limit
Coord. frame 2 2.000000

*##4+ Cartesian Coordinates #+++
##4% of Cursor Tool in Frame 1 #++

X ¥ z

-1.6570e+01 4.0198e+01 3.988Te+01

Figure 6-16

Transformation Editor (Cursor)
Cloze

The Transformation Editor dialog provides three methods for the precise positioning of
the Cursor Tool. First, the Cursor Tool may be positioned within the Graphics Window by
entering coordinates in the X, Y, and Z fields. Pressing return causes the Cursor Tool to
relocate to the specified coordinates in the selected Frame (or, if more than one Frame is
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Line Tool

Position

selected, for Frame 0).

It is also possible to reposition the Cursor Tool from its present coordinate position by
specific increments. The Axis Button allows you to choose the axis of translation (X, Y, Z,
or All). The Slider Bar at Top allows you to quickly choose the increment by which to
move the position of the Cursor Tool. Dragging the slider in the negative (left) or positive
(right) directions and then releasing it will cause the X, Y, and Z coordinate fields to
increment as specified and the Cursor Tool to relocate to the new coordinates. The number
specified in the Limit field of the Scale Settings area determines the negative (-) and
positive (+) range of the slider. If the Limit is set to 1.0 as shown, then the numerical range
of the slider bar will be -1 to +1.

Alternatively, you can specify an increment for translation in the Increment field of the
Scale Settings area. Pressing return while the mouse pointer is in the Increment field will
cause the Cursor Tool to translate along the specified axis (or all axes) by the increment
specified.

Access: Transformation Editor > Editor Function > Tools > Cursor

(see How to Use the Cursor (Point) Tool)

Clicking on Editor Function in the Transformation Editor dialog and then selecting Tools
> Line from the pull-down menu configures the dialog as shown below.

- Transformation Editor (Line Tool) [O][=]
File Editor Function Help
Transform Action: m % m %& Scale |Con
About Axis: X ¥ All
0.0 ¥ Translate lcon
Which Frame Scale Settings
Coord. frame 0 Increment | | ypggog

Coord. frame 1

Limit 2,000

*##4+ Cartesian Coordinates #+++
##4% of Line Towol in Frame 2 ###++

X ¥ z
-1.1925e+01 1.0198e-+01 3.9587e+01
8.7850e-+00 1.0198e-+01 3.9587e+01

Length | 5 0710e+01

Figure 6-17

a Transformation Editor (Line Tool)
Lol

The Transformation Editor can control precisely the position and size of the line tool.

The Transformation Editor dialog provides three methods for the precise positioning of
the Line Tool. First, the Line Tool may be positioned within the Graphics Window by
entering coordinates for the two endpoints in the X, Y, and Z fields. Pressing return causes
the Line Tool to relocate to the specified coordinates in the selected Frame (or if more than
one Frame is selected, in Frame 0).

It is also possible to reposition the Line Tool from its present coordinate position by
specific increments. First click on the translate icon. The Axis Button allows you to
choose the axis of translation for the center of the line (X, Y, Z, or All). The Slider Bar at
Top allows you to quickly choose the increment by which to move the position of the
center point of the Line Tool. Dragging the slider in the negative (left) or positive (right)
directions and then releasing it will cause the X, Y, and Z coordinate fields to increment as
specified and the Line Tool to relocate to the new coordinates. The number specified in the
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Limit field of the Scale Settings area determines the negative (-) and positive (+) range of
the slider. If the Limit is set to 1.0 as shown, then the numerical range of the slider bar will
be -1 to +1.

Alternatively, you can specify an increment for translation in the Increment field of
the Scale Settings area. Pressing return while the mouse pointer is in the Increment field
will cause the center point of the Line Tool to translate along the specified axis (or all
axes) by the increment specified.

First click on the scale icon. Next pick an increment and limit and slide the slider to scale
the line about its center, along its length.

Access: Transformation Editor > Editor Function > Tools > Line
(see How to Use the Line Tool)

Clicking on Editor Function in the Transformation Editor dialog and then selecting Tools
> Plane from the pull-down menu configures the dialog as shown below.

- Transformation Editor (Ptane Tool) ||§HZ|
File Editor Function Help
Transform Action: -1 =) %g SCale ICOn

About Axis: X \Z\All
.

"
Which Frame Seale Settings
Inerement [ 1 po0000

Limit 80.000000

Translate Icon

| Rotate Icon

*** Cartesian Coordinates *+++
#tt of Plane Tool in Frame 0 #+++

X ¥ z
Origin | 5 pnone-01 5.00002-01 1.0000e+00
Normal | 0,0000e+00 0.0000e+00 1.0000e-+00

XSize [55000e+00 | ¥-5i2e |2 5000e+00

........ Plane Equation s
X + ¥ + ¥4

0000000 0.000000 1000000

= | 1.000000

X Y Z
! 75000001 75000801 1.0000-+00
1.7500e-+00 75000801 1.0000-+00

1.7500+00 1.7500e+00 1.0000e+00

Figure 6-18

Close Transformation Editor (Plane Tool)

The Transformation Editor can control precisely the position, orientation, and size of the
plane tool.

The Transformation Editor dialog provides four methods for the precise positioning of the
Plane Tool. First, the Plane Tool may be positioned within the Graphics Window by
entering coordinates for the three corners of the plane in the X, Y, and Z fields. Corner 1 is
defined as the -X, -Y corner of the plane, Corner 2 is defined as the +X, -Y corner of the
plane, and Corner 3 is defined as the +X, +Y corner of the plane. Pressing return causes
the Line Tool to relocate to the specified coordinates in the selected Frame (or if more than
one Frame is selected, in Frame 0).

You can also position the Plane Tool by entering a plane equation in the form
Ay +By+C,=D in the X+Y+Z fields and then pressing Return. The coefficients of the

plane equation are in reference to the selected Frame (or if more than one Frame is
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Orientation

Scale

Box Tool

Position
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selected, to Frame 0).

As with the Cursor and Line Tools, it is possible to reposition the Plane Tool from its
present coordinate position by specific increments. First click the translate icon at the top
of the Transformation Editor. The Axis Button allows you to choose the axis of
translation (X, Y, Z, or All) for the origin of the Plane Tool (intersection of the axes). The
Slider Bar at Top allows you to quickly choose the increment by which to move the
position of the origin. Dragging the slider in the negative (left) or positive (right)
directions and then releasing it will cause the X, Y, and Z coordinate fields to increment as
specified and the origin of the Plane Tool to relocate to the new coordinates. The number
specified in the Limit field of the Scale Settings area determines the negative (-) and
positive (+) range of the slider. If the Limit is set to 1.0 as shown, then the numerical range
of the slider bar will be -1 to +1.

Alternatively, you can specify an increment for translation in the Increment field of the
Scale Settings area. Pressing return while the mouse pointer is in the Increment field will
cause the center of the Plane Tool to translate along the specified axis (or all axes) by the
increment specified.

First click on the rotate icon. Next, pick an axis about which to rotate. Next pick an
increment and limit (in degrees) and slide the slider to rotate the plane.

First click on the scale icon. Next pick an axis direction to scale (X or Y only). Finally
pick an increment and limit and slide the slider to scale the size of the plane.

Access: Transformation Editor > Editor Function > Tools > Plane
(see How to Use the Plane Tool)

Clicking on Editor Function in the Transformation Editor dialog and then selecting Tools
> Box from the pull-down menu configures the dialog as shown below.

- Transformation Editor (Box Tool) o][x]
File Editor Function Help
Transform Action:
A= Ol Scale Icon
About Axis: X All
R Translate Icon
0.0
Which Frame Scale Settings ROtate ICon
Coord. frame 0 Increment | | pogpon
Coord. frame 1 Limit
2.000000
*##4+ Cartesian Coordinates #+++
##k% of Box Tool in Frame 2 ####
X ¥ Z
Origin | .3 5355e+01 -5.2558e-+00 -5.106de+00
Length | 5.0710e+01 5.0710e+01 5.0710e+01
Orientation Vectors
X 1.0000e+00 0.0000e+00 0.0000e+00
Y | 0.0000e+00 1.0000e+00 0.0000e+00
Z | 0.0000e+00 0.0000e+00 1.0000e+00
Figure 6-19
Close Transformation Editor (Box Tool)
il I

The Transformation Editor can control precisely the position, orientation, and size of the

box tool.

The Transformation Editor dialog provides several methods for the precise positioning of
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the Box Tool. First, the Box Tool may be positioned within the Graphics Window by
entering coordinates for the origin of the box in the X, Y, and Z fields and the length of the
each of the X, Y, and Z sides. Pressing return causes the Box Tool to relocate to the
specified location in the selected Frame (or if more than one Frame is selected, in Frame
0).

Additionally, you can modify the orientation of the Box Tool by entering the X, Y, and Z
orientation vectors of the box axis in regards to Frame 0.

As with other Tools, it is possible to reposition the Box Tool from its present coordinate
position by specific increments. First click the translate icon at the top of the
Transformation Editor. The Axis Button allows you to choose the axis of translation (X,
Y, Z, or All) for the origin of the Box Tool (intersection of the axes). The Slider Bar at Top
allows you to quickly choose the increment by which to move the position of the origin.
Dragging the slider in the negative (left) or positive (right) directions and then releasing it
will cause the X, Y, and Z coordinate fields to increment as specified and the origin of the
Box Tool to relocate to the new coordinates. The number specified in the Limit field of the
Scale Settings area determines the negative (-) and positive (+) range of the slider. If the
Limit is set to 1.0 as shown, then the numerical range of the slider bar will be -1 to +1.

Alternatively, you can specify an increment for translation in the Increment field of the
Scale Settings area. Pressing return while the mouse pointer is in the Increment field will
cause the origin of the Box Tool to translate along the specified axis (or all axes) by the
increment specified.

Orientation First click on the rotate icon. Next, pick an axis about which to rotate. Next pick an
increment and limit (in degrees) and slide the slider to rotate the Box Tool.

Scale First click on the scale icon. Next pick an axis direction to scale. Finally pick an
increment and limit and slide the slider to scale the size of the Box Tool.

Access: Transformation Editor > Editor Function > Tools > Box
(see How to Use the Box Tool)

Cylinder or Sphere Clicking on Editor Function in the Transformation Editor dialog and then selecting

Tools Tools and then Cylinder or Sphere from the pull-down menu configures the dialog as
shown below.
- Transformation Editor {Cylinder Tool) [O][=]
File Editor Function Help
Transform Action: m % m %& Scale ICon
About Axis: X ¥ A 1
0.0 + —— Translate Icon

Which Frame Scale Settings

Coord. frame 0 Increment |y agoo00

L

Coord. frame 2 e 2.000000

*##4+ Cartesian Coordinates #+++
##k+ of Cylinder Tool in Frame 1 ##%%

X ¥ z
Orig [ g 7850e+00 | | 0.0000e+00 9.9983¢.03
AXIS [ 00006400 0.0000e+00 0.0000e+00
Radius |y 0142401 Figure 6-20
Transformation Editor (Cylinder Tool) or
Close (Sphere Tool)

The Transformation Editor can control precisely the position and size of the cylinder tool.

Position The Transformation Editor dialog enables you to precisely control the coordinates of the
Cylinder or Sphere Tool origin (center point of the thick direction line) by specifying them
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Cone Tool

Scale

Position

in the Orig. X, Y, and Z fields. You control the direction vector for the Cylinder or Sphere
Tool direction axes by specifying the coordinates in the Axis X, Y, and Z fields of the
selected Frame (or if more than one Frame is selected, in Frame 0). The Radius of each
tool may be specified in the Radius Field.

It is possible to reposition the Cylinder or Sphere Tool origins by specific increments. First
click on the translate icon. The Axis Button allows you to choose the axis of translation
(X, Y, Z, or All) for the origin of the tool. The Slider Bar at Top allows you to quickly
choose the increment by which to move the position of the origin. Dragging the slider it in
the negative (left) or positive (right) directions and then releasing it will cause the X, Y,
and Z coordinate fields to increment as specified and the origin of the Cylinder or Sphere
Tool to relocate to the new coordinates. The number specified in the Limit field of the
Scale Settings area determines the negative (-) and positive (+) range of the slider. If the
Limit is set to 1.0 as shown, then the numerical range of the slider bar will be -1 to +1.

Alternatively, you can specify an increment for translation in the Increment field of the
Scale Settings area. Pressing return while the mouse pointer is in the Increment field will
cause the origin of the Cylinder or Sphere Tool to translate along the specified axis (or all
axes) by the increment specified.

First click on the scale icon. Next pick an axis direction to scale. Can only scale in the X
(longitudinal) or Y (radial) directions. Finally pick an increment and limit and slide the
slider to scale the size of the cylinder or sphere Tool.

Access: Transformation Editor > Editor Function > Tools > Cylinder or Sphere
(see How To Use the Cylinder Tool and How To use the Sphere Tool)

Clicking on Editor Function in the Transformation Editor dialog and then selecting Tools
and then Cone from the pull-down menus configures the dialog as shown below.

- Transformation Editor {Cone Tool) [O][=]
File Editor Function Help
Transform Action: m ) m %g Scale Icon
About Axis: X ¥ 1
0.0 ¥ Translate lcon

Which Frame Scale Settings

Increment | | pooonn

Limit 2.000000

*##4+ Cartesian Coordinates #+++
#k of Cone Tool in Frame 0 ##%%

X ¥ Z
Orig [ g 7850e+00 | | 0.0000e+00 9.9983¢.03
AXIS [ 00006400 0.0000e+00 0.0000e+00

Angle | 5 0000e+01

Figure 6-21
Close Transformation Editor (Cone Tool)

The Transformation Editor dialog enables you to precisely control the coordinates of the
Cone Tool origin (the point of the cone) by specifying them in the Orig. X, Y, and Z fields.
You control the direction vector for the Cone Tool direction axis by specifying the
coordinates in the Axis X, Y, and Z fields for the selected Frame (or if more than one
Frame is selected, in Frame 0). The conical half angle may be specified in degrees in the
Angle Field.

It is possible to reposition the Cone Tool origin by specific increments. The Axis Button
allows you to choose the axis of translation (X, Y, Z, or All) for the origin of the tool. The
Slider Bar at Top allows you to quickly choose the increment by which to move the
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position of the origin. Dragging the slider in the negative (left) or positive (right)
directions and then releasing it will cause the X, Y, and Z coordinate fields to increment as
specified and the origin of the Cone Tool to relocate to the new coordinates. The number
specified in the Limit field of the Scale Settings area determines the negative (-) and
positive (+) range of the slider. If the Limit is set to 1.0 as shown, then the numerical range
of the slider bar will be -1 to +1.

Alternatively, you can specify an increment for translation in the Increment field of the
Scale Settings area. Pressing return while the mouse pointer is in the Increment field will
cause the center of the Cone Tool to translate along the specified axis (or all axes) by the
increment specified.

First click on the scale icon. Next pick an axis direction to scale. Can only scale in the X
(longitudinal) or Y (half conical angle) directions. Finally pick an increment and limit and
slide the slider to scale the size of the cone tool.

Access: Transformation Editor > Editor Function > Tools > Cone
(see How to Use the Cone Tool)

Clicking on Editor Function in the Transformation Editor dialog and then selecting Tools
and then Revolution from the pull-down menu configures the dialog as shown below.

- Transformation Editor {Revolution Tool) [O][=]
File Editor Function Help
T fo Action:

ranstorm Action' [ EE B0 Be————+—— Scale Icon
About Axis: X ¥ All

0.0 —— Translate Icon

Which Frame Scale Settings

Increment | | gpp000

Limit 2.000000

*##4+ Cartesian Coordinates #+++
##4+ of Revolution Tool in Frame ( ####

Distance Radius Add Point

-2.5355e-+01 1.0142e+01
Gl e e o

2.5355e+01 1.0142e+01

X ¥ Z
Orig | 1.6570e+01 0.0000e+00 9.9983e-03
Vect | | n000e-+00 0.0000e+00 0.0000e+00
Figure 6-22
Close Transformation Editor (Revolution Tool)

For the Revolution Tool, you not only control the origin and direction vector, but the
number of points and positions that are revolved about the axis.The desired coordinates of
the Revolution Tool origin (center point of the thick direction line) are specified in the
Orig. X, Y, and Z fields. The direction vector for the Revolution Tool direction axis is
specified by entering the desired coordinates in the Vect X, Y, and Z fields for the selected
Frame (or if more than one Frame is selected, in Frame 0).

Additional points may be added to the Revolution Tool by clicking on the Add Point(s)
toggle and then clicking at the desired location in the schematic for the tool. There is no
need to be overly precise in its placement since its location can be modified. Once you
have added all of the new points you wish, the Add Point(s) toggle should be turned off.
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A point may be deleted by selecting it in the schematic area and then clicking the Delete
button.

The position of any point may be modified interactively within the Revolution Tool
schematic window, Simply click on and drag the point to the desired location. The precise
location of any point may be specified by selecting the point in the schematic with the
mouse and then entering the desired Distance (from the Revolution Tool origin) or Radius
(from the axis) for the point in the text entry fields beneath the Distance and Radius Lists.
Pressing return will enter the new value in the list above for the selected point.

The Transformation Editor can control precisely the position and size of the revolution
tool.

Position It is possible to reposition the Revolution Tool origin by specific increments. First click on
the translate icon. The Axis Button allows you to choose the axis of translation (X, Y, Z,
or All) for the origin of the tool. The Slider Bar at Top allows you to quickly choose the
increment by which to move the position of the origin. Dragging the slider in the negative
(left) or positive (right) directions and then releasing it will cause the X, Y, and Z
coordinate fields to increment as specified and the origin of the Revolution Tool to
relocate to the new coordinates. The number specified in the Limit field of the Scale
Settings area determines the negative (-) and positive (+) range of the slider. If the Limit is
set to 1.0 as shown, then the numerical range of the slider bar will be -1 to +1.

Alternatively, you can specify an increment for translation in the Increment field of the
Scale Settings area. Pressing return while the mouse pointer is in the Increment field will
cause the center of the Revolution Tool to translate along the specified axis (or all axes) by
the increment specified.

Scale First click on the scale icon. Next pick an axis direction to scale. Can only scale in the X
(longitudinal) or Y (radial) directions. Finally pick an increment and limit and slide the
slider to scale the size of the revolution tool.

Redraw This button will cause the Revolution Tool schematic window to re-center to the currently
defined points of the tool.
Access: Transformation Editor > Editor Function > Tools > Revolution
(see How to Use the Surface of Revolution Tool)
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EnSight allows you to work concurrently with up to sixteen different sets of

results data (computational or experimental). Each set of results data is read in as
a “Case”.

Clicking the Case button in the Main Menu opens a pull-down menu which
provides access to the following features:

File Edit Query View Tools gasel Eelpl

Add, Replace, Delete...

Viewport Visibility...
4 Restrict List Info. Per Case

Add, Replace, Delete... Opens the File Selection dialog.

“ Case 1
Figure 6-23
Case pull-down menu
-* File Selection [x]

Filter

fusrilocal/bin/ensight73/data‘guard_rail#]

Directories Files
usrflocalfbinfensisht73/data/guard_rail/. crash.gea
fusrlocal/binfensight73/data/guard rail/.. crash.res
displace000
displace00l
Case (Add,Replace Delete) =+ = === === ===»==»===== - Case (Add,Replace,Delete)
Add... Replace... Delete
*#+#+Pile Information*+++*
Format Case
Specify Starting Time Step

Binary Files Are Big-Endian(HP IBM,5GI,SUN}

EnSight Case File(*.case Required}
{Set) Caze

fety Beault
fehy BMeagured

Rty Boundary

Path

Selection

fusrilocal/bin/ensight7d/data‘guard _rail/

Okay Apply Filter Cancel Help

Figure 6-24
File Selection Dialog to Add, Replace or Delete a Case

Case Turndown Button

Add...

EnSight 7 User Manual

Opens a dialog which allows you to specify a name and other options for the new Case.
The name will appear in the list of active Cases at the bottom of the Main Menu: Case
pull-down menu as shown in Figure 6-23 above. Adding a Case actually starts a new
EnSight Server and connects it to the EnSight Client. You then read and load data files for
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the new Case and the data will be added to the data already present in the EnSight Client.

[x]
Case Name pase 2

Optional Settings

Create new viewport for this case

Apply Context From Case 1
Reflect Model About Axis
X UY UZ
Origin X [ g 0000e+00 ¥ | 0.0000e+00 Z | 0.0000e+00

Okay Cancel
Figure 6-25
Add Case Dialog

When adding a case, you can have some options. The new case can be placed in a new
viewport or added to the current. It can have the context of casel applied to it, which will
cause it to basically inherit the positioning etc.of case 1. And you can even reflect the new
case about any of the major axes and specify the origin as it is read.

Replace... Replacing a Case causes all parts and variables associated with the active Case to be
deleted. The Server will be restarted and assigned the new Case name. Clicking the
Replace... button opens a small dialog which allows you to specify a name for the Case
you wish to use to replace the Case currently selected in the Main Menu: Case pull-down
menu as shown in Figure 6-23 above. You then read and load data for the new Case.

Delete Deleting a Case causes all parts and variables associated with the Case to be deleted and
terminates the Server associated with the Case. Clicking the Delete button opens a
Warning Dialog which asks you to confirm that you wish to delete the Case currently
selected in the Main Menu: Case pull-down menu as shown in Figure 6-23 above.

(see How To Load Multiple Datasets (Cases))

Viewport Visibility... Opens the Case Visible In Which Viewport dialog which allows you to specify in which
Viewports (including the Main Graphics Window) you wish to make the parts associated
with the currently selected Case visible. Parts associated with the selected Case will be
visible in the viewports outlined in green and invisible in those outlined in red. Visibility
for specific Parts can of course be toggled on/off using the Part Visibility Icon in the Part
Mode Icon Bar.

(see Part Visibility Toggle Icon in Section 8.1, Part Mode)

Restrict List Info. Toggling this menu selection on will restrict all lists displayed in EnSight (such as the
Per Case Toggle Parts and variables Lists) to show only information pertaining to the Case currently
selected in the Main Menu: Case pull-down menu as shown in Figure 6-23 above.

Finally, at the bottom of the pull-down menu you will find a list of active Cases,

The toggle buttons allow the selection of only one Case at a time. In Figure 6-23
above, Case 1 is the currently selected Case. The current selected Case is the one
which will be affected by the Data Reader, Querys, and many other operations.
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6.7 Help Menu Functions

Help Menu Functions

Clicking the Help button in the Main Menu opens a pull-down menu which

provides access to the following features:

File Edit Query View Tools Case

Help |

Getting Started...

.R_elease Nuotes...

Guide to Online Documentation...
EnSight Overview...

Quick Icon Reference...

How To Manual...

User Manual...

Command Manual...

License Agreement...

Version...

CEI Information...

Figure 6-26
Help pull-down menu

Opens the Getting Started Manual on-line. Note that this document is not cross-referenced
within itself or to other documents.

Provides an overview of changes made since the last major EnSight release.

Provides a guide to the use of the On-Line Documentation.

Provides an overview of EnSight.

Provides a quick reference guide to all EnSight GUI icons, many of which have links to
appropriate How To documents

Opens the How To Manual on-line.
Opens the User Manual on-line.
Opens the Command Language Manual on-line.

Opens up On-Line Documentation to the text of the EnSight End User License Agreement
and the EnSight Support and Maintenance Service Agreement.

Opens up the Version Information dialog which states the version number of the EnSight
software currently running.

Opens up the CEI Information display which gives full CEI contact information.
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7 Features

This chapter describes the functions available through the Feature Icon Bar.

Figure 7-1
EnSight Feature Icon Bar

Section 7.1, Color

Section 7.2, Contour Create/Update

Section 7.3, Isosurface Create/Update

Section 7.4, Particle Trace Create/Update

Section 7.5, Clip Create/Update

Section 7.6, Vector Arrow Create/Update

Section 7.7, Elevated Surface Create/Update
Section 7.8, Profile Create/Update

Section 7.9, Developed Surface Create/Update
Section 7.10, Displacements On Parts

Section 7.11, Query/Plot

Section 7.12, Interactive Probe Query

Section 7.13, Solution Time

Section 7.14, Flipbook Animation

Section 7.15, Keyframe Animation

Section 7.16, Subset Parts Create/Update

Section 7.17, Tensor Glyph Parts Create/Update
Section 7.18, Material Parts Create/Update
Section 7.19, Vortex Core Create/Update

Section 7.20, Shock Surface/Region Create/Update
Section 7.21, Separation/Attachment Lines Create/Update
Section 7.22, Boundary Layer Variables Create/Update

EnSight 7 User Manual
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7.1 Color

7.1 Color

Clicking once on the Color Icon opens the Color Editor in the Quick Interaction
Area which allows you to assign color to the individual Part(s) which has(have)
been selected in the Parts List. If no Parts are selected, modifications will affect
the default Part color and all Parts subsequently loaded or created will be assigned
the new default color.

Figure 7-2
Color Icon

Color By Constant Color i | Co‘r;:::l:.nt Magnitude i |

temperature Mix...I Blroo (Glroo Blioo
velocity

Coordinates

Time

Apply New Variable | Help... |

Figure 7-3
Quick Interaction Area - Color Editor - Constant Color

Color By Opens a pull-down menu which allows you to choose whether to color the selected Part(s)
by a Constant Color or by the Variable selected in the Variables List.

Constant Color The selected Part(s) may be assigned a constant color in two ways. First, the color may be
assigned by entering red, green, and blue numerical values (0.0 to 1.0) in the R,G,B fields
of the Quick Interaction Area and then pressing the return key.

Mix... Second, you can click on the Mix... button and the Color Selector dialog will open.

“ RGE <+ HSV %+ Change Caolor Cell

Figure 7-4
Color Selector dialog

You can choose whether you wish to use the RGB color scheme or HSV. A color may be
chosen in one of four ways. First, a color may be chosen from one of the color cells (small
squares of constant color). Second, you can grab the small circle in the color assignment
hexagon and interactively pick the desired color. Third, you can pick a color by entering
numerical values (0.0 to 1.0) in the numerical (RGB or HSV) fields and then pressing
return key. Finally, you can interactively choose a color by using the slider bars to the right
of the numerical (RGB or HSV) fields which adjust the values therein (the color in the
slider bars indicates the effect that modifying the color components will have on the final
color).
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7.1 Color

It is possible to assign to the Color Cells area a color that you have specified in one of the
other three ways by clicking the Change Color Cell and then clicking on the cell to which
you wish to assign the currently defined color (as shown in the large rectangle to the left).
This reassignment will be retained for use in subsequent EnSight sessions.

Regardless of which method you use to define a color, it will not be applied to the selected
Part(s) unless and until you click the Apply button.

ColorBy  Variable _||Co‘r’:;f;:’;nt Magnitude .||
Mix...IRII.OO Glooo B|o.00
velocity
Coordinates
Time

Apply New Variable I Help... I
Figure 7-5

Quick Interaction Area - Color Editor - Variable

Alternatively, the Part(s) may be colored by a variable selected in the Variables List
instead of by one constant color. The color palette for each Variable associates a color with
each value of the variable and these colors are used to color the selected Part(s).

If you are coloring by a vector variable, this opens a pull-down menu which allows you to
choose whether you wish to color using the magnitude or a component of the vector.
Color by the vector magnitude.

Color by the vector’s X component.

Color by the vector’s Y component.

Color by the vector’s Z component.

Changes the color palette used to color the selected Part(s) to that of the variable currently

chosen in the Variables List. If more than one variable is selected, then the color palette of
the first selected variable will be used.

Double clicking on the Color Icon will open the Feature Detail Editor (Variables)
dialog.

(see Section 4.1, Variable Selection and Activation, Section 4.2, Variable
Summary & Palette, and How To Edit Color Palettes)
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7.2 Contour Create/Update

Contours are lines that trace out constant values of a variable across the surface(s)
of selected Part(s), just like contour lines on a topographical map.

Figure 7-6

Pressure Contours in a Flow Field around a Circular Obstruction

The variable must be a node-based scalar, but can, of course, be a function of a
vector variable (i.e., the magnitude or a component). A Contour Part can consist
of one contour line, or a set of lines corresponding to the value-levels of the
variable palette. A Contour Part has its own attributes independent of those Parts
used to create it (the parent Part(s)).

Contours are drawn across the faces of parent Part elements (one-dimensional
elements are ignored). At each node along the edges of any one element face, the
contour’s variable has a value. If the range of these values includes the contour’s
value-level, the contour line crosses the face. EnSight draws the contour by
dividing the face into triangles each having the face’s centroid as one vertex. For
each triangle the contour crosses, it will cross only two sides. EnSight interpolates
to find the point on each of those two sides where the variable value equals the
contour value-level, then creates a bar element to connect the two points. Note
that a contour line can bend while crossing an element face.

Because Contour Parts are created on the EnSight Client, the Representation
attribute of the parent Part(s) greatly affects the result. Representations that reduce
Part elements to one-dimensional representations (Border applied to two-
dimensional Parts and Feature Angle), or do not download the Part (Not Loaded),
will eliminate those Part elements from the Contour creation process. On the other
hand, Full representation of three-dimensional elements will create contour lines
across hidden surfaces. Usually, you will want the Representation selection to be
3D Border, 2D Full.

Contour Parts are created on the Client, and so cannot be queried or used in
creating new variables. However, Contours can be used as parent Parts for Profiles
and Vector Arrows.

If you change the value-levels in the Feature Detail Editor (Variables) Summary
and Palette section, the Contour automatically regenerates using the new value-
levels.
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7.2 Contour Create/Update

Use care when simultaneously displaying contours based on different function
palettes so that you do not become confused as to which contours are which.
Coloring them differently and adding an on-screen legend can help.

Clicking once on the Contour Create/Update Icon opens the Contour Editor in the
Quick Interaction Area which is used to both create and update (make changes to)
contour Parts.

Figure 7-7
Contour Create/Update Icon

Select a Variahl
cecta varlane Syne To Palette

temperature
velocity Range Min Lewvels isi
0.0000e-+00 5 Visibl
Coordinates e e
Range Max [{ 0000e+00 Sublevels | o Visible
Distribution Linear Label Attributes...
Create Apply New Variable Help...
-~ Contour Label Settings [al[x]
Spacing |4 5415e+00
Mix...| B 100 %100 B[roo
Format Exponential Decimal Places |
Figure 7-8 Close

Quick Interaction Area - Contour Editor

Toggles on/off the contour line synchronization to the legend color palette.
This field is activated when Sync to Palette Toggle is Off.
This field is activated when Sync to Palette Toggle is Off.

This pop-up menu is activated when Sync to Palette Toggle is Off. Opens a pop-up menu
for the selection of a distribution function for the contour lines. Choices include Linear,
Logarithmic, and Quadratic.

This field is activated when Sync to Palette Toggle is Off. This field determines the
number of contours between the Range Min and Range Max.

Toggles whether the main level contours are visible or not.

This field allows you to specify the number of sub-contours you wish to be drawn at
evenly spaced value-levels between the value-levels defined in the Variable Feature Detail
Editor Summary and Palette section. Leaving this field 0 will produce exactly the number
of contour lines for which value levels are specified in the Feature Detail Editor
(Variables) Summary and Palette.

Toggles whether the sublevel contours are visible or not.
Opens the Contour Label Settings dialog.

Toggles on/off the visibility of number labels for contour lines.

Determines the spacing between number labels.

Opens the Color Selector dialog for the assignment of a color to number labels.
Allows the specification of red, green, and blue values for the assignment of a color to
number labels.

This pop-up menu allows selection of format of number labels. Choices include
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Decimal Places

Create

Apply New Variable

Feature Detail Editor
(Contours)

Display offset

Exponential, and Floating Point.
This field allows the specification of the number of decimal places of the number labels.

Creates a Contour Part using the selected Part(s) in the Parts List and the color palette
associated with the Variable currently selected in the Main Variables List.

Will change the Contour Part to show contours based on the color palette associated with
the Variable currently selected in the Variables List.

Double clicking on the Contour Create/Update Icon opens the Feature Detail
Editor (Contours), the Creation Attributes Section of which provides access to the
same functions available in the Quick Interaction Area, as well as one more. For a
detailed discussion of the remaining Feature Detail Editor turn-down sections
(which are the same for all Part types):

This field specifies the normal distance away from a surface to display the
contours. A positive value moves the contours away from the surface in the
direction of the surface normal. A negative value moves in the negative surface
normal direction.

Please note that there is a hardware offset that will apply to contours, vector arrows,
separation/attachment lines, and surface restricted particle traces that can be turned on
or off in the View portion of Edit->Preferences. This preference (“Use graphics hardware
to offset line objects... ) is on by default and generally gives good images for everything
except move/draw printing. This hardware offset differs from the display offset in that it is

in the direction perpendicular to the computer screen monitor (Z-buffer).

Thus, for viewing, you may generally leave the display offset at zero. But for
printing, a non-zero value may become necessary so the contours print cleanly.

(see Section 3.3, Part Editing and How to Create Contours)

Troubleshooting Contours

Problem

Probable Causes

Solutions

No contours created.

Too many contours.

Too few contours.

Contour Part created but (empty)

Variable values on element faces are
outside range of palette function
value-levels.

Parent Parts do not contain any 2D
elements.

Parent Parts do not contain the
specified Variable.

Palette has too many function levels.

Specified too many sub-contours.

The palette levels do not adequately
cover the function value range for
the Parent Parts.

Sub-contour attribute set to 0.

Parent Part is in Feature Angle
representation.

Adjust palette function using the
Feature Detail Editor (Variables)
Summary and Palette section.

Re-specify Parent Part list.

Recreate the Variable for the selected
Parent Part(s).

Change the number of levels for the
palette using the Feature Detail
Editor (Variables) Summary and
Palette.

Lower the sub-contour attribute.
Modify the palette using the Feature
Detail Editor (Variables) Summary
and Palette.

Modify the Sub-contour attribute.

Change Parent Part to 3D border, 2D
full representation.
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7.2 Contour Create/Update

Problem Probable Causes Solutions

Contours are fine at first, but later go  Parent Parts representation changed = The contours are created from the

away. to Feature Angle, or Not Loaded. Part representation on the EnSight
client. Modifying the representation
affects the Contour Parts.

Contour parts don’t print well See Display Offset above. Enter a display offset (may need to
be less than zero if viewed from
“backside”).
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7.3 Isosurface Create/Update

7.3 Isosurface Create/Update

Isosurfaces are surfaces that follow a constant value of a variable through three-
dimensional elements. Hence, isosurfaces are to three-dimensional elements what
contour lines are to two-dimensional elements.

Temperature (10 degrees)

Figure 7-9

An isosurface may be based on a vector variable (magnitude or components), or a
scalar variable.

At each node of a three-dimensional element, the isosurface’s variable has a value.
If the range of these values includes the isosurface’s isovalue, the isosurface cuts
through the element. EnSight draws the isosurface through that element by first
determining which edges the isosurface crosses, and then interpolating to find the
point on each of those edges corresponding to the isovalue. EnSight connects
these points with triangle elements passing through the parent Part elements. If the
Parent Part(s) contain two-dimensional elements, a line is created across the
elements - just like a contour.

All the triangle elements created inside all the three-dimensional elements of all
the parent Part(s) together with all the lines created across the two-dimensional
elements of all the Parent Part(s) constitute the isosurface. One-dimensional
elements of the parent Part(s) are ignored. Because isosurfaces are generated by
the server, the Representation of the parent Part(s) is not important.

You can interactively manipulate the value of an isosurface with a slider allowing
you to scan through the min/max range of a variable. This scanning can also be
done automatically. The isosurface will change shape as the value is changed.

If you are using animation, you can specify an Animation Delta value by which
the isovalue is incremented for each animation frame or page. The isosurface is
automatically updated to appear as if it had been newly created at the new location
and time.
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7.3 Isosurface Create/Update

Clicking once on the Isosurface Create/Update Icon opens the Isosurface Editor in
the Quick Interaction Area which is used to both create and update (make changes
to) isosurface Parts.

=

Figure 7-10
Isosurface Create/Update Icon

Select a Variable Value | | pogpe+o1
N_velocity Interactive Manual
Coordinates
Min | 4 4000e-+00 Max | 4 g192¢.+01 Increment | 5 499ge+00
Create Apply New Variable Help...
Figure 7-11

Quick Interaction Area - Isosurface Editor

Specification of numerical isovalue of the isosurface. To avoid an empty Part, this value
must be in the range of the Variable within the Parent Parts. You can find this range using
the Variables dialog or by showing the Legend for the Variable. For vector-variable-based
isosurfaces, the vector magnitude is used.

Opens pull-down menu for selection of type of interactive manipulation of the isosurface
value. Options are:
Interactive isosurfaces are turned off.
Value of the isosurface(s) selected are manipulated via the slider bar and the
isosurface is interactively updated in the Graphics Window to the new value.
Value of the isosurface is incremented by the Auto Delta value from the minimum
range value to the maximum value when the cursor is moved into the Main
View. When reaching the maximum it starts again from the minimum.
Value of the isosurface is incremented by the Auto Increment value from the
minimum range value to the maximum value. When reaching the maximum
it decrements back to the minimum.

Specification of the increment for the Auto and Auto Cycle options to use when
modifying the value between the minimum and maximum values.

Specification of the minimum isosurface value for the range used with the “Manual” slider
bar and the “Auto” and “Auto Cycle” options.

Specification of the maximum isosurface value for the range used with the “Manual”
slider and the “Auto” and “Auto Cycle” options.

Specification of the increment/decrement the slider will move within the min and max,
each time the stepper buttons are clicked.

Creates an isosurface Part at the value specified for the variable selected in the Variables
List and from the Part(s) selected in the Parts List.

Will recreate the isosurface Part at the value specified for the variable currently selected in
the Variables List.
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Feature Detail Editor
(Isosurfaces)

Variable

XYZ
Type

Isosurface

Value

Isovolume

Constraint

Double clicking on the Isosurface Create/Update Icon opens the Feature Detail
Editor (Isosurfaces), the Creation Attributes Section of which provides access to
additional features for isosurface creation and modification:

[ Feature Detai Editor foosuraces) |

File Edit View Help

Desc I Isosurface part

Creation Attributes

Variable temperature _l|

X | o000 Y | o000  Z | 0.0000

Type Isosurface _l|
Value | 1.0000e-+00

Animation Delta I D000+

Figure 7-12
Feature Detail Editor (Isosurfaces) Creation Attributes Area

Opens a pop-up menu for the selection of an active Variable to use to calculate the
isosurface.

These fields specify the vector- component coefficients. When the three fields are set to
0.0000, the vector magnitude is used for the isosurface calculation. Otherwise, the sum of:
(Vectory * X)+(Vectory, *Y) + (Vector,*Z) is used as the isosurface value.

Specification that an Isosurface type part created from the specified Variable and selected
parts will have the isovalue of Value for all its elements.

Specification of the numerical isovalue of the Isosurface Part(s) selected in the Feature
Detail Editor's Parts List (or if none is selected, of the isosurface you are about to Create).

Type Isovolume _I|Consh'aint Band _l| H

Min | 5.0000e-01 Max | 1.0000-+00

Figure 7-13
Feature Detail Editor (Isovolume) Creation Attributes Area

Specification that an Isovolume type part created from the specified Variable and selected
parts will consist of elements with isovalues constrained to either below a Min, above a
Max, or within the specified interval of Min and Max.

Specification restricting the element isovalues of the Isovolume Part to an interval. The
Constraint options are:

Low all elements of Isovolume Part have isovalues below the specified Min value.

Band all elements of Isovolume Part have isovalues within the specified Min and
Max interval values.

High all elements of Isovolume Part have isovalues above the specified Max value.
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7.3 Isosurface Create/Update

Specification of the minimum isovalue limit for the Isovolume Part.
Specification of the maximum isovalue limit for the Isovolume Part.

This field specifies the incremental change in isovalue for each frame or page of
animation. It can be negative.

(see Section 7.14, Flipbook Animation and Section 7.15, Keyframe Animation)

(At the bottom of the Feature Detail Editor) Creates an Isosurface Part at the value
specified for the variable selected in the Variable pop-up menu of the Creation Attributes
section and from the Part(s) selected in the Main Parts List.

The Feature Detail Editor also allows you to make changes in batch; that is, to
make several changes to the menus and fields which do not effect the Graphics
Window until you click in the Apply Changes button. It is sometimes quicker
(with respect to CPU time) to make several changes at once rather than one at a
time as in the Quick Interaction Area.

For a detailed discussion of the remaining Feature Detail Editor turn-down
sections (which are the same for all Parts):

(see Section 3.3, Part Editing and How To Create Isosurfaces
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7.4 Particle Trace Create/Update

7.4 Particle Trace Create/Update

A Particle trace visualizes a vector field by displaying the path that a massless
Particle would follow if placed in that field. At each point on the Particle trace, the
direction of the trace is parallel to the vector field at that point and time.

A streamline is a Particle trace in a steady-state vector field, while a pathline is a
Particle trace in a time-varying vector field. Particle traces can be lines or
“ribbons” (that additionally visualize the rotation of the vector field around the
path of the trace).

EnSight is capable of computing a pathline through a model with changing
coordinates and/or changing connectivity. The variable values are assumed to
behave linearly between the known timesteps.

Particle Trace Parts have their own attributes, so you can, for example, trace a
flow field using the velocity variable, and then color the resulting trace using the
temperature variable.

Figure 7-14
Particle Trace lllustration

Emitters A Particle Trace Part consists of one or more Particle traces originating from
points on one or more emitters. Each emitter is capable of emitting a Particle
starting at a specified time and continuing to emit Particles at given intervals.
When pathlines are generated with emitters emitting at multiple time intervals and
these traces are then animated, streaklines are displayed.

Emitters consist of single points, points along a line, points forming a grid in a
plane, or points corresponding to the nodes of a Part. You can define emitters
using the Cursor tool, the Line tool, the Plane tool, or a Part.

Emitters can be created using the cursor, line, and plane tools, using existing Part
nodes, or can be created in a surface restricted mode where the mouse can be used
to project points, rakes or nets directly onto the displayed surfaces of the model.

Pathlines, of course, must be drawn forward in time, but streamlines can be drawn
forward in time, backward in time, or both. Each Particle trace terminates when
either (1) the Particle trace moves outside the space in which the vector field is
defined, (2) a user-specified time limit is reached, (3) the massless Particle
becomes stationary in a place where the vector field is zero, or (4) the last
transient-data time step is reached. (4 applies only to pathlines)
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7.4 Particle Trace Create/Update

A Particle trace can pass through any point inside an element of the parent Part(s).
The vector field at any point is calculated from the shape function of the
containing element. Emitter points located outside the elements are ignored when
creating Particle traces.

A surface-restricted Particle trace is constrained to the surface of the selected
Part(s) by using only the tangential component of the velocity. The velocity values
for this type of trace can be the velocity at the surface (if nonzero) or at some user
specified offset into the velocity field.

A Particle trace can be updated interactively by entering interactive mode and
moving the tool used to create the emitter. When a trace is selected and interactive
emitter is turned on, the tool will appear at the location of the emitter. The user
then manipulates the tool interactively in the Graphics Window or using the
transformations dialog. (This option is not available for surface-restricted Particle
traces or traces emitted from a Part).

EnSight creates Particle traces by integrating the vector field variable over time
using a Fourth Order Runge-Kutta method and utilizing a time varying integration
step. The integration step is lengthened or shortened depending on the flow field,
but you can control the minimum number of integration steps performed in any
element as well as other time step controls.

Normally, EnSight will perform the integration using all of the components of the
vector. However, it is possible to restrict the integration to a plane by specifying
which components of the vector to use. Typical uses of this feature would be to
restrict the Particle traces to a clip plane. Surface-restricted Particle traces provide
even greater flexibility in restricting a trace to planes or other surfaces.

Line-type Particle traces consist of bar elements. Ribbons consist of 4-noded quad
elements and originate with their end-edge parallel to the Z-axis of the global
frame. Then, at each integration step, the leading edge is rotated around the
current direction of the path by the same amount the vector field has rotated
around the path since the previous time step. Ribbons are not available for
surface-restricted Particle traces.

Particle Trace Parts are created on the server, so the Representation-type of the
parent Parts has no effect. The algorithm that creates Particle traces initially sets
up a cross-referencing map of adjoining elements. Hence, the first Particle trace
takes longer to generate than subsequent traces.

If you calculate pathlines, consider calculating as many as possible at a time, since
the process can be very time consuming (most of the time is taken in reading time
step information). However, the data for the Trace Part is sent to and stored on the
Client, Thus, you cannot label or make queries about Particle Trace Parts. Instead,
label or make queries about the Particle Trace’s parent Part(s). Line-type Particle
Traces can be parent Parts for Profiles. You can animate the motion of the
massless Particles along their Particle traces.

By default the emission point is always set to emit the Particles at the current time
step. This can be a problem if you have a transient dataset with the current time set
at the last time step available. If you compute pathlines from this location, the
default emission time will be at the current time (last time step), thus no pathlines
will be generated. To solve this problem you will need to either change the current
time, or change the Start Time of the emitter.
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Massed-Particle Traces

The process of creating a Particle trace is always to specify an emission point
(location and time), specify the Part(s) to trace the Particle through and specify
which vector variable to integrate. There are quick ways of doing this process
which assume that the correct defaults are set, or there are more deliberate ways
which give you more control. Particle trace Parts carry only one set of attributes
for all of the traces in the Part, thus it is not possible, for example, to trace some of
the emission points forward in time and others backward in time.

Particle trace Parts are different from all other created Parts in that when the
parent Parts change (such as at a time step change), the Particle trace Part does not
change. This is due to the fact that the Particle trace has been created at a specified
time (the emission time), making the Part independent of time (after the trace has
been created).

Regular Particle traces can only be computed through a set of parent Parts
consisting of model Parts. Surface-restricted Particle traces can be created on
model Parts, clip Parts, elevated surface Parts, and developed surface Parts.

If your dataset contains 3D elements, the Particles for regular traces will be traced
through 3D element fields only. Surface-restricted traces would have to be used to
trace along 2D elements of such a data set.

A particle trace can be created or updated from a massless-particle trace to a
massed-particle trace, or visa-versa. Massed-particle traces are specified via their
appended section in the Feature Detailed Editor (Traces) dialog. Massed-particle
traces switch to massless-particle traces during interactive mode.

Definitions

Motion of a particle as a function of its velocity is defined as
a/dt (xy) = Vv,

with initial conditions V (ty) =V, o and initial particle position

Xp (tg) =Xy, ¢ (capital letters denote vectors unless otherwise indicated).

For massless particles, the particle velocity is always identical to the local fluid
velocity, V,=V¢. For massed particles, additional forces acting on them result in a
different velocity for the V, than for the fluid, V, not equal to V. This particle
velocity is determined from a momentum balance for the particle by

m, ApZFp,
or
my, d/dt(Vp) = Fg + Fg + Fg + Fg,
where
A, = particle acceleration vector,
F, = total (particle) force vector,
Fy = gravitational (body) force vector = my, b G,
Fp = pressure (surface) force vector = - v, Ves,
Fq = drag (surface) force(s) vector = % pg ay cq |Vy| Vy,
F. = additional forces vector, here =0,

EnSight 7 User Manual



EnSight 7 User Manual

7.4 Particle Trace Create/Update

given the following definitions (Note: the underlined definitions are user
specified)

My, = particlemass = py vp,
Pp = particle density,
Vp = particle volume = dp3 T/6,
o = particle diameter,
= particle buoyancy ratio = (p, - pg) /Py,
Ps = fluid density (scalar or constant),
G = gravitational acceleration vector,
Vee = fluid pressure gradient vector, (computed from ¢ = fluid
pressure scalar variable)
- i - 2
ap = particle reference area = dp T/4,
vV, = reference velocity vector = Ve - Vg,
cq = drag coefficient, typically given as a function of the local
relative Re,i.e. c¢g = c4(Re),
Re = Reynolds number = pg |V,| dy / Wg,
e = fluid dynamic viscosity (scalar or constant).

Thus, the total mass balance equation for massed particles may be defined by:
m, d/dt (Vp) = (my b G) - (v Vpe) + (% pr ap Cq [Ve| Vi) .

Drag Coefficient
Currently, the following Drag Coefficient (C) table is provided as the default.

Re << 1 Cq = 24/Re
1 < Re << 500 Cq = 24/Re0-%%¢
500 < Re << 3e5 Cq = 0.43
3e5 < Re << 2e6 Cy = 3.66E-4 Re *?7°
2e6 < Re Cq = 0.18

This table is also coded as an example for your reference and access via the User-
Defined Math Function DragCoefTablel (Re) which is found in

$CEI_HOME/ensight76/src/math_functions/drag_coef tablel/libudmf-drag_coef tablel.c

In addition, two other drag coefficient functions are provided for your selection
via the User-Defined Math Function facility.

DragCoefPoly(Re) = (a + b Re + ¢ Re? + d/Re )

Where: {a,b,c,d} are polynomial coefficients with default values of {1.,0.,0.,0},
respectively.

DragCoefPower (Re) = (1 + .15 Re%:°87) 24 / Re
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Both of these functions are located respectively in

$CEI_ HOME/ensight76/src/math_functions/drag_coef poly/libudmf-drag_coef poly.cf
$CEI_ HOME/ensight76/src/math_functions/drag_coef power/libudmf-drag_coef power.c
You may also code your own. (See UDMF in EnSight User Manual.)

Particle-Mass Scalar on Boundaries

Information to compute a particle-mass scalar on boundaries (mp = mp;) is

provided each time massed-particle traces are created. This scalar is found and
computed via the New Computed Variables (NCV) functionality.

Massed Particle Scalar(massed-particle traced part(s))

This scalar creates a massed-particle per element scalar variable for each of the
parent parts of the massed-particle traces. This per element variable is the mass of
the particle times the sum of the number of times each element is exited by a
mass-particle trace.

References

The following references have contributed in part toward the development of the
massed-particle algorithm.

Donley, H. Edward

“The Drag Force on a Sphere”,
http:\\www.ma.iup.edu/projects/CalcDEMma/drag/drag.html

Lund, Christoph

“Vorgaben fiir die Berechnung und Visualisierung der Bahnlinien
massebehafteter Partikel im Postprozessor EnSight”, Volkswagen AG,
27.07.2001. English translation by Kent Misegades.

Fluid Dynamics International, Inc.
FIDAP 7.0 Theory Manual”, April 1993, pp12-3+

Clicking once on the Particle Trace Create/Update Icon opens the Particle Trace
Editor in the Quick Interaction Area which is used to both create and update
(make changes to) Particle trace Parts.

Figure 7-15
Particle Trace Create/Update Icon

Select a Variable Type Stream Show As... Animate Animate...
velocity
Emit | oy Emit... Pick Surface Interactive Emitter
From

Surface Variahie v 145
Restrict (et s

Tool Location...

Create Help...

Figure 7-16
Quick Interaction Area - Particle Trace Editor

Type Opens a pull-down menu for specification of whether Particle trace calculation uses
steady-state data (streamlines) or transient data (pathlines).
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Stream Traces a massless Particle in a steady-sate vector field (for steady-state data or the current
time-step of transient data).

Path Traces a massless Particle through a time-varying vector field and so is only available
with transient results data. On certain systems, this selection can consume significant
quantities of CPU time to calculate the resulting Particle trace.

Show As Opens a dialog for specification of trace representation.
Line Depicts the trace as a line.
Ribbon Depicts trace as if it were a ribbon. The ribbon width is a specified fixed value, while the

twisting is determined by the rotation of the flow about the path of the trace at any
particular point on the trace.

Square Tubes Depicts trace as if it were a square tube. The tube width is a specified fixed value, while
the twisting is determined by the rotation of the flow about the path of the trace at any
particular point on the trace.

Animate Toggle Toggles on/off the animation of the motion of the Particles along the traces. In addition to
creating Particle traces based on vector variables, EnSight can also animate the motion of
the Particles along the Particle traces. To distinguish them from discrete Particles, we call
Particles moving along Particle traces “tracers.”

At any instant, each tracer consists of a portion of a Particle trace displayed with attributes
you specify separately from the attributes of the Particle trace. EnSight animates each
tracer by updating which portion of the Particle trace is currently displayed. You specify
the length of each tracer as a time value, so the tracer’s length varies dynamically as it
moves down the Particle trace (faster moving tracers are longer). This option can add
tremendously to the understanding of the flow field since relative speed can be
determined.

EnSight provides control over how the tracer looks and acts. You can animate one, some,
or all of the Particle traces you have created, but they are all animated in the one way you
specify. To help you get started, at the click of a button EnSight will suggest time-
specification values based on the Particle traces you have selected to animate. You can
specify the line width of the tracer, and choose to color it with a constant color or the same
calculated color used to color the Particle trace. You can also display a spherical “head” on
the leading-end of the tracer, and dynamically size the head according to any active
variable.

You control the speed of the motion and have the option to display multiple tracers on the
same Particle trace separated by a time interval. Hence, you can choose to view rapid-fire
pulses, slow moving “noodles,” or something in between. For steady-state Particle traces
(streamlines), “time” is the integration time with the emitters located at time zero. For
transient Particle traces (pathlines), you have the option to synchronize the animation time
to the solution time. The choice of whether a Particle trace is a streamline or a pathline is
made when you create the Particle trace.

You do not have to animate the entire Particle trace. You can specify where you want the
animation to start with a time value corresponding to a distance down the Particle trace
from the emitter, and where you want the animation to stop with a time value
corresponding to a distance farther down the Particle trace.

Tracers on all animated Particle traces are synchronized. If you combine Particle trace
animation with flipbook animation or keyframe animation, the animation time values are
automatically synchronized if you toggle-on Sync To Transient in the Trace Animation
Settings dialog.
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Animate...

Color By

Constant
Mix...
R,GB

Trace Color

Line Width

Start Time
Tracer Time (Length)
Tracer Delta (Speed)

Sync to Transient
Toggle

Max Time Toggle

Max Time

Multiple Pulses Toggle

Pulse Interval

Opens the Trace Animation Settings dialog

ColorBy Trace Color ,,,,eE Mix. |B[100 | G100 | B [L00

Line Width 1 I Syne To Transient
[Start Time  [yo gTEDS I Max Time L0000.-+00
1.0000e1 00 | Multiple Pulses
Pulse Interval L0000+00
1.0000e+00

Tracer Head Representation

[ Type  Spheres ,,EE Seale El.l]l]l]l)e+l]l] Detail | 3

Variable i
JE‘“

Tracer Time
| {Length)
Tracer Delta

(Speed)

Size By = Constant

Close E Get Defaults E

Figure 7-17
Trace Animation Settings dialog

Opens a pull-down menu for selection of method by which to color the tracers.

Displays tracers in the constant color specified in this dialog.
Opens the Color Selector dialog (See Figure 7-4 Color Selector dialog).
Fields allow specification of constant color.

Displays tracers in the same color as the Particle Trace Part from which they originate.

Specification of displayed width (in pixels) of tracers. Note: Line Width specification may
not be available on some workstation platforms.

Specification of how far down each Particle trace to begin displaying tracers. A Particle
trace is made up of line segments. Each segment that makes up a Particle trace has an
associated time value. The start time indicates where on the Particle trace the tracers will
begin animation.

Specification of length of tracers which varies as the tracer speed varies along the Particle
trace. The Particle Time Length parameter scales the length of all tracers at all times.

Specification of how fast tracers move. Longer times result in faster moving tracers. This
parameter is not applicable when using Sync To Transient and displaying transient data
through flipbook or keyframe animation.

Toggles on/off synchronization of tracer position to solution time of transient data. When
toggled-on and transient data is in use, each tracer is displayed with its leading-end at the
correct location along the Particle trace for the current solution time. Traces only move
forward in time so cycling through transient data is not applicable here.

Toggles on/off maximum lifetime for all tracers. If toggled-off, tracers continue to end of
Particle trace. If toggled-on, each tracer stops after moving down the Particle trace for a
distance corresponding to the specified Max Time (or until one of the other conditions that
stop a tracer occurs).

Field specifies lifetime of all tracers when Set Max Time is toggled-on.

Toggles on/off multiple emission of tracers. When toggled-off, a single tracer for each
Particle trace appears at the specified Start Time. When toggled-on, additional tracers
appear after each specified Pulse Interval. Not applicable to pathlines.

Field specifies time delay between tracers. Not applicable when Multiple Pulses is
toggled-off.

Tracer Head Representation

Type

None

Opens a pull-down menu for selection of type of head for each tracer.

Specifies that no head will appear.
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Specifies that a sphere will appear on the leading end of the tracer.

Specification of scaling factor for head size. Values between 0 and 1 reduce the size,
factors greater than one enlarge the size. Not applicable when Head Type is None.

Specification of detail-level of head in range from 2 to 10, with 10 being the most detailed
(e.g., rounder spheres because more polygons are used to create spheres). Higher values
take longer to draw, slowing performance. Not applicable when Head Type is None.

Opens a pull-down menu for the selection of variable-type to use to size each tracer’s
head. If you select a variable, the head size is determined by multiplying the Scale factor
times the variable value, which will vary depending on the location of the tracer. Not
applicable when Head Type is None.

Sizes head using just the Scale factor value.

Sizes head using a scalar variable.

Sizes head using magnitude a vector variable.

Sizes head using X-component of a vector variable.
Sizes head using Y-component of a vector variable.
Sizes head using Z-component of a vector variable.

Selection of variable to use to size the tracer heads. Not applicable when Type is None or
Size By is Constant.

Click to set time-value specifications in this dialog to values suggested by EnSight based
upon the characteristics of the selected Particle traces.

See Also: How To Animate Particle Traces

Troubleshooting Animated Particle Traces

Problem

Probable Causes

Solutions

No motion. Can’t see any tracers.

Motion too fast.
Can’t get multiple pulses at same

time.

Have one big tracer, no pulses.

EnSight 7 User Manual

No Particle traces selected to
animate.

Tracers colored same as Particle
traces and have same line width.

Animate Traces not toggled-on.

Start Time > maximum Particle trace
time for all traces selected.

Delta Time (Speed) set too high.

Particle Time (Length) set too small.

Delta Time (Speed) set too high.

Pulse interval too high.

Pulse interval too small, pulses start
right after each other with no
separation.

Select the traces you wish to animate
in the list at the top of the Animated
Trace Setup dialog.

Change Color By or Line Width.

Toggle Animate on in the Quick
Interaction Area.

Change settings in the Trace
Animation Settings dialog.

Change settings in the Trace
Animation Settings dialog.

Change settings in the Trace
Animation Settings dialog.

Change settings in the Trace
Animation Settings dialog.

Decrease to have pulses start closer
together.

Increase the interval.
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Quick Interaction Area Particle Trace Editor, continued,

Emit From Opens a pull-down menu for the specification of the emitter type.
Cursor Creates Particle trace beginning from the position of the Cursor tool.
Line Creates Particle traces beginning from the position of the Line tool.
# Points This field specifies the number of evenly spaced traces you want to emit from the Line
tool.
Plane Create Particle traces beginning from the position of the Plane tool.
# Points These fields specify the number of traces you want to emit from the Plane tool in the X

and Y axes of the tool.

Part Creates particle traces beginning from nodes of the Part specified by the Part ID Number
field.
Part ID This field specifies the Part you wish to use as an emitter for the creation of a particle
trace. The Part ID number for a Part is found in the Main Parts List.
Number of This field specifies the number of emitters desired. They will be randomly selected from
Emitters the nodes of the part. (see Section 3.1, Part Overview)
File Creates particle traces from the locations specified in an external file.

(see Section 11.12, EnSight Particle Emitter File Format)

Emit... Opens the Emission Detail Attributes dialog.

Direction + _l|

Total Time Limit I 1.00002+02

_| Emit At Current Time

Emission Time Start I 0.00002+00
Emission Time Delta I 0.00002+00

Close I

Figure 7-18
Emission Detail Attributes dialog

Direction Trace the Particle in positive time, meaning to trace with the vector field, or trace the
Particle in negative time, meaning to trace the Particle upstream. Option only applies to
streamlines. Pathlines must be traced in + time.

(+) Positive time option traces Particle(s) forward in time. (This is the only option for
pathlines.)
) Negative time option traces Particle(s) backward in time.
(+/-) Positive/Negative time option traces Particle(s) both forward and backward in time.
Total Time Limit This field specifies the maximum length of time the Particle trace may continue (it may

terminate sooner for other reasons). For vector fields with recirculation zones, this can be
important to keep from integrating a trace indefinitely.

Emission Time Start This field specifies the simulation time at which to begin Particle emission. Enter value
between beginning and ending time available.

Time Delta This field specifies the time interval between emissions of Particles from the emitters. If
“0”, only one set of emissions will occur at start time

Pick Surface Toggle  Toggles on/off the feature which allows you to place the trace emitter at a point on a
surface directly below the mouse pointer by clicking the left mouse button.

Surface-Restrict Toggles on/off surface restricted feature for streamlines. The streamline will be
Toggle constrained to stay on the surface of the selected Part(s) by using only the tangential
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component of velocity. Be sure to use the Pick Surface feature in locating the emitter for a
surface restricted particle trace to ensure that the emitter is located on the surface of a Part.

Variable Offset If Surface-Restrict toggled on, this field specifies the distance into the flow field at which
velocity (and other variables) are to be sampled for the surface restricted trace(s). If
velocity values are present at the surface, this offset can be set to zero.

Interactive Emitter Toggles on/off interactive Particle tracing. Manipulation of the Cursor, Line or Plane tool
will cause the Particle trace to be recreated at the new location and updated in the
Graphics Window. When manipulation of the tool stops, the Particle trace and any Parts
that are dependent on it will be updated. (Only available for non-surface-restricted
streamlines).

Tool Location... Opens Transformations Editor dialog which allows you to precisely position the Cursor,
Line or Plane tool.

Create Creates a Particle trace Part using the selected Part(s) in the Main Parts List and the vector
Variable selected in the Main Variables List.
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7-22

Feature Detail Editor
(Traces)

Variable

XYZ

Type

Stream

Path

Show As

Double clicking on the Particle Trace Create/Update Icon opens the Feature Detail
Editor for Particle Traces, the Creation Attributes Section of which provides
access to additional functions for trace creation and modification:

=™ Feature Detail Editor (Traces) [%]
File Edit View Help ¥ Time Step Determination
CAE =R NV

Rot Angle | 0, 4 Max Angle | 5,

3 - (TVC1) Particle trace part Y Massed Particle

Massed Particles

Force Terms Drag Gravity Pressure

Desc | particle trace part Particle Diameter | | nngge.n3

Particle Densi
Creation Attributes % | 1.0000e+03

Variable N_velocity Initial Velocity
Uszse Fluid
Xl10000 | Y |10000  Z| 10000

X 0.0000e+00 ¥ | 0.0000e+00  Z | 0.0000e+00
Type Streamline

: Gravity Vectar
Show As Ribbon Ribbon [y y
Width 1.5418e-01

X 0.0000e+00 ¥ |.9.5100e+00 Z | 0.0000e+00

Emitter Information Fluid Density
Emitters Emit | oy None ¥| OF | 1.0000e+00
From

ursar at 0.500001

Fluid Dynamic Viscosity
None | Or | 1.9620e-05

5 Presaure Grasdient
Interactive  Add Emit| Delete Emit

Emitter B eelonily ¥
Direction  + T"*La_l T_itme 1.0000+02 Drag Coefficient Punction
11l
Default Y
Emit At Current Time elan

Emission g g000e+00 | TIME | 0 0000e+00
Delta

EiraelStar Contents of Time Step Determination and
Surface Restrict Pick Surface Massed Particle turn-downs.

Yariable [& nnanans Dleplay
AEee | 6 paseenn A | eoesteos

[ Time Step Determination

[ Massed Particle

Close | Create| Update Parent Appby Changes

Figure 7-19
Feature Detail Editor (Traces)

Opens a pop-up menu for the selection of an active variable to use to calculate the trace.

These fields specify the fraction of each vector component to be used in the calculation.
Specify 1 to use the full value of the vector component. Specify 0 to ignore the
corresponding vector component (and thus confine the motion of the Particle to a plane
perpendicular to that axis). Values between 0 and 1 diminish the contribution of the
corresponding component, while values greater than 1 exaggerate them.

Opens a pull-down menu for specification of whether Particle trace calculation uses
steady-state data to produce a Streamline or transient data to produce a Pathline.

Traces a massless Particle in a steady-sate vector field (for steady-state data or the current
time-step of transient data).

Traces a massless Particle through a time-varying vector field and so is only available
with transient results data. On certain systems, this selection can consume significant
quantities of CPU time to calculate the resulting Particle trace.

Opens a dialog for specification of trace representation.
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Depicts the trace as a line.

Depicts trace as if it were a ribbon. The ribbon width is a specified fixed value, while the
twisting is determined by the rotation of the flow about the path of the trace at any
particular point on the trace.

This field only applies when Ribbon representation is chosen. Larger values in this field
produce wider ribbons.

This section shows a list of all emitters created for the currently selected Particle Trace
Part.

Opens a pull-down menu for the specification of the emitter type.

Creates Particle trace beginning from the position of the Cursor tool.

Creates Particle traces beginning from the position of the Line tool.

This field specifies the number of traces you want to emit from the Line tool.
Create Particle traces beginning from the position of the Plane tool.

These fields specify the number of traces you want to emit from the Plane tool in the X
and Y axes of the tool.

Creates particle traces beginning from each node of the Part specified by the Part ID Number field.

This field specifies the Part you wish to use as an emitter for the creation of a particle
trace. The Part ID Number for a Part is found in the Main Parts List.
(see Section 3.1, Part Overview)

If 1.0, will emit from each node of the part. Lass than 1.0 values indicate a subset of nodes
to be used, randomly placed, as emitters.

Toggles on/off interactive Particle tracing. Manipulation of the emitter currently selected
in the Emitters List will cause the Particle trace to be recreated at the new location and
updated in the Graphics Window. When manipulation of the tool stops, the Particle trace
and any Parts that are dependent on it will be updated. (Only available for non-surface-
restricted streamlines) (Emitters created by picking a surface or from a Part can not be
made interactive).

Adds an emitter of the type specified by Emit From to the currently selected Particle Trace
Part.

Deletes the emitter selected in the Emitters List from the selected Particle Trace Part.

Trace the Particle in positive time, meaning to trace with the vector field, or trace the
Particle in negative time, meaning to trace the Particle upstream. Option only applies to
streamlines. Pathlines must be traced in + time.

Positive time option traces Particle(s) forward in time. (This is the only option for time-
dependent datasets.)

Negative time option traces Particle(s) backward in time.

Positive/Negative time option traces Particle(s) both forward and backward in time.
This field specifies the maximum length of time the Particle trace may continue (it may
terminate sooner for other reasons).

This field specifies the solution time at which to begin Particle emission. Enter value
between beginning and ending time available.

This field specifies the time interval between emissions of Particles from the emitters. If
“0”, only one set of emissions will occur at start time

Toggles on/off surface restricted feature for streamlines. The streamline will be
constrained to stay on the surface of the selected Part(s) by using only the tangential
component of velocity. Be sure to use the Pick Surface feature in locating the emitter for a
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surface restricted particle trace to ensure that the emitter is located on the surface of a Part.

Pick Surface Toggle  Toggles on/off the feature which allows you to place the trace emitter at a point on a
surface directly below the mouse pointer by clicking the left mouse button. This option is
forced on if the Surface Restricted Toggle is on.

Variable Offset This field specifies the distance into the flow field at which velocity (and other variables)
are to be sampled for the surface restricted trace(s). If velocity values are present at the
surface, this offset can be set to zero.

Display offset This field specifies the normal distance away from a surface to display the surface
restricted traces. A positive value moves the traces away from the surface in the
direction of the surface normal.

Please note that there is a hardware offset that will apply to contours, vector arrows,
separation/attachment lines, and surface restricted particle traces that can be turned on
or off in the View portion of Edit->Preferences. This preference (“Use graphics hardware
to offset line objects... ) is on by default and generally gives good images for everything
except move/draw printing. This hardware offset differs from the display offset in that it is
in the direction perpendicular to the computer screen monitor (Z-buffer).

Thus, for viewing, you may generally leave the display offset at zero. But for
printing, a non-zero value may become necessary so the traces print cleanly.

Time Step Opens a turn-down area for the specification of time-step parameters.
Determination
Min Steps This field is used to specify the minimum number of integration steps to perform in each
element.
Min Angle If angle between two successive line segments of the Particle trace is less than this value

EnSight will double the integration step.

Max Angle If angle between two successive line segments of the Particle trace is greater than this
value EnSight will half the integration step.

Rot Angle If the dot product between successive rotation vectors of the Particle trace is greater than
COS(Rot Angle), the integration step is halved.

Massed Particles Opens a turn-down area for the specification of massed-particle parameters.

Massed Particles ~ Toggles on/off the massed-particle traces feature. The default is OFF.

Force Terms Determines which force terms are used in the momentum balance equation calculation.
Drag Term Toggle Toggles on/off the inclusion of the drag force term in the massed-particle computation.
The default is ON.
Gravity Term Toggle Toggles on/off the inclusion of the gravity force term in the massed-particle computation.
The default is ON.
Pressure Term Toggles on/off the inclusion of the pressure force term in the massed-particle
Toggle computation. The default is OFF.

Particle Diameter ~ This field specifies the diameter of all particles. The default is 1.e-3.
Particle Density This field specifies the density value of all particles. The default is 1.e+3.

Initial Velocity Determines what initial velocity to use for all the particle emitters. The default is Use
Fluid Toggle ON.

Use Field Toggle  Toggles on/off whether all particle emitters should use the fluid velocity at their
corresponding locations. The default is ON.

XY, Z These fields specify the initial velocity components of all particle emitters. Their default is
<0.,0.,0.>.
Gravity Vector These fields specify the gravity vector to be applied in the massed-particle computation.
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The default gravity components are <0., -9.81, 0.>. This parameter only works with the
gravity force term.

This field specifies the fluid density variable to be used in the massed-particle
computation. The default is “None”.

This field specifies the fluid density value to be used in the computation if “None” is
specified as the variable name. The default value is 1.

This field specifies the fluid dynamic viscosity variable to be used in the massed-particle
computation. The default is “None”.

This field specifies the fluid dynamic viscosity value to be used in the computation if
“None” is specified as the variable name. The default value is 1.9620e-5. This parameter
only works with the drag force term.

This field specifies the fluid pressure gradient variable to be used in the massed-particle
computation. The default is “None”. This parameter only works with the pressure force
term.

This field specifies the drag coefficient function to be called each time the drag coefficient
is calculated. This function defaults to “None” which essentially defaults to the table
described above. Other functions may be accessed via the User-Defined Math Function
facility, i.e. DragCoefTable1(Re) (same as default), DragCoefPoly(Re),
DragCoefPower(Re). All functions must take the Reynolds Number as their only
argument. This parameter only works with the drag force terms.

(At the bottom of the Feature Detail Editor) Creates the Particle trace Part in the Graphics
Window as specified.

The Feature Detail Editor also allows you to make changes in batch; that is, to
make several changes to the menus and fields which do not effect the Graphics
Window until you click in the Apply Changes button. It is sometimes quicker
(with respect to CPU time) to make several changes at once rather than one at a
time as in the Quick Interaction Area.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

(see How to Create Particle Traces)

Troubleshooting Particle Traces

Problem Probable Causes Solutions
Particle Trace Part is empty. Velocity is zero. Change time steps or change
location of emitters.
Emitter points are outside of flow Change location for emitter points.
field.
Dataset is 3D and parent Parts are Change parent Parts.
2D, or dataset is 2D and parent Parts
are not planar.
The created variable selected does Recreate the variable for the parent
not exist for the parent Part(s) Part(s) selected
Streamline is OK, but pathline is Creating pathline with the emitter Modify emitter time for the emitter
empty. emitting at the last time step. groups.
Particle trace terminates prematurely Velocity has gone to zero. None
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Problem

Probable Causes

Solutions

Particle trace exists, then is removed
after deleting Parts.

Particle trace creation requested, but
Particles don’t come back.

Interactive tracing is slow.

Interactive trace does not enter the
next Part

Surface restricted Particle trace does
not appear

Surface Restricted particle trace does
not print well

Particle has been traced out of the
flow field.

Stopping point is at the boundary
between two Parts.

Particle getting lost and EnSight’s
search algorithm failing.

Total Time Limit reached.

The parent Part for the Particle trace
was deleted.

Requested a large number of Particle
traces and/or doing pathlines in large
transient dataset.

Particles are stuck in a recirculation
area.

The size of the model and density of
the mesh will affect the performance
of an interactive trace.

Interactive tracing is only done
through the Part the emitter resides
in.

Zero velocity at chosen variable
offset

Display offset causing trace to be on
opposite side of a surface (hidden
surface on)

Emitter does not lie on the surface of
selected Parts

See Display Offset discussion above

None

Change the parent Parts for the
Particle trace to include neighbor
Part.

Call CEI hotline support.

Change Total Time Limit.

None

Be patient.

Process will finish when Total Time
Limit is reached. Consider
terminating job and starting over
with a smaller Total Time Limit.

If you can, run on a faster, larger
memory workstation. Also, limit if
possible the area of interest by
cutting the mesh into pieces with the
Cut & Split Part editing operation.

When you let go of the emitter the
full trace will be shown

Select a Variable offset distance that
will give nonzero velocity

Change sign of the Display offset

Create emitters that lie on the surface

Enter a non-zero display offset.
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7.5 Clip Create/Update
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A Clip is a straight line (a Clip Line), a plane (a Clip Plane), a quadric surface
(cylinder, sphere, etc.), a constant X, y, or z plane, a box, or an i, j, or k plane that
passes through selected model Parts (or already created Clips, Isosurface, or
Developed Surface Parts). EnSight calculates the values of variables at the nodes
of the Clip. Clips can be parent Parts. For example, you can create a Clip Line
passing through a vector field, then create vector arrows originating from the
nodes of the Clip Line. Clips are created on the server, and so are not affected by
the selected Representation(s) of the parent Part(s). If you activate or create
variables after creating a Clip, the Clip automatically updates to include them.

You specify the location, orientation, and size of the Clip numerically in the
Transformations Editor dialog, or interactively using the Line, Plane, Box, or
Quadric surface tool. If you wish, EnSight will automatically extend the size of a
Clip Plane to include all the elements of the parent Part(s) that intersect the plane.

For a Clip Line, which is composed of bar elements, you specify how many
evenly spaced nodes are along the line. For a grid-type Clip Plane, which is
composed of rectangular elements, you specify the number of nodes in each
dimension, resulting in an evenly spaced grid of nodes across the plane.

If you request a mesh-type Clip Plane, an xyz clip, or any of the quadric surfaces,
EnSight finds the intersection of the specified plane or surface with the selected
parent Part(s) and creates elements of various dimensions, sizes, and shapes that
together form a cross-section of the parent Part(s). In this cross-section, three-
dimensional parent Part elements result in two-dimensional Clip Plane elements,
and two-dimensional parent Part elements result in one-dimensional Clip Plane
elements. Note that two-dimensional parent Part elements that are coplanar with
the cross-section are not included since they do not intersect the plane.

For XYZ, Plane, Quadric and Revolution Clips you can specify the resulting part
to be all elements that intersect the specified value - resulting in a “crinkly”
surface which can help analyze mesh quality.

For each Clip node on or inside an element of the selected parent Part(s), EnSight
calculates the value of each variable by interpolating from the variable’s values at
the surrounding nodes of the parent Part(s).

You can interactively manipulate the location of a clip Part by toggling on the
Interactive Tool button. When this toggle is on, the tool used to create the clip Part
will appear in the Graphics Window. Manipulation of this tool will cause the clip
Part to be recreated at the new location. This feature allows you to interactively
sweep a plane across your model or manipulate the size and location of the
cylinder, sphere, or cone.

You can animate a Clip by specifying an Animation Delta vector that moves the
Clip to a new location for each frame or page of the animation. The Clip updates
to appear as if it had been newly created at the new location and time.

For structured Parts, you can sweep through the Part with any of the i, j, or k
planes.

A Box Clip will create a part according to the Box Tool, and that can either be the
intersection of the Box Tool walls with the selected model parts (intersect), the
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crinkly intersection of the Box Tool walls with the selected model parts (crinkly),
the portion of the selected model parts that lie within the Box Tool (inside), or the
portion of the selected model parts which lie outside the Box Tool (outside).

Clicking once on the Clip Create/Update Icon opens the Clip Editor in the Quick
interaction Area which is used to both create and update clip Parts.

Figure 7-20
Clip Create/Update Icon

Use Tool
UK The 1JK clip tool is used with structured mesh results.
Use Towl IJK Domain Intersect Interactive Manual
Min 1 Max 3 Increment 1
Mesh Slice I Value 1 Limit J,K Extents...
Create Apply Tool Change Fool Locaion... Help...
Figure 7-21
Quick Interaction Area - Clip Editor - 1JK tool
Domain Specification to extract the intersection of the specified mesh slice values. For IJK clips,
the only valid selection is “Intersect”.
Interactive Opens pull-down menu for selection of type of interactive manipulation of the IJK clip.
Options are:

Off Interactive 1JK clips are turned off.

Manual Value of the IJK clip selected are manipulated via the slider bar and the
1JK clip is interactively updated in the Graphics Window to the new value.

Auto Value of the IJK clip is incremented by the Auto Delta value from the
minimum range value to the maximum value. When reaching the maximum it
starts again from the minimum.

Auto Cycle Value of the IJK clip is incremented by the Auto Increment value from the
minimum range value to the maximum value. When reaching the maximum
it decrements back to the minimum.

Slider Bar For 1JK clips, the slider bar is used to increment / decrement the Mesh Slice Value
between its Minimum and Maximum value.

Min Specification of the minimum slice value for the range used with the “Manual” slider bar

and the “Auto” and “Auto Cycle” options.

Max Specification of the maximum slice value for the range used with the “Manual” slider and

the “Auto” and “Auto Cycle” options.

Increment Specification of the increment/decrement the slider will move within the min and max,

each time the stepper buttons are clicked.

Mesh Slice Opens a pull-down menu for selecting which of the IJK dimensions you wish to allow to
change. You will then specify Min, Max and Step limits for the two remaining “fixed”
dimensions.

7-28 EnSight 7 User Manual



Value

Limit IJK Extents

IJK D(2)Min
IJK D(2)Max
IJK D(2) Step
IJK D(3)Min
IJK D(3)Max
IJK D(3) Step

Show Parent IJK
Part Extents...

Create

Apply Tool Change

Feature Detail Editor
(Clips) - UK

Use Tool

XYz

Domain

Interactive

Off

Manual

Auto

Auto Cycle
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This field specifies the I, J, or K plane desired for the dimension selected in Mesh Slice

Opens the “Limits Extents of Current Slice By” dialog, in which the off dimension ranges
can be limited.

This field specifies the minimum value for the second fixed dimension.

This field specifies the maximum value for the second fixed dimension.

This field specifies the step size through the second fixed dimension.

This field specifies the minimum value for the third fixed dimension.

This field specifies the maximum value for the third fixed dimension.

This field specifies the step size through the third fixed dimension.

Will show the second and third dimension Min and Max extents as defined
for the clip parent Part.

Creates the Clip Part in the Graphics Window as specified.

Recreates the Clip Part selected in the Main Parts List at the current position of and of the
type specified by Use Tool.

Double Clicking on the Clip Create/Update Icon brings up the Feature Detail
Editor, the Creation attributes section of which offers the same features for the IJK
tool as the Quick Interaction Area Editor.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

(see How To Create IJK Clips)

The XYZ tool is used to create a planar Part at a constant Cartesian component value that
is referenced according to the local frame of the part.

Use Towl XYZ Domain Intersect Interactive Manual

Increment |y 4000e.01

Min | 0000e-+00 Max | g 0000e-+00

Mesh Slice X Value | | 0000e+00

Create Apply Tool Change Fool Locaion... Help...

Figure 7-22
Quick Interaction Area - Clip Editor - XYZ Tool

Intersect  will create the cross section of the selected parts at the specified X, Y, or Z
plane.
Crinkly will create a new part consisting of the parent part elements that intersect the

X, Y, or Z plane
Opens pull-down menu for selection of type of interactive manipulation of the XYZ clip.
Options are:
Interactive XYZ clips are turned off.

Value of the XYZ clip selected are manipulated via the slider bar and the
XYZ clip is interactively updated in the Graphics Window to the new value.

Value of the XYZ clip is incremented by the Auto Delta value from the
minimum range value to the maximum value. When reaching the maximum it
starts again from the minimum.

Value of the XYZ clip is incremented by the Auto Increment value from the
minimum range value to the maximum value. When reaching the maximum
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Slider Bar

Min
Max

Increment

Mesh Slice

Value

Apply Tool Change

Create

Feature Detail Editor
(Clips) - XYZ

Animation Delta

7-30

it decrements back to the minimum.

For XYZ clips, the slider bar is used to increment / decrement the Mesh Slice Value
between its Minimum and Maximum value.

Specification of the minimum interval value of the interactive XYZ clip.
Specification of the maximum interval value of the interactive XYZ clip.

Specification of the interval step of the interactive XYZ clip.

Opens a pulldown menu for selecting which of the XYZ components you wish to clip, i.e. the X, the
Y, or the Z component.

This field specifies the coordinate desired for the Mesh Slice component.

Recreates the Clip Part selected in the Main Parts List at the current position of and of the
type specified by Use Tool.

Creates the Clip Part in the Graphics Window as specified.

Double Clicking on the Clip Create/Update Icon brings up the Feature Detail
Editor (Clips), the Creation attributes section of which offers access to the same
interactive clip parameters as found in the Quick Interaction Area Editor, along
with additional animation delta control of clips using the XYZ tool.

Desc I Clip_plane

Creation Attributes

=i | 7 Interactive
Tool

Tool XYZ

Domain  Intersect _II
Clip Parameters
| | ]
Min | 0.0000e+00 | MaX | 3.3120e+01
Step

Mesh
Slice

2.0152e+00

X | Value | 2.3695e+01

Animation Delta

X ¥ z
| 0.0000e+00 | 0.0000e+00 | 0.0000e+00
Figure 7-23

Quick Interaction Area - Clip Editor - XYZ Tool - Creation Attributes

These X,Y,Z fields specify the incremental change in position of the clip for each page of
Flipbook or frame of Keyframe animation.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

(see How To Create XYZ Clips)

EnSight 7 User Manual



Use Tool

RTZ

Domain

Intersect

Crinkly
Interactive

Off

Manual

Auto

Auto Cycle

Slider Bar
Min
Max

Increment

Slice

Value
Axis
Create

Apply Tool Change

Feature Detail Editor
(Clips) - RTZ
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The RTZ tool is used to create a Part using cylindrical coordinates at a constant radius
about an axis, angle around that axis or height along an axis..

Use Towl RTZ Interactive Off

Domain Intersect

i | o spopecon Max | s anane o9

Ioorernent |y anone o
Slice B 1| Value | go00e+00
Axis ¥
Create Apply Tool Change Fool Lecaien... Help...
Figure 7-24

Quick Interaction Area - Clip Editor - RTZ tool

Will create a cross section of the selected parts at the specified radius, angle, or distance
along the axis.

Will create a new part consisting of the parent part elements that intersect the specified
radius, angle or distance.

Opens pull-down menu for selection of type of interactive manipulation of the RTZ clip.
Options are:

Interactive RTZ clips are turned off.

Value of the RTZ clip selected are manipulated via the slider bar and the
RTZ clip is interactively updated in the Graphics Window to the new value.

Value of the RTZ clip is incremented by the Auto Delta value from the
minimum range value to the maximum value. When reaching the maximum it
starts again from the minimum.

Value of the RTZ clip is incremented by the Auto Increment value from the
minimum range value to the maximum value. When reaching the maximum
it decrements back to the minimum.

For RTZ clips, the slider bar is used to increment / decrement the Slice Value between its
Minimum and Maximum value.

Specification of the minimum slice value for the range used with the “Manual” slider bar
and the “Auto” and “Auto Cycle” options.

Specification of the maximum slice value for the range used with the “Manual” slider and
the “Auto” and “Auto Cycle” options.

Specification of the increment/decrement the slider will move within the min and max,
each time the stepper buttons are clicked.

Opens a pull-down menu for selecting which of the RTZ components to clip, i.e. the radial
(R), the angle theta (T) in degrees, or the distance along the longitudinal axis Z, (Z).

This field specifies the magnitude desired for the Slice component, (theta in degrees).
The global axis with which to align the longitudinal (Z) RTZ axis.
Creates the Clip Part in the Graphics Window as specified.

Recreates the Clip Part selected in the Main Parts List at the current position of and of the
type specified by Use Tool.

Double Clicking on the Clip Create/Update Icon brings up the Feature Detail
Editor, the Creation attributes section of which offers the same features for the
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7-32

Use Tool

Line

Domain

Interactive Tool

# of Points on Line

Tool Location...

Apply Tool Change

Create

RTZ tool as the Quick Interaction Area Editor.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

(see How To Create RTZ Clips)

The Line tool is used to create a clip line.
Use Towl Line Domain Intersect Interactive
Tool

# of Points on Line | o,

Create Apply Tool Change Tool Location... Help...

Figure 7-25
Quick Interaction Area - Clip Editor - Line Tool

Specification to extract the intersection of the line tool with the selected part(s). For Line
clips, the only valid selection is “Intersect”.

Toggles on/off interactive movement and updating of a clip Part. When toggled on, the
line tool used to create the 2D clip line will appear in the Graphics Window. Movement of
the tool will cause the Clip Part to be recreated at the new position. When manipulation of
the tool stops, the clip Part and any Parts that are dependent on it will be updated. During
movement, the Tool itself will not be visible, so as not to obscure the Line Clip Part. The
Tool will reappear when the mouse button is released.

Specification of number of evenly spaced points on the line at which to create a node.

Opens the Transformation Editor dialog to permit precise positioning of the Line Tool
within the Graphics Window. (see Tool Positions... Line Tool in Section 6.5, Tools Menu
Functions and How To Use the Line Tool)

Recreates the Clip Part selected in the Main Parts List at the current position of and of the
type specified by Use Tool.

Creates the Clip Part in the Graphics Window as specified.
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Feature Detail Editor ~ Double Clicking on the Clip Create/Update Icon brings up the Feature Detail
(Clips) - Line Editor (Clips), the Creation attributes section of which offers access to additional
features for the creation and modification of clips using the Line tool.

[ Fearure Detai Edvor Clips) ]

File Edit View
]

Desc | Clip _line -
Creation Attributes
Tool Line =] I | Interactive
Tl
Domain  Intersect i I
Clip Parameters
Pos X Y Z
Ptl [1.9879+00 || 1.3648e-01 [ -6.98508+00
Pt2 | 553986400 || 1.60856+01 | -9.0838e+00
# of Points on Line IT Figure 7-26
Got Tool Cmmsl Sot Tool Cmmsl Featu.re Detgll Editor (Clips) - Line Tool
Creation Attributes
Animation Delta
X ¥ z
[0.00006+00 || 0.0000+00 || 0.00008+00
Clip Parameters
Pos of Pt1 Specification of XYZ endpoint-coordinates of Line Clip. The position of a Line Clip
Pos of Pt2 Part, if selected in the Feature Detail Editor’s Parts List, can be changed by entering values

in the numeric fields and then pressing Return.

Set Tool Coords The position of the Line Clip tool can be changed by entering values in the numeric fields
and then pressing Set Tool Coords.

Get Tool Coords The values in the numeric fields (and the position of a Line Clip Part, if selected in the
Feature Detail Editor’s Parts List) can be updated after moving the Line tool interactively
in the Graphics Window by clicking Get Tool Coords. If a Line Clip Part is selected in the
Feature Detail Editor Parts List, it will be repositioned to the new coordinates after
clicking Get Tool Coords. Coordinates are always in the original model frame (Frame 0).

Animation Delta These X,Y,Z fields specify the incremental change in position of the clip for each page of
Flipbook or frame of Keyframe animation.

The Feature Detail Editor also allows you to make changes in batch; that is, to
make several changes to the menus and fields which do not effect the Graphics
Window until you click in the Apply Changes button. It is sometimes quicker
(with respect to CPU time) to make several changes at once rather than one at a
time as in the Quick Interaction Area.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

(see How To Create Line Clips)
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Use Tool
Plane The Plane Tool is used to create a Plane Clip.

Domain Intersect  will create the cross section of the selected parts where they intersect the plane

tool.

Crinkly will create a new part consisting of the parent part elements that intersect the
plane tool.

Inside will cut the parent parts and create a new part consisting of the portion on the
positive z side of the plane tool.

Outside  will cut the parent parts and create a new part consisting of the portion on the
negative z side of the plane tool.

In/Out will cut the parent parts and create two new parts - namely an /nside and
Outside part.

Plane Type
Mesh Will create a Plane Clip showing the cross section of the parent Part.

Use Towl Plane Domain Intersect Interactive
Tool

Plane Type Mesh Plane Extents Infinite

Gl Prr o B | 4 ¥y

Create Apply Tool Change Tool Location... Help...

Figure 7-27
Quick Interaction Area - Clip Editor - Plane Tool - Mesh Type

Plane Extents Opens a pull down menu for selection of the extent of the Plane Clip.
Finite limits the Plane Clip to the area specified by the Plane Tool corner coordinates.
Infinite extends the Plane Clip to include the intersection of the plane with all elements of
the selected model Parts.

Grid Will create a Plane Clip by discrete point sampling.

Use Towl Plane Domain Intersect Interactive
Tool

Plane Type Grid Plame Bxlenty | Finite
Grid Ptzon: X | g Y5

Create Apply Tool Change Tool Location... Help...

Figure 7-28
Quick Interaction Area - Clip Editor - Plane Tool - Grid Type

Grid Pts on:XY These fields specify the number of points on each edge of a Plane Clip at which to create
nodes. Additional nodes are located in the interior of the plane to form an evenly spaced
grid. The values must be positive integers. Applicable only to grid-type Plane Clips. Grid
Pts in X correspond to the x-direction on the Plane tool, while the number of Grid Pts in Y
correspond to the y-direction of the Plane tool.

Apply Tool Change Recreates the Clip Part selected in the Main Parts List at the current position of and of the
type specified by Use Tool.

Interactive Tool Toggles on/off interactive movement and updating of the clip Part. When toggled on, the
Plane Tool used to create the clip Part will appear in the Graphics Window. Movement of
the Plane Tool will cause the Plane Clip to be recreated at the new position. When
manipulation of the tool stops, the clip Part and any Parts that are dependent on it will be
updated. During movement, the Tool itself will not be visible, so as not to obscure the Line
Clip Part. The Tool will reappear when the mouse button is released.
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Tool Location...

Create

Feature Detail Editor
(Clips) - Plane

Clip Parameters

Pos of C1
Pos of C2
Pos of C3

Set Tool Coords
Get Tool Coords

Animation Delta
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Opens the Transformation Editor dialog to permit precise positioning of the Plane Tool.
(see Section 6.5, Tools Menu Functions and How To Use the Plane Tool)

Creates the Clip Part in the Graphics Window as specified.

Double Clicking on the Clip Create/Update Icon brings up the Feature Detail
Editor (Clips), the Creation attributes section of which offers access to additional
features for the creation and modification of clips using the Plane tool.

File Edit View
]

3 - (2/C1) Clip_plane

Desc I Clip_plane

Creation Attributes

Tool Plane = I I Interactive
Tool
Domain  Intersect _II

Clip Parameters

Type Mesh _l| Extents Finite _l|
Pos X Y Z

c1 |s.2850e+00 |-s.2850e+00 |s.3290e-01
cz2 |2.4855e+01 |-s.2850e+00 |s.3290e-01
3 |2.4855e+01 |s.2850e+00 |s.3290e-01

Orwbed Pheoomy X I‘”} % I‘”}
Get Tool Coor\dsl Set Tool Coor\dsl

Animation Delta

X ¥ z
| 0.0000e+00 | 0.0000e+00 | 0.0000e+00
Figure 7-29

Feature Detail Editor (Clips) - Plane Tool Creation Attributes

Specification of the location, orientation, and size of the Plane Clip using the coordinates
(in the Parts reference frame) of three corner points, as follows:

Corner 1 is corner located in negative-X negative-Y quadrant

Corner 2 is corner located in positive-X negative-Y quadrant

Corner 3 is corner located in positive-X positive-Y quadrant

Will reposition the Plane Tool to the position specified in C1, C2, and C3.
Will update the C1, C2, and C3 fields to reflect the current position of the Plane Tool.

These X,Y,Z fields specify the incremental change in position of the clip for each page of
Flipbook or frame of Keyframe animation.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

(see How To Create Plane Clips)
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Use Tool
Box This Clipping Tool extracts portions of the model that are inside, outside, or that intersect
a specified box.
Be aware that due to the alogorithm used, this clip can (and most often does) have
chamfered edges, the size of which depends on the coarseness of the model elements
Domain Intersect  will create a new part consisting of the intersection of the box tool sides and

the selected parts.
Crinkly will create a new part consisting of the parent part elements that intersect the
box tool sides.

Inside will extract the volume portion of the parent parts that lie within the box.
Outside  will extract the volume portion of the parent parts that do not lie within the
box.
In/Out will create two new parts - namely the /nside and Outside parts.
Use Toal Box Domain Intersect
Create Apply Tool Change Tool Location... Help...
Figure 7-30

Quick Interaction Area - Clip Editor - Box Tool
Apply Tool Change Recreates the Clip Part selected in the Main Parts List at the current position of and of the
type specified by Use Tool.

Tool Location... Opens the Transformation Editor dialog to permit precise positioning of the Box Tool. (see
Section 6.5, Tools Menu Functions and How To Use the Box Tool)

Create Creates the Clip Part in the Graphics Window as specified.

Feature Detail Editor  Double Clicking on the Clip Create/Update Icon brings up the Feature Detail
(Clips) - Box Editor, the Creation attributes section of which offers the same features for the
Box tool as the Quick Interaction Area Editor.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

(see How To Create Box Clips)
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Cylinder, Sphere, Cone These Tools are used to create a quadric clip surface

Domain

Interactive Tool

Tool Location...

Apply Tool Change

Create

EnSight 7 User Manual

Intersect  will create the cross section of the selected parts where they intersect the
quadric tool.

Crinkly will create a new part consisting of the parent part elements that intersect the
quadric tool.

Inside will cut the parent parts and create a new part consisting of the portion on the
inside of the quadric tool.

Outside  will cut the parent parts and create a new part consisting of the portion on the
outside of the quadric tool.

In/Out will cut the parent parts and create two new parts - namely an /nside and
Outside part.

LUK
 xvz

= &

Use Towl Line Domain Intersect Interactive
= Tool

Plane
# of Poi Pox
Cylinder
Sphere
Cone
. Bevolution Taol

Revolve 1D Part

Crea Mool Change Tool Location... Help...

Figure 7-31
Quick Interaction Area - Clip Editor - Cylinder, Sphere, & Cone Tools

Toggles on/off interactive movement and updating of a clip Part. When toggled on, the
Quadric Tool used to create the Clip Part will appear in the Graphics Window at the
location of the Clip Part. Movement of the Quadric Tool will cause the Clip Part to be
recreated at the new position. When manipulation of the tool stops, the Clip Part and any
Parts that are dependent on it will be updated. During movement, the Tool itself will not
be visible, so as not to obscure the Line Clip Part. The Tool will reappear when the mouse
button is released.

Opens the Transformation Editor dialog to permit precise positioning of Quadric
Tools.(see Section 6.5, Tools Menu Functions and How To Use the Cylinder Tool, How
To Use the Sphere Tool, and How To Use the Cone Tool)

Recreates the Clip Part selected in the Main Parts List at the current position of and of the
type specified by Use Tool.

Creates the Clip Part in the Graphics Window as specified.
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Feature Detail Editor
(Clips) Quadric Tool

Clip Parameters
Cylinder

Orig XYZ

Axis

Radius
Sphere

Orig

Axis

Radius

Cone
Orig

Axis

Angle
Set Tool Coords
Get Tool Coords

Animation Delta
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Double Clicking on the Clip Create/Update Icon brings up the Feature Detail
Editor (Clips), the Creation attributes section of which offers access to additional
features for the creation and modification of clips using the Quadric tools.

File Edit View

Desc | Clip_cylinder

Creation Attributes

Tl Cylinder = I ) Interactive
Taool
Domain  Intersect _II

Clip Parameters

X ¥ 4

Orig | 3 28500+00

Axis

[0.0000e+00 | 6.3290¢-01

[ 1.0000e+00 | 0.00008+00

Radius | 2.21408-+00

| 0.0000¢+00

Get Tool Coor\dsl Set Tool Coor\dsl
Animation Delta
X Y -4
[0.00006+00 | 0.0000+00 || 0.0000e+00
Figure 7-32

Feature Detail Editor (Clips) - Quadric Tool Creation Attributes

Specification of the origin (the center point) of the Cylindrical Clip.
Specification of the longitudinal axis direction of the Cylindrical Clip.
Specification of the radius of the Cylindrical Clip.

Specification of the origin (the center point) of the Spherical Clip.

Specification of the axis direction of the Spherical Clip. (Note. Axis is important if
Developed Surface is created from the spherical clip.)

Specification of the radius of the Spherical Clip.

Specification of the origin (the tip of the cone) of the Conical Clip.

Specification of the axis direction of the Conical Clip. Axis direction goes from tip to
base.

Specification of the conical half angle (in degrees) of the Conical Clip.
Will reposition the Quadric Tool to the position specified in the Clip Parameter fields.
Will update the Clip Parameter fields to reflect the current position of the Quadric Tool.

These X,Y,Z fields specify the incremental change in position of the clip for each page of
Flipbook or frame of Keyframe animation.
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The Feature Detail Editor also allows you to make changes in batch; that is, to
make several changes to the menus and fields which do not effect the Graphics
Window until you click in the Apply Changes button. It is sometimes quicker
(with respect to CPU time) to make several changes at once rather than one at a
time as in the Quick Interaction Area.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

(see How To Create Quadric Clips)
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Use Tool
Revolution Tool This clipping Tool is used to create custom clip surfaces which are defined by revolving a
set of lines about a defined axis.
Use Tool Revolution Tool Domain Inside
Create Apply Tool Change Tool Location... Help...
Figure 7-33
Quick Interaction Area - Clip Editor - Revolution Tool
Domain Intersect  will create the cross section of the selected parts where they intersect the
revolved surface.
Crinkly ~ will create a new part consisting of the parent part elements that intersect the
revolved surface.
Inside will cut the parent parts and create a new part consisting of the portion on the
inside of the revolved surface.
Outside  will cut the parent parts and create a new part consisting of the portion on the
outside of the revolved surface.
In/Out will cut the parent parts and create two new parts - namely an /nside and
Outside part.
Tool Location... Opens the Transformation Editor dialog to permit precise location of the revolution tool

within the Graphics Window. It is here where you also can control the number and
positioning of the set of lines which make up the tool.
(see Section 6.5, Tools Menu Functions and How To Use the Surface of Revolution Tool)

Apply Tool Change Recreates the Clip Part selected in the Main Parts List at the current position of and of the
type specified by Use Tool.

Create Creates the Clip Part in the Graphics Window as specified.
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Feature Detail Editor ~ Double Clicking on the Clip Create/Update Icon brings up the Feature Detail
(Clips) - Revolution Editor (Clips), the Creation attributes section of which offers access to additional
Tool features for the creation and modification of clips using the Revolution tool.

File Edit View Help |
B 1 =

3 — (2/C1) Clip_revalution

Desc I Clip_revalution =
Creation Attributes
Tool | Revolution Tool i I L inderactive
Famnd
Domain  Intersect i I
Clip Parameters
X ¥ z
Orig
| 16570e+01 || 0.00000+00 || 8:32005-01
Axis
[1.0000e+00 [ 0.0000e+00 [ 0.0000e+00
Distance Radius
—-5.2860e+00 = | 2.3140e-+00
-4.1325e+00 u 3.3140e+00
0.0000e+00 7 6.6280e+00
Get Tool Cnnrdsl Set Tool Cnnrdal
Animation Delta
X Y Z
[0.0000e+00 | 0.0000e00 || 0.0000+00
Figure 7-34

Feature Detail Editor (Clips) - Revolution Tool Creation Attributes

Revolution Tool Clip Parameters

Orig These fields specify the XYZ coordinates of the origin (center point) of the Revolution
Clip.

Axis These fields specify the XYZ coordinates of the axis direction of the Revolution Clip.

Distance/Radius These lists specify the distance (from the origin) and radius for each point that defines the

Revolution Clip. The points can Not be edited within this dialog. You must edit the
Revolution Tool in the Transformations dialog.

Set Tool Coords Will reposition the Revolution Tool to the position specified in the Clip Parameter fields.
Get Tool Coords Will update the Clip Parameter fields to reflect the current position of the Revolution Tool.
Animation Delta These X,Y,Z fields specify the incremental change in position of the clip for each page of

Flipbook or frame of Keyframe animation.

The Feature Detail Editor also allows you to make changes in batch; that is, to
make several changes to the menus and fields which do not effect the Graphics
Window until you click in the Apply Changes button. It is sometimes quicker
(with respect to CPU time) to make several changes at once rather than one at a
time as in the Quick Interaction Area.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

(see Section 6.5, Tools Menu Functions and How To Use the Surface of Revolution Tool)

EnSight 7 User Manual 7-41



7.5 Clip Create/Update

Use Tool
Revolve 1D Part This option will create a clip surface by revolving a line, defined by a Part, about an axis.
Usge Towl Revolve 1D Part Domain  Inside
Revolve Part i
X ¥ z
Orig
0.0000e+00 0.0000e+00 0.0000e+00
1.00006-+00 0.0000e+00 0.0000e+00
Create Apply Tool Change Fool Locaion... Help...
Figure 7-35
Quick Interaction Area - Revolve 1D Part Clip Editor
Domain Intersect  will create the cross section of the selected parts where they intersect the
revolved surface
Crinkly ~ will create a new part consisting of the parent part elements that intersect the
revolved surface.
Inside will cut the parent parts and create a new part consisting of the portion on the
inside of the revolved surface.
Outside  will cut the parent parts and create a new part consisting of the portion on the
outside of the revolved surface.
In/Out will cut the parent parts and create two new parts - namely an /nside and
Outside part.

Revolve Part This field specifies the Part number which will be revolved. The 1D Part must contain
only bar elements and must have only two free ends (i.e., there must be only one “logical”
line contained in the Part).

Orig These fields specify the XYZ coordinates of the axis line origin point.

Axis These fields specify the direction vector of the axis line. The “line” contained in the Part

specified by number in Revolve Part will be revolved about this axis to create the clip
surface Part.

Apply Tool Change Recreates the Clip Part selected in the Main Parts List at the current position of and of the
type specified by Use Tool.

Create Creates the Clip Part in the Graphics Window as specified.
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Feature Detail Editor Double Clicking on the Clip Create/Update Icon brings up the Feature Detail

(Clips)

10 coefficient values

Animation Delta

EnSight 7 User Manual

Editor (Clips), the Creation attributes section of which offers access to one type of
clip creation which is not available in the Quick Interaction area. It is possible to
create a 3D Quadric clip using the General Quadric option by directly specifying
the coefficients of a general quadric equation.

The Feature Detail Editor also allows you to make changes in batch; that is, to
make several changes to the menus and fields which do not affect the Graphics
Window until you click in the Apply Changes button. It is sometimes quicker
(with respect to CPU time) to make several changes at once rather than one at a
time as in the Quick Interaction Area.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

File Edit

co=mn

.

)

L

Desc I

Creation Attributes

Tool General Quadric i I  Inderactive
Fad
Domain  Intersect _II

Clip Parameters
XAZ o+ YAZ 4+ ZAZ 4
| 1.0000-+00 | 1.0000-+00 | 1.0000-+00
XY + YZ + XKZ +
| 0.0000e+00 | 0.0000e+00 | 0.0000e+00
X + ¥ o+ Z
| 0.0000e+00 | 0.0000e+00

= I 1.0000e+00

| 0.0000e+00

Animation Delta
% ¥ Z
| D e+ 05 | B e B0

| D e+ 05

Figure 7-36
Feature Detail Editor (Clips) - Revolve 1D Part Creation Attributes

These coefficient values represent the general equation of a Quadric surface. They can be
changed by modifying the values. No tool exists corresponding to this equation.
AXZ+BYHCZ*+DXY+EY ZAFXZ+GX+HY+IZ=]

Not available for General Quadric Clips.

The Feature Detail Editor also allows you to make changes in batch; that is, to
make several changes to the menus and fields which do not effect the Graphics

7-43



7.5 Clip Create/Update

Window until you click in the Apply Changes button. It is sometimes quicker
(with respect to CPU time) to make several changes at once rather than one at a
time as in the Quick Interaction Area.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

Troubleshooting Clips

Problem Probable Causes Solutions

Clip does not move during animation Animation deltas are not set, or ~ Change the animation delta

are too small. values.
Clip results in an empty Part. Clip was taken outside of the Change the clip Tool location.
model.

7-44 EnSight 7 User Manual



7.6 Vector Arrow Create/Update

7.6 Vector Arrow Create/Update
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Vector Arrows visualize the magnitude and direction of a vector variable at
discrete points (at nodes, element vertices, or at the center of elements).

Other features can visualize magnitude, but Vector Arrows also show direction.

Vector arrow Parts are dependent Parts known only to the client. They cannot be
used as a parent Part for other Part types and cannot be used in queries. As
dependent Parts, they are updated anytime the parent Part and/or the creation
vector variable changes (unless the general attribute Active flag is off).

Vector arrows can be filtered according to low and/or high threshold values.

Vector arrows can emanate from the available nodes of the parent Part(s), the
available element vertex nodes of the parent Part(s), or the available element
centers of the parent Part(s) which pass through the filter successfully. The nodes
and elements available in the parent Part are based on the visual Representation of
the Part. Thus, for a border Representation of a Part, only the border elements and
associated nodes are candidates.

Vector arrows can have straight shafts representing the vector at the originating
location, or be the segment of a streamline emanating from the originating
location (curved). Straight vector arrows are displayed relatively quickly, while
curved vector arrows can be time consuming.

Different tip styles, sizes, and colors can be used to enhance vector arrow display.

Clicking once on the Vector Arrow Create/Update Icon opens the Vector Arrow
Editor section of the Quick interaction Area which is used to both create and
update (make changes to) vector arrow Parts.

Figure 7-37
Vector Arrow Create/Update Icon
File Edit Query View Tools Case Help |
e A
b
Select Part(s) To Operate On Select a Variable Scale Factor [ 4 g105. 00 Get Default|  Arrow Tipe...
L-(M/C1) external flow field velocity — . .
2.(M/C1) ami-x hypersonic bod SurfaceNormal Type  Rectilinear Lecation Vertices
3-(2/C1} Clip_plane Density [ 1 00
2.(V/CL) Vector Arrow part :
Filter  None Low | .0000e+00 High [ 1 0000e+00
Create Apply New Variable Help...
Shaded _|Hidden Line Cursor _|Line _|Plane Axis _|Bounds Fast Display  Legend... Info...

Figurer-38
Quick Interaction Area - Vector Arrow Editor
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Scale Factor / Time When Type is “Rectilinear”, this field specifies a scale factor to apply to the vector values
before displaying them. Scaling is usually necessary to control the visual length of the
vector arrows since the vector values may not relate well to the geometric dimensions.
Can be negative, causing the vector arrows to reverse direction.

When Type is “Rect. Fixed”, this field specifies the length of the arrows in units of the
model coordinate system. Can be negative, causing the vector arrows to reverse direction.
When Type is “Curved”, this field specifies the duration time for streamlines forming the
shaft of curved vector arrows. Is an indication of the length of the curved vector arrow.

Get Default Sets Scale or Time Factor value to a computed reasonable value based on the vector
variable values and the geometry.

Arrow Tips... Opens the Vector Arrow Tip Settings dialog.

Shape None

| s B [oe (G [ie [P [i0e
[Size Proportional i IB.BSBOe—O2

Figure 7-39
Vector Arrow Tip Settings dialog

Shape Opens a pop-up menu to select tip shape.

None option displays arrows as lines without tips.

Normal arrows have two short line tips, similar to the way many people draw
arrows by hand. The tip will lie in the X-Y, X-Z, or Y-Z plane depending on
the relative magnitudes of the X, Y, and Z components of each individual vector.
Suggested for 2D problems.

Triangles arrows have a tip composed of two intersecting triangles in the two
dominant planes. Good for both 2D and 3D fields.

Tipped arrows display the tip of the arrow in any user specified color. Good for both
2D and 3D fields. The color may be specified in the RGB fields or chosen from the
Color Selector dialog which is opened by pressing the Mix... button

Size Opens a pop-up menu for selecting tip size.
Fixed sized arrows have tips for which the length is specified in the data entry field to the
right of the pop-up menu button. Units are in the model coordinate system.
Proportional sized arrow tips change proportionally to the change in the magnitude of the
Vector arrows.

Type Opens a pop-up menu for selection of shaft-type of vector arrows. Options are:

Rectilinear arrows have straight shafts. The arrow points in the direction of the
vector at the originating location. The length of the arrow shaft is determined
by multiplying the vector magnitude by the scale factor.

Rect. Fixed arrows have straight shafts. The arrow points in the direction of the
vector at the originating location. The length of the arrow shaft is determined
by the scale factor. It is independent of the vector variable.

Curved arrows have curved shafts. The arrow is actually a streamline emanating
from the originating location. It represents the path that a massless Particle
would follow if the flow field was steady state. For this option, the “Scale
Factor” changes to “Time”. Time is the amount of time the streamline is
allowed to take and is an indication of how long the arrow will be.

Hint: Since curved arrows can take a significant amount of time(depending on
the number of originating locations), the setting of a proper “Time” value is
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7.6 Vector Arrow Create/Update

critical. The best way to do this is to first do a single Particle trace at a
representative location with the estimated “Time” value as the Max Time. A
quick iteration or two on the value here could save considerable time for the
curved vector arrow computation.

Opens a pop-up dialog for the selection of root-location of arrow shafts. The options are:

Node arrows originate from each node of the parent Part(s).

Note: Discrete Particles Parts must use Node option.

Vertices arrows originate only from those nodes at the vertices of each element of
the parent Part(s) (i.e., arrows are not displayed at free nodes or mid-side
nodes).

Element Center arrows originate from the geometric center of each element of the
parent Part(s).

The fraction of the parent’s nodes/elements which will show a vector arrow. A value of
1.0 will result in a vector arrow at each node/element, while a value of 0.0 will result in no
arrows. If between these two values, the arrows will be distributed randomly at the
specified density. There is no check for duplicates in the random distribution of arrows. It
is entirely possible that when you specify a density of 0.25 in a model containing 100
nodes you only get 15 unique locations with 10 duplicates. It will appear that only 15
arrows show up, but there are actually 25 with 10 duplicates.

Selection of pattern for filtering Vector Arrows according to magnitude. Options are:

None displays all the vector arrows. No filtering done.

Low displays only those arrows with magnitude above that specified in the Low
field. Filters low values out.

Band displays only those arrows with magnitude below that specified in the Low
field and above that specified in the High field. Filters the band out.

High displays only those arrows with magnitude below that specified in the High
field. Filters the high values out.

Low_High displays only those arrows with magnitude between that specified in the
Low field and that specified in the High field. Filters out low and high values.

Changes the vector Variable used to create the Vector Arrows to that currently selected in
the Variables List.

Double clicking on the Vector Arrow Create/Update Icon opens the Feature Detail
Editor for Vector Arrows, the Creation Attributes Section of which provides
access to the functions available in the Quick Interaction Area plus three more:

Creation Attributes

Variable welocity i |
Scale Factor I 1.0000e+00 Get DefaultI

Type Rectilian _llLocal'ion Vertices _l|

Filter Threshalds None - |

Low | 0.0000e+00 High [ 0000e+00

Display Density
aepla [ 0.00008+00 [ 1.00

Projection All b= | |
Projection components:

X|1.00 Y|1.oo Z|1.oo

Figure 7-40
Feature Detail Editor (Vector Arrows)

This field specifies the normal distance away from a surface to display the vector
arrows. A positive value moves the vector arrows away from the surface in the
direction of the surface normal.
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Please note that there is a hardware offset that will apply to contours, vector arrows,
separation/attachment lines, and surface restricted particle traces that can be turned on
or off in the View portion of Edit->Preferences. This preference (“Use graphics hardware
to offset line objects... ) is on by default and generally gives good images for everything
except move/draw printing. This hardware offset differs from the display offset in that it is
in the direction perpendicular to the computer screen monitor (Z-buffer).

Thus, for viewing, you may generally leave the display offset at zero. But for
printing, a non-zero value may become necessary so the arrows print cleanly.

Projection Opens a pop-up menu to allow selection of which vector components to include when
calculating both the direction and magnitude of the vector arrows. The vector components
at the originating point are always first multiplied by the Projection Components (see
below). Then one of the following options is applied:

All, to display a vector arrow composed of the Projection-Component-modified X,
Y, and Z components.

Normal, to display a vector which is the projection of the All vector in the direction
of the normal at the originating location.

Tangential, to display a vector which is the projection of the All vector into the
tangential plane at the originating location.

Component, to display both the Normal and the Tangential vectors

The All, Normal, and Tangential options produce a single vector per location, while the
Component option produces two vectors per location. If selection is not applicable to a
Particular element, that element’s vector arrow uses the A/l projection.

Projection These fields specify a scaling factor for each coordinate component of each vector arrow

Components X Y Z used in calculating both the magnitude and direction of the vector arrow. Specify 1 to use
the full value of a component. Specify 0 to ignore the corresponding vector component
(and thus confine all the vector arrows to planes perpendicular to that axis). Values
between 0 and 1 diminish the contribution of the corresponding component, while values
greater than 1 exaggerate them. Negative values reverse the direction of the component.
Always applied before the Projection options above.

The Feature Detail Editor also allows you to make changes in batch; that is, to
make several changes to the menus and fields which do not effect the Graphics
Window until you click in the Apply Changes button. It is sometimes quicker
(with respect to CPU time) to make several changes at once rather than one at a
time as in the Quick Interaction Area.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

(see How to Create Vector Arrows)

Troubleshooting Vector Arrows

Problem Probable Causes Solutions

Vector arrows do not match up with  Displacements are on for some ofthe Create separate vector arrow Parts
their originating locations on one or  parent Parts, but not others. Or the for the parents that will be displaced
more of the parent Parts. parent Parts have been assigned to (or assigned to different frame) and
different coordinate frames the ones that will not be displaced
(or assigned to different frames).
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Solutions

You are displaying several different
vector arrow Parts at once and can’t
tell which is which.

You are trying to display vector
arrows on a Discrete Particle Part,
but can’t get them to show up

Vector arrows do not print well

EnSight 7 User Manual

Just too much similar information in
the same area.

Arrow Location set to Vertices (the
default).

No vector data provided for the
Discrete Particle dataset, thus values
all set to zero when read into
EnSight.

See Display Offset discussion above.

Use different attributes for the
different vector arrow Parts, or better
yet, display the conflicting vector
arrow Parts on separate Part copies
which have been moved apart.

Set the Arrow Location to Nodes.

Provide vector data for the particles.
Specify in the Measured results file.
See Section 3.7.

Enter a non-zero Display Offset.
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7.7 Elevated Surface Create/Update

Elevated Surfaces visualize the value of a variable by creating a surface projected
away from the 2D elements of the parent Part. It is easiest to describe this feature
if you think of a planar Part as the parent Part. Now warp this surface up out of
plane proportionally to the value of a variable. The resultant surface is an Elevated
Surface. Elevated surfaces are to surfaces what Profiles are to lines. While planar
surfaces are perhaps the most useful parent Parts to use, parents do not have to be
planar. Model Parts containing 2D elements, Clip Planes, Isosurfaces, and even
other elevated surfaces are all valid parent Parts.

Figure 7-41
Elevated Surface example, with and without Sidewalls

The parent Part is not actually changed, a new surface is created. As this new
surface is “raised”, projection (Sidewall) elements can be created stretching from
the parent to the elevated surface around the boundary of the surfaces if desired.
Just the surface, just the sidewalls, or both can be created.

The projection from a node on the parent Part will be in the direction of the
normal at the node. If the node is shared by multiple elements, the average normal
is used.

The projected distance from a parent Part’s node to the corresponding elevated
surface node is calculated by adding to the variable’s value an Offset value, then
multiplying the sum by a Scaling value. Adding the Offset enables you to shift the
zero location of the plane. An Offset performs a “shift”, but does not change the
“shape” of the resulting elevated surface. The Scaling factor changes the distance
between parent and elevated surface, a “stretching” effect. EnSight will provide
default values for both factors based on the variable’s values at the parent Part’s
nodes.
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Clicking once on the Elevated Surface Create/Update Icon opens the Elevated
Surface Editor in the Quick Interaction Area which is used to both create and
update (make changes to) elevated surface Parts.

Figure 7-42
Elevated Surface Create/Update Icon

Select a Variable Scale Factor I 1 0000+00 Clet DefaultI
pressure

velocity Offset | 0.0000e+00

[ Surface [ Sidewalls

Create I Apply New Variable I Help... I

Figure 7-43
Quick Interaction Area - Elevated Surface Editor

This field specifies the scaling for magnitude of distance between the parent Part node and
the corresponding elevated surface node. The Factor is multiplied times the value of the
variable. Values larger than one increase the size and values smaller than one decease the
size. A negative value will have the effect of switching the direction of the projected
surface.

Click to set Scale Factor and Offset values to the calculated defaults based on the variable
values for the parent Part.

Value specified is added to the variable values before the Scale Factor is applied to change
the magnitude of projected distance. Default offset is magnitude of most-negative
projection distance (will cause the surface to be projected positively). Has the effect of
shifting the surface plot, but does not change the surface plot shape.

Toggles on/off the creation of the actual elevated surface. The sidewalls alone will be
created if this toggle is off.

Toggles on/off the creation of the sidewalls of the Elevated Surface. Elements will stretch
from the parent Part to the Elevated surface around the boundary of the surfaces. The

Elevated Surface alone will be created if this toggle is off.

Changes the variable the Elevated Surface Part is based on to that currently selected in the
Variables List.
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Feature Detail Editor
(Elevated Surfaces)

Double clicking on the Elevated Surfaces Create/Update Icon opens the Feature
Detail Editor for Elevated Surfaces, the Creation Attributes Section of which
provides access to all of the functions available in the Quick Interaction Area plus
one more:

Creation Attributes

Variable None i |

X | o000 Y | o000  Z | 0.0000

Scale Factor I 1.0000e+00 Get DefaultI
Offset | 0.0000¢+00

[ Surface [ Sidewalls

Figure 7-44
Feature Detail Editor (Elevated Surfaces)

XY Zz For vector-based or coordinate-based elevated surfaces, specify vector components used
in creating the elevated surface. Not applicable to scalar-type elevated surfaces. Are
according to the reference frame of the Elevated Surface-Part. Letters labeling dialog data
entry fields depend on type of the reference frame (Rectangular, Spherical, or Cylindrical).

If all components are 0.0, the vector or coordinate magnitude will be used.

The Feature Detail Editor also allows you to make changes in batch; that is, to
make several changes to the menus and fields which do not effect the Graphics
Window until you click in the Apply Changes button. It is sometimes quicker
(with respect to CPU time) to make several changes at once rather than one at a
time as in the Quick Interaction Area.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

(see How to Create Elevated Surfaces)

Troubleshooting Elevated Surfaces

Problem

Probable Causes Solutions

The entire Elevated Surface is not
projected in the direction you
want.

Change the sign of the scale factor.

Sidewall elements are not
appropriate

You have a non-planar parent
Part and the elevated surface
seems to have strange
intersecting elements.

Turn off sidewall toggle.
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The Elevated Surface projection
appears to be “confused” at
various locations.

Scale factor too large.

Inconsistently ordered elements,
such that the normals are not
“consistent”

Lower the Scale Factor.

Modify element ordering to be
consistent, if possible.
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Profiles visualize values of a variable along a line with a plot projecting away
from the line. Projectors are parallel to a plane, but not necessarily in a plane.
Hence, Profile can follow the line.

You can scale and offset projectors. The positive direction is set with the center
point of the Plane Tool (away from center point is positive). Consider a base-line
(not necessarily straight) along which the value of a variable is known. Moving
along this base-line, you can “plot” the value of the variable on an “axis” whose
origin moves along the base-line and whose orientation varies so that it is always
both perpendicular to the base-line and parallel to a specified plane (but not
necessarily parallel to a /ine, enabling the plot-line to follow the curve of the base-
line in one dimension). A surface joining the base-line to the plot-line is called a

profile.

The parent Part of a Profile-Part can be a 2D-Clip Line, a Contour, a Particle
Trace, or a model Part consisting of a chain of bar elements. From each node of
the parent Part, EnSight draws a “projector” whose length is proportional to the
value of the variable at the node, and whose orientation makes it (1) parallel to a
specified plane, (2) pointing in a direction corresponding to the sign of the
variable’s value at the node (with the negative-direction determined by the
location of a specified point), and (3) perpendicular to the base-line elements
adjoining the node, or, if the base-line bends at the node, oriented so that its
projection into the plane defined by the base-line elements will bisect the angle
formed by the base-line elements. The outer-end of each projector is connected to
those of its neighbors, forming a series of four-sided polygons and hence a
surface.

The appearance of the profile depends greatly on the position of the specified
sign-direction point (From Point) and the orientation of the specified plane, which
you can specify numerically or with the Plane tool. EnSight calculates the
projectors using the vector cross-product of the specified-plane’s normal (the Z-
axis) and each parent Part element, thus you should orient the plane so that its
normal is not parallel to the parent Part elements.
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Scale Factor

Offset

Get Default

Show Orientation Tool
Update Orientation

Apply New Variable
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The projector length is calculated by adding to the variable’s value an Offset
value, then multiplying the sum by a Scaling value. Adding the Offset enables you
to shift the zero location of the projectors, which might be useful if you wanted to
make all the projectors have the same sign. An offset performs a “shift”, but does
not change the “shape” of the resulting profile. The Scaling factor changes the
displayed size of the profile, a “stretching” type of action. EnSight will provide
default values for both factors based on the variable’s values at the parent Part’s
nodes.

Clicking once on the Profile Create/Update Icon opens the Profile Editor the
Quick Interaction Area which is used to both create and update (make changes to)
profile Parts.

Figure 7-45
Profile Create/Update Icon

Select a Variable Scale Factor I 1 0000+00 Clet DefaultI
pressure

velocity Offset [ 0.0000e+00

Show Orientation Tooll Update Oﬁental'ionl

Create I Apply New Variable I Help... I

Figure 7-46
Quick Interaction Area - Profile Editor

This field specifies the scaling for magnitude of the projector. The Scale Factor is
multiplied times the value of the variable. Values larger than one increase the size and
values smaller than one decrease the size.

The value specified in this field is added to the variable values before the Scale Factor is
applied to change the magnitude of projectors. Default offset is magnitude of most-
negative projector (making them all positive). Has the effect of shifting the plot, but does
not change the plot shape.

Click to set Scale Factor and Offset values to the calculated defaults based on the variable
values for the parent Part.

Causes the Plane Tool to become visible in the Graphics Window at the location specified
Recreates the Profile Part at the current location and orientation of the Plane Tool.

Changes the variable the Profile Part is based on to that currently selected in the Variables
List.
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Feature Detail Editor ~ Double clicking on the Profile Create/Update Icon opens the Feature Detail Editor
(Profiles) for Profiles, the Creation Attributes Section of which provides access to additional
functions for the creation and modification of Profiles:

N G R—

File Edit View

LLL]

-] Pl
Desc I iy
Creation Attributes
Variable None I
Xloooon  ¥looo00 | Z|0.0000

Seale Factor | | g000e+00 Get DefaultI
Offset | o 0000e+00

Figure 7-47

Feature Detail Editor (Profiles)

XY Zz These fields specify the vector components used in creating the Part for vector based or

coordinate-based Profiles. These fields are not applicable to Scalar-based Profiles. When
all fields are zero, the magnitude of the Variable value is used. If a value other than zero is
entered into a field, the sum of (Vectory*X)+(Vectory*Y)+(Vector;*Z) is used as the

variable value.

Orientation Plane

Pos of C1 Specification of the location, orientation, and size of the Plane Clip using the coordinates
Pos of C2 (in the Parts reference frame) of three corner points, as follows:
Pos of C3 Corner 1 is corner located in negative-X negative-Y quadrant

Corner 2 is corner located in positive-X negative-Y quadrant
Corner 3 is corner located in positive-X positive-Y quadrant

Set Tool Coords ~ Will reposition the Plane Tool to the position specified in C1, C2, and C3.
Get Tool Coords ~ Will update the C1, C2, and C3 fields to reflect the current position of the Plane Tool.

The Feature Detail Editor also allows you to make changes in batch; that is, to
make several changes to the menus and fields which do not effect the Graphics
Window until you click in the Apply Changes button. It is sometimes quicker
(with respect to CPU time) to make several changes at once rather than one at a
time as in the Quick Interaction Area.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

(see How To Create Profile Plots)
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Troubleshooting Profiles

Problem

Probable Causes

Solutions

The entire profile is not projected the
direction you want.

Portions of the profile appear to be
projected in the wrong direction.

The Plane is not oriented correctly.

The From Point is not in a good
location

The From Point is not in a good
location.

The normal to the Plane is parallel to
some of the elements of the parent
Part.

The Parent Part does not contain
elements which are consistently
ordered

Turn on the Plane tool so you can see
its orientation. The projectors will be
parallel to this plane, so adjust its
orientation.

Turn on the Plane tool so you can see
the location of the center of the
plane. Positive projectors will go
away from this point, negative
towards.

Turn on the Plane tool so you can see
the location of the center of the
plane. Positive projectors will go
away from this point, negative
towards.

Turn on the Plane tool so you can see
its orientation. Try to make sure the

Z axis of the Plane tool does not lie

parallel to any portions of the parent
Part.

None
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7.9 Developed Surface Create/Update

7.9 Developed Surface Create/Update

Parent Parts

EnSight 7 User Manual

A Developed Surface is generated by treating any 2D Part (or parent Part) as a
surface of revolution, and mapping specific curvilinear coordinates of the
revolved surface into a planar representation.

A Developed Surface derives its name from the implied process that defines a
developable surface. A surface is considered “developable” if it can be unrolled
onto a plane without distortion. Although every 2D Part in EnSight is not by
definition a developable surface, each 2D Part can nevertheless be developed into
a planar surface which is distorted according to the type of developed projection
specified. For example, a Cylinder Clip Part is by definition a developable
surface, because it can be developed into planar surface without distortion.
Whereas, a Sphere Clip Part is not a developable surface, because it can not be
developed into a planar surface without distortion.

Only 2D Parts are developed. Also, only one Part is developed at a time. While all
2D Parts qualify as candidate parent Parts, only 2D Parts of revolution are
developed coherently. The current developed surface algorithm treats all parent
Parts as surfaces of revolution that are developed according to a local origin and
axis of revolution. These attributes are either inherited from the parent Part, or
must be specified according to the parent Part.

A developed surface permanently inherits the local origin and axis of revolution
information from any parent Part created via the cylinder, cone, sphere, or
revolution Clip tools. Whereas, surfaces developed from non-Clip Parts require
this information to be specified via the Orig. and Axis fields in the Attributes
(Developed Surfaces) dialog. The latter case is the only time the values in these
fields are used. Although default values are provided, it is up to you to make sure
that valid values are specified. In the former case, the Orig and Axis fields only
provide convenient feedback of the selected Clip Part. Note that developed
surfaces resulting from parent Parts of revolution created via the general quadric
Clip tool do not inherit the local origin and axis of revolution attributes from the
General Quadric Clip parent; rather, these attributes must be specified.

Figure 7-48
Developed
Surface
Examples
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Developed Projections A parent Part is developed by specifying one of three curvilinear mappings called

Seam Line

developed projections; namely, an (1,z), (0,z), or (m,0) projection. The curvilinear
coordinates r, 6, z, and m stand for the respective radius, 0, z, and meridian (or
longitude) directional components which are defined relative to the local origin
and axis of revolution of the parent Part. The meridian component is defined as m

= SQRT(r? + Z?).

Essentially, each topological projection first
surrounds the parent Part of revolution with a
virtual cylinder of constant radius. The
curvilinear coordinates of the parent Part are
then projected along the normals of (and thus
onto) the virtual cylinder. Finally, the virtual
cylinder is slit along a straight line, or
generator, and unwrapped into a plane. This
process yields an equiareal, or area
preserving, mapping which means that the
area of any enclosed curve on the surface of
the parent Part is equal to the area enclosed
by the image of the enclosed curve on the
developed plane. Although equiareal
mappings provide reduced shape distortion,
they do suffer from angular distortions of
local scale.

Vector fields of the parent Part (for all three
/ e developed projections) are developed such
that a vector’s angle to its surface normal is

—

N/

o
N

~o\

preserved. For example, a vector normal to
— the parent surface remains normal when
developed onto the planar surface.

N

—_—

Figure 7-49
Developed Equiareal Projection

A surface of revolution is developed about its axis, starting at its “seam” line (or
zero meridian) where the surface is to be slit. Surface points along the seam are
duplicated on both ends of the developed Part. The seam line is specified via a
vector that is perpendicular to and originates from the axis of revolution, and
which points toward the seam which is located on the surface at a constant value.
This vector can be specified either manually or interactively. Interactive seam line
display and manipulation is provided via a slider in the Attributes (Developed
Surfaces) dialog.
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Projection

Scale Factors (u,v)

Show Cutting Seam

Align with Parent
Origin/Axis
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7.9 Developed Surface Create/Update

Clicking once on the Developed Surface Create/Update Icon opens the Developed Surface
Editor in the Quick Interaction Area which is used to both create and update (make
changes to) developed surface Parts.

Figure 7-50
Developed Surface Create/Update Icon

Projection = (theta,z) _l|

Scale Factors(u,v) “|1.00009+00 ¥ | 1.0000e+00

Shew Cutting Seam | Align with Parent Origin/Axis |
Z 0 .
| | =
Create I Help... I
Figure 7-51

Quick Interaction Area - Developed Surface Editor

Opens a pop-up dialog for the specification of which type of (u,v) projection, or mapping,
you wish to use for developing a surface of revolution; where u,v denotes curvilinear
components of the parent Part that are mapped into the xy-plane of reference Frame 0.
The options are:

(m,r) denotes the meridian and radial components of the revolved surface
(m,theta) denotes the meridian and theta components of the revolved surface.
(1,2) denotes the radial and z-directional components of the revolved surface

(theta,z)  denotes the theta and z-directional components of the revolved surface.
(m,theta) denotes the meridian and theta components of the revolved surface.

The meridian component is the curvilinear component along a revolved
surface that runs in the direction of its axis of revolution (e.g. the meridonal
and z-directional components along a right cylinder are coincident, and for a
sphere the meridian is the longitude).

These fields specify the scaling factors which will be applied to the u and v projections.

Click this button to display the current seam line location about the circumference of the
revolved surface. The seam line is manipulated interactively via the Slider Bar.

Retrieves the Origin and Axis information from the Parent Part. Must be done if Parent
Part is a quadric clip.
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Feature Detail Editor
(Developed Surfaces

Vector _|_ To Axis
Pointing To Seam

Orig XY Z

Axis XY Z

Double clicking on the Developed Surface Create/Update Icon opens the Feature
Detail Editor for Developed Surfaces, the Creation Attributes Section of which
provides access to all of the functions available in the Quick Interaction Area plus
several more:

Creation Attributes

Projection  (theta,z)
Scale Factors {u,v)
W L0000e-+00 | L0000e-+00
Seam Orientation
Show Cutting Seam
0 +

Vector _|_ To Axis Pointing To Seam
1.0000e+00 0.0000e-+00 0.0000e+00

Align With Parent Origin/Axis

X ¥ zZ
Orig [ 0000e+00 0.00006+00 0.00006+00
Axis

0.00006+00 0.00006+00 1.0000e+00
Figure 7-52

Feature Detail Editor (Developed Surfaces)

These fields allow you to precisely specify the position of the Cutting Seam Line
by specifying the direction of the vector perpendicular to the axis of revolution which
points in the direction of the seam line.

These fields specify a point on the axis of revolution.

These fields specify a vector, which when used with the Axis Origin defines the axis of
revolution.

The Feature Detail Editor also allows you to make changes in batch; that is, to
make several changes to the menus and fields which do not effect the Graphics
Window until you click in the Apply Changes button. It is sometimes quicker
(with respect to CPU time) to make several changes at once rather than one at a
time as in the Quick Interaction Area.

(see Section 3.3, Part Editing for a detailed discussion of the remaining Feature
Detail Editor turn-down sections which are the same for all Parts),

(see How To Create Developed (Unrolled) Surfaces)

Troubleshooting Developed Surfaces

Problem

Probable Causes Solutions

Error message is encountered while ~ Parent Part is invalid. Only 2D Parts can be developed.
creating a Developed Surface Part.
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Problem

Probable Causes

7.9 Developed Surface Create/Update

Solutions

Developed Surface is created, but is
either not visible, Partially visible, or
obstructed by other Parts which may
be other developed Parts

Developed Surface Part is a line.

Developed Surface Part does not
update to new Orig and/or Axis
values.

EnSight 7 User Manual

Since all Developed Surfaces are
projected about the origin on the xy-
plane of the reference frame of the
parent Part, they may map outside
the viewport, intersect other Parts, or
pile up on each other.

Wrong Projection type was
specified.

The Orig and Axis values can not be
specified if the Parent Part is created
from either a cylinder, sphere, cone,
or revolution quadric clip. These
values can only be specified if the
2D parent Part is not a quadric
clipped surface.

Set the Developed Surface to be
viewed in its own viewport and
initialize the viewport.

Use different u/v scaling.

Assign the developed Part to its own
local reference frame and transform
it accordingly.

Select a different Projection.

Since values entered for this
condition are not used, click the Get
Parent Part Defaults button to update
the fields based on the selected
parent Part in the Parts & Frames
list.
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7.10 Displacements On Parts

Displace by

Displacement Factor

Apply New Variable

Each node of a Part is displaced by a distance and direction corresponding to the
value of a vector variable at the node. The new coordinate is equal to the old
coordinate plus the vector times the specified Factor, or:

Chew = Corig + Factor * Vector,

where C,, is the new coordinate location, C,;, is the coordinate location as
defined in the data files, Factor is a scale factor, and Vector is the displacement
vector.

You can greatly exaggerate the displacement vector by specifying a large Factor
value. Though you can use any vector variable for displacements, it certainly
makes the most sense to use a variable calculated for this purpose. Note that the
variable value represents the displacement from the original location, not the
coordinates of the new location.

Clicking once on the Displacements On Parts Icon opens the Displacements
Editor in the Quick Interaction Area which is used to specify how you wish to
displace Part nodes based on a vector variable.

Figure 7-53
Displacements On Parts Icon

Displace By Variable i |
displacements Displacement Factor I 1.0000e+00

Apply New Variable | Help... |

Figure 7-54
Quick Interaction Area - Displacements Editor

This button allows selection of either None for no displacement or Variable (that selected
in the Variables List) to use for displacement. The selected Variable must be a node-based
vector and must be defined on the Parent Parts.

This field specifies a scale factor for the displacement vector. New coordinates are
calculated as: C,¢,, = Cqyig + Factor*Vector, where C,,, is the new coordinate location,

Corig 18 the original coordinate location as defined in the data file, Factor is a scale factor,

and Vector is the displacement vector. Note that a value of 1.0 will give you “true”
displacements.

Changes the variable the Displacements are based upon to that currently selected in the
Variables List.
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7.10 Displacements On Parts

Feature Detail Editor ~ Double clicking on the Displacement on Parts Icon opens the Feature

(Model) Detail Editor for Model Parts, the Displacements Attributes turndown area of
which provides access to the same functions available in the Quick Interaction
Area.

(see Section 3.3, Part Editing for a detailed discussion of the other features
available in the Feature Detail Editor (Model)),

(see How To Display Displacements)

Troubleshooting Displacement Attributes

Problem Probable Causes Solutions

Displacement not visible Displace By set to None for Part that ~ Set Displace By to Variable
is not displacing.
Displacement Factor value too Specify a larger Displacement
small. Factor.
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7.11 Query/Plot

EnSight provides several ways to examine information about variable values. You
can, of course, visualize variable values with fringes, contours, vector arrows,
profiles, isosurfaces, etc. This section describes how to query variables
quantitatively:

Over Distance EnSight can query variables at points over distance for the following information:
« variable values inside Parts at evenly spaced points along a straight line
 variable values inside Parts at the nodes of a different 1D Part

Over Time EnSight can query variables over time for the following information:

* minimum and maximum variable values for Parts
« variable values at any number of sample times at any point inside of a Part or at
any labeled node or element.

Over-time queries can report actual variable values, or Fast Fourier Transform
(FFT) spectral values at the positive FFT frequencies.

Variable vs. EnSight can produce a scatter plot of one variable vs. another.
Variable
Operations on EnSight can scale query values and/or combine one set of query values with

another set to produce a new set of values.

Importing EnSight can import query values from external files.

Query Candidates Only Parts with data residing on the Server host system may be queried. Thus,
Parts that reside exclusively on the Client host system (i.e. contours, particle
traces, profiles, vector arrows) may NOT be queried.

(see Section 3.1, Part Overview)

Clicking once on the Query/Plot Icon opens the Query/Plot Editor in the Quick
Interaction Area which is used to query about the selected Variable on the selected
Part and, if you wish, assign a query entity to a plotter.

Figure 7-55
Query/Plot Icon

Q| Query Items Sample | pleage Select A Query Style ¥
u

e

r

¥

P

1

o| Show...| Save..| Delete...

t

Marker Visibility ... Cvaale Lhdate Help...
Figure 7-56

Quick Interaction Area - Query/Plot Editor

Query ltems This is the list of query items that currently exist in EnSight. After creating a query item, it
will show up in this list and can be modified by selecting it in the list and changing the
displayed values. (Note, it is best to deselect any query items in the list when creating a
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7.11 Query/Plot

new one, otherwise you may accidently modify values for the item with the left mouse
button.)

This menu contains the types of queries that can be created. Selecting one of these changes
the interface to display controls related to the type.

Sample | pleace Select A Query Style ¥

At Line Tool Over Distance

At 1D Part Over Distance

At Node Over Time

At Element Over Time

At LIK Over Time

At Cursor Over Time

At Mininum Over Time

At Maximum Over Time

By Operating On Existing Queries
Read From An External File

Figure 7-57
Query Sample Types

Please Select A Query Style is displayed until a Sample selection is made.
At Line Tool Over Distance
At 1D Part Over Distance

At Node Over Time

queries at uniform points along the line tool.
queries at the nodes of a 1D part.

queries at a node over a range of times.

At Element Over Time
At IJK Over Time

queries at an element over a range of times.
queries at an [JK location over a range of times.
At Cursor Over Time queries at the cursor tool location over a range of times.

At Minimum Over Time queries the minimum of a variable over a range of times.

At Maximum Over Time queries the maximum of a variable over a range of times.

By Operating On Existing Queries forms new query by scaling and/or combining existing ones.
Read From An External File imports previously saved or externally generated queries.
(This can be EnSight XY data format or MSC Dytran .ths

files.)

General to Each Type of Query

Marker Visibility

Mix...
RGB

Size

Update

EnSight 7 User Manual

Toggles the visibility of the marker showing the location for the query. For distance
queries, a sphere marker will be shown indicating the beginning location for the query.

Opens the Query Display Attributes dialog for the specification of the display attributes of
the query marker.

FW
MRII.OO G[1o0 B [100
| Stz< [1o000er00 |

= |

Figure 7-58
Query Display Attributes dialog

Opens the Color Selector to specify the color of the marker.
The red, green, and blue color for the marker.

The size of the sphere marker. The value is a scale factor. Values larger than 1.0 will scale
the marker up, while values less than 1.0 (but greater than 0.0) will scale the marker down.

This button causes the query to be recomputed using any modified attributes or variables.
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Save...

Format

File Name

File Select

Show ...

Save Text To File

Delete...

Create

Plot

7-66

Opens the Save Entity Query To dialog for the specification of the format, and file name in
which you wish to save the query entity.

Format Formatted

File name

File Select... E
Cancel E

Figure 7-59
Save Query Entity To dialog

Opens a pop-up menu to allow specification of the format. Choices are:

Formatted Outputs the query information to the specified file in the same format as the
Show Text button.

XY Data  Outputs the query information in a generic format which could be used to
export the information to a different plotting system.

This field is used to specify the file name in which you wish to save the query entity.

Opens up the File Selection dialog for specifying the File Name as an alternative to
entering it manually in the File Name field.

This button will display the results of the selected query in the EnSight Message Window.
[ - EnsightMessagevingow ____H

Time vz, displacement For Mode 100

Time{Sim, ) Value
0,000002+00  0,000002+00
2,611112-02  4,64008=+02
5,222292-02  9,15206e+02
7 ,83333=2-02 1,326782+03
1.04ddde-01  1,679122+03
1,308562-01  2,0030d=2+03
1,B66672-01  2,322092+03
1,82778=-01  2,64489=2+03
2,0888%-01  2,97097e+03
2,33000e-01  3,14882e+03

Minimim value overall
At Time = 0,000008+00, Walue = 0,000008+00

Maxtinum value owverall
At Time = 2,35000e-01. Walue = 3,14882e+03

Close Save Text To File

Figure 7-60
EnSight Message Window displaying query information

Opens the File Selection dialog for specification of filename to save to.

This button will delete the selected query items. You must confirm the deletion before it as
actually done.

This button will create the query according to options and variables specified.

Changes the Quick Interaction Area into the plotting section.

q| Query Items Platters Of Query's Type

v = Rescale plotter when

= curve assigned

r

¥

P

i L

e - J .

t Sheow...| Save...| Delete...| New Plotter | Delete... | Help
Figure 7-61

Plot Query Entity To dialog
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Query ltems Shows a list of current query items. As you select these, the plotters of the same type (if
any) will be displayed in the Plotters Of Query’s Type list. And if the query has been
assigned to one of these plotters, it will be highlighted.

Plotters Of Query’s  Shows a list of currently defined Plotters which are of the same type as the selected query.
Type The selected query can be plotted on these or on a new plotter.

Rescale plotter If a query is assigned to an existing plotter by selecting one in the Plotter Of Query’s Type
when curve assigned list, enabling this option will rescale the axis of the Plotter to include all queries that are
assigned to it.

New Plotter Will create a new plotter, add the new plotter to the list, and display the plotter with its
query curve in the graphics window.
Delete ... Will delete the selected plotters. You must confirm the deletion before it is actually done.
Query
At Line Tool Over Distance
Q| Query Items Sample | 4t Line Tool Over Distance ¥
‘: Time vs. Maximum pla = vrauiable: 1 plastic =T None(optional) =
; Distance  Are Length Samples | 5, Tool Loc...
P
40
a| Show...| Save...| Delete...
t Marker Visibility ... Create Update Help...
Figure 7-62
Quick Interaction Area - Query/Plot Editor - At Line Tool Over Distance
Variable: 1 A list of variables than can be chosen for the query. If plotted, this variable will be plotted
along the Y-Axis.
Variable: 2 If you leave this as “None”, DISTANCE will be the default X- Axis variable. If you

choose a variable form the list, a “scatter plot” query will result, and the X-Axis will be
the variable you have chosen.

Distance A menu of choices that control the distance parameter.

Arc Length The distance along the part from the first node to each subsequent node
(i.e. the sum of the 1D element lengths).

X Arc Length The X coordinate value of each node accumulated from the start.

Y Arc Length The Y coordinate value of each node accumulated from the start.

Z Arc Length The Z coordinate value of each node accumulated from the start.

From Origin The distance from the origin.

X from Origin ~ The X distance from the origin.

Y from Origin ~ The Y distance from the origin.

Z from Origin ~ The Z distance from the origin.

Samples For queries over Distance using the Line Tool, this field specifies the number of equally
spaced points to query along the line.

Tool Loc... Brings up the Transformation Editor (Line Tool) dialog for feedback and manipulation of
the location of the line tool.
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At 1D Part Over Distance

Select Part(s} To Operate On Q| Query Items Sample | 4t 1D Part Over Distance v
13-(M/C1} guardrail supports LIlIDi=tance vs. plastic for Variable: 1 " 2 q
14-(M/C1) guardrail supports - e ariable: © | plastic ¥| | None(optionaly | ¥
. r n
15-(M/C1} guardrail ¥ Distance  Arc Length Multiple | 4 ccumulation
P |16-(M/C1) GROUP: car Segments By

17-(2/C1} elip with 1D elements| P Query Origin...

1

o| Show...| Save..| Delete...

t

Marker Visibility ... Create Update Help...
Figure 7-63

Quick Interaction Area - Query/Plot Editor - At 1D Part Over Distance

Note that the 1D part to use for the query must be selected from the Part’s list.

Variable: 1 A list of variables than can be chosen for the query. If plotted, this variable will be plotted
along the Y-Axis.
Variable: 2 If you leave this as “None”, DISTANCE will be the default X- Axis variable. If you

choose a variable form the list, a “scatter plot” query will result, and the X-Axis will be
the variable you have chosen.

Distance A menu of choices that control the distance parameter.

Arc Length The distance along the part from the first node to each subsequent node
(i.e. the sum of the 1D element lengths).

X Arc Length The X coordinate value of each node accumulated from the start.

Y Arc Length The Y coordinate value of each node accumulated from the start.

Z Arc Length The Z coordinate value of each node accumulated from the start.

From Origin The distance from the origin.

X from Origin ~ The X distance from the origin.

Y from Origin ~ The Y distance from the origin.

Z from Origin ~ The Z distance from the origin.

Multiple Segments By When the selected 1D part contains more than one contiguous segment, these are handled
by:

Accumulation ~ Each segment’s query is appended to the previous. Thus a plot of this
query will be one extended curve, but the extents of individual segment
may not be obvious.

Reset Each Each segment’s query is treated like it is independent. Thus a plot of
this query will appear as several curves.

Query Origin ... Brings up the Query Origin dialog for feedback and manipulation of the location of the
query origin. .

The line segment end point closest to the
origin specified below will be used for the
query origin. (ie. where distance = 0.0}

OrigX | 5 0000e.01 Y | 5.0000e-01  Z | 1.0000e-+00

Jump To Next Endpoint Get Cursor Tool Location

Close Help...
L

Figure 7-64
Query Origin dialog

Orig XYZ Coordinates of the location to use for query origin determination. The endpoint closest to
the origin specified will be used as the “origin” of the query, i.e., where distance is zero. If
the 1D part is s closed loop (i.e. there are no end points), the closest point on the loop is
used as the “origin”.
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Jump To Next
Endpoint

Get Cursor Tool
Location

At Node Over Time

Variable: 1

Variable: 2

Samples

Node ID
Beg/End Time ...

Sample By

7.11 Query/Plot

When multiple segments are present, clicking this button jumps to the beginning of the
next segment, placing that location in to the Orig XYZ fields.

Places the current cursor tool location into the Orig XYZ fields so that point can be used
as the query origin.

Q| Query Items Sample | 2t Node Over Time ¥

‘: Variable: 1 displacement v 2 None{optional} ¥

; Samples | 9y Node ID | )

P Beg/End Time...| Sample By Value

:lx Show...| Save...| Delete...

t Marker Visibility ... Create Update Help...
Figure 7-65

Quick Interaction Area - Query/Plot Editor - At Node Over Time

A list of variables than can be chosen for the query. If plotted, this variable will be plotted
along the Y-Axis.

If you leave this as “None”, TIME will be the default X- Axis variable. If you choose a
variable form the list, a “scatter plot” query will result, and the X-Axis will be the variable
you have chosen.

Specifies how many evenly timed moments over the specified range of time steps at which
to query (if left blank, you get a sample point at each time step). If you specify more or
fewer sample points than the number of time steps, EnSight linearly interpolates between
the adjoining time steps. If query is an FFT sampling, the number of frequencies output
will be less than or equal to the number of sample points.

Specifies a node ID.

Opens up the Solution Time Editor in the Quick Interaction Area. Here you can specify
the start and end times for queries Over Time.
(see Section 7.13, Solution Time)

Opens a pop-up menu for specification of how to report values for Over Time queries.
Options are:

Value reports values versus time.

FFT reports FFT spectral values versus FFT positive frequencies.

At Element Over Time

Variable: 1

Variable: 2

Samples
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Q| Query Items Sample | 4t Element Over Time v

‘: Variable: 1 elem plastic v 2 None{optional} ¥

; Samples | 9y Element ID | o5

P Beg/End Time...| Sample By Value

:lx Show...| Save...| Delete...

t Marker Visibility ... Create Update Help...
Figure 7-66

Quick Interaction Area - Query/Plot Editor - At Element Over Time

A list of variables than can be chosen for the query. If plotted, this variable will be plotted
along the Y-Axis. (Note: only per_element variables can be used for this query type.)

If you leave this as “None”, TIME will be the default X- Axis variable. If you choose a
variable form the list, a “scatter plot” query will result, and the X-Axis will be the variable
you have chosen.

Specifies how many evenly timed moments over the specified range of time steps at which
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Element ID
Beg/End Time ...

Sample By

At IJK Over Time

Variable: 1

Variable: 2

Samples

IJK
Beg/End Time ...

Sample By

7-70

to query (if left blank, you get a sample point at each time step). If you specify more or
fewer sample points than the number of time steps, EnSight linearly interpolates between
the adjoining time steps. If query is an FFT sampling, the number of frequencies output
will be less than or equal to the number of sample points.

Specifies an element ID.

Opens up the Solution Time Editor in the Quick Interaction Area. Here you can specify
the start and end times for queries Over Time.
(see Section 7.13, Solution Time)

Opens a pop-up menu for specification of how to report values for Over Time queries.
Options are:

Value reports values versus time.

FFT reports FFT spectral values versus FFT positive frequencies.

Q| Query Items Sample | 4¢1TK Over Time v

‘: zscalarfor LIK_ 13 3 Variable: 1 node_scalar ¥ 2 None{optional} ¥

; Samples | o, I 1 J 3 K 3

P Beg/End Time...| Sample By Value

:lx Show...| Sawve...| Delete...

t Marker Visibility ... Create Update Help...
Figure 7-67

Quick Interaction Area - Query/Plot Editor - At IJK Over Time

A list of variables than can be chosen for the query. If plotted, this variable will be plotted
along the Y-Axis.

If you leave this as “None”, TIME will be the default X- Axis variable. If you choose a
variable form the list, a “scatter plot” query will result, and the X-Axis will be the variable
you have chosen.

Specifies how many evenly timed moments over the specified range of time steps at which
to query (if left blank, you get a sample point at each time step). If you specify more or
fewer sample points than the number of time steps, EnSight linearly interpolates between
the adjoining time steps. If query is an FFT sampling, the number of frequencies output
will be less than or equal to the number of sample points.

Specifies the 1JK planes of the desired location.

Opens up the Solution Time Editor in the Quick Interaction Area. Here you can specify
the start and end times for queries Over Time.
(see Section 7.13, Solution Time)

Opens a pop-up menu for specification of how to report values for Over Time queries.
Options are:

Value reports values versus time.

FFT reports FFT spectral values versus FFT positive frequencies.
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Figure 7-68

Quick Interaction Area - Query/Plot Editor - At Cursor Over Time

A list of variables than can be chosen for the query. If plotted, this variable will be plotted
along the Y-Axis.

If you leave this as “None”, TIME will be the default X- Axis variable. If you choose a
variable form the list, a “scatter plot” query will result, and the X-Axis will be the variable
you have chosen.

Specifies how many evenly timed moments over the specified range of time steps at which
to query (if left blank, you get a sample point at each time step). If you specify more or
fewer sample points than the number of time steps, EnSight linearly interpolates between
the adjoining time steps. If query is an FFT sampling, the number of frequencies output
will be less than or equal to the number of sample points.

Can be used to open up the Transformation Editor (Cursor Tool) dialog for specification
of the cursor location. You can of course also set this location using interactive or picking
methods.

Opens up the Solution Time Editor in the Quick Interaction Area. Here you can specify
the start and end times for queries Over Time.
(see Section 7.13, Solution Time)

Opens a pop-up menu for specification of how to report values for Over Time queries.
Options are:

Value reports values versus time.

FFT reports FFT spectral values versus FFT positive frequencies.
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Figure 7-69

Quick Interaction Area - Query/Plot Editor - At Minimum Over Time

A list of variables than can be chosen for the query. If plotted, this variable will be plotted
along the Y-Axis.

If you leave this as “None”, TIME will be the default X- Axis variable. If you choose a
variable form the list, a “scatter plot” query will result, and the X-Axis will be the variable
you have chosen.

Specifies how many evenly timed moments over the specified range of time steps at which
to query (if left blank, you get a sample point at each time step). If you specify more or
fewer sample points than the number of time steps, EnSight linearly interpolates between
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the adjoining time steps. If query is an FFT sampling, the number of frequencies output
will be less than or equal to the number of sample points.

Opens up the Solution Time Editor in the Quick Interaction Area. Here you can specify
the start and end times for queries Over Time.
(see Section 7.13, Solution Time)

Opens a pop-up menu for specification of how to report values for Over Time queries.
Options are:

Value reports values versus time.

FFT reports FFT spectral values versus FFT positive frequencies.
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Figure 7-70

Quick Interaction Area - Query/Plot Editor - At Maximum Over Time

A list of variables than can be chosen for the query. If plotted, this variable will be plotted
along the Y-Axis.

If you leave this as “None”, TIME will be the default X- Axis variable. If you choose a
variable form the list, a “scatter plot” query will result, and the X-Axis will be the variable
you have chosen.

Specifies how many evenly timed moments over the specified range of time steps at which
to query (if left blank, you get a sample point at each time step). If you specify more or
fewer sample points than the number of time steps, EnSight linearly interpolates between
the adjoining time steps. If query is an FFT sampling, the number of frequencies output
will be less than or equal to the number of sample points.

Opens up the Solution Time Editor in the Quick Interaction Area. Here you can specify
the start and end ti